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Patent Information
This product may be protected by one or more patents.
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Use the following related documentation to configure GV Orbit and to better understand 
the available features. You can obtain the latest product documentation from Grass Valley’s 
website (see the GV Orbit Documentation Library web page accessible from the GV Orbit 
product page at https://www.grassvalley.com/products/network-orchestration/gv-orbit/).

Latest Software
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Valley Technical Support, on page 549.
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Welcome to the GV Orbit Client User Guide
In this first chapter, there is a GV Orbit Product Introduction and GV Orbit Client 
Introduction. The next chapter contains Getting Started Steps and subsequent chapters 
provide additional information and feature descriptions. 

See In This Document, on page 6, for a document overview.
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GV Orbit Product Introduction
GV Orbit is a single, consolidated, overarching configuration, control and monitoring 
package specifically designed for the dynamic orchestration of broadcast media networks, 
whether they be SDI, hybrid or pure IP. The underlying client-server architecture is targeted 
at open standards-based IP systems with many features and functions specifically crafted to 
make IP easy.

‘Dynamic Orchestration’ is GV Orbit’s core strength that differentiates it from competitive 
systems. The ability to build, configure and change systems on-the-fly is hugely powerful, 
whether it is the adding/removing of devices or simply changing a name. In today’s cost-
conscious world, fast and efficient deployment and re-purposing of systems for alternative 
scenarios or productions is a key requirement.

GV Orbit uses one or more GV Orbit servers running the GV Orbit services and one or more 
client computers running GV Orbit Client Introduction application(s), which provide the 
user interface(s) to a GV Orbit system.

GV Orbit Products
The product is offered in the following basic forms:

• GV Orbit Lite 
• GV Orbit Professional
• GV Orbit Enterprise

The GV Orbit Professional and Enterprise products require a GV Orbit server (GVO-HW) 
and are shipped with various software license options preinstalled. The options purchased 
determine the overall functionality and feature set available in a GV Orbit deployment.

The GV Orbit Lite product is a free-of-charge download from the Grass Valley website; it 
operates without a GV Orbit server and has basic functionality.
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Options Codes
Table 1-1 outlines the GV Orbit option codes available and their functionality.

Sections and/or sub-sections of this guide are marked accordingly as being applicable to 
Lite, and/or Professional (Pro), and/or Enterprise (Ent) users.

 Table 1-1: GV Orbit Products - Functionality and Options Codes
 Lite Professional Enterprise

Functionality
(Free of 
charge)

GVO-
CFG-PRO

GVO-
MON-PRO

GVO-
CTL-PRO

GVO-
CTL-ENT

Uses GV Orbit Client     

Requires GV Orbit Control Client    

Requires min. one GV Orbit server a 

a. For system redundancy, purchase two Professional or Enterprise systems.

   

Functionality:

Device Configuration     

Device Upgrade     

Design MV-8 Series Video Wall     

Design MV Cluster Video Walls    

Client Real-Time Video Wall b

b. Displays H.264 video streams from compatible multiviewers (e.g. MV-8 series multiviewers).

    

1 Seat GV Orbit Client/Control Client    

Advanced Configuration 

Bulk Upgrade 

Custom Screens 

Custom Screens in Web View 

Alarm Logging 

Routing Configuration  

Hardware Panel Support  

Simple Routing  

Advanced Routing 

Third-party Device Routing Control 



4

Introduction
GV Orbit Client Introduction

GV Orbit Client Introduction
GV Orbit Client comprises two client applications: 

1 GV Orbit Client.
2 GV Orbit Control Client, launched seamlessly from within the GV Orbit Client.

Both client applications are installable on PCs running MS WindowsTM. All the steps required 
to download, install and get started are covered in this guide. 

GV Orbit Client and Existing Orbit
GV Orbit Client may be installed on the same client PC as the older Orbit client application. 

Legacy Orbit projects can be opened and run by GV Orbit Client. However, any new features 
offered by GV Orbit will not be available in legacy Orbit projects run in GV Orbit Client.

GV Orbit Project Types 
GV Orbit uses a project-based workflow. 

The Control and Monitoring project (C&M project) is the main GV Orbit project type and is used 
for control and monitoring, and for routing control applications in GV Orbit Professional and 
Enterprise.

Note: GV Orbit projects cannot be opened by a legacy Orbit client.

 Table 1-2: GV Orbit Project Types

Project Type
Product

Description Supported Devices
Lite Pro Ent

Multiviewer Project   
Defines a video wall targeted at 
MV-8 series multiviewers.

MV-8 Series multiviewer 
devices.

IQ Multiviewer Project   
Defines a video wall targeted at 
IQ-MV multiviewers.

IQ-MV multiviewer devices, 
e.g. IQUCP25-MV.

Connected Multiviewer 
Project   

Pulls a Multiviewer project from 
a multiviewer into GV Orbit 
Client for video wall editing.

MV-8 Series and IQ-MV 
multiviewers.

Clustered Multiviewer -  
Defines video walls that are 
served by a cluster of MV-8 
series multiviewer devices.

MV-8 Series multiviewer 
devices.

Control and Monitoring 
Project

(C&M project)
-  

Main project type. Includes:
• Design and deployment of 

custom graphical operator 
screens. 

• Device configuration, control and 
monitoring. 

• Device routing control. 

Uses services/applications 
running on GV Orbit server(s).

Densité-protocol and RollCall-
protocol devices.

Routing control:
• IP end-points 

(Grass Valley and NMOS).
• Traditional/SDI 

(NP-0017 and SW-P-08 
protocols).
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Requirements
For a full list of requirements for running GV Orbit Client, please refer to the GV Orbit Release 
Notes, see Related Documentation, on page iii. 

Domain IDs and IP Ports
A GV Orbit system employs ‘domains’ to segregate internal communications. Domains are 
specified with a Domain ID number (1 to 252) and each Domain uses separate IP ports. 
(For further information about IP Ports and Domain IDs for the GV Orbit client and server, 
refer to the GV Orbit Release Notes see Related Documentation, on page iii.) 
 

GV Orbit Services Requirements

Lite:

There are no GV Orbit servers in a GV Orbit Lite installation and, as a result, no GV Orbit 
services in a GV Orbit Lite system.

Professional and Enterprise:

GV Orbit Client requires at least one GV Orbit server running configured GV Orbit Services. 
Please refer to related GV Orbit documentation, see Related Documentation, on page iii. In 
particular, for information on GV Orbit services, refer to the GV Orbit Admin Guide.

Note:
Domain ID numbers may be changed by the user. When using changed 
Domain ID numbers, recalculate the IP port numbers (refer to the GV 
Orbit Release Notes in Related Documentation, on page iii). 
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In This Document
This document describes some steps for getting started with GV Orbit Client and then 
proceeds to describe other features.

• Chapter 2, Getting Started Steps, on page 7.
• Chapter 3, Home Screen, on page 65.
• Chapter 4, Manage Users, on page 141.
• Routing control panels:

• Chapter 5, Routing Control - Bulk Routing Panel, on page 171.
• Chapter 6, Routing Control - XY Routing Panel, on page 265.

• Clustered multiviewers (applications with multiple multiviewers):
• Chapter 7, Multiviewer Cluster, on page 331.
• Chapter 8, MV Cluster - Room Editor, on page 359.
• Chapter 9, MV Cluster - TSL Tally Configuration, on page 445.
• Chapter 10, Audio Bars Configuration, on page 473.

• IP configuration for IP routing:
• Chapter 11, IP Configuration, on page 483.

At the end of the document there is a handy Glossary of Terms.
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The purpose of this chapter is to provide the minimum steps required to install, configure 
and get started with the GV Orbit Client application. 
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Step 1: Download, Install and Launch

This section describes how to download/install client installers and launch GV Orbit Client.
• Step 1.1: Download Client Installers, on page 8.
• Step 1.2: Installation of GV Orbit Client, on page 10.
• Step 1.3: Installation of GV Orbit Control Client, on page 13.
• Step 1.4: Launch GV Orbit Client, on page 15.

Step 1.1: Download Client Installers

Download Installer for GV Orbit Lite
On the client PC:

1 Go to https://community.grassvalley.com/support/s/productdownloads 

The Grass Valley product downloads login web page is shown.
2 If you already have a Grass Valley support login user name and password, 

then click Login and login here.
3 If you require a Grass Valley support user name and password, 

then click Request Portal Access, fill in your details and click Send Request to request 
Grass Valley portal access. 

Login information will subsequently be sent to you.

The GV Orbit Lite client installer has been downloaded.

Download Installers for GV Orbit Professional and Enterprise 
GV Orbit Professional and Enterprise use one or more GV Orbit servers which are the 
source of client installers in GV Orbit Professional and Enterprise systems. 

Download both the GV Orbit Client and the GV Orbit Control Client installer from the GV 
Orbit server. (Thus, client versions are kept compatible.) 

(For full download instructions, refer to the GV Orbit Admin Guide, see Related 
Documentation, on page iii.)

On the client PC: 
1 Enter the GV Orbit server‘s IP address into a browser. (Chrome recommended.)

The GV Orbit server Admin Login screen appears. (See Figure 2-1.)

Lite Professional Enterprise

  

Note:
Downloading of the GV Orbit Client installer is separate from the 
downloading of the GV Orbit Control Client installer.

https://community.grassvalley.com/support/s/productdownloads


9

GV Orbit Client User Guide
- Step 1.1: Download Client Installers

2 Click on each of the client installer download links to download the installers.

Fig. 2-1: GV Orbit Server Admin Login Screen

Note:
Client installers on the GV Orbit server are updated with a server update. 
After a server update, download and reinstall the clients (recommended).

Client installer download links
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Step 1.2: Installation of GV Orbit Client

Installation of GV Orbit Client and of GV Orbit Control Client is done separately. 
This section covers GV Orbit Client installation, including some information about any 
existing, legacy Orbit installs. 
(For GV Orbit Control Client, see Step 1.3: Installation of GV Orbit Control Client, on page 13.)

Legacy Orbit Client Users
For users with the older, legacy ‘Orbit’ client already installed on the client PC, the following 
applies:

• GV Orbit Client may be installed on the same client PC as the legacy ‘Orbit’ client 
application.

• GV Orbit Client and the legacy ‘Orbit’ client may not be run together.
• At installation, GV Orbit Client inherits registry settings from any already-installed 

legacy ‘Orbit’ client (e.g. multicast/unicast discovery setting, and ‘recent projects’ list).

Install GV Orbit Client 

1 Run the downloaded installer file on the client PC. 

Allow the installer to run by 
responding to any WindowsTM dialogs 
accordingly.

The GV Orbit Client installer ‘Setup GV 
Orbit’ screen is then shown.

2 Click Next> to begin the installation.

Lite Professional Enterprise

  

Note: GV Orbit client installs into client PC’s ‘Program Files’ folder by default.

Fig. 2-2: GV Orbit Client’s Setup Screen
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3 Accept the License Agreement in the 
following dialog and click Next>.

The installer will install into the folder 
of an existing installation of GV Orbit 
Client.

4 If no previous GV Orbit Client is found, then an installation folder is prompted for. 
(Default folder location is C:\Program Files\Grass Valley\GV Orbit .) 

5 Select a new folder, if required. 
Click Next.

6 At the next dialog, click Install.

GV Orbit Client installation begins 
and a progress bar is shown.

7 When GV Orbit Client installation is 
complete, the GV Orbit Client setup 
‘Completing’ screen is shown.

8 Click Finish and the GV Orbit Client 
application launches and shows its 
initial screen. See Figure 2-6.

9 Close the GV Orbit Client 
application.GV Orbit Client is 
installed. 

Note:
A shortcut is available from the 
WindowsTM Start menu. 
(Start -> Grass Valley -> GV Orbit)

Fig. 2-3: GV Orbit Client’s Setup Screen

Fig. 2-4: GV Orbit Client Setup ‘Completing’ Screen 

Fig. 2-5: GV Orbit Client Setup ‘Completing’ Screen 
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Fig. 2-6: GV Orbit Client Initial Screen

Firewall
10 Check that the GV Orbit Client application is not blocked by your client PC’s firewall. 

Note: Firewall:
‘orbit.exe’ should be on a list of allowed apps (or programs) that can 
communicate through the client PC’s firewall. 
These PC settings may be controlled by your network administrator.
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Step 1.3: Installation of GV Orbit Control Client

This sub-section is applicable to GV Orbit Professional and Enterprise product versions.

1 Log into the client PC as the user who will be operating the GV Orbit clients.
2 Run the downloaded GV Orbit Control Client 

installer file. 

Allow the file to run on the client PC by 
responding to any dialogs accordingly.

A splash screen is shown during installation:

3 When the installation is complete, the GV Orbit Control Client login screen appears.

Fig. 2-7: GV Orbit Control Client Login Screen 

4 Enter ‘admin’ for both the User name and the Password.
5 Enter the IP address of the GV Orbit server in the Server text box.
6 Click Log in.

A blank GV Orbit Control Client screen appears.

Lite Professional Enterprise

-  

Note:
The GV Orbit Control client installs into a user folder on the client PC. Thus it 
is normally only available to the user who carries out the installation.
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Fig. 2-8: GV Orbit Control Client Screen Example

7 Close GV Orbit Control Client.

GV Orbit Control Client installation is complete.

The installation folder is in the user folder, for example:
 C:\Users\A_User\AppData\Roaming\JWrapper-GVOrbitControlClient\

Firewall
8 Check that the installed application is not blocked by your client PC’s firewall. 

CAUTION: 
The GV Orbit Control Client is installed in a user folder and is therefore 
normally only available to the user who carried out the installation.

Note:
GV Orbit Control Client is not normally launched manually by the user. 
Instead, it is launched by the GV Orbit Client application.
(Although a shortcut is available on the client PC desktop and from the 
WindowsTM Start menu: Start -> Grass Valley -> GV Orbit Control Client)

Note: Firewall:
‘GVOrbitControlClient.exe’ should be on a list of allowed apps (or 
programs) that can communicate through the client PC’s firewall. 
These PC settings may be controlled by your network administrator.
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Step 1.4: Launch GV Orbit Client
1 GV Orbit Client may be launched from the WindowsTM ‘Start’ button. (“GV Orbit”)

A splash screen is shown during start up:

And then the GV Orbit Client initial 
screen is shown. See Figure 2-9.

Fig. 2-9: GV Orbit Client Initial Screen

To GV Orbit 
documentation

Open a Network
Tree View

Create New Project

Information about
the GV Orbit Client

To Grass Valley web site

Access a RollCall
device control

screen

Open existing Project

Open a Project 
recently-opened by 
GV Orbit client 
(Initially grayed-out)

Options
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Step 2: GV Orbit Projects

Introduction
This section describes how to open a project. GV Orbit project types are listed in Table 1-2 
on page 4. Once a project is created in GV Orbit Client, it can be saved locally on the client 
PC but it needs to be deployed for use by saving it (pushing it) to either:

• a multiviewer device (multiviewer projects; GV Orbit Lite, Enterprise and 
Professional); or to 

• a GV Orbit server (C&M projects; GV Orbit Professional and Enterprise only).

Multiviewer project types are used to define a compatible multiviewer’s video wall. These 
are applicable to GV Orbit Lite, Enterprise and Professional. 

The main project type for GV Orbit is a ‘Control and Monitoring’ project (C&M project) 
which is used for control and monitoring applications, and for routing control. This project 
type uses services running on a GV Orbit server and is applicable to GV Orbit Professional 
and Enterprise only. 

• Step 2.1: New Project, on page 17.
• Project Home Screens in GV Orbit Client, on page 22.
• Step 2.2: Save, Push, and Close a Project, on page 23.
• Open and Pull a Project, on page 24.

Lite Professional Enterprise
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Step 2.1: New Project 

To Open a Project from the Initial Screen
1 Click New Project.

The New Project dialog is shown.
2 Select a project type. 

Fig. 2-10: New Project Dialogs 

3 Click Browse and browse to a local folder on the client PC (or to a network folder 
accessible from the client PC) where the new project files will be placed. 
Click Choose.

4 Enter a name for the new project.
5 Click OK / Next. 

A sub-folder is created with the name of the project. It contains the new project files.
6 If prompted, answer Yes to create a directory (sub-folder).

• For a Multiviewer project, see
For a Multiviewer Project (GV Orbit Lite, Enterprise and Professional), on page 18.

• For a C&M project, see
For a C&M Project (GV Orbit Enterprise and Professional), on page 18.

Entered project name. Path to chosen folder. 

b) Multiviewer project type selecteda) C&M project type selected

Note: The chosen folder is not on a GV Orbit server.
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For a Multiviewer Project (GV Orbit Lite, Enterprise and Professional)

A dialog is shown for setting up the resolution of the multiviewer head display outputs.
7 Select the Output Size (1920x1080 or 1280x720).
8 Click OK.

The new multiviewer project is created and its GV Orbit Client project Home Screen is 
shown. See Project Home Screens in GV Orbit Client, on page 22.

For a C&M Project (GV Orbit Enterprise and Professional)

For a Control and Monitoring (C&M) project, a Setup dialog is shown. 
(For more information about setting up a C&M project, see Step 7: Control and 
Monitoring Project Setup (Professional/Enterprise), on page 51.)

Fig. 2-11: C&M Project Setup Dialog 

For the C&M project, in the Setup dialog:
9 Set Server 1 IP to the IP address of the GV Orbit server. 

(For a dual-server GV Orbit system, still just enter the IP address of one server. The 
second server will be discovered automatically in the steps below.)

After the IP address is entered, GV Orbit Client carries out some basic system tests; it 
uses the current Setup dialog settings. System connectivity is checked and some basic 
system information is discovered from the GV Orbit server.

10 After these system tests are done, the results are listed in the dialog in a console pane. 
See Figure 2-12.

Server 1 IP
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Fig. 2-12: Example Basic System Test Results (Single Server Shown)

Repository in Setup Dialog

For deployment, a C&M project is saved to the GV Orbit server in a Repository, one project per 
Repository. This setting selects which Repository is used by the project.

11 For the Repository setting, click New.

The Create Repository dialog is shown:
12 Enter a name for the new repository and click OK.

System Re-Test

A system re-test will now remove any red items in the console pane. In the Setup dialog:
13 Click System Test.

This forces the GV Orbit Client to redo its basic system tests. The results are shown in 
the console. Any ‘red’ items from before should now be cleared.

Server 1 IP

Green indicating GV Orbit Client’s server connection is OK.

(For more information, see Step 7: Control and Monitoring Project Setup 

Results of basic system 
tests in console pane.

Repository setting

Note:
Some system test console items may be shown in ‘red’, indicating where 
discovered information disagrees with settings in the Setup dialog. In this 
case, settings in the dialog are then filled out automatically to be consistent 
with discovered settings. 
A subsequent system re-test (performed below) will clear these red items. 
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Fig. 2-13: System Test Console Output:
a) Single GV Orbit Server. 
b) Dual GV Orbit Server Cluster.

14 Click Apply.

The settings are 
applied to the 
project and a 
progress bar appears in the dialog.

15 A pop-up dialog may appear, asking if the local 
project should be updated from the chosen 
repository. 

• Click Yes to update the local project (and 
lose any local changes made).

• Click No to keep the local project changes 
(and not pull the project from the repository on the server).

The applying of settings continues and progress is shown in the progress bar:

16 A pop-up dialog box confirms when the ‘Applying’ is all done. 

Click OK in the pop-up to proceed.

System Test clear output

Single GV Orbit server

a) Single GV Orbit Server b) Dual GV Orbit Server Cluster

Dual GV Orbit servers and 
Virtual IP Address
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17 In the Setup dialog, 
click Close.

The new C&M project is created in GV Orbit Client and its Home Screen is shown.
(See Project Home Screens in GV Orbit Client, on page 22.)

Note:
The Setup dialog can also be viewed when a C&M project is open by clicking 
Connections -> GV Server in the main menu of GV Orbit Client.

Note:
Setting up and applying the GV Orbit server IP address for a project will 
automatically set up other comms settings for the project.
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Project Home Screens in GV Orbit Client
The project’s Home Screen is shown and a new GV Orbit project has been created.

Fig. 2-14: GV Orbit Home Screen Examples: a) Multiviewer Project; b) C&M Project.

Note:
The Home Screen appearance varies according to project type and which 
GV Orbit Client windows are enabled and being shown.

a) Example New Multiviewer Project Home Screen

b) Example New C&M Project Home Screen (See Project Home Screen for Information)

Click icons to 
hide/show windows 
of project Home 
Screen

Workflow Window

Project Window

Network Window
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Step 2.2: Save, Push, and Close a Project

Step 2.2.1: Save a Project Locally
To locally save a project from GV Orbit Client:

1 Click Project -> Save Project in the main menu to save the project into the local folder 
on the client PC.

Step 2.2.2: Push Project (Save to Server)
To push an open project back into a repository (on the GV Orbit server, or on a multiviewer 
device):

1 Click Project -> Push in the main menu.

A Choose Projects dialog is shown.

Fig. 2-15: Choose Projects Dialog

2 Select the project to be pushed. (More than one may be selected.)
Click OK.

The project is pushed to the repository.

Once a project is in a repository, it is deployed for use:

Note: A GV Orbit ‘Multiviewer’ project type is typically for single-
multiviewer designs. 
For video walls designs that are served by a cluster of multiviewers 
(MV Cluster), then use the GV Orbit ‘Clustered Multiviewer’ project 
type (described in Chapter 7, Multiviewer Cluster, on page 331).

Note: A C&M project type is for GV Orbit Professional and Enterprise only. 
A C&M project can be created in GV Orbit Lite, but may not be used. 

Projects listed have been opened by the GV Orbit 
Client before. These appear in the Project window on 
the client. 
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• Multiviewer project - A project is pushed to a multiviewer which can then adopt the 
project’s video wall design.

• C&M project - A project is pushed to the GV Orbit server. Applications/services etc. on 
the server can then access the project. For example, the Web Renderer service can read 
the project and render its custom operator screens for viewing in a web browser.

Step 2.2.3: Close a Project
To close a project in GV Orbit Client:

• Click Project -> Close Project to close the project.

Open and Pull a Project

Open Existing Local Project
To open an existing local project from the GV Orbit Initial Screen:

1 Click the Open Project icon.

The Open dialog is shown:
2 Browse into the local project 

folder required and select the 
‘configuration.prj’ file within it.

3 Click Open.

A login screen is shown.
4 For a new project, enter 

User name ‘admin’ and 
Password ‘admin’ 
and click Login. 

The project’s Home Screen is 
shown.

Pull a Project (Load from Server)
To pull a project from a repository (on the GV Orbit server, or on a compatible multiviewer):

1 Click Project -> Pull in the main menu.

A Choose Projects dialog is shown. (See Figure 2-15.)
2 Select the project to pull.
3 Click OK.

The project is pulled from the repository, stored locally on the client PC, and is opened 
by the GV Orbit Client.

Note: New GV Orbit projects have User name ‘admin’ , Password ‘admin.
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Exit GV Orbit Client
Save the project locally and push it to be deployed, as required, before exiting GV Orbit 
Client.

To exit and close the GV Orbit Client application:
1 Click Project -> Exit.

The application shuts down and exits.

Note: Pull and Push:
When connecting to a repository, the user may be prompted to Pull a project 
from a Repository. Pull a project in order to either:
• edit the project locally (any local project is overwritten); or 
• run the project locally (for example, to run operator screens).

Do not Pull:
• if a local project has all been created or changed and which needs to be 

put into a Repository. (This requires a Push.)
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Step 3: Device Configuration

Introduction
This section describes how to access device control screens with GV Orbit Client. Devices 
can then be configured as required. RollCall- and Densité-protocol devices are covered.

• Step 3.1: Direct Configuration of RollCall-protocol Devices, on page 26.
• Step 3.2: Configuration of Densité and RollCall Devices, on page 27.

Step 3.1: Direct Configuration of RollCall-protocol Devices
RollCall-protocol devices can be configured directly from GV Orbit Client with the device’s 
IP address from the GV Orbit Client Initial Screen:

1 Click the RollCall Control Screen icon, (or, with a project open, in the main menu
click Connections -> RollCall -> RollCall Control Screen).

The Open Template dialog is shown: 

2 Enter the IP address of the target device. 
3 Click OK.

The control screen is shown in a tab.

Lite Professional Enterprise
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Fig. 2-16: Example Device Control Screen (RollCall-protocol Device shown)

4 When all device configuration changes are complete, 
close the control screen tab.

Step 3.2: Configuration of Densité and RollCall Devices
With a GV Orbit project open in GV Orbit Client, GV Orbit Professional and Enterprise can 
show RollCall-protocol and Densité-protocol devices with full status indication listed in a 
Network window. 

However, GV Orbit Lite can only list RollCall-protocol device items in the Network window 
and without any status indication.

Network Window Views
The Network window can show devices either in a tree-view or in a list-view. Toggle 
between these views with the tool bar controls shown in Figure 2-17. 
See Network Window for a description of the Network window.

Click on x on tab to close device control screen
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Fig. 2-17: Network Window Views

Initial set up of the Network window can be done in a project; this is done differently for 
RollCall-protocol devices than for Densité-protocol devices and each is described below:

• Step 3.2.1: Network Window Setup For RollCall Devices
• Step 3.2.2: View a Device Control Screen - RollCall Devices
• Step 3.2.3: Network Window Setup For Densité Devices
• Step 3.2.4: View a Device Control Screen - Densité Devices

Step 3.2.1: Network Window Setup For RollCall Devices
RollCall device control screens can be viewed with GV Orbit Client via a GV Orbit server 
(which runs a GV Orbit IP Proxy service). 

To set up the Network window:
1 For GV Orbit:

• Lite - From the GV Orbit Client Initial Screen, click the Network Map icon. 
• Professional and Enterprise and with a C&M project open - 

Click Connections -> RollCall -> Network Map  in the main menu.

An Open Network dialog is shown. (See Figure 2-18.)

Note:
The Network window may already be showing system devices etc. 
for a C&M project open in GV Orbit Client if the GV Orbit services have 
been set up on the GV Orbit server, so no set up may be required here.

Click to show List-View Click to show Tree-View

b) List-Viewa) Tree-View
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Fig. 2-18: Open Network Dialogs:
a) After clicking Network Map icon in GV Orbit Client Initial Screen.
b) After clicking RollCall -> Network Map in GV Orbit Client main menu.
c) Redundant server case.

2 Select Enable Network Map Connection, if available in the dialog.
3 Enter an IP address for the Primary Address:

• GV Orbit Lite:
Enter the address of an IQ frame controller to be able to access all devices in the 
frame.

• GV Orbit Professional and Enterprise:
Enter the IP address of a GV Orbit server.

This will connect to the IP Proxy service running on the server and allow access to 
all devices connected to the IP Proxy service.

4 For redundant GV Orbit systems, 
select Enable Redundancy and enter the IP address of a second GV Orbit server.

a) Open Network Dialog 

(after clicking on 
Network Map in the GV Orbit 
Client Initial Screen).

b) Open Network dialog 
(after clicking on RollCall -> Network Map in GV Orbit Client’s main menu).

c) Redundant server case.

Note:
The IP address entered in the Open Network dialog may be for either:

• a GV Orbit server, which runs a IP Proxy service; or for
• a single device. 
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5 Click OK. 

A Network window appears in the GV Orbit 
Client:

This can be re-sized. It can show an expandable 
tree-view of all devices attached to the IP Proxy 
service. 

Step 3.2.2: View a Device Control Screen - RollCall Devices
To view a RollCall device control screen from the Network window:

1 Locate the target device in the Network window (tree-view or list-view).
Right-click on the item and select ‘Control’.

The control screen and its sub-menus are loaded and are then shown in a tab. 

Fig. 2-19: Example Device Control Screen (RollCall-protocol Device Shown)

2 When all required user device configuration changes are done,
close the control screen tab.

Right-click on any other device in the Network window to display/edit its control screen, as 
required.

Step 3.2.3: Network Window Setup For Densité Devices
Densité device control screens (card control panels) can be viewed with GV Orbit Client 
from the Network window via a GV Orbit server (which runs a GV Orbit Densité service). GV 
Orbit Client must be configured to connect to the Densité server/service. 

In a C&M project open in GV Orbit Client:

Click to close the device control screen tab
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1 Click Connections -> Densité in the main menu.

The Densité Configuration dialog is 
shown:

2 Enter the GV Orbit server IP address.
3 Select:

• ‘Lookup Service’; and 
• ‘Densité REST’. 

4 Enter the Username and Password (if 
not already set up) to access the GV 
Orbit server (and hence the Densité 
service). 

Note: These are not the same login 
credentials as those used when opening 
a GV Orbit project with GV Orbit Client.

5 Click OK.

GV Orbit Client connects to the Densité service on the GV Orbit server.
6 Add all Densité frames to the Densité service. (Refer to the Densité Manager service 

chapter in the GV Orbit Admin Guide in the Related Documentation.)

Added Densité frames become visible in the Network window.

This has set up the Network window in GV Orbit Client to show Densité frames and to show 
fitted cards supported by the GV Orbit server. 

If a Densité card is still not shown in the window, support for it may need to be added to the 
GV Orbit server. To add support for other Densité cards, if required, see Step 5: Adding 
Support for Further Densité Cards.

Note: Densité service credentials are set up automatically if the Setup 
dialog (Connections -> GV Server in main menu) was used when 
creating the C&M project. 

Note: Densité cards can appear in the Network window if the card is:
• present in a Densité frame that has been added into the GV Orbit 

Densité Manager service on the GV Orbit server; and is

• supported by the GV Orbit server; and is 
• accessible by the GV Orbit server over the network.

Note: GV Orbit Professional and Enterprise ship with native support for 
some Densité cards. Refer to the GV Orbit release notes 
documentation for a list of natively-supported Densité cards. See 
Related Documentation.
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Step 3.2.4: View a Device Control Screen - Densité Devices
This step assumes that the Densité card is shown in the Network window (see Step 3.2.3: 
Network Window Setup For Densité Devices).

To access a Densité device control screen (device control panel) from the Network window:
1 Locate the target device in the Network window.
2 Right-click on the device and select ‘Control’.

The Densité-protocol device’s control screen 
opens in a separate window (i.e. not in the GV 
Orbit Client’s overall window) and may be 
obscured on your client PC’s screen. Check that this window is not behind the GV Orbit 
Client window or other windows.

Fig. 2-20: Example Densité Device Control Panel

Note: Densité cards can appear in the GV Orbit Client Network window 
if the card is:

• present in a Densité frame that has been added into the GV Orbit 
Densité Manager service;

• supported by the GV Orbit server; and is 
• accessible by the GV Orbit server over the network.

To add support for a card, see Step 5: Adding Support for Further 
Densité Cards.

Note: An informative message 
appears (bottom left of GV 
Orbit Client) while the 
control screen is being 
accessed.

Click to close the 
Densité device 
control panel.
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3 When all the required user device configuration is complete,
close the control panel.

Right-click on any other device in the Network window to open its control screen, as 
required.

Step 3.3: Configuration of Other Devices
Devices in a GV Orbit system which may be configured via GV Orbit appear in the GV Orbit 
Client Network window and present a ‘Control’ drop-down menu option: 

• Right-click on such a device and select ‘Control’ to open their web page in GV Orbit.

Fig. 2-21: Example GV Fabric Device Control Panel

Right-click on device and select ‘Control’
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Step 4: Device Upgrade

Introduction
This section describes how to upgrade software/firmware on a device using GV Orbit Client.

Upgrade packages for RollCall or Densité cards comprise a version of software and a version 
of firmware bundled together in a .zip file. 

To upgrade a device (or unit), the Network window must be open and showing the system 
device to be upgraded. (See Network Window Views, on page 27.)

• Step 4.1: Upgrade RollCall-protocol Devices, on page 34.
• Step 4.2: Upgrade Densité-protocol Devices, on page 38.

Also see Change Functionality of a ‘Software-Defined Core’ Card, on page 41.

Step 4.1: Upgrade RollCall-protocol Devices 
• Lite - Simple device upgrade is possible directly from GV Orbit Client.
• Professional and Enterprise - Simple device upgrade and advanced device upgrades 

are possible with the GVO-CFG-PRO option.

Simple Upgrade

Check the Current Software/Firmware Version
1 Open the Network window. 
2 Locate the device to be upgraded, right-click on it and select Info.

A Details window is shown for the unit, displaying unit information which includes the 
device’s current version of software/firmware.

Lite Professional Enterprise

  

Note:
Before starting, ensure that the upgrade package file is: 
• accessible; 
• for the correct RollCall or Densité card model; and is 
• the correct version required. 
Contact Grass Valley customer support for advice about upgrade packages.
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Fig. 2-22: Unit Information in Details Window

3 Close the Details window.

Import Upgrade Packages
4 Right-click on the tree-view device item and select ‘Upgrade’.

The RollCall Upgrade window is shown. Any software/firmware upgrade packages 
that have been previously uploaded to the GV Orbit Client are shown listed on the left 
hand side. For a fresh install of GV Orbit Client, no packages are listed.

Fig. 2-23: RollCall Upgrade Window

5 Click Import Upgrade Package(s) and browse to the upgrade package to be 
uploaded. Select the package and click Open.

The package is imported into the GV Orbit Client.

After the package has been imported, it is listed under ‘Available Packages’ in the 
RollCall Upgrade window.

Device’s software/firmware version
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Upgrade the Device
6 Select a package in the ‘Available Packages’ list of the RollCall Upgrade window.
7 Select Upgrade All Files in the ‘Options’ pane to upgrade all files on the device, 

regardless of whether a file is the same on the device and in the upgrade package.
(Deselect Upgrade All Files for a quicker upgrade.)

Fig. 2-24: RollCall Upgrade Window

8 Click the Upgrade button to start the upgrade of the device.

A message box appears informing you 
that the upgrade has started and will 
proceed in the background. 
Click OK.

The progress of the upgrade is reported bottom left in the GV Orbit Client window.

Options pane

Note:
The user may continue using the GV Orbit Client project while the upgrade 
proceeds.
However, only one RollCall upgrade can be running at any one time.
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Fig. 2-25: Upgrade Progress Messages (Bottom left in GV Orbit Client window)

9 When the device has been upgraded, this is indicated by:
• a final message at the bottom of the GV Orbit Client window; and also by
• a pop-up notification message in the WindowsTM system tray.

Check the Upgraded Software/Firmware Version
10 Right-click on the Network window upgraded-device item and select Info.

A Details window is shown displaying unit information. 
11 Check that the device’s current (upgraded) version of software/firmware is correct.

Final message

Messages 
as 

upgrade 
progresses

Bottom left 

Note:
If the Network window is being presented through an IP Proxy then a GV 
Orbit server fail-over (in a dual server cluster system) during an upgrade will 
cause a failed upgrade.
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Step 4.2: Upgrade Densité-protocol Devices 
• Lite - Simple device upgrade of Densité devices is not possible via the GV Orbit Client. 

• Professional and Enterprise - Densité device upgrade is possible via GV Orbit Client
with the GVO-CFG-PRO option, including upgrade of single and multiple Densité 
devices.

Device Upgrade (GV Orbit Professional and Enterprise only)
This sub-section assumes that the Densité card is shown in the Network window (see Step 
3.2.3: Network Window Setup For Densité Devices).

Check Current Device Software/Firmware Version
1 Open the Network window and locate the device to be upgraded.
2 Right-click on the device item to be upgraded and select Info.

A Details window is shown for the unit, displaying unit information which includes the 
device’s current version of software/firmware.

Fig. 2-26: Unit Information in Details Window

Note:
Densité modular devices may still be upgraded independently of GV Orbit 
Client using Grass Valley’s iControl Solo product. 

Note: Densité cards can appear in the GV Orbit Client Network window 
if the card is:

• present in a Densité frame that has been added into the GV Orbit 
Densité Manager service;

• supported by the GV Orbit server; and is 
• accessible by the GV Orbit server over the network.

To add support for a card, see Step 5: Adding Support for Further 
Densité Cards to be able to see the card to upgrade.

Device’s software/firmware version
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3 Close the Details window.

Import Upgrade Packages
4 Right-click on the tree-view device item and select ‘Upgrade’.

The Densité Upgrade Manager window is shown. 

Fig. 2-27: Densité Upgrade Manager 

5 Click Upload Files... and browse to the upgrade package to be uploaded. 
Select the package and click Open.

A message window appears prompting the user to start the upload.
6 Click Upload in the Progress window.

Progress of the upload is 
shown in the window and the 
package is uploaded to the 
Densité Upgrade Manager.

7 When complete, the Progress 
window shows 100% done, 
‘Operation finished’:

Click Close.
8 Verify the uploaded package 

is present in the Densité 
Upgrade Manager window by clicking in the ‘Available package’ column and looking 
in the drop-down list.

Fig. 2-28: Progress Window - Upgrade Package 100% 
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Upgrade the Device

In the Densité Upgrade Manager window, in the row for the device to be upgraded:
9 Select an upgrade package in the ‘Available Package’ column’s drop-down list.

Fig. 2-29: Upgrade Window with Selected Upgrade Package

10 Click the Upgrade button to start 
the upgrade of the device.

An Upgrade Confirmation 
message box appears. 

11 Click Yes to start the upgrade.

 Progress is reported in the ‘Install 
Progress’ column as a progress bar and a percentage (%): 
When done, a ‘Finished 100%’ message appears in the ‘Install progress’ column.

Fig. 2-30: Upgrade ‘Finished 100%’

12 Close the Densité Upgrade Manager window.

Note: After an upgrade package has been uploaded, it is available in a drop-
down box in the ‘Available Package’ column, in all rows for Densité 
devices compatible with the newly-uploaded package. 
(I.e. for an IPG-3901 package, check in any IPG-3901 device row.)

Upgraded software/firmware version on device is shown
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Check Software/Firmware Version on Upgraded Device
13 In the Network window, right-click on the upgraded-device item and select Info.

A Details window is shown for the device/unit.
14 Check that the newly-upgraded device software/firmware version is correct.

Change Functionality of a ‘Software-Defined Core’ Card
Grass Valley offer a range of cards which have a software-defined core, enabling a user to 
change the functionality of a card with core packages and licenses. GV Orbit Client enables a 
user to change such a ‘software-defined core’ card’s functionality. 

To change a card’s functionality, use the ‘upgrade’ mechanism in GV Orbit Client:
1 Locate the software-defined core card in the Network window.

Fig. 2-31: Software-Defined Core Device in Network Window

2 Right-click on the card item in the tree-view and select ‘Upgrade’.

The RollCall Upgrade window is shown for the card. The window shows:
• the core package currently in use by the card; and 
• all available (imported) core packages.

See Figure 2-32.

Note: The Densité Upgrade Manager can upgrade multiple devices.

Note: Supported software-defined core cards include:
• UCP-3901 and IQ-UCP cards, with various core packages, 

including Essence Processing (EP) cores and Multiviewer (MV) 
cores. 

See the documentation on the respective cards for further 
information and instructions on how to add licenses etc.

Note: License a card first before loading a core package into the card. 
If a core package is loaded but a card is not licensed, then default, 
‘base’ functionality results. See the documentation on the respective 
card for information.
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Fig. 2-32: RollCall Upgrade Window - Available Cores

To import further core packages: 
3 Import the core package in a similar way to an upgrade package (see Step 4.1: Upgrade 

RollCall-protocol Devices, on page 34).

To load an available (already-imported) core package into the card and change card 
functionality:

4 Select an available core package and click Upgrade. The procedure is similar to 
upgrading a card (see Step 4.1: Upgrade RollCall-protocol Devices, on page 34).

The new core package is placed on the card; the card reboots and then adopts the 
functionality of the new core package if the card is licensed.

Current software-defined core being used by the card.Available core packages
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Step 5: Adding Support for Further Densité Cards

Introduction
GV Orbit fully supports all Densité cards. GV Orbit Professional and Enterprise ship with 
native support for many Densité cards; for other cards, support needs to be added to your GV 
Orbit server. This section describes how to add support for Densité cards to your GV Orbit 
server. 

Support is added by uploading the requisite Densité card software package. Once 
uploaded, the GV Orbit server can recognize the cards and they may be integrated into the 
Network window.

Carry out this procedure to add or to update support of a Densité card.

Add or Update Densité Card Support
Many Densité cards are automatically recognized by GV Orbit. However, some Densité cards 
may not show in the Network window, even though they are physically installed in a 
Densité frame. For example, a frame’s controller card may be shown but one or more cards 
in the same frame are not shown (in the tree-view nor list-view). To make such cards 
available, the corresponding card software packages must be uploaded through the 
Densité Upgrade Manager tool.

Prerequisite:
• All Densité frames are added to the Densité Manager service on the GV Orbit server. 

(Refer to the Densité Manager service chapter in the GV Orbit Admin Guide. See Related 
Documentation.)

• Software package are available for each Densité card type to be added/updated. 
(See each separate card documentation for how to obtain each software package.) 

The procedure is similar to upgrading Densité cards (see Step 4.2: Upgrade Densité-
protocol Devices):

1 Locate a Densité frame item in the Network window tree-view and expand it to show 
all available cards.

2 If one or more cards are not shown in the Network window tree-view, 
right-click on a fitted card item (for example, on the frame controller card item) and 
select ‘Upgrade’.

The Densité Upgrade Manager tool is opened showing all the cards in the Densité 
frame. Some cards may be grayed-out.

For each Densité card type for which support is to be added/updated: 

Lite Professional Enterprise

 

Note: Refer to GV Orbit release notes documentation for a list of natively 
supported Densité cards. See Related Documentation.
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3 Import the card’s software package. 
(See Import Upgrade Packages for how to do this.)

4 Upgrade each card. 
(See Upgrade the Device for how to do this).

After a card type has been upgraded, it should appear in the Densité Upgrade Manager 
tool and not be grayed-out. 
Support for the card has now been added to the GV Orbit server.

When the support for all cards has been added:
5 Close the Densité Upgrade Manager window.

Support for the Densité cards has now been added to the GV Orbit server and the cards are 
displayed in the GV Orbit Client’s Network window. 
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Step 6: Multiviewer Project 

Introduction
This section is applicable to GV Orbit Client and multiviewer applications with single 
multiviewers that use the GV Orbit ‘Multiviewer’ project type. 

This section describes a simple edit to a GV Orbit (single-multiviewer) ‘Multiviewer’ project 
pulled from a multiviewer (MV-8 series or IQ-MV series multiviewer). The simple edit 
changes the appearance of the video wall and the project is pushed back to the device.

Simple Multiviewer Project Editing Example

Pull Project and Open
1 Open GV Orbit Client at the 

initial screen and 
click New Project.

The New Project dialog is 
shown.

2 Select Connected 
Multiviewer Project type.

3 Browse into a new, empty 
folder (into which project 
information will be placed). 

4 Click Choose.
5 Click Next.

A list of available 
multiviewers is shown.

Lite Professional Enterprise

  

Note: A GV Orbit ‘Multiviewer’ project type is typically for single-
multiviewer designs. 
For video walls designs that are served by a cluster of multiviewers 
(MV Cluster), then use the GV Orbit ‘Clustered Multiviewer’ project 
type (described in Chapter 7, Multiviewer Cluster, on page 331 
onwards).

Note: GV Orbit ‘Multiviewer’ projects are pushed/pulled to/from a 
compatible (single) multiviewer device rather than to/from a GV Orbit 
server.
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Fig. 2-33: Select Multiviewer to Connect To

6 Select the multiviewer to connect to and click OK.

GV Orbit Client connects to the multiviewer, pulls the GV Orbit project from it, attempts 
to open the project, and shows the login screen.

7 Enter the correct User name and Password for the accessing the GV Orbit project.

8 Click Login. 

The project is opened and the multiviewer project Home Screen is shown.

Note: The IP network used needs to support multicast for automatic 
discovery of devices to occur (for example, for listing available 
multiviewers).

Note: The default login for new projects is ‘admin’ ‘admin’.
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Fig. 2-34: Multiviewer Project Home Screen

The GV Orbit multiviewer project has been pulled from the target multiviewer device, 
locally stored on the client PC, and opened in GV Orbit Client. 

The multiviewer video wall design may now be edited in GV Orbit Client.

Edit the Multiviewer Project
9 Click on the large Walls icon, and select one of the wall items that is shown listed. 

The multiviewer video wall design is opened in a tab in the overall GV Orbit Client 
window. See Figure 2-35. 

Name of GV Orbit project (pulled from multiviewer)
Folder path where project is stored on the client PC.
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Fig. 2-35: Example Video Wall Tab in Wall Editor

The Wall tab is the stage on which a Wall is:
• designed and edited (in GV Orbit Client Design mode); and
• may be run and viewed (in GV Orbit Client Run mode). 

Although a video wall is fully deployed when running on a compatible multiviewer 
device.

10 Click the Run Mode / Design Mode tool bar icon to select ‘Design Mode’.

Fig. 2-36: Run Mode / Design Mode Tool Bar Icon

Run Mode / Design Mode icon (GV Orbit Client is shown in Design Mode)

Wall tab

Properties Box

Video Wall design

Video tiles

Note:
Clicking the Run Mode / Design Mode tool bar icon toggles between ‘Run’ 
and ‘Design’ modes of GV Orbit Client.

b) Icon appearance when in Design Mode 

a) Icon appearance when in Run Mode

Click to exit Run Mode

Click to enter Run Mode

Note: 
• In Design Mode, a project may be 

edited (for example, a video wall may 
be modified). 

• In Run Mode, a project monitors log 
and alarm data and generates 
display screens in real-time.
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This example edit will do a simple change to the video wall:
11 Click on one of the video tiles on the wall to select it. (E.g. the top-left video tile.)
12 In the Properties Box, change the Preferences -> Type property value to ‘Analogue 

Clock’ via the drop-down menu.

The selected tile changes to a round-faced clock within the Wall tab.

Fig. 2-37: Edited Wall Design

13 Click Project -> Save Project to save the whole project locally, including the video wall 
design.

Push Project Back to Multiviewer
14 Click Project -> Push in the main menu.

The Choose Projects dialog is shown.

Fig. 2-38: Choose Projects Dialog

Round-faced, analogue clock tile Analogue clock typeSelected video tile

Hint: 
Hover on a Project item to see local folder path

Project selected
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15 Select just the project to push to the multiviewer. 
16 Click OK.

The selected project is pushed back to the multiviewer.
The edited video wall is then used and shown by the multiviewer device.
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Step 7: Control and Monitoring Project Setup (Professional/Enterprise)

Introduction
This section is applicable to GV Orbit Professional and Enterprise only. It describes setting 
up a new ‘Control and Monitoring’ project (C&M project), which is the main project type 
applicable to GV Orbit Professional and Enterprise. Following its setting up, a C&M project 
is ready for use. For example, custom graphical operator screens etc. can be designed, 
created and used.

All C&M projects are centrally stored in and used from repositories on the GV Orbit server 
(one project per repository). The GV Orbit Client application needs to be configured to 
communicate with the GV Orbit server(s) (see Step 7.2: C&M Setup Dialog, on page 52). A 
project is loaded by GV Orbit Client from a server repository and stored locally on the client 
PC. 

• Step 7.1: New C&M Project, on page 51.
• Step 7.2: C&M Setup Dialog, on page 52.
• Step 7.3: Further Setup, on page 58.
• Step 7.4: Saving and Pushing a Project, on page 62.

Step 7.1: New C&M Project 
From the GV Orbit Client Initial Screen:

1 Click New Project.

The New Project dialog is shown.
2 Select the C&M project type. 
3 Click Browse and browse to a folder 

where the project will be placed. 
Click Choose.

4 Enter a name for the new project.

5 Click OK. 
And, if prompted, answer Yes to 
create a directory.

The Setup dialog is shown. See Step 
7.2: C&M Setup Dialog, on page 52.

Lite Professional Enterprise

-  

Note:
GV Orbit Client requires network access to one or more GV Orbit 
servers running configured GV Orbit services.
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Step 7.2: C&M Setup Dialog 

Fig. 2-39: C&M Project Setup Dialog 

The C&M Setup dialog provides a quick way to enter key project parameters for a project.

The dialog is shown automatically when creating a new C&M project. And it can be 
accessed when an existing C&M project is open by clicking Connections -> GV Server in 
the main menu.

Server IP Address(es)
1 Enter the IP address of the GV Orbit server into the Server 1 IP text box. 

For dual-server systems, enter the IP address of one server. The second server’s address 
will be discovered automatically in the steps below.

Check the address is correct.

The GV Orbit Client attempts to connect to the server and performs some basic system 
tests. 

Note:
Some key project parameters are entered in the Setup dialog and used for 
the project settings. Some settings may be subsequently edited by the user, 
if required. Refer to Step 7.3.1: Project Variables (Project -> Edit Variables), on 
page 58.
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The resulting connection status from the basic system tests is indicated in a console 
pane showing any system messages issued. See Figure 2-40a.

Note: Basic System Tests:

a. Connect to the GV Orbit server. 

A good connection status is shown with a green light indicator. 
b. Find out other GV Orbit system information from the server.
c. Fill out settings in the Setup dialog. 

For example: 
• Client Domain number being used (default is 100). 
• Available Repositories on the server.
• IP address of any second GV Orbit server; and any IP address 

being commonly used by the servers (‘Virtual IP’).
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Fig. 2-40: C&M Project Setup Dialog:
a) Single GV Orbit Server;
b) Dual GV Orbit Server Cluster

Green indicates GV 
Orbit Client 
successfully 
connected to the 
GV Orbit server.

System messages 
from basic system 
tests.

a) Single GV Orbit Server

IP addresses 
automatically 
added

b) Dual GV Orbit Server Cluster

Green indicates GV 
Orbit Client 
successfully 
connected to the 
GV Orbit servers 
and virtual IP 
address detected.

Console pane
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Select a Repository

2 In the Setup dialog, click New.

The Create Repository dialog is shown:
3 Enter a name for the new repository and click OK.

Alternatively, to select an existing repository: 
4 Select a Repository in the ‘Repository’ drop-down list in 

the Setup dialog.

The C&M project will use the project from this Repository.

Fig. 2-41: Select a Repository in Setup Dialog

System Re-Test
5 Click System Test to redo the basic system tests. 

Note: Repository:
Projects may be locally stored on the client PC but, for deployment, a C&M 
project must be saved to the GV Orbit server (Pushed) into a Repository, one 
project per Repository. Multiple clients can access the same project.

Note:
The Repository Manager service, running on the GV Orbit server, can be 
configured on the server and each repository may be set up from there. 
Alternatively, 
a New repository may be created from the C&M Project’s Setup dialog.
Available Repositories are listed in a drop-down box in the Setup dialog.

Note:
Pull a project from a Repository to load the project from a server.
Push a project to a Repository to save it back to the GV Orbit server.

Click New to 
create a new 
Repository
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For the basic system test, GV Orbit Client performs a:
• ping to each server;
• client-server communication check; 
• services check on the server; and 
• check of service Domain configurations (Monitoring and Log Server services).

The console pane in the Setup dialog may have shown some red messages which 
highlight differences between entered dialog settings and those of the GV Orbit system 
connected to. (For example, a Client Domain number difference.)
Re-do the basic system tests and the red messages should clear.

Fig. 2-42: System Test Re-done and Console Output OK:
a) Single GV Orbit Server. 
b) Dual GV Orbit Server Cluster.

Apply Settings
6 In the Setup dialog, click Apply to apply these settings to the project.

Click OK to any pop-up message.
7 Click Close to close the dialog.

The GV Orbit pulls the project etc. from the repository and shows the Home Screen.

System Test clear console output

Single GV Orbit server

a) Single GV Orbit Server b) Dual GV Orbit Server Cluster

Dual GV Orbit servers and Virtual IP Address
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Note:
When connecting to a Repository, the user may be prompted to Pull a 
project from a Repository, i.e. get a project from the server.
Pull a project in order to either:

• edit the project locally (any existing local project is overwritten); or
• run the project locally (for example, to run operator screens).

Do not Pull if a local project has been created/changed and it needs to 
be put into a Repository. This requires a Push to a repository.
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Step 7.3: Further Setup 
Following initial set up, a C&M project is ready for use. Project settings and variables are set 
up from the settings in a C&M Project’s Setup window.

This sub-section describes how to adjust the project settings (including project variables) 
further, if any parameters need changing for some reason. 

Step 7.3.1: Project Variables (Project -> Edit Variables)
C&M projects have a set of project variables that are set up when using the C&M Project 
Setup window to establish connection to a GV Orbit server. This done as part of creating a 
new C&M Project. (The Setup window is also accessed by selecting Connections -> GV 
Server in the main menu.)

The Project Variables enable GV Orbit Client workflows, and other user graphical screens, 
to communicate with GV Orbit services and server(s). 

To access the project variables from the project Home Screen:
1 Click Project -> Edit Variables... in the main menu.

A Variables window is shown for the C&M project.

Fig. 2-43: C&M Project Variables Window

Note:
Most Project Variables hold default values consistent with the default GV 
Orbit server and GV Orbit services settings. Do not change the values of 
these variables unless the items have been changed from their default. 

Virtual IP address
of GV Orbit servers

Server 1 IP address

Server 2 IP address

Path to launcher for GV Orbit Control Client

GV Orbit Control Client login credentials

Network file name 
for IP endpoint 
configuration

RollCall ‘Control’ address of 
Routing Service on GV Orbit 
server(s)
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2 Click OK when project-variable value changes have been done.
3 Click Project -> Save Project in the main menu to save the project locally to disk.
4 Push the project to the repository when all changes are done.

Custom Project Variables

The Variables window also allows a user to create custom project variables for their own 
use. For example, the RollCall addresses of system devices, a company name, the TV 
channel/studio name, etc. These may each be set up as custom project variables and used 
in custom control and monitoring screens. Custom project variables can be created and 
deleted.

Step 7.3.2: Client Domain Number (Connections -> GVOP)
To configure the Client Domain for the GV Orbit Client to use for the project:

1 Click Connections -> GVOP in the main menu. 

The GV Orchestration Protocol dialog is shown.

Note: For a multiviewer project there are fewer variables.

CAUTION
Do not delete any of the C&M project variables presented here.
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Fig. 2-44: GV Orchestration Protocol Dialog 

2 Set the Domain number of the Client Domain that the C&M project will use. (Default is 
100.)

3 Other project parameters can be changed in the dialog, see Figure 2-44.
4 Click OK to finish and close the dialog.

Step 7.3.3: Configure Network Window for RollCall-protocol Devices
5 Click Connections -> RollCall -> Network Map in the main menu. 

The Open Network dialog is shown.

Set the Client Domain number for 
the project to use. (Default is100.)

Select for multicast discovery of 
server IP addresses. 
(Default is unicast discovery.)

Click to add a new IP address (for 
unicast discovery). 

Select/deselect IP interfaces of the 
client PC to be used by GV Orbit 
Client.

Set multicast packet ‘Time to Live’ 
(TTL) - defines the number of “hops” 
that a network multicast message is 
allowed to do between IP network 
routers. The TTL value can limit the 
distance these messages travel within 
a network.
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Fig. 2-45: Open Network Dialog

6 Enter the IP address of the server running an IP Proxy service as ‘Primary Address’. 
Typically, this is the IP address of a GV Orbit server.

7 For a dual-redundant GV Orbit server system, 
select Enable Redundancy 
and enter the IP address of the second GV Orbit server.

8 Click OK to finish and close the dialog.

Step 7.3.4: Configure Network Window for Densité-protocol Devices
9 Click Connections -> Densité in the main menu.

The iControl/Densité Configuration dialog is shown.

IP address of a server running a IP Proxy 
service, typically, a GV Orbit server.
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Fig. 2-46: iControl/Densité Configuration Dialog

10 Click Add and enter the IP address(es) of GV Orbit server(s) (which run a Densité 
Manager service), or add the IP address of a server.

11 Select ‘Lookup Service’  and ‘Densité REST’.
12 Enter the Username and Password to access the Densité Manager service.
13 Click OK to finish and close the dialog.

Finally:
14 Click Project -> Save Project in the main menu to save the project locally.
15 Push the project to the repository when all changes are done. See Step 7.4: Saving and 

Pushing a Project, on page 62.

Step 7.4: Saving and Pushing a Project 

Save Project (Locally)
To save a project locally to the folder on the client PC:

• Click Project -> Save Project in the main menu.

Push Project (Save to Server)
To push a project back into a repository (on the GV Orbit server):

• Click Project -> Push. (See Step 2.2.2: Push Project (Save to Server), on page 23.)
In the Choose Project dialog, select the project to be pushed and click OK.

Pull Project (Load from Server)
To pull a project from a repository (on the GV Orbit server):

• Click Project -> Pull in the main menu.

IP address(es) of a server running a 
Densité Manager service, typically, a 
GV Orbit server.

Click Add to add a new IP address.
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Close Project
To close a project that is open in GV Orbit Client:

• Click Project -> Close Project in the main menu.
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Project Home Screen

Home Screen Windows
The appearance of the GV Orbit Client project Home Screen varies according to project type and 
according to which GV Orbit Client windows are enabled and being shown. Use tool bar icons to 
show/hide windows.

Fig. 3-1: GV Orbit Client Project Home Screen Windows

Lite Professional Enterprise

  

Some tool bar icons to show/hide windows in the Home Screen:
• Alarm History window icon

• Project window icon

• Network window

• Properties window (shown when a C&M screen tab is selected)

• Workflow window

Project Window

Network Window

History Window (Alarm History) tab

Graphical Routing Workflow tab selected and a graphical routing 
workflow stage is shown.

C&M Screen tabWorkflow tab
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Close All Windows
To close all windows and just see a default workflow: 

• Click Window -> Close All in the main menu.

 Table 3-1: Home Screen Windows
Window Description See

Project A tree view of projects opened by the GV Orbit 
Client. Allows users to access aspects of the current 
project, or to load another project.

Project Window, on page 69.

Network A view of devices/frames/services etc. in a GV Orbit 
system, presented in a tree-view or a list-view. A user 
can access device information and alarms.

Network Window, on page 70.

Alarm History A list of alarms that have occurred across the system 
over time.

History Window (Alarm History), on 
page 94.

Properties Shows the properties of the selected graphical 
widget when designing a graphical C&M project.

Properties Window, on page 74.

Workflow A graphical presentation of all the tasks and 
functions available in GV Orbit. 
Click on an icon to access a task or a function.

Graphical Routing Workflow, on 
page 98.
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Project Window
The Project window lists the project currently 
open and any projects previously opened by 
the GV Orbit Client on the client PC.

The currently-open project is expandable in a 
tree view to show the various project items. 
The user can access and manage different 
aspects/functions of the project from this tree 
view item. 

Project Tree-Items
Project items seen when a project is expanded 
include:

• Components - Graphical custom 
components that appear on GV Orbit Client graphical control and monitoring screens.

• Networks - IP End-point configuration files, used in IP routing control set up.
• Panels - Soft XY Router control panels, created with a wizard and user-customizable.
• Resources - Imported resource items used in the project (e.g. logo images etc.).
• Screens - C&M project user-defined graphical control/monitoring screens.
• Themes - The appearance of each graphical element on a GV Orbit custom graphical 

screen (multiviewer video wall screen, or C&M project control and monitoring screen) 
can have a style applied to it. A theme is a set of styles that can be applied to a project.

• Workflows - Workflow screen.
• configuration.prj - The GV Orbit project file. Select this file when opening an existing 

project in GV Orbit Client. Do not edit this file. 
• db.users - Project users, user roles and their associated permissions can be managed. 

New user names and logins etc. can be set up. 
• Grids - Imported tile-grid layouts for all multiviewer projects.
• Tiles - Video wall tile designs for all multiviewer projects.
• Rooms - Video wall designs for ‘Clustered Multiviewer’ projects.
• Walls - Video wall designs for ‘Multiviewer’ projects.

Note:
Some project items are also accessible via icons in the routing workflow 
window (see Graphical Routing Workflow, on page 98).

Note:
Some project items may be specific to certain project types.

Project is 
expanded

Currently-open 
project

Fig. 3-2: Project Window
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Project Window Actions
Right-click on a Project window tree-view item to open, import, or create a new item. 

For example, right click on: 
• Screens - Select New to create a new user screen in a C&M project.
• Walls - Select New to create a new video wall in a single-multiviewer project.
• Resources - Select Import File(s) to import an image file into a project.
• db.users 

• Select Open to open the User Management window in a tab to set up users and 
roles.

• Select Import user database to import users from another project.
• <Project Name> - Select Rename project to rename the project.

Network Window
The Network window shows a tree-view or a list-view of devices/frames/services etc. in a 
GV Orbit system. A user can access control screens, information and alarms about these 
items from the window. For more information, see Network Window for more information.

Show/Hide Network Window
The Network window may be shown/hidden using a main tool bar icon, see Figure 3-8.

Fig. 3-3: Network Window Hide/Show

Note:
To set up the Network window for a project, see Network Window Views, 
on page 27 onwards.

Click icon to hide/show the Network window (toggles).
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Fig. 3-4: Network Window Examples: a) Tree-View; b) List-View.

Network Window Actions
Locate a device in the Network window and right-click on the item. The following actions 
are possible in GV Orbit:

• Lite, Professional and Enterprise:
• Device Information - View information about a device.
• Card Parameters - View Densité-protocol device parameters.
• Device Control - View and change device configuration settings. (Lite: RollCall 

devices only.)
• Upgrade Device - Upgrade (or downgrade) device software/firmware.

• And for Professional and Enterprise only:
• Alarm List - Live Alarms/Status - View a list of a device’s live status and alarms. 
• Alarm History for a Device - View the alarm history of a device. 
• Alarm Masking (Professional and Enterprise) - Mask device alarms. 

a) Tree-View b) List-View
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History Window (Alarm History)

The GV Orbit Client History window can show the history of system-wide alarms and status 
messages which are read from the Event Logging service on the GV Orbit server. 

For more information, see History Window (Alarm History).

View Alarm History for System-wide Alarms
To view the Alarm History for GV Orbit system-wide alarms:

1 Click the Alarm History icon in the main 
tool bar.

The History window appears in a tab. 
Note: The tab shows no specific device 
address when showing system-wide alarms.

Select the History tab to view it. 

Lite Professional Enterprise

-  

Note:
The History window is similar to the window shown for Alarm History for 
a Device, on page 89.
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Fig. 3-5: Alarm History Window Example
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Properties Window

The Properties window shows the properties of a selected graphical widget or on-screen 
item when designing/editing a C&M screen in GV Orbit Client in ‘Design’ mode. The 
window may be shown when a C&M screen tab, or a multiviewer video wall, or other 
graphical GV Orbit project item is selected.

Fig. 3-6: Properties Window Example: a) In Design Mode; b) In Run Mode.

Lite Professional Enterprise

-  

a) Example C&M Screen Running in ‘Design’ mode in GV Orbit Client

Run/Design Mode icon indicates GV Orbit Client is in ‘Design’ mode 
for graphical editing and design.

Alarm List widget showing 
live alarms in a system

Selected (Alarm List) widget and its corresponding 
properties shown in Properties window

b) Example C&M Screen Running in GV Orbit Client

Properties Window
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Workflow Window

A workflow window shows a graphical representation of all the tasks and functions 
available in GV Orbit Professional and Enterprise systems. The Workflow window is the 
stage which presents all the tasks and functions the system has to offer to the GV Orbit 
Client user. Click on a workflow icon for direct access to a task or a function. 

View WorkFlow Stage
To view the Workflow stage:

1 Click the  icon in the tool bar. 

Workflow stage is then shown in a tab.
2 Select the workflow tab (if it is not already selected) to view it.

The workflow in Figure 3-7 is available to all new projects.

Fig. 3-7: Graphical Routing Workflow Stage

Lite Professional Enterprise

-  

Note:
A Workflow window may be visible in GV Orbit Lite but it is not 
applicable to the GV Orbit Lite product version.

Workflow window icon workflow.wfl tab

Click on an icon to access GV Orbit project functions in GV 
Orbit Client, see Project Window, on page 69. 

Click on an icon to access a task item, 
see Graphical Routing Workflow, on 

page 98. 

Workflow stage

Click on a server icon to 
access a GV Orbit server. 
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The graphical Workflow stage makes it easy to understand how tasks and functions are 
related and each icon provides direct access to the task/function it represents.

The workflow is optimized for carrying out the system configuration required:
• when re-purposing an existing routing infrastructure; or 
• for the steps to set up a fresh, new routing environment. 

Routing configuration and control is done via the GV Orbit Control application running on a 
GV Orbit server, which supports Grass Valley NP0017 and SW-P-08 protocols. Both IP and 
SDI routing etc. may be controlled. The GV Orbit Client communicates with the GV Orbit 
Control service via the GV Orbit Control Client, launched automatically from the GV Orbit 
Client.
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Network Window

What is the Network Window?
The Network window shows a tree-view or a list-view of devices/frames/services etc. in a 
GV Orbit system. A user can access control screens, information and alarms about these 
items from the window.

Show/Hide Network Window
The Network window may be shown/hidden using a main tool bar icon, see Figure 3-8.

Fig. 3-8: Network Window Hide/Show

Tree-View and List-View
The tree-view and list-view forms of the Network window are shown in Figure 3-9. 

The tree-view presents a hierarchical view of system devices/units/frames/services. See 
Figure 3-9a. The tree-view’s expand/collapse controls are presented in Figure 3-9a. 

The list-view is a flattened view, listing all system devices/units/frames/services. See 
Figure 3-9b. The list may be filtered, see Network Window List-View Filter for a description 
of the list-view filter controls.

Note:
To set up the Network window for a project, see Network Window Views, 
on page 27 onwards.
(See Step 3.2.1: Network Window Setup For RollCall Devices, on page 28; 
Step 3.2.2: View a Device Control Screen - RollCall Devices, on page 30; 
Step 3.2.3: Network Window Setup For Densité Devices, on page 30; and 
Step 3.2.4: View a Device Control Screen - Densité Devices, on page 32.)

Note: Automatically discovered devices:
For devices that are automatically discoverable by a GV Orbit system, 
these are shown in the Network window. For example, GV Fabric IP 
switch.

Click icon to hide/show the Network window (toggles).
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Fig. 3-9: Network Window: a) Tree-View; b) List-View.

Network Window List-View Filter
In the Network window, the displaying of items in the list-view can be filtered. Filtering can 
be done:

• with a text string; and/or 
• by card type; and/or 
• by alarm state. 

The filter controls are shown in Figure 3-10.

a) Tree-View b) List-View

Click to show List-View

Click to show Tree-View

Click to expand all of the tree-view.
Click to expand the selected part of the tree-view.

Click to collapse all of the tree-view.
Click to collapse the selected part of the tree-view.

List-view filter controls, see 
Network Window List-View 
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Fig. 3-10: List-View Filter Controls

Filter Example 1: Filter List Item Name
To filter the Network window list-view for a particular device by its name:

1 Enter a fragment of text in the Filter text box. For example, “UCP or “XIO”.

The displayed names are those containing the entered text. See Figure 3-11b or c.

Fig. 3-11: List-View Filtered Names on Text

2 Click on the Filter icon and select ‘Clear Filter’. 

Filter text box

Filter icon
Filter drop-down menu

Filter on Device Type

Filter on Alarm State

Clear Filter text box filtering

Clear All Filtering

c) Filtered on “XIO”b) Filtered on “UCP”a) Unfiltered.
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The text box is cleared and the text--box filtering is cleared.

Filter Example 2: Filter Device Type and then Alarm State
With all filters cleared, to filter on a device type and then their alarm states:

1 Click on the Filter icon and select ‘RollCall’. 

RollCall-protocol devices are shown. See Figure 3-12a.
2 Click on the Filter icon and select ‘Minor. 

‘Minor Warning’ RollCall-protocol devices are shown. See Figure 3-12c.

Fig. 3-12: Filter on Device Type and then Alarm State

To clear the alarms:
3 Click on the Filter icon and select ‘Clear All Filters’. 

All filters are cleared and all devices are shown.

b) Select to Show Minor Warning 
Alarm States

a) Filter RollCall-protocol devices c) Minor Warning RollCall-
protocol devices shown

Filter icon indicates some filtering is active
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Network Window Actions
Locate a device in the Network window and right-click on the item. 

The following actions are possible in GV Orbit:
• Lite, Professional and Enterprise:

• Device Information - View information about a device.
• Card Parameters - View Densité-protocol device parameters.
• Device Control - View and change device configuration settings. (Lite: RollCall 

devices only.)
• Upgrade Device - Upgrade (or downgrade) device software/firmware.

• And for Professional and Enterprise only:
• Alarm List - Live Alarms/Status - View a list of a devices’ live status and alarms. 
• Alarm History for a Device - View the alarm history of a device. 
• Alarm Masking (Professional and Enterprise) - Mask device alarms. 

Device Information
To inspect device information from the Network window (tree-view or list-view):

1 Right-click on a device and select ‘Info’. 

Device information is shown in a Details pop-up window.
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Fig. 3-13: Device Info - Details Pop-up Windows

Card Parameters
To view a Densité-protocol device’s parameter settings from the Network window:

1 Right-click on a Densité-protocol device and select ‘Card Parameters’.

A summary of the device’s parameter settings is shown in a tab. See Figure 3-14.

a) RollCall-protocol Device - Details window

b) Densité-protocol Device - Details window
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Fig. 3-14: Card Parameters Tab

2 Click on a column heading to sort the listed parameters on a column. 
3 Use the filter controls to restrict the shown listed items. See Figure 3-15.

Fig. 3-15: Example Filtered Card Parameters

4 Read/Write card parameters can be entered via the ‘Current Value’ column.

Right-click and select ‘Card Parameters’, 
a summary of card parameters is shown in a tab

Example: Filtering on parameter name containing ‘Resp’



84

Home Screen
Network Window Actions -

Device Control
To inspect a device’s configuration settings from the Network window:

1 Right-click on a device and select ‘Control’ to view the device’s control screen. (See Step 
3.2: Configuration of Densité and RollCall Devices, on page 27.)

Upgrade Device
To upgrade a device from the Network window:

1 Right-click on a device and select ‘Upgrade’ to open the device’s upgrade screen. (See 
Step 4: Device Upgrade, on page 34.)

Alarms
See Alarms section for more information.

Note: For GV Fabric IP Switch devices, the control screen that is opened in 
the GV Orbit Client window is the device’s web page.



85

GV Orbit Client User Guide
- Alarms

Alarms

Alarm List - Live Alarms/Status 
Professional and Enterprise only.

Alarm List Window
To inspect live alarms and status of a device/frame/service from the Network window:

1 Right-click on a device item in the Network window and select ‘Alarm List’.

The live status and alarms reported by the device/frame/service are listed in an Alarm 
List window. See examples shown in Figure 3-16a and b, and Figure 3-17a and b.

Note: Alarms in GV Orbit v1.2 onwards:
In GV Orbit systems, alarms are handled ‘behind the scenes’ with internal 
addresses. These addresses have changed for GV Orbit v1.2.0 onwards:

• v1.2.0 onwards: Alarm-addresses for Densité-protocol devices are 
now aligned with the respective device/card address. 

• Earlier than v1.2.0: Densité-protocol device alarm-addresses are 
separate and are not aligned to device addresses.

CAUTION
As a result of this alarm addressing change, when upgrading to GV Orbit 
v1.2.0 onwards, addresses specified for alarms must be changed. This applies 
to custom operator panels of C&M projects and to Alarm Behaviours.
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Fig. 3-16: Example Alarm List Windows for:
a) System Device (XIP shown); b) GV Fabric IP Switch.

Click to select sorting of listed alarms from drop-down menu.

Filter on a column (Name or 
Value or State).

Clear filters on all columns.

a) Alarm List example for a system device, XIP device

b) Alarm List for an Auto-discovered GV Fabric IP Switch
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Fig. 3-17: Example Alarm List Windows for:
a) GV Orbit Server; 
b) GV Orbit Service.

b) Alarm List for a GV Orbit Service

a) Alarm List for a GV Orbit Server
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Alarm List Window Masking
In the Alarm List window, alarms can be masked:

• at a device-level; or 
• individual alarms for a device can be masked (alarm-level). 

Right-click on an item in the Alarm List window to see masking options. See Alarm 
Masking (Professional and Enterprise), on page 91 for further information on masking.

Fig. 3-18: Alarm List Window Right-Click Options

Right-click options

Device-level masking options

Right-click options Alarm-level masking options
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Alarm History for a Device
Professional and Enterprise only.

To inspect the history of device status and alarms from the Network window:
1 Right-click on a device in the Network window and select ‘Alarm History’.

The status messages and alarms etc. reported by the device are listed in 
a new History window tab. The address of the device is shown in the window tab. See 
Figure 3-19.

2 Click the search icon ( ) in the 
History window.

The Search Parameters dialog is 
shown.

3 Select a Log Data Source from the 
drop-down menu.

This selects an alarm data source to view in the window.

4 To close the Search Parameters dialog, 
(re-)click on the search icon (or click somewhere else in the History window).

The selected data source is shown in the History window. 
(See History Window (Alarm History), on page 94 for further information.)

Note:
The Alarm History window uses the following GV Orbit services:
IP Proxy, Log Server, Monitoring, Event Logging, and Densité Manager.
These services are all required for Alarm History.

Note:
The Log Data Source drop-
down menu lists the Event 
Logging filters that are set up 
on the GV Orbit server’s Event 
Logging service.

Note:
See History Window (Alarm History), on page 94 for further information on 
data sources and the controls in this tab window.
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Fig. 3-19: Example History Window

Address of device shown in tab Click to filter on a column (Name or Value or State)

(See History Window (Alarm History), on page 94 for further information on the History window.)

Note: Masked alarms are shown “grayed-out” in the History window.
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Alarm Masking (Professional and Enterprise)
Alarm masking may be done on a device (device-level masking), or it may be done on a an 
individual alarm from a device (alarm-level masking):

• Device-level masking/unmasking can be done from the Network window, or from the 
Alarm List window for a device.

• Alarm-level masking/unmasking may be done from a device’s the Alarm List window.

Device-level masking is applied separately and additionally to any alarm-level masking. 
For example, if an alarm-level mask is applied to alarm A for a device and then a device-
level mask is applied to the device, when the device-level mask is removed, the alarm-level-
mask will still apply.

Apply a Device-Level Mask
To mask alarms associated with a device, from the Network window:

1 Right-click on a device, select ‘Alarm Masking’. See Figure 3-23.

Fig. 3-20: ‘Alarm Masking’ Menu Options

2 Select one masking option from:
• Mask Device - Mask all alarms from a device/unit/frame/service. 
• Mask Device Until Normal - Mask alarms from a device/unit until alarm state is OK 

(‘green’). I.e. mask a device/unit until any fault/error is corrected. 
Note: This menu item is grayed-out for devices with an OK Alarm state.

• Mask Device with Tag - Mask a device with a Masking Tag. See Alarm Masking 
Tags. 

• Snooze Device - Mask alarms from a device/unit for a period of time. See Alarm 
Masking Snooze Times.

• Unmask - Unmask a device or a set of tagged devices.

Apply an Alarm-Level Mask
Mask an alarm from a device, from the device’s Alarm List window. See Figure 3-18 on page 
88.

Note: Masking or unmasking menu options may be grayed-out in the 
menu.

‘Mask device until 
normal’ is grayed-out 
for devices with OK 
status.
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Alarm Masking Tags
A set of device(s) can be masked with a Masking Tag.

Fig. 3-21: Mask a Device with a Masking Tag

Masking Tags are created in the ‘Tools > Options > Monitoring’ dialog from the main menu 
and provide the user with a flexible, multiple and layered masking facility.

Fig. 3-22: Tools > Options > Monitoring Dialog

Masking Snooze Times defined

Masking Tags defined
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Alarm Masking Snooze Times
Alarms for a device/unit/frame/service may be masked for a period of time. 

Fig. 3-23: Masking Snooze Times

The selectable masking snooze times are configurable, see ‘Tools > Options > Monitoring’ 
in main menu in Figure 3-22 on page 92.

Masking ‘Snooze’ times
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History Window (Alarm History)

Introduction
The GV Orbit Client History window can show the history of system-wide alarms and status 
messages which are read from the Event Logging service on the GV Orbit server. 

A GV Orbit Professional or Enterprise user can:
• Select an event log data-set to use from the event log store.
• Search for messages from a particular time period.
• Filter what is shown in the pages (for example, to just display minor alarms).

View Alarm History for System-wide Alarms
To view the Alarm History for GV Orbit system-wide alarms:

1 Click the Alarm History icon in the main 
tool bar.

The History window appears in a tab. 
Note: The tab shows no specific device 
address when showing system-wide alarms.

Select the History tab to view it. 

Lite Professional Enterprise

-  

Note:
The History window is similar to the window shown for Alarm History for 
a Device, on page 89.

Note:
By default, the History window sources event log data from the event log 
store which is set up as default in the Event Logging service. 

(I.e. the event log for which the Default Index setting is selected.)
A user can change the event log data source for an History window (I.e. 
change Log Data Source in the Search Parameter dialog.)

Note: Log Data Sources: 
A History window sources log data from the GV Orbit system event log store. 
All events are logged by an Event Logging service running on the GV Orbit 
server (see Event Logs, on page 114). Depending on a log data-set’s 
configuration, some and/or all events and alarms are logged. A store may be 
selected as the log data source for display in the History window.
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Search Parameters Dialog
The Search Parameters dialog appears in the History window for both system-wide 
alarms or for device alarms.

1 Click on the search icon ( ).

The Search Parameters dialog is shown. See Figure 3-24.
2 Set Log Data Source to the log data-set to use from the event log store. 

Fig. 3-24: Search Parameters Dialog

b) Select Date and Start Time and End Time of messages to display.

a) Select Log Data Source to display.

c) Display only messages from the last hour.
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3 Select the date and time period to display. 
This can be done by: 

• setting Date, Start Time, and End Time; or by 
• selecting to see a last period (Reset to last 30 minutes, or Reset to last hour).

All event logs, including alarm messages, are listed in time stamp order, most recent 
first. See Figure 3-25.
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Fig. 3-25: Alarm History Window (History Tab Selected)

• a page

State alarm icons:

Click to:
• Clear column filter settings.
• Hide/show columns.
• Show Search Parameters  dialog, 

to select log file and time period to display. 
See Figure 3-24.)

• Refresh data in the table.

• Click in a column 
heading on to filter displayed 
data on a column.

• next page. 
• last page.

Page navigation

Alarms which are masked are shown “grayed-out”

Click to go to: • first page.
• previous page.
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Graphical Routing Workflow 

Introduction
The factory-set Workflow stage shows a graphical workflow for routing system 
configuration and control with clickable icons to access tools via GV Orbit Control Client.

Fig. 3-26: Graphical Routing Workflow Stage - with Icons (1) to (13)

Lite Professional Enterprise

-  

(1)

(2) (3) (4)

(5)

(6)

(8) (9)

(12) (13)

Click on icons (1) to (13) to access routing tools

(7)

(10)

(11)

Click on server icons to access 
landing pages for each GV Orbit server.

Each icon (1) to (13) is described in 
the Steps for Graphical Routing Workflow Stage Icons 
table, on page 99.
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 Table 3-2: Steps for Graphical Routing Workflow Stage Icons 

Steps relating to icons in Figure 3-26 Graphical Routing Workflow Stage - with Icons (1) to (13), on page 98

(1) IP Configuration and Spreadsheet Import 
Access the IP Routing endpoint configuration editing tool and a new, default GV Orbit C&M 
project (see Chapter 11 IP Configuration for more information):
1 Click the Comms Setup button:

• Select Routing System controller type to be ‘GVC’, (to work 
with the GV Orbit server).

• Select Domain number for IP End-point setup (default 
‘101’). 

• Leave the GVC domain number at its default (105).
• Select the client PC network IP interfaces to use. 

Click OK. 
GV Orbit Client will discover IP End-points and list them.

2 Click on the Devices tab to see the listed devices.
3 Click Export to export the discovered IP end-point devices and 

their current settings. (A spreadsheet file, .xlsx file, is exported and 
this shows the spreadsheet file format. Settings include: device 
names, router port numbers, source/destination IP flows, and 
multi-cast IP addresses etc.) 

4 Edit the spreadsheet file to change settings and/or add more IP end-point devices.
5 Click Import to import IP End-point device settings via a spreadsheet. 

6 Project -> Save Project from the main menu. Close the IP Endpoint Editor tab.

Fig. 3-27: IP Endpoint Configuration Editor tab in GV Orbit Client (Device sub-tab shown)

This screen also allows:
• Manual configuration of end-points, if required.
• Review IP End-point settings, edit settings, validate settings, make engineering routes, if required.
• Monitor bandwidths at device interfaces, if required.
Note: SDI ‘end-point’ configuration etc. is set up via GV Orbit Control in the remaining controls on 
the routing workflow.

Comms Setup ButtonExport Import Device tab

Discovered devices are listed

IP Endpoint Editor tab
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(2) Logical Level Editor
Access logical route editor tool 
in GV Orbit Control Client. For 
the target router:

• Define, review, edit logical 
routing levels. For example, 
levels for audio channel(s), 
video channels, SDI video, 
ancillary data etc.

(Refer to ‘Logical Level Editor’ 
tasks in the GV Orbit Control 
User Guide. See Related 
Documentation, on page iii.)

(3) Topology Configurator
Access router topology 
configurator tool in GV Orbit 
Control Client:

• Define router topology with the 
logical levels. I.e. how physical 
and logical devices are 
arranged in the broadcast 
facility. 

• Select topology to use.
(Refer to ‘Topology 
Configurator’ in the GV Orbit 
Control User Guide. See Related 
Documentation, on page iii.)

(4) Logical Device Table
Access the logical devices 
editor tool in GV Orbit Control 
Client:

• Define logical devices in a table.
• Configure levels and IP streams.
• Configure audio shuffled 

streams and break-away 
streams.

• Create virtual crosspoints and 
logical destinations devices.

(Refer to ‘Logical Device Table’ 
tasks in the GV Orbit Control 
User Guide. See Related 
Documentation, on page iii.)

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-26 Graphical Routing Workflow Stage - with Icons (1) to (13), on page 98
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(5) Category
Access the Category 
Configurator tool in GV Orbit 
Control Client:

• Manage sources and 
destinations with groups (or 
categories) based on type or 
usage. This is useful when there 
are multiple resources. 
Categories allow 
sources/destinations to be 
accessed quickly on a routing 
control panel.

(Refer to ‘Logical Device Table’ 
tasks in the GV Orbit Control 
User Guide. See Related 
Documentation, on page iii.)

(6) Panel Configurator
Access the Panel Configurator 
tool in GV Orbit Control Client:

• Create soft router control panel 
designs.

• Add buttons and behaviors to a 
routing control panel.

• Push the design to soft or hard 
panels.

(Refer to ‘Panel Configurator’ 
tasks in the GV Orbit Control 
User Guide. See Related 
Documentation, on page iii.)

(7) GPIO Configurator
Access the GPIO Configurator 
tool for GPIs and GPOs on 
supported panels (e.g. GPI-
1501) with GV Orbit Control 
Client:

• Add rules for GPIs to trigger 
events such as a salvo or routing 
a source to a destination.

• Add rules for GPOs to activate 
on combinations of conditions.

(Refer to ‘GPIO Configurator’ 
tasks in the GV Orbit Control 
User Guide. See Related 
Documentation, on page iii.)

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-26 Graphical Routing Workflow Stage - with Icons (1) to (13), on page 98
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(8) Bulk Routing
Access the Bulk Routing 
Control Panel tool in GV Orbit 
Client:

• Make routes between sources 
and destinations.

• Form break-away routes and 
shuffled routes.

• Execute salvos.

For an introduction to the Bulk 
Routing Control panel, see 
Bulk Routing Control Panel, on 
page 104.

(9) Snapshots
Access the Snapshots tab of 
the GV Orbit Routing Service 
that runs on the GV Orbit 
server:

• Recall routing snapshots.
• Create and save new snapshots.

(10) Router Control
Access the Router Control 
Panel tool in GV Orbit Control:

• Make routes between sources 
and destinations.

• Create and execute salvos.
(Refer to ‘Router Control’ tasks 
in the GV Orbit Control User 
Guide. See Related 
Documentation, on page iii.)

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-26 Graphical Routing Workflow Stage - with Icons (1) to (13), on page 98
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(11) Alias Editor
Access the Alias editor tool in 
GV Orbit Control:

• Assign aliases to sources and 
destinations 
(to support shorter length 
names, other languages, or 
different production staff 
needs).

(Refer to ‘Alias Editor’ tasks in 
the GV Orbit Control User Guide. 
See Related Documentation, 
on page iii.)

(12) System Status
Access the System Status 
screen of the GV Orbit 
Control router controllers: 

• Monitor the health of GV 
Orbit Control router 
controller(s).

• View device health for a 
selected topology.

• Manual fail-over, if 
required.

(Refer to ‘System Status’ 
tasks in the GV Orbit 
Control User Guide. See 
Related Documentation, on 

page iii.)

(13) Path Manager
Access the Path Manager 
screen of GV Orbit Control: 

• View source-destination 
paths of routed streams.

• View Tie-Line usage 
information, including % 
bandwidth used.

(Refer to ‘Path Manager’ 
tasks in the GV Orbit 
Control User Guide. See 
Related Documentation, on 

page iii.)

 Table 3-2: Steps for Graphical Routing Workflow Stage Icons  (continued)

Steps relating to icons in Figure 3-26 Graphical Routing Workflow Stage - with Icons (1) to (13), on page 98
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Bulk Routing Control Panel 

Introduction 
The Bulk Routing Control Panel is a built-in router control panel accessible from GV Orbit 
Client. It requires the GV Orbit Routing service to be running on GV Orbit server(s). IP 
routing or traditional (e.g. SDI) routing may be controlled.

More Information on Bulk Routing Panel
For more information, see Chapter 5, Routing Control - Bulk Routing Panel, on page 171.

Open Bulk Routing Panel
1 Open an existing C&M project and set the GV Orbit Client window size to 1920x1080.
2 Click on the Bulk Routing icon in the 

Graphical Routing Workflow stage. 

A Bulk Routing Panel is shown in a 
window tab in the GV Orbit Client. 
See Figure 3-28.

Lite Professional Enterprise

-  
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Fig. 3-28: Example Bulk Routing Panel

Troubleshooting
If problems are encountered when opening a Bulk Routing Panel, carry out the following 
checks:

1 Check that the project’s Client Domain is set for the GV Orbit system.

(Click Connections -> GVOP in the main menu. 
Set Client Domain to be the system’s ‘Client Domain’ number.)

2 The project’s Routing Address project variable (a RollCall address) should be set to the 
Routing service’s Logging Address. To verify this: 

• To see the project variables, click Project -> Edit Variables in the main menu.
• To see the Routing service’s Logging Address: 

Log into the GV Orbit server and access the Routing service’s ‘System’ 
configuration screen. (See GV Orbit Server Login, on page 111, and Accessing 
Services Configuration Screens, on page 113.)

Source Grid

Router Control Pane

Destination Grid

Source Levels Grid Destination Levels Grid

Salvos Pane

Filtering boxes to limit items shown, 
see Chapter 5, Filtering, on page 219
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To save any changes made to the project settings:
3 Click Project -> Save Project in the main menu to save the project locally.
4 Click Project -> Push to push and save the project to the GV Orbit server.

Alternative Open Bulk Routing Panel (Network Window)
The Bulk Routing Panel may also be opened from 
the Network window in GV Orbit Client:

1 Display the Network window tree-view (click 
in the main tool bar to toggle displaying 

the window) and expand the tree-view.
2 In the Network window, 

locate the ‘Routing service’ item. 
(The item’s name is the Routing service’s 
“Logging Name”.)

3 Right-click on the Routing service item and 
select Open Panel. 

A Bulk Routing Panel is shown in a window tab 
in the GV Orbit Client. See Figure 3-28 on page 
105.

Note: A ‘Routing service’ item appears in the GV Orbit Network window 
when a Routing service is running on the connected GV Orbit server 
and is configured to talk to a router controller.
Bulk Routing Panel ‘Source’ and ‘Destination’ buttons are annotated 
with router port names obtained through the Routing service.
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Bulk Routing Panel - List View
List View is a level-centric view of a Bulk Routing Panel, allowing a user to focus on routing 
to Destination Levels. List View presents all of the destinations in a ‘list’ format; each list 
item is a Destination with all of its Levels.

To access List View mode:
1 Open the Bulk Routing Panel and set the GV Orbit Client window size to 1920x1080.
2 In the Destination Grid’s tool bar, click on the List View icon.

This toggles between 
the normal Bulk 
Routing Panel view and 
the List View mode. 

The List View is shown. 
See Figure 3-29.

Fig. 3-29: Bulk Routing Panel - List View

Bulk Routing Panel Information
For further Bulk Routing Panel information, including about List View and about general 
operation, please refer to Chapter 5, Routing Control - Bulk Routing Panel, on page 171.

List View icon

Destination Grid

Click icon to toggle between List View and the normal view

Scrollable list of destinations

Destination Levels Grid
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Routing Snapshots
Snapshots of all routes and crosspoints in a GV Orbit system can be taken and restored from 
the GV Orbit Client with the Routing service configuration screen.

Access Routing Service Screen
1 Go to the GV Orbit Client workflow.wfl Workflow 

window. 
2 Click on the Snapshots icon.

The GV Orbit server window is shown in a tab.

3 Scroll down the server window on 
the left 
and locate the ‘Services’ section 
and select ‘Routing’.

The Routing service configuration 
screen is shown.

4 Select the ‘Snapshots’ side-tab on 
the left.

The Routing service’s Snapshots 
screen is shown. See Figure 3-30.

Fig. 3-30: Routing Service Snapshots Configuration Screen
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To Take a Routing Snapshot
In the Routing service Snapshots screen:

1 Enter a name for the new snapshot.
2 Click Create Snapshot.

Fig. 3-31: Routing Service Snapshots Configuration Screen

A snapshot of all routes and crosspoints is taken. And the new snapshot appears in the 
list.

Fig. 3-32: New Snapshot Item in List

3 Click Save Changes.
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To Recall a Snapshot
In the Routing service Snapshots screen:

1 Find a snapshot in the list and click Recall.

The signal routing and crosspoint settings present when the snapshot was taken are 
restored.

Fig. 3-33: Recall Snapshot
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GV Orbit Server Login

This section describes how to log into a GV Orbit server from either the GV Orbit Client or 
with a web browser. When logged in, various configurations can be viewed, including 
settings for the GV Orbit services. 

For more details, please refer to the GV Orbit Admin Guide in Related Documentation, on 
page iii.

Login From GV Orbit Client
With a GV Orbit C&M project open in GV Orbit Client, to open a GV Orbit server’s Home 
stage:

1 Either:
• click Project -> URLs in the main menu and select the GV Orbit server item; or
• click on a server icon in the Workflow stage (e.g. Server 1). 

Fig. 3-34: Click on Server Icon in Workflow Stage 

The GV Orbit server Admin Login screen is then shown. See Figure 3-35 on page 112.

Login from a Browser
To log into a GV Orbit server from a browser:

1 Enter the IP address of a GV Orbit server into a web browser (Chrome recommended).

Lite Professional Enterprise

-  
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The GV Orbit server Admin Login screen is shown. See Figure 3-35.

Server Admin Login Screen
For more details about the GV Orbit server and logging in, please refer to the GV Orbit 
Admin Guide in Related Documentation, on page iii.

Fig. 3-35: GV Orbit Server Admin Login Screen

1 Click Log in.

A login screen is shown.
2 Enter the User ID and Password (the default user ID is ‘admin’ with password ‘admin’). 

Click Login.

The GV Orbit server Home stage is shown. See Figure 3-36 on page 113.

Note:
The GV Orbit Client and GV Orbit Control Client installers may also be 
downloaded from the GV Orbit server Admin Login screen.
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GV Orbit Server Home Stage

Fig. 3-36: Example GV Orbit Server Home Stage

Accessing Services Configuration Screens
Services should be set up by the GV Orbit system administrator. Services running on the GV 
Orbit server are configured via their configuration screens accessible from the GV Orbit 
server Home stage.

For information about the server and services, please refer to the GV Orbit Admin Guide. See 
Related Documentation, on page iii.

Click Home to return to this screen.

Note: The GV Orbit Client and GV Orbit Control Client installers 
may also be downloaded via links. 
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Logs 

Introduction
Logs are kept for system device status/alarm messages (events) and also for 
applications/services running on the GV Orbit server. 

• Event Logs - In an operating GV Orbit system, GV Orbit device/service status, alarm 
messages and events are logged by a GV Orbit service running on a GV Orbit server. 
Events etc. are logged to an event log data set. This is set up when configuring the 
Event Logging service on the server. 

• Server Application and Service Log Files - Each application/service running on the GV 
Orbit server also has a set of log files. 
Please refer to the GV Orbit Admin Guide in Related Documentation, on page iii, for 
further information about the GV Orbit server and the available log files. 

Event Logs
Instructions for quickly viewing event log files are presented here. 
For full log file instructions, please refer to the GV Orbit Admin Guide.

A new GV Orbit system is set up with a default log file configuration. To set up custom event 
logging in the GV Orbit system, a new event log file configuration can be set up for the 
Event Logging service. This can be done on the GV Orbit server:

1 Log into a GV Orbit server. (See GV Orbit Server Login, on page 111.)
And view the GV Orbit server Home stage.

Fig. 3-37: Select Event Logging from the GV Orbit Server Home Stage

Lite Professional Enterprise

-  
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2 Select Event Logging. (Scroll down on the left-hand side, if required.)

The Event Logging service configuration screen on the GV Orbit server is shown.
3 Click on the Event Log Setup tab.

The Elastic Search Setup tab for the Event Logging service is shown.

Fig. 3-38: Event Logging Service - Search Setup Tab

New log data-sets can be created. For more information, refer the Event Logging service 
information in the GV Orbit Admin Guide in Related Documentation, on page iii.

Example New Event Log
To quickly create a new event log:

1 Click New to view the Event Logging service dialog.
2 Enter a name (identifier) for a new event log file configuration (index). For example, 

‘chan_001’. (The name acts as an identifier for the event log data-set to be created.)

3 Click OK in the dialog.

The Index name field shows the new event log file configuration name.
4 Select Enable this index.
5 At the bottom of the screen, set Delete Data After (days) to’ 7’. 

Log data will be kept for 7 days.

Fig. 3-39: Event Logging Service - Search Setup Screen Controls

6 Set Recording Mode to ‘Everything’.

Note: Event log naming rules:
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7 Click Save.

This has set up a new event log to record all events, alarms and log messages. 

View Event Log 
Event log data may be viewed from the:

• Event Log Viewer (on GV Orbit Server); or 
• Alarm History Window (in GV Orbit Client).

Event Log Viewer (on GV Orbit Server)
1 Select the Event Log Viewer tab for the Event Logging service.

A log viewer screen is shown. (See Event Log Viewer Screen, on page 116.)

Alarm History Window (in GV Orbit Client)
1 Open a C&M project in the GV Orbit Client.
2 View the Alarm History window (click on the Alarm History window tool bar icon) and 

select the required tab. (See History Window (Alarm History), on page 94.) 

This is a log viewer screen. (See Event Log Viewer Screen, on page 116.)

Event Log Viewer Screen
In the log viewer screen:

1 Click on the Search Parameters icon ( ).

The Search Parameters dialog is shown.
2 Set Log Data Source to the required event log name in the drop-down list.
3 Select Reset to last 30 minutes. (To show the last 30 minutes of log messages.)
4 Re-click on the Search Parameters icon ( ) to close the dialog 

and view the resulting logged data.

Note:
For information about viewing the event logs, please refer to the GV Orbit 
Admin Guide in Related Documentation, on page iii.
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Simple Custom Monitoring Screen Example 

Introduction
A simple custom graphical operator screen is presented here. The example describes a 
monitoring screen using a C&M project; device status is monitored by the screen. 

This requires:
• a configured C&M project; 
• a configured GV Orbit server; and 
• the following minimum GV Orbit services to be running: 

• IP Proxy 
• Log Server 
• Monitoring
• Densité.

Steps:
• Step 1: Create a New Monitoring Screen Schematic, on page 117.
• Step 2: Add Monitoring, on page 120.
• Step 3: Save and Push Project, on page 125.
• Step 4: Run Custom Monitoring Screen, on page 125.

Step 1: Create a New Monitoring Screen Schematic
1 Open the C&M Project and show 

the Project window and the 
Workflow window with the 
Workflow stage.

2 On the workflow stage, 
click on the Screens icon.

The Screens dialog is shown.

Lite Professional Enterprise

-  
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Fig. 3-40: Screens Dialog

3 Click New Screen.

The New Screen dialog is shown.
4 Enter a name for the new screen schematic and click OK.

A new, blank custom screen schematic is created. The new, blank schematic is shown in 
a window tab in GV Orbit Client. See Figure 3-41.

Note:
A custom screen schematic is shown in GV Orbit Client; this is the ‘stage’ on 
which the schematic is:

• designed when GV Orbit Client is in Design Mode; and
• run and operated when GV Orbit Client is in Run Mode.
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Fig. 3-41: New, Blank Custom Schematic

5 Click the Run Mode tool bar icon to select GV Orbit Client Design Mode. See Figure 3-
42.

Fig. 3-42: Run Mode / Design Mode Tool Bar Icon

Run Mode icon (Showing project is in Design Mode) Note: Drag ‘handle’ to the right to 
reveal more tool bar icons

Schematic stage

b) Icon appearance when in Design Mode 

a) Icon appearance when in Run Mode

Click to exit Run Mode

Click to enter Run Mode

Note:
In Design Mode, a project may be edited 
(for example, a video wall may be 
modified). 
In Run Mode, a project monitors log and 
alarm data and displays updated custom 
operator screens in real-time.

Note: A project’s ‘mode’ toggles between Run Mode and Design Mode.
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Step 2: Add Monitoring
A control and monitoring (C&M) screen will monitor items in a system with individual or 
aggregate alarms for a device (or collection of devices), or an individual alarm (or collection 
of alarms). This is quick and easy to achieve with GV Orbit Client. 

Items to be monitored can be dragged onto a C&M screen either from the Network 
window or from an Alarm List window. One or more devices or device alarms can be 
monitored.

Add Monitoring of Devices
For a C&M screen schematic open in GV Orbit Client in Design Mode:

1 Expand the Network window to find a RollCall- or Densité-protocol device to monitor.
2 Drag a device onto the C&M screen schematic, and release. 

At release, GV Orbit Client pops up a list of options. These control what will be created 
from the drag. See Figure 3-43a. 
(Figure 3-43b shows the resulting Run Mode screen appearance, see later steps.)

Fig. 3-43: Drag Device Monitoring onto the Schematic: 
a) Drag on Devices; b) Monitoring Shown when in Run Mode

Project is in Design Mode

Selected device

Drag on-screen

a) Drag on Devices 

b) Monitoring Example when in Run Mode

Project is in Run Mode

Pop-up Options
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3 Click ‘Create Single Tally’ in the pop-up options list.

GV Orbit Client then infers a default, graphical Tally widget on the schematic which is 
automatically set up to graphically indicate the overall status of the device when in Run 
Mode.

4 Drag on more devices, as required.

(Figure 3-43b shows what the graphical items may look like in Run Mode.)

This has quickly added simple device alarm state monitoring to the C&M project.

Add Monitoring of Alarms
Device alarm monitoring can also be added:

1 Expand the Network window to find a device to monitor.
Then right-click on the device item and select ‘Alarm List’.

The device’s alarms are all shown in a pop-up Alarm List window.
2 Select one or more alarms in the Alarm List window and drag them onto the C&M 

screen schematic, and release. 
(To select more than one alarm item, click on an item to select it, and select more with 
CTRL-click.)

At release, a list of options pops up which will control what will be created from the 
drag. See Figure 3-44.

Note: Add Device:
Dragging a device onto the schematic and releasing it on top of an existing 
monitoring Tally widget will add the device to the screen widget, thus 
creating an aggregate alarm.

Note: Pop-up Options:
These pop-up options are described in ‘Drag-On’ Options, on page 123.
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Fig. 3-44: Drag Alarm Monitoring onto the C&M Screen Schematic

3 Select the pop-up option required.

GV Orbit Client then infers graphical monitoring widget(s) on the schematic which are 
automatically set up to indicate the alarm status.

This has quickly added simple device alarm monitoring to the C&M project.

When all monitoring widgets have been added, proceed to Step 3: Save and Push Project, 
on page 125.

C&M project is in Design Mode

Drag on screen

Alarm List window

Selected alarms

Pop-up options:

Note: Add an Alarm:
Dragging an alarm (from the same or from a different device) onto an 
existing monitoring widget will add the alarm to the screen widget.

Note: Right-click Drag:
Right-click dragging will use the last pop-up option selected and will avoid 
the user having to select the same pop-up option each time.

Note: Label Style Change:
A text label is difficult to see against a black background. In this case, change 
the label’s appearance by selecting it and changing its ‘Style’ property value, 
see Text Label Style Change, on page 124.
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‘Drag-On’ Options
The pop-up options for creating graphical, on-screen from the ‘drag-on’ item(s) are shown 
in Table 3-3. Figure 3-45b and Figure 3-45c show the result of each option Design Mode 
and in Run Mode respectively.

Fig. 3-45: Dragged-on Monitoring Options A), B), C), and D) in: 
a) Design Mode; 
b) Run Mode.

 Table 3-3: ‘Drag-On Options
Option Description

A) Create multiple labels Creates a text label per item.

B) Create multiple tallies Creates a graphical Tally widget per item, to show the individual 
alarm state of each item.

C) Create multiple ‘stateful’ labels Creates a colorful text label per item, where the text color 
indicates each individual alarm state.

D) Create single aggregate tally Creates one graphical Tally widget to show a combined, 
aggregate alarm state of all the dragged-on items.

b) Result of options A), B), C), and D) in Run Mode

A)

B)

C)

D)

a) Result of options A), B), C), and D) in Design Mode

A)

B)

C)

D)

These graphical items show alarm state.
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Text Label Style Change
When creating a text label with this ‘drag-on’ method, the resulting default label may be 
difficult to see (for example, if against a black background). In this case, change the 
appearance of the text label by changing its ‘Style’ property value, see Figure 3-46a and 
Figure 3-46b.

• Select the label(s) on the schematic.

In the Properties box, click on the Style’-
property’s value (see Figure 3-46a).

A drop-down menu is shown.
• Select a Style value from the drop-down 

menu, for example ‘Solid Caption’.
• Click ‘Yes’ in the dialog that is shown.

The label appearance has been changed (see 
Figure 3-46b).

Fig. 3-46: Changing Text Label Style Property
b) New Text Label Style 

a) Selected Labels
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Step 3: Save and Push Project
When all the required device/alarm monitoring is added to the C&M project screen: 

1 Click Project -> Save Project in the main menu to save the project locally.
2 Click Project -> Push to push the project to the GV Orbit server repository.

Step 4: Run Custom Monitoring Screen
1 Click the Design/Run Mode tool bar icon to take GV Orbit 

Client out of ‘Design Mode’ and into ‘Run Mode’: 

GV Orbit Client runs the C&M project and gets device status 
information to display on the custom monitoring screen’s 
Lamp widgets, which illuminate red/yellow/green to show 
device status. See Figure 3-47.

Fig. 3-47: Simple Custom Monitor Example Running in GV Orbit Client

Icon when in Run Mode

Device status shown in Network window is reflected 
in the custom monitoring screen

Project in Run Mode

Note: Tally Widget graphics:
The graphics shown by these Tally widgets are:

Shape Alarm Status

Green circle OK
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2 To go back to ‘Design Mode’, click the Design/Run Mode icon again.
3 To save the project locally, 

click Project -> Save Project from the main menu.
4 To push the project back to the GV Orbit server:

• click Project -> Push from the main menu;
• select the project name in the list (it may already be selected/highlighted); and
• click OK.

5 To close the project, click Project -> Close Project .
6 To close the GV Orbit Client application, click Project -> Exit .

Yellow/amber triangle Minor Warning

Orange inverted triangle Major Warning

Red square Failure/Error

Blue diamond Unknown
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Main Menu and Tool Bar Items
This section describes the Home Screen’s main menu items and main tool bar items:

• Main Menu Items
• Main Tool Bar Items

And:
• Common Operations in Graphic Editors

Main Menu Items

Project Menu

Fig. 3-48: Project Menu

Note: The main menu items shown depend on the type of GV Orbit project 
open in GV Orbit Client.

 Table 3-4: Project Menu Items 
Menu Item Description

New Project Click to create a new project.

Open Project Click to open an existing, locally-stored project.

Recent Projects Click to see a list of recently opened projects.

Save Project Click to locally save the current project with all recent changes.
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Connections Menu

Fig. 3-49: Connections Menu

Rename Project Click to rename the open project.

Close Project Click to close the open project.

Pull Click to pull a project from a repository (on a GV Orbit server).

Push Click to push a project to a repository (on a GV Orbit server).

Recent Files Click to see a list of recently opened files.

Save File Click to locally save the open file.

Save File As Click to locally save the open file as a new file.

Close Click to close the open file.

Set Home Click to set the currently open schematic to be the home schematic.

Edit Variables Click to see and edit project variables.

URLs Click to see and access URLs defined in the project.

Exit Click to close any project and exit GV Orbit Client.

Note: Setting up GV Orbit server IP address:
When the GV Orbit server IP address is set up 
(either at the start of a project, or in the ‘Connections > GV Server 
‘menu) 
then the ‘RollCall-, ‘Densité-, and ‘GVOP-Connections’ > menu item 
settings are automatically filled out and applied.

 Table 3-5: Connections Menu Items 
Menu Item Description

GV Server Click to set up project connection to GV Orbit server.
Note: Setting this up will automatically cause the other settings in the 
‘Connections’ menu to be set up and applied.

 Table 3-4: Project Menu Items  (continued)
Menu Item Description
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Tools Menu

Fig. 3-50: Tools Menu

RollCall Click to set up RollCall connection settings and options.

Densité Click to configure Densité connection settings.

GVOP Click to set up GV Orchestration Protocol settings.

 Table 3-6: Connections Menu Items
Menu Item Description

Options Click to set up options in GV Orbit Client, including:
• Application - Graphical grid settings and font settings.
• Video - Real time video rendering options.
• Launch - Project launch options.
• Remotes - Remote access options.
• Links - Set URLs in project
• Pop-ups - Name, size and position of any pop-up windows in 

project.
• Monitoring - Alarm Masking options.
• Map View - Options for C&M project MapView screens, 

including built-in links and alarm state colors.

Fig. 3-51: Tools > Options Dialog from Main Menu

 Table 3-5: Connections Menu Items  (continued)
Menu Item Description
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Window Menu
These menu items apply when more than one window (tab) is open in GV Orbit Client. 
Menu options may be grayed-out if they do not apply.

Fig. 3-52: Window Menu

Multiviewer Menu Items

Multiviewer Menu (Single-Multiviewer Project)

This menu appear for non-clustered, single multiviewer cases.

Fig. 3-53: Multiviewer Menu

 Table 3-7: Window Menu Items
Menu Item Description

Next Tab Click to go to the next open window tab. 
Alternatively, press CTRL-Tab.

Previous Tab Click to go to the previous open window tab. 
Alternatively, press CTRL-SHIFT-Tab.

Close All Click to close all window tabs.

List of open tabs Radio-button list:
Click on a list item to go to that windows tab.
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 Table 3-8: Multiviewer Menu Items 
Menu Item Description

Properties Click to see multiviewer device information.

Input Alarms Click to enable and configure alarms on each multiviewer input. 
Alarms include video alarms and audio alarms.

Unit Alarms Click to enable and configure specific alarms for the multiviewer 
device. For example, ‘genlock state’.

Input Audio Set up input audio related settings, including: ‘audio metering type’, 
digital audio reference level, audio loudness and phase engines.

Note: The ‘audio metering type’ setting defines:
• the ballistics of all audio metering data generated by the 

device; and 
• the default audio meter scale for graphical Audio Bars 

widgets on the multiviewer’s video wall. 

CAUTION The audio metering data ballistics set up here applies 
globally for the multiviewer device. All audio metering 
data generated by the device will have the same 
ballistics.
A GV Orbit multiviewer project may change an audio 
meter type locally on a video wall tile/schematic which 
locally changes the meter scale only; the audio 
metering data used will still have the global ballistics 
type.

Output Audio Set up the audio sources for each of the audio channels in each of 
the multiviewer outputs. Up to eight stereo channels are 
embedded in each output.

Units Select the units published by a Grass Valley Log Server that a 
multiviewer may view.

Download Logs Obtain logs from a multiviewer unit.

Note: The Alarm items are described in the user manual for the MV-8 Series 
multiviewer devices. 
See the MV-8 Series Core Multiviewer User Manual.
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Multiviewer Menu (Clustered Multiviewer Project)

This menu appears for clustered multiviewer cases.

Fig. 3-54: Multiviewer Menu

Help Menu

Fig. 3-55: Help Menu

 Table 3-9: Multiviewer Menu Items
Menu Item Description

Multiviewer 
Cluster

Click to see multiviewer cluster information.
See Chapter 7 Multiviewer Cluster, on page 331.

 Table 3-10: Help Menu Items
Menu Item Description

About GV Orbit 
Client

Click to see information about GV Orbit Client software.

Grass Valley Home 
Page

Click to go to the Grass Valley web page.

GV Orbit Manual Click to go to the GV Orbit documentation web page.
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Main Tool Bar Items
Tool bar icons implement some main menu functions. 

Fig. 3-56: Main Tool Bar Items

The tool icons shown depend on the type of project open in GV Orbit Client and on the 
editing function being carried out. For example, further Tool Bar items are shown when a 
multiviewer video wall is open. See Main Tool Bar with a Graphic Editor Open.

Main Tool Bar with a Graphic Editor Open
Additional tool bar icons are shown here. See Main Tool Bar Items for the other icons.

Fig. 3-57: Main Tool Bar with a Graphic Editor Screen Open

• New Project
• Open Project
• Save Project
• Save File
• Save File As

• Alarm History Window
• Project Window
• Network Window

(Toggle the display of windows 
in the GV Orbit Client)

• Tools > Options
• Lock/Unlock 

the client 
window

• Pull
• Push

• URL - Go to project 
URLs

• Home - Go to Home 
schematic

Design Mode / Run Mode 
(shown in Design mode)

Properties window

Dock/Undock the active window

Set the active window to full-screen mode

Display drawing grid

Options 
(Tools > Options in main menu)

Zoom stage screen in/outGraphic Object Alignment Controls

Graphic object layer

Go back/forward a step

Select All
DeSelect All

Cut Copy Paste Delete
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Design Mode / Run Mode
Clicking on the Run Mode / Design Mode tool bar icon toggles between ‘Run’ and ‘Design’ 
modes of GV Orbit Client.

Fig. 3-58: Run Mode / Design Mode Tool Bar Icon

Full-Screen View
The graphical stage area can be viewed in full-screen mode. There are two ways to do this,

To Enter/Leave Full Screen Mode - Short Cut

To enter or to leave the full screen mode, when in a graphical screen:
• Press ALT-Enter.

This toggles full-screen mode on/off.

To View Full-screen
1 Click the Full Screen button ( ).

Fig. 3-59: Main Tool Bar with a Graphic Editor Screen Open

Note: Object selection/deselection operations used in graphic editors in GV 
Orbit Client are described Selection/De-Selection of Objects in 
Graphic Editors, on page 138.

b) Icon appearance when in Design Mode 

a) Icon appearance when in Run Mode

Click to exit Run Mode

Click to enter Run Mode

Note: 
• In Design Mode, a project may be 

edited (for example, a video wall may 
be modified). 

• In Run Mode, a project monitors log 
and alarm data and generates 
display screens in real-time.

Note: The Design Mode / Run Mode tool bar icon may not be shown if 
changing between these modes is not applicable in the screen mode 
of the GV Orbit project shown.

Set the active window to full-screen mode
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To Exit Full-Screen Mode
1 Right-click on the (full) screen and select ‘Full screen’ in the pop-up menu to exit full 

screen mode.

Fig. 3-60: Main Tool Bar with a Graphic Editor Screen Open

Graphic Object Alignment Controls
The graphic object controls are used in most graphical editing screens in GV Orbit Client. 
The controls are grayed out where they are not used.

Fig. 3-61: Graphic Object Alignment Tool Bar Controls

Align Controls

To use an align control in one of the GV Orbit Client’s graphical editor tools:
1 Select a graphical object. (See Figure 3-62a.)

This will be the object that will be aligned to.
2 SHIFT-select one or more further graphical objects. (See Figure 3-62b.)
3 Click on an align control in the main tool bar. 

The alignment is done to the first object selected. (See Figure 3-62c.)

Note: Object selection/deselection operations used in graphic editors in GV 
Orbit Client are described Selection/De-Selection of Objects in 
Graphic Editors, on page 138.

Align on a Grid

Align Controls

Layer controls: Send selected object(s):
• to the front; or 
• to the back.

Place selected object(s) in a central 
position of the stage area.
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Fig. 3-62: Alignment Example

Align on a Grid

Use this control to arrange selected objects (see Figure 3-63a) in a grid arrangement.

In one of the GV Orbit Client’s graphical editor tools:
1 Select all of the graphical objects to be arranged in a grid. (See Figure 3-63b.)
2 Click on the Align to Grid tool icon. (See Figure 3-63b.)

‘Align to Grid’ controls are shown in the Properties box. (See Figure 3-63c.)
3 Set the following ‘Align to Grid’ control values:

• Num Rows - number of rows required in the resulting grid of objects.
(For example, = 3.)

• Row Spacing - number of pixels between rows of the resulting grid. 
(For example, = 50.)

• Col Spacing - number of pixels between columns of objects in the resulting grid.
(For example, =20.)

4 Click Apply. (See Figure 3-63c.)

The object alignment is done to the specified grid. (See Figure 3-62d and Figure 3-62e.)

a) Select an object to align to. b) SHIFT-Select further objects. c) Objects aligned.
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Fig. 3-63: Align to Grid Example

a) Objects

e) Objects (deselected) aligned to a grid.

b) Select objects. Click Align to Grid icon.
c) Align to Grid settings in Properties box

d) Objects aligned to a grid.

Selected objects

Click Align to Grid
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Common Operations in Graphic Editors
• Selection/De-Selection of Objects in Graphic Editors
• Selection Etc. in Groups of Objects
• Selection/De-Selection of Objects in Graphic Editors

Selection/De-Selection of Objects in Graphic Editors
This section outlines actions to select and de-select objects in general in any of the graphic 
editors in GV Orbit Client. For example, in the Wall, Room, Tile, or Screen Editor tools.

 Table 3-11: Object Selection / De-selection in a Graphic Editor
Action Description

Click outside the schematic stage area.

Deselect All ESC

Click ‘Deselect All’ in main tool bar.

CTRL-A
Select All 

Click ‘Select All’ in the main tool bar

Click on an item. Select

ALT-Click on an item. Select an alternative item from a layer-stack 
of items.

Or: 

Select the group of objects that an item 
belongs to.
(For information on groups of objects, see 
Selection Etc. in Groups of Objects, on 
page 139.)

SHIFT-Click on an item. Add an item to the current selection. 

Note: When in a router control panel, 
SHIFT-click selects a contiguous range of 
sources are destination. 
(I.e. in the Routing Control - Bulk Routing 
Panel, in the Routing Control - XY Routing 
Panel, or in the XY Routing Sources screen of 
the MV Cluster - Room Editor.)

CTRL-Click on an item. Add an item to the current selection when 
in a Room Editor XY Routing Sources 
screen. 

SHIFT-ALT-Click on an item. Add another item to the current selection 
from a layer-stack of items.
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Select All
Select All is accomplished via CTRL-A or by clicking a Select All button when in a graphic 
editor in GV Orbit Client. 

General Select All
The Select All operation generally selects all objects on a wall or tile etc.

Select All in Some Screens of the Room Editor
However, in the Room Editor there is some flexibility built into Select All when in either 
the:

• Design Layout mode; or 
• X/Y Routing mode.

In these Room Editor modes, then Select All is slightly modified:
• if nothing is selected, then 

Select All will select all multiviewer outputs of the video wall.
• if a video tile is selected in a multiviewer output, then 

Select All will select all tiles just belonging to that multiviewer output.

Selection Etc. in Groups of Objects

Grouping Objects Together
Graphical objects can be grouped together:

1 Select the objects. (‘Select’, and ‘SHIFT-select’ to add objects to selection.)
2 Right-click on the selected objects and select ‘Group’. (See Figure 3-64a.)

The objects are grouped together. (See Figure 3-64b.)

SHIFT-Click on an already-selected item. Remove an item from the current selection 

SHIFT-drag-cursor on screen to describe a 
rectangular area. 

Select objects within a rectangular area. 
All objects wholly or partly within the area 
are selected.

 Table 3-11: Object Selection / De-selection in a Graphic Editor
Action Description
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Fig. 3-64: Grouping Objects

Un-Grouping Objects
Graphical objects can be un-grouped:

1 Select the group of objects. 
2 Right-click and select ‘Un-Group’. 

Operations on Groups

a) Selected objects b) Grouped objects

Selected objects Right-click and select ‘Group’

 Table 3-12: Operations on Groups of Objects
Action Description

Select an object.
Hold down Left-click and start to drag, 
and then additionally 
hold down SHIFT to drag into a Group.

Add an object to a Group. 
(Drag into a group.)

ALT-click to select an object in a group, 
and then 
hold Left-click and drag out of group.

Remove an object from a group. 
(Drag out of a group.)
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Introduction
GV Orbit Client provides user access control to GV Orbit projects. This controls who can 
open a GV Orbit project in GV Orbit Client and what editing or operational actions they may 
perform. Users of a project will require different access to aspects of a project depending on 
their role. 

The GV Orbit Client Manage Users screen enables project user roles and levels of user 
access to be set up and managed. 

When opening a project, a user is prompted for a user name and a password when 
accessing a GV Orbit project. 

Default Admin Username and Password
By default, only an ‘admin’ user is initially configured in a new project. The ‘admin’ user has 
full permissions. 

Default username = admin

Default password = admin
 

Note: The ‘admin’ user has administrator role permissions which enable all 
operations within GV Orbit Client to be carried out. 
The default ‘admin’ user password should be changed as soon as you 
log in for the first time, How to Change a User Password, on page 161. 

Note: Administrator user passwords should be recorded and kept secure.

Note: The ‘Users’ described here in this chapter are GV Orbit Client users. 
These are not users for the GV Orbit Control application in GV Orbit, 
which utilizes a separate users and user setup - described in the GV 
Orbit Control User Guide, see Related Documentation, on page iii.
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Accessing the Manage Users Tab
The Manage Users tab is accessible in several ways:

• From the Workflow Screen.
• From the Project Home Page.
• From the Project Window.

From the Workflow Screen
To access the Manage Users screen from the GV Orbit Dynamic System Orchestrator 
workflow screen:

1 Click on the ‘User Management’ icon. See Figure 4-1.

The Manage Users tab is opened. See Figure 4-2 on page 144.

Fig. 4-1: Workflow User Management Icon
Click User Management icon
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From the Project Home Page
The Manage Users tab is accessible from a GV Orbit Project Home screen (for example, in a 
multiviewer project): 

1 Start the GV Orbit Client application.
2 Open a (multiviewer) project and log in as an ‘admin’ user.

The GV Orbit Project Home screen is displayed.
3 Click on the large Manage Users icon. See Figure 4-2.

The Manage Users tab is shown. See Figure 4-4 on page 145.

Fig. 4-2: Manage Users icon on Home Screen

From the Project Window
The Manage Users tab is accessible from the GV Orbit Client Project window: 

1 Start the GV Orbit Client application.
2 Open a (multiviewer) project and log in as an ‘admin’ user.
3 Clicking on the icon in the main tool bar ( ) toggles showing the Project window.

In the Project window:
4 Locate the name of the current project and expand the item.
5 Right-click on the ‘db.users’ item and select ‘Open’. See Figure 4-3.

The Manage Users tab is shown. See Figure 4-4 on page 145.

Fig. 4-3: Open Manage Users Tab from Project Window

Manage Users Icon

Current project item, 
expanded in Project window.

Project window icon selected.

Click to 
expand/collapse 
current project item

Right-click on 
‘db.users’ item and 
select ‘Open’.
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Manage Users Tab

Fig. 4-4: Manage Users Tab (‘Roles’ Tab shown)

The Manage Users tab is labeled ‘db.users’ and contains the following ‘sub-tabs’:
• Roles.
• Users.
• Permissions.

A file with the name “db.users” appears in the Project window, see Figure 4-4. 
This file contains encrypted project information, including user name and password details.

Note: Managing users:
Ensure that you are logged into the GV Orbit project with 
administrator permissions when managing users.

Note: The logged-in User name is shown in the main tool bar of each GV 
Orbit Client screen.

Manage Users tab
db.users tab name,
click x to close tab

Click to log out of project and change user

User name shown
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Changes to User Information
If a change has been made to settings in any of the Manage Users tabs, 
an asterisk (*) is appended to the “db.users” label. 

Save changes by:
1 Clicking the Save File icon in the GV Orbit Client main tool bar.

Change Logged-in User
When logged into a project as a user, it is possible to quickly log out and log back in as 
another user.

1 Start the GV Orbit Client application, open a project and log in.

The project opens in GV Orbit Client and the currently logged-in User name is shown in 
the main tool bar.

In the main tool bar:
2 Click the Change User icon ( ).

A Change User dialog is shown. See Figure 4-5.
3 Click Yes to log out and log in (as another user).

Fig. 4-5: User Name and Change Users Icon in Main Tool Bar

Click Change User icon to log out and change user

Current logged-in User name 
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Roles Tab
To display the Roles tab in the Manage Users tab:

1 Click on the Roles tab. 

The Roles tab lists the defined user roles for the GV Orbit project with a brief description of 
each, see Figure 4-6. 

Select a listed Role for full role details.
 

Fig. 4-6: Roles Tab

The Roles tab allows the roles to be viewed, created and edited; it is used to:
• Add and delete roles - New roles can be created and roles can also be deleted.

See Roles Tab, on page 147. 
• Edit permissions for each role - This defines which operations may be carried out in a 

role with the Permissions pane.
See Edit Role Permissions, on page 152. 

Permissions pane

List of defined User roles

Membership pane

Full details for selected Role
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• Edit user roles - This assigns a role to each user name.
See Roles Tab, on page 147. 

Pre-defined User Roles
The following user Roles are configured by default in a new GV Orbit project:

• Administrator - role with all default permissions.
• Supervisor - role as administrator, but no user management role.
• Operator - role limited to read-only access to projects.

The permissions for each of these roles are listed in Figure 4-7.
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Fig. 4-7: Predefined User Role Permissions (Multiviewer project shown): 
a) Administrator; b) Supervisor; c) Operator.

Role Permissions (Permissions Pane)
A role’s permissions are set up in the Permissions pane. 

Permissions are operations that can be carried out on a GV Orbit project in the GV Orbit 
Client application. When applied to a user, they form the user’s privileges, i.e. what each 
user is allowed to do.

a) Administrator b) Supervisor

c) Operator
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1 Select the Role in the list in the Roles tab.

Permissions information for the selected Role is shown in the Permissions pane. 
Permissions that are ‘allowed’ for the role and others that are ‘available’ are listed in the 
Permissions pane. See Figure 4-8. 

Fig. 4-8: Permissions (Supervisor Role in a Multiviewer Project Shown)

Note: A default new project’s ‘administrator’ role has permissions to 
add/edit users.

Note: The list of all permissions varies between GV Orbit project types.

 Table 4-1: Permissions - GV Orbit project types Multiviewer (MV)/ IP Routing (IP))

Permission The ability to... Project 
Type

MV IP

Purge ALL Purge all off-line devices. IP

Change multicast options Change automatic multicast assignment options. IP

Export ALL Export settings for all devices. IP

Change flow options Change the options used for automatic flow enabling. IP

Assign device ports Assign ports for a device. IP

Assign ALL ports Assign ports for all devices. IP
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Edit source multicast Edit individual multicast settings for a source flow. IP

Enable flows for source device Enable flows for a source device. IP

Edit port number Edit a port number for a spigot. IP

Edit device name Edit a device name. IP

Import ALL Import settings for all devices. IP

Disable flows for source device Disable flows for a source device. IP

Edit port name Edit a port name for a spigot. IP

Enable source flow Enable/disable individual source flows. IP

Export device Export settings for a device. IP

Enable flows for all source devices Enable flows for all source devices. IP

Import device Import settings for a device. IP

Clear multicast for source device Clear multicast settings for a device. IP

Clear multicast for all source devices Clear multicast settings for all source devices. IP

Assign multicast for source device Assign multicast settings for a source device. IP

Assign multicast for all dest devices Set 1:1 or 1:All routes for all destination devices. IP

Clear multicast for all dest devices Clear multicast settings for all destination devices. IP

Transfer device Transfer settings from one device to another. IP

Edit schematics Modify video wall and tile designs. MV IP

Import user database Import a user database IP

Clear device ports Clear ports for a device. IP

Disable flows for all source device Disable flows for all source devices. IP

Clear multicast for dest device Clear multicast settings for a destination device. IP

Edit destination multicast Edit individual multicast settings for a destination 
flow.

IP

Assign multicast for dest device Set 1:1 or 1:All routes for a destination device. IP

 Table 4-1: Permissions - GV Orbit project types Multiviewer (MV)/ IP Routing (IP))

Permission The ability to... Project 
Type

MV IP
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Edit Role Permissions
To edit the permissions for a Role:

1 Select a permission on the Permissions pane. See Figure 4-9.
2 Click > or < in the pane to move the selected Permission to/from the set of 

‘allowed’/’available’ permissions for the role.

Assign multicast for all source 
devices

Assign multicast settings for all source devices. IP

Change comms settings Change network domain and change IP interfaces. IP

Purge device Purge an off-line device. IP

Pull from repository Move a project from a product unit to GV Orbit Client.
For example, pulling a project from a multiviewer.

MV

Push to repository Move a project from GV Orbit Client to a product unit.
For example, pushing a project to a multiviewer.

MV

Add/rename/delete files or folders Manage project files and folders. MV

Edit multiviewer properties Edit properties for video wall themes, tiles and walls. MV

Edit multiviewer alarms Create and delete alarms. MV

Add/edit users Manage users and roles. MV

Import themes Import themes into a project from another GV Orbit 
Client project.

MV

Import walls Import walls into a project from another GV Orbit 
Client project.

MV

Import layouts Import wall layouts into a project from an GV Orbit 
Client project.

MV

Import settings Import project settings from another GV Orbit Client 
project.

MV

Import tiles Import tiles into a project from another GV Orbit 
Client project.

MV

Import grids Import grids into a project from another GV Orbit 
Client project.

MV

 Table 4-1: Permissions - GV Orbit project types Multiviewer (MV)/ IP Routing (IP))

Permission The ability to... Project 
Type

MV IP
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3 Add/remove permissions as required.

When done:
4 Click Save File in the main menu to save changes.

Fig. 4-9: Edit Role Permissions

Assign Users to Roles (Membership Pane)
The Membership pane displays the following for the selected Role:

• User names assigned in the role - These are listed in the “Users in Role” list. 
• User names not assigned in the role - These are listed in the “Users not in Role” list. 

To assign a role to a user, in the Roles tab, 
1 Select a Role in the list.

This selects a role to be edited. (See Figure 4-10.)
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Fig. 4-10: Selected Role and Membership Pane

To assign a user into a role: 
2 Click on the user name item in the “Users not in Role” list to select an user.

(More than one user may be selected. To deselect an item, click on the selected item.)
3 Click on the < button to add the selected user name(s) to the “Users in Role” list. 

The selected user(s) move from the “Users not in Role” list to the “Users in Role” list.

To remove a user from a role: 
4 Select the user name item in the “Users in Role” list.
5 Click on the > button to remove it from the “Users in Role” list. 

The selected user name moves to the “Users not in Role” list.

Lastly:
6 Save any changes by clicking on the Save File in the main menu.

Note: Click the Save File icon in the GV Orbit Client screen’s main tool 
bar to save changes made in the Roles tab.

Selected Role
and corresponding Membership pane
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How to Delete Roles 

To delete a Role, in the Roles tab: 
1 Select the Role to be deleted. 

Fig. 4-11: Select a Role for Deletion

2 Review the Role’s user details in the Membership Pane.

Before deleting a Role, there should be no users assigned to that Role.
3 Remove any users from the role using the Membership Pane.

Note: A user will lose permissions if they are assigned to a role when the role 
is deleted. Ensure that no users are assigned in any role to be 
deleted. 
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Fig. 4-12: Remove All Users from the Role

4 Click on the Delete Role button, see Figure 4-13.

A confirmation Delete Role dialog box will appear. 

Fig. 4-13: Delete Role

5 Read the message in the dialog. 
If you wish to proceed, click “Yes” to confirm that the role should be deleted, 
otherwise, click “No”.

The Role is deleted from the Roles tab.
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Fig. 4-14: Deleted Role

6 Save any changes by clicking Save File in the main tool bar.

Note: Click the Save File icon in the GV Orbit Client screen’s main tool 
bar to save changes made in the Roles tab.
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How to Add a Role
New roles can be added. In the Roles tab:

1 Click Add New Role.

A new blank role item is added to the bottom of the roles list in the Roles tab.

Fig. 4-15: Adding Role

On the right-hand side of the screen:
2 Enter a name for the new role in the Role name text box. Use a short, descriptive name.

(Use characters ‘a’ to ‘z’, ‘A’ to ‘Z’, ‘space’ and ‘0’ to ‘9’.)
3 Enter a brief description of the role in the Description text box. 

The new role’s name and description are shown in the list of roles. 
4 With the new role highlighted, add the permissions required 

- see Role Permissions (Permissions Pane), on page 149. 
5 With the new role still highlighted, assign any users

- see Assign Users to Roles (Membership Pane), on page 153. 

New blank role item
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6 Save any changes by clicking Save File in the main tool bar. 

A finished new role screen is shown in Figure 4-16.

Fig. 4-16: New Role Added
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Users Tab
Click on the Users tab at the top of the Manager Users tab to display the Users Tab tab, 
see Figure 4-17. The users of a GV Orbit project can be viewed, edited and created. 
Users are listed in the main screen area in a graphical Users List - a list of icons.

The Users tab is used to:
• Change the password of an existing user, see How to Change a User Password.
• Add a new user, see How to Add a User.
• Delete an existing user, see How to Delete a User.

Fig. 4-17: Users Tab 

Pre-defined Users
Initially, in a new GV Orbit project, a user named ‘admin’ is already defined with full 
administrator role permissions. This enables all operations within GV Orbit Client to be 
carried out.

Default username - admin

Default password - admin

The default password for user ‘admin’ should be changed as soon as you log into a new 
project, see section . 

User Roles list

User Name Change Password buttonUsers List (Icons)Users tab
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Record the user names and passwords somewhere safe and secure.

How to Change a User Password
In the Users tab:

1 Click on a user icon in the Users List. 

This selects the user to be edited. 
2 Click on the Change button, located below the User name text box.

The change password dialog is displayed. See Figure 4-18.

Fig. 4-18: Change Password Dialogs

3 Enter the original password in the Old password text box, if this is shown.
Enter the new password in both the New password text box 
and also in the Confirm password text box. 

4 Click OK to change the password or click Cancel to abandon the change. 

If a new password has been set, a “Password changed successfully” message is 
displayed; click OK. See Figure 4-19.

Fig. 4-19: Password Changed Successfully Message

5 Save any changes by clicking Save File in the main tool bar. 

How to Add a User 
In the Users tab: 

1 Click Add User. 
A new User Icon appears in the graphical Users List. See Figure 4-20.

Note: Keep a record of the administrator user name and password used.

a) Add Password for a new user
b) Change Password for a user
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Fig. 4-20: Adding a New User

2 Enter a name for the new user in the User name text box. 
(Use characters ‘a’ to ‘z’, ‘A’ to ‘Z’, ‘space’ and ‘0’ to ‘9’.)

3 Click on the Change button below the User name text box.

The Set New Password dialog is displayed. 

4 Enter a new password in the New password text box
and re-enter it in the Confirm password text box. 

5 Click OK to set the password, or click Cancel to abandon the change. 
If a new password has been set, 
a “Password changed successfully” message is displayed; click OK. 

6 Save any changes by clicking Save File in the main tool bar. 

A new, empty user has been created. 

To assign the user to Role(s), see Assign Users to Roles (Membership Pane), on page 153.

How to Delete a User
In the Users tab:

1 Click on a User Icon in the Users List to select the user to be deleted. 
2 Click on the Delete user button.

A confirmation message dialog box appears. 

New User Icon

User name text box

Set/change password button

Note: Click the Save File icon in the GV Orbit Client screen’s main tool 
bar to save changes made in the Users tab.
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3 Click Yes to confirm user deletion, or click No to abandon deleting the user. 
If the user is deleted, the corresponding user icon disappears from the Users List.

4 Save any changes by clicking Save File in the main tool bar.

Note: Click the Save File icon in the GV Orbit Client screen’s main tool 
bar to save changes made in the Users tab.
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Permissions Tab
The Permissions tab lists the available Permissions with a brief description of each.

Permission types:
• Built-in - By default, a project has built-in Permissions, which are project-type-

dependent. 
• User - Additionally, a user can create custom Permissions for use.

To see the Permissions tab:
1 Click on the Permissions tab in the Manage Users tab to display the Permissions tab.

Fig. 4-21: Permissions Tab

Custom User Permissions
Custom ‘user’ permissions can be created alongside the existing ‘built-in’ permissions and 
they can be assigned to roles. These allow user access/privileges to be tailored to 
operational needs.

A custom user Permission is automatically given to the ‘administrator’ Role.

Access-control to GV Orbit Client project screens or to on-screen graphical widgets can be 
designed into an GV Orbit Client project using custom ‘user’ permissions.
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Add Custom User Permission
In the Permissions tab:

1 Click Add Permission.

A new item is added to the list.
2 Enter a name and enter a brief description for the new custom Permission. See 

Figure 4-22.
3 Click Save File in the main tool bar to save the change.

Fig. 4-22: New Custom User Permission

See Using a Custom User Permission.



166

Manage Users
Using a Custom User Permission -

Using a Custom User Permission

Permission Properties
In a GV Orbit Client project, a GV Orbit control and monitoring screen can be designed to 
implement access control for:

• GV Orbit Client project screens; or for
• on-screen graphical widgets (e.g. buttons).

This is accomplished by utilizing a screen’s or a widget’s ‘Permission’ properties. See 
Figure 4-23.

Fig. 4-23: Permission Properties (Widget shown)

Button Widget and its ‘Permissions’ properties

 Table 4-2: Widget Permissions Properties 
Property Description

General > Permission Specify the Permission required by the widget user. Select 
from:

• <none> - no Permission required. No access control.
• <inherit> - use the Permission of the parent MapView 

screen/component/widget.
• built-in permissions - list of all built-in Permissions.
• user permissions - list of all custom user Permissions.

General > Permission Type Set how the on-screen widget is affected if logged-in user 
does not have specified Permission:

• Disable - Widget on-screen control is disabled.
• Hidden - Widget is hidden from view.
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A user’s ‘Role’, which will include or exclude various permissions, can determine whether a 
logged-in user:

• may use a widget or access screens in a running GV Orbit Client project; and 
• how a widget appears on-screen (i.e. disabled or hidden). 

This facility could, for example, control access to a MapView screen with certain 
operationally-sensitive controls and limit them to logged-in users whose role includes a 
certain (custom) permission. 

Access Control Example - MapView C&M Screen
This is a simple, contrived example on a C&M ‘MapView’ screen to demonstrate controlled 
access to a Button widget. 

In our example:
1 A custom ‘user’ Permission has been defined (‘My Custom Permission’).
2 Four Button widgets have been configured to turn a Lamp widget on/off (see Figure 4-

24):
• Two (green-colored) Buttons control the Lamp widget on/off green. 

The Button widgets do not have any specific Permissions properties set.
• Two (red-colored) Buttons control the same Lamp widget on/off red.

These Button widgets require a logged-in user to have a specific, ‘user’ Permission 
set up.

3 There are two Users set up for this example (see Figure 4-25):
• User ‘admin’ has an administrator Role, which includes all Permissions, ‘built-in’ 

and ‘user’.
• User ‘supervisor 1’ has a supervisor Role which does not include a custom user 

Permission.

When this C&M project is run, the resulting on-screen behavior is shown in Figure 4-26. A 
user without the custom ‘user’ Permission only sees some grayed-out buttons and is unable 
to access them.
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Fig. 4-24: C&M Screen Widget Access Control Example - Buttons

Button widgets without any specific Permission set.

Button widgets with a specific, custom ‘user’ Permission set up.
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Fig. 4-25: C&M Screen Widget Access Control Example - Users:
a) Supervisor;
b) Administrator.

a) supervisor Role, without custom Permission

b) administrator Role, with custom ‘user’ Permission
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Fig. 4-26: C&M Screen Widget Access Control Example - Running:
a) Logged in as ‘administrator’ role;
b) logged in as ‘supervisor’ role.

a) Project run when logged in with ‘administrator’ role

b) Project run when logged in with ‘supervisor’ role

Buttons ‘grayed-out’, user ‘supervisor 1’ has no access to these Buttons.

All Buttons are accessible to the user.
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Introduction
GV Orbit Client has user router control functionality and offers the following routing control 
panels:

• Routing Control - Bulk Routing Panel (see this chapter) - a simple, non-editable soft 
panel for fast control of all router cross-points. 

• Routing Control - XY Routing Panel - an editable and customizable soft panel, typically 
used for small custom panels for specific routing needs.

This chapter describes the Bulk Routing Panel.

GV Orbit System
Routing control panels (soft or hard) connect to a GV Orbit Routing service running on a GV 
Orbit server.

Fig. 5-1: GV Orbit Routing Panel, Routing Service and Router Controller

A GV Orbit system has one or more GV Orbit servers which run GV Orbit services. Routing 
panels in a GV Orbit Client connect to a router controller device via the GV Orbit Routing 
service. Router controllers include GV Orbit itself, a Grass Valley Router Controller device, or 
GV Convergent. The Routing service provides source/destination information to the client 
and acts on routing commands from the client. See Figure 5-2.

GV Orbit Client

GVOP protocol

Controller-specific connection protocol: 
• SW-P-08; or
• NP-0017

GV Orbit server

GV Orbit Routing Panel
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Fig. 5-2: GV Orbit System Diagram 

Prerequisites
A GV Orbit server is required, running:

• A GV Orbit Control application.
• A GV Orbit Routing service configured for connection to a Router Controller using 

either NP0017 or SW-P-08 protocol.
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What is a Bulk Routing Panel?
The GV Orbit Bulk Routing panel is accessible from the GV Orbit Client application. This is a 
simple, quick, non-editable panel which has been designed to allow fast control of router 
cross-points and facilitate both keyboard and mouse navigation. 

Fig. 5-3: Bulk Routing Panel Example

Key Features

• Keyboard navigation. • Shuffles and Breakaways.

• Single source to single destination.
• Single source to multiple destinations.
• Multiple sources to multiple destinations.
• Copy Paste

• Filter Sources, Destinations, Levels 
and Salvos.

• Custom filtering.
• Filter destinations by routed source.

• Take and Auto Take. • Sort (ascending and descending). 

• Lock and Protect. • Source and Source-Level Dial-up.

• Salvos.

• List View mode for level-focused routing.
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Open a Bulk Routing Panel
The GV Orbit Bulk Routing Panel is accessible from the GV Orbit Client application:

• From the Workflow Window 
• From the Network Window

From the Workflow Window
To open the Bulk Routing Panel from the Workflow window: 

1 Open a GV Orbit C&M project in GV Orbit Client and adjust the window size to be full-
screen.

Full-size is the recommended window size for operation; all controls are visible.
2 Ensure the GVOP client domain is set to be the same as that being used by the GV Orbit 

Routing service on the GV Orbit server. (Main menu: ‘Connections > GVOP’.)
3 In the Workflow window, click on the Bulk Routing icon. (See Figure 5-4.)

Fig. 5-4: Open a Bulk Routing Panel

The Bulk Routing Panel is opened. See Figure 5-6 for a sample Bulk Routing Panel.

From the Network Window
To open the Bulk Routing Panel from the Network window: 

1 Open a GV Orbit C&M project in GV Orbit Client and set the window size to be full-
screen.

2 Ensure the GVOP client domain is set to be the same as that being used by the GV Orbit 
Routing service on the GV Orbit server. (Main menu: ‘Connections > GVOP’.)

3 Locate the Routing service item in the Network window of GV Orbit Client.
And right-click on the item and select ‘Open Panel’. See Figure 5-5.

Note: The Bulk Routing Panel is best viewed in full-screen on a 1080P 16:9 
monitor screen with GV Orbit Client.

Click on Bulk Routing icon.
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Fig. 5-5: Open a Bulk Routing Panel

An example Bulk Routing Panel is shown in Figure 5-6.

Note: A ‘Routing service’ item in the Network window is formed when a 
Routing service is running on the GV Orbit server and is configured 
to talk to a router controller.

Right-click on the
Routing service item 
and select ‘Open Panel’.
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Fig. 5-6: Example Bulk Routing Panel
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Bulk Routing Panel Layout and Controls

Fig. 5-7: Bulk Routing Panel Layout

The panel is laid out as six grids/panes (see Figure 5-7): 
• (1) Source Grid – Scrollable list of all available sources. 
• (2) Source Levels Grid – Scrollable list of available levels for selected source(s).
• (3) Destination Grid – Scrollable list of all available destinations.
• (4) Destination Levels Grid – Scrollable list of available levels for selected 

destination(s).
• (5) Router Control Pane – Take, Lock, and Protect functionality.
• (6) Salvos Pane – List of available Salvos when connected over the NP0017 protocol.

Vertical sizing of the Source and Destination grids can be altered by dragging a splitter 
handle up/down the screen. Horizontal sizing and sizing of the Router Control and Salvos 
panes can be altered by dragging a splitter handle left/right. Other sizing is handled 
automatically. See Figure 5-7.

(1) Source Grid

(5) Router Control

(3) Destination Grid

(2) Source Levels Grid

(4) Destination Levels Grid

(6) Salvos

Splitter handles

Keyboard Shortcuts icon
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What are the Operational Keyboard Shortcuts?
Keyboard shortcuts are available when navigating and operating the Bulk Routing Panel, in 
addition to using a mouse. The user can freely mix ‘mouse’ and ‘keyboard’ methods. 

A list of keyboard shortcuts may be displayed in a movable window which can remain on 
display while using the Bulk Routing Panel. 

To see a list of keyboard shortcuts:
1 Click on the ‘Keyboard Shortcuts’ icon 

in the tool bar of the Router Control pane.

The Bulk Routing Keyboard Shortcuts 
window is shown, see Figure 5-8. This window lists the keyboard shortcuts. It remains 
on display and may be moved.

Fig. 5-8: Bulk Routing Keyboard Shortcuts Movable Window

Equivalent mouse clicks for some keyboard shortcuts are listed in Table 5-1.
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 Table 5-1: Bulk Routing Panel Operational Keys / Mouse operations
Operation Keyboard Mouse

Toggle Selection Space bar Mouse click

Take Enter Click Take

Panel Button Focus Cursor Arrow Keys Mouse movement/click

Panel/Grid Focus CTRL + Arrow Keys Mouse movement/click

Add a series of items to/remove 
from a multiple selection

SHIFT + Cursor keys SHIFT + Mouse click

Add distinct items to/remove 
from a multiple selection

CTRL + Space bar CTRL + Mouse click

Select Range

(Select a contiguous range)

Space bar on first item then 
SHIFT + space bar on last item.

Mouse click on first item then
SHIFT click on last item.

Paste Series Alt-CTRL + V when a range of 
destinations are selected.

Click ‘Paste Series’ icon in panel.

See What is Copy-and-Paste Series Routing?, on page 205.

Take Return / Enter Double-click

Dial Source Begin to type the name of a 
Source when a destination is 
selected.

See Dial Source Dialog, on 
page 195.

N/A

Dial Source-Level Press any single alpha-numeric 
key when a destination and (one 
or more) levels are selected.

See Dial Source-Level Dialog, on 
page 196.

N/A

Cancel Escape Click ‘Cancel’ button in the Router 
Control pane.

Select All in the focused panel CTRL + A Click ‘Select All’ icon in panel.

Select None in focused panel CTRL + D Click ‘Select None’ icon in panel.

Copy a Destination CTRL + C when a destination is 
selected

Click ‘Copy’ icon in panel

Paste a Destination CTRL + V when target destination, 
or destinations, are selected

Click on ‘Paste’ icon in panel



182

Routing Control - Bulk Routing Panel
Select/Focus in a Bulk Routing Panel

Select/Focus in a Bulk Routing Panel

Current Button-Focus
When the mouse cursor is moved over a button, or control item, the button/item is 
highlighted indicating the current item is in focus.

Fig. 5-9: Current Button-Focus Item

Select a Button
To select a button:

• click on a button; or
• press the space-bar key when a button is the current focus item.

De-select Buttons
To deselect all buttons:

• click Cancel in the Router Control pane; or
• press the ESC key.

Move Focus Between Grids/Panels of the Bulk Routing Panel
To move the focus between a grid/panel of the Bulk Routing panel:

• Use the CTRL key and one of the cursor arrow keys. 

Focus is indicated by a border around the focused grid.

Selected Destination
Current Button- Focus

Navigate with:
Cursor Keys, 

or use the mouse
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Fig. 5-10: Current Panel/Grid Focus Item

Currently-routed 
Source

Current 
Button-Focus

Current Panel/Grid Focus

Pre-selected Source

Navigate with:
Control-Cursor Keys, 

or use the mouse
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Selecting Multiple Items

Select Multiple Items (CTRL select)
Select multiple items (i.e. destinations, or sources, etc.) by selecting the first item and CTRL-
selecting the others. For example, to select multiple destinations:

1 Select the first destination by clicking on the destination selection button.
2 CTRL-click on the next destination to add that to the selection.
3 Add other destinations.

Select Multiple - Alternative Method

Multiple items can be selected using the Control key, the Cursor Arrow keys and the Enter 
key.

1 With the cursor over the first item to be selected, press enter to select it.
2 Use the cursor arrow keys to move to the next item. 
3 Select it with CTRL-Enter. This adds to the selection.
4 Add other items similarly.

Select a Range of Items (SHIFT select)
When selecting multiple items (i.e. destinations, or sources etc.), a range may be selected by 
selecting:

1 The first destination in the range by clicking on the destination selection button.
2 Selecting the last destination by SHIFT + clicking on its destination button.

Source ranges can be selected similarly.

Select a Range - Alternative Method

A range of consecutive sources or destinations can be selected using the Shift key, Cursor 
Arrow keys, and Enter key.

1 With the cursor over the first item to be selected, press Enter to select it.
2 Move to the last item in the range with the cursor keys.
3 Hold down the SHIFT key and press Enter to select it.

The last item and all the items from the first to the last are added to the selection.
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Source/Destination Grid Buttons
The source/destination selection grid buttons and level-selection buttons are annotated to 
reflect the source/destination name or the level name. Additionally, the destination buttons 
may show the currently-routed source and currently-selected source for the selected 
destination. Buttons also change shape and are highlighted to show if they are selected or 
if sources are currently-routed or currently-selected. See Figure 5-11.

Fig. 5-11: Selection Buttons

Note:
See Breakaway and Levels and Shuffle and Levels for examples of 
selecting levels.

Source Name Destination Name

Pre-Selected Source Name

Currently-Routed Source Name

Pre-Selected Source

Currently-Routed Source

Pre-Selected Source Level NameSource Level Name

Selected Destination

Destination Level Name

Pre-Selected Source Name

Note: Select a Destination or a Source to see the corresponding Level 
selection buttons.
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Level Selection
When a source or a destination is selected, the associated levels are shown in the 
corresponding ‘Levels’ grid. If multiple sources or destinations are selected, then only their 
common levels are shown. 

All levels are selected by default. If the user selects one or more levels, then all other levels 
are deselected. 

Keep Last Level Selection After Take
When a different source or destination is selected after a ‘Take’, the level selection is 
normally cleared. To keep the selected levels, select the Keep Last Selection button in the 
‘Levels Grid’ pane tool bar (see Figure 5-12). 

Fig. 5-12: Keep Last Selection Buttons

Keep Last Selection toggle buttons

Source Levels Grid Destination Levels Grid
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Router Control Pane
The Router Control pane in the Bulk Routing Panel contains the Take, Lock and Protect 
functions.

Fig. 5-13: Router Control Pane: 
a) No Selections Made; 
b) Destination Selected; 
c) Destination and Source Selected.

Click Cancel to cancel all selections.

Select Auto-Take to make a route as 
soon as source(s) and destination(s) are 
selected.

a) No Selections Made

b) Destination Selected

With a destination selected, Lock and Protect buttons are active.

c) After Destination and Source Selection

After destination(s) and source(s) are selected, the Take button goes active (red). 

Click icon to see a list of keyboard shortcuts.
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Tool Bars in a Bulk Routing Panel
There is a small tool bar at the top of each grid/pane containing controls for selection/de-
selection, sorting and filtering.

Source Selection Grid Tool Bar

Fig. 5-14: Source Selection Grid - Tool Bar

Source Levels Grid Tool Bar

Fig. 5-15: Source Level Selection Grid - Tool Bar

Click to see drop-down menu of tool bar items.
Click to Select all sources.

Click to Deselect all sources.

Click to Sort sources A-Z.

Click to Sort sources Z-A.

Filter control, see What is 
Bulk Routing Panel 
Filtering?, on page 219.

Click to toggle the optional display of Wide Source and 
Destination Selection Buttons.

Click to see drop-down menu of tool bar items.

Click to Select all levels.
Click to Deselect all levels. 

Click to Sort levels A-Z.
Click to Sort levels Z-A.

Click to keep the Levels selection after a Take.

Filter control, see What is Bulk Routing 
Panel Filtering?, on page 219.
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Destination Grid Tool Bar

Fig. 5-16: Destination Selection Grid - Tool Bar

Filter control, see What is Bulk 
Routing Panel Filtering?, on 
page 219.

Click to:
• See a drop-down menu of all tool bar items.

• Copy routing information of a Destination selection.
• Paste routing information to a Destination.
• Paste a series of sources to a Destination range. 

(See What is Copy-and-Paste Routing?, on page 203.)
• Select all destinations.
• Deselect all destinations.
• Sort destinations A-Z.
• Sort destinations Z-A.

• Toggle display of wide selection buttons.
• Toggle Hide Sources. See Hide Sources, on page 234.
• Toggle List View mode. See List View, on page 236.
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Destination Levels Grid Tool Bar

Fig. 5-17: Destination Level Selection Grid - Tool Bar

Router Control Pane Tool Bar

Fig. 5-18: Router Control Pane - Tool Bar

Click to see drop-down menu of tool bar items.

Click to Select all level.
Click to Deselect all levels. 

Click to Sort levels A-Z.
Click to Sort levels Z-A.

Click to keep the Levels selection after a Take.

Filter control, see What is Bulk Routing 
Panel Filtering?, on page 219.

Keyboard Shortcuts icon
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Salvos Pane Tool Bar

Fig. 5-19: Salvos Pane - Tool Bar

Click to see drop-down menu of tool bar items

Click to sort sources A-Z
Click to sort sources Z-A

Filter control, 
see What is Bulk Routing Panel Filtering?, on page 219



192

Routing Control - Bulk Routing Panel
Wide Source and Destination Selection Buttons

Wide Source and Destination Selection Buttons
To facilitate the display of longer source or destination names on selection buttons, there is a 
‘wide button’ display option. This is selectable in the Source Grid and, independently, in the 
Destination Grid. The option is selected with a toggle button in the tool bar of each grid. See 
Figure 5-20. 

The display option persists between sessions with the Bulk Routing Panel.

Fig. 5-20: Wide Buttons (Source Grid Shown)

Click to toggle display of normal and wide buttons.
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Panel Pop-Up Items

Right-Click in a Bulk Routing Panel
Right-click on the Bulk Routing Panel to display a pop-up context menu. See Figure 5-21.

Fig. 5-21: Right-Click Context Menu

 Table 5-2: Right-Click Context Menu Items 
Item Keyboard

Dock/Undock 
Window

Undock or dock the Bulk Routing Panel window from/to the GV 
Orbit Client window.

Full Screen The Bulk Routing Panel window is shown full-screen. 
The control toggles full screen mode on/off.

Copy Same as:
• clicking on Copy icon in grid/pane tool bar; or 
• pressing Ctrl-C.

Deselect All Deselects all items. 

Lock/Unlock Click to lock panel. When panel is locked, controls are grayed-out 
and user operation is disabled. The control toggles lock on/off

Set Timeout Click to set a timeout (in seconds) for confirmation from the router 
controller of routing actions (i.e. the setting of router crosspoints). 

If the timeout is exceeded, a timeout notification is shown on 
screen. See Pop-up Notification Messages.

Copy As Widgets Click to copy a selection of one or more buttons to the GV Orbit 
Client’s copy-buffer. 
(This is used when designing an XY Routing Panel. See Chapter 6, 
Routing Control - XY Routing Panel, Quick Port-per-Button 
Assignment, on page 305.)
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Pop-up Notification Messages
During Bulk Routing Panel operation, notification messages may pop up at the foot of the 
GV Orbit Client application window. These messages are informative to the user, advising, 
for example, on the setting up of a route, or of a broken/re-made Routing service 
connection. See Figure 5-22 for some example messages. 

Click OK to clear a message. 

Fig. 5-22: Notification Message Examples

Click OK to clear the message. 



195

GV Orbit Routing Panel
User Guide

Dial Source and Dial Source-Level Dialogs
To help with source and source level selection when making a route, a ‘dial-up’ dialog 
allows the user to begin to type in a source name and see a filtered list of sources and 
source levels. 

There are two ‘dial-up’ dialogs
• Dial Source Dialog for Source selection.
• Dial Source-Level Dialog for Source and Level selection.

These dialogs enable a user to select a source and/or level and route it to a destination.

Dial Source Dialog
Dial Source is a quick way of selecting a Source for a destination and routing it.

With a Destination selected, a Source may then be found by typing a part of a source 
name with the keyboard’s alpha-numeric keys. A Dial Source dialog is displayed and, as 
characters are entered:

• Sources matching the entered characters are displayed in a drop down list; and the 
• Source Grid is correspondingly filtered. 

After a valid Source has been selected, a route can be made by pressing the Enter key.

Example

To see and use the Dial Source dialog:
1 Select a Destination.
2 Begin to type in a Source name.

A Dial Source dialog pops up. (See Figure 5-23.)
3 Continue typing in a valid source name and press Enter; and/or

select a source from the (scrollable) filtered list in the dialog.

A route is made from the selected Source to the selected Destination. No ‘Take’ is 
required.

Note: To clear a ‘dial-up’ dialog before making a route, click the ESC key.

Note: Enter will execute the route if a valid source has been selected. A 
mouse click on a source will also execute the route.
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Fig. 5-23: Dial Source Dialog

Further routing examples can be found at:
• Route with Dial Source, on page 200.

Dial Source-Level Dialog
Dial Source-Level is a quick way of selecting a Source and a Level for a destination and 
routing it. By default, the Dial Source-Level dialog shows the currently-routed Source and 
Source-Level.

With a Destination and a Destination Level selected, type a single alpha-numeric 
character to display the default Dial Source-Level dialog. 

A Source may then be found by starting to type a source name. As the Source name is 
typed, the Sources listed in the dialog are filtered. 

After a valid Source has been highlighted, press Tab to select a valid Source Level and a 
route can be made by pressing the Enter key.

Routing a level from a different source to a destination forms a breakaway (see Breakaway 
and Levels). Routing a different level from the same source forms a shuffle (see Shuffle and 
Levels). 

Example

To see and use the Dial Source-Level dialog:
1 Select a Destination.
2 Select one or more Destination Levels.
3 Type a single alpha-numeric character.

Selected 
Destination

Pop-up Dial Source dialog

Type in Source name, or 
select Source name.
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A default Dial Source-Level dialog pops up and shows the currently-routed Source 
name and Level. (See Figure 5-24.) 
(Note: It is assumed that level-based routing is required.)

Fig. 5-24: Dial Source-Level Dialog

4 If a different Source Name is required, begin to enter the required Source name.

The list of Source names is filtered on the typed text.
5 Either:

• continue typing in a valid Source name (but do not press the Enter key); or
• highlight a Source name in the list (do not select it).

6 When the required (and valid) Source name is in the upper text box of the dialog,
press the Tab key. (See Figure 5-24.)

This toggles focus from ‘Sources’ to ‘Levels’; the filtered list changes to listing Levels.

7 Type in the Level name required and press Enter; and/or 
select the Level from the filtered list in the dialog.

A route is made from the (one) selected Source Level to the selected Destination 
Level(s). No ‘Take’ is required. 

Selected 
Destination Pop-up Dial Source-Level 

dialog

Type in a valid Source name; 
and press Tab key to 
toggle focus to Levels.

Selected 
Destination 
Levels

Type in Level name; and/or 
select Level name.

Note: To clear a ‘dial-up’ dialog before making a route, click the ESC key.



198

Routing Control - Bulk Routing Panel
Dial Source and Dial Source-Level Dialogs

Further routing examples can be found at:
• Quick Breakaway with Dial Source-Level, on page 211.
• Quick One-Level Shuffle with Dial Source-Level, on page 217.

Note: Enter will execute the route if a valid source and level has been 
selected. A mouse click on a source or source level will also execute 
the route.
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Bulk Routing Panel Operation

Make a Simple Route
To make a simple route:

1 Select a Destination.

The source currently routed to the selected destination is automatically highlighted in 
the Source Grid.

2 Select a Source to be routed to the selected destination.

See Figure 5-25.

Fig. 5-25: Make a Route Example - Before TAKE. 

3 Click Take. (Click Cancel, to deselect the source/destination.)

The selected source (all of its levels) is routed to the selected destination. See Figure 5-
26.

Before a Take, the Levels Grids show level information for the selected source and destination.

Click Take to make route

1

2
3
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Fig. 5-26: Make a Route Example - After TAKE. 

Simple Route - Alternative Method

Also, to make a route, the source may be selected first:
1 Select a Source.
2 Select a Destination.
3 Click Take.

Route with Dial Source
See Dial Source Dialog, on page 195, for more information. To make a simple route:

1 Select a Destination.
2 Begin to type in a Source name.

A Dial Source dialog pops up. 
3 Continue typing in a source name and press Enter; and/or

select a source from the (scrollable) filtered list in the dialog.

A route is made from the selected Source to the selected Destination. No ‘Take’ is 
required.

After the TAKE, the new source of 
the destination and its levels is 
shown in the Destination Grid and 
Destination Levels Grid.
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Route One Source to Multiple Destinations
One to many.

To route a single source to multiple destinations:
1 Select a Destination by clicking on the destination selection button. 

(Equivalent keyboard shortcuts = cursor arrow keys and space-bar.)
2 Select a second Destination by CTRL + clicking on a destination button. 

(Equivalent keyboard shortcuts = cursor arrow keys and CTRL-Space-Bar.)
3 Select further destinations with CTRL + click.

A selection of destinations has been made.

When all destinations have been selected:
4 Select a Source.

(Equivalent keyboard shortcuts:
Change to Source grid = CTRL-Cursor arrow keys.
Select Source = cursor arrow keys and space bar.)

5 Click Take.
(Equivalent keyboard shortcuts = Enter.)

The selected source is routed to all selected destinations.

One Source to Multiple Destinations - Alternative Method
Alternatively, the source may be selected first:

1 Select a Source.
2 Make a selection of Destinations (by CTRL-clicking, or SHIFT-clicking, or a combination). 
3 Click Take.

Note: The Bulk Routing Panel may be operated with a mouse, or using 
keyboard shortcuts, or by using a mixture of both.

Note: Alternatively, a range selection may be made by:

• Selecting the first destination; and then 
• SHIFT-selecting the last one. 

This selects a sequential range of destinations, from first to last.
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Route Multiple Sources to Multiple Destinations
May to many.

To route multiple sources to multiple destinations:
1 Select a Destination by clicking on the destination selection button.
2 Select a second Destination by CTRL + clicking on a destination button.
3 Select further destinations with CTRL + click.

When all destinations have been selected:
4 Select a Source by clicking on the source selection button.
5 Select a second Source by CTRL + clicking on a source button.
6 Select further sources with CTRL + click.

7 Click Take.

The source is routed to all selected destinations.

Multiple Sources to Multiple Destinations - Alternative Method
Alternatively, the source may be selected first:

1 Select multiple sources.
2 Select multiple destinations.
3 Click Take.

Multiple Selection Type and Routing Order
Routing multiple Sources and/or multiple Destinations requires a selection of Sources and 
of Destinations to be made. This can be done as:

• a selection of multiple items (see Select Multiple Items (CTRL select), on page 184); or 
as

• a range selection of multiple items (see Select a Range of Items (SHIFT select), on 
page 184).

The selection order is different in each case and affects routing order.

Note: Alternatively, a range selection may be made by:

• Selecting the first Destination; and then 
• SHIFT-selecting the last one. 

This selects a range, from first to last.

Note: Alternatively, a range selection may be made by selecting the first 
Source and then SHIFT-selecting the last one. This selects a range, 
from first to last.

Note: Select the same number of sources as there are selected destinations. 
A reminding, pop-up notification message will appear.
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CTRL-Selection Type Order
When routing multiple sources to multiple destinations and selecting multiple items with 
CTRL-clicks (i.e. not by using a range selection), then the order of selection is significant and 
affects the order in which routing is done. 

For example, to route sources 1 to 8 to destinations 8 to 1:
• Select sources 1 to 8 by CTRL-clicking on each source button in the order 1 to 8.
• Select destinations 8 to 1 in that order by CTRL+clicking on each destination button in 

the order 8 to 1.
• Click Take.

SHIFT-Selection (Range) Type Order
When routing multiple sources to multiple destinations and using a selection range (a 
selection made with ‘SHIFT’), then selection order is from the first to the last item of the 
range, in the order that the items (Source or Destination buttons) are shown. This is the 
routing order used.

What is Copy-and-Paste Routing?
Copy and paste allow routing information from one destination to be copied onto another 
destination. The Copy and Paste controls are in the Destination Grid tool bar.

Fig. 5-27: Destination Grid Copy and Paste Controls

To Perform Copy-and-Paste Routing
1 Select a Destination.
2 Click the Copy icon in the tool bar of the Destination Grid, or press ‘CTRL +C’.

The copy-selected Destination is shown highlighted with a ‘crawling’, dashed outline. 
See Figure 5-28.

Copy
Paste
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Fig. 5-28: Copy-Selected Destination

Then:
3 Select a different Destination (the one to copy to).
4 Click the Paste icon, or press ‘CTRL + V’.

The routing of the first destination is applied to the second destination and a route is 
made automatically. The routing done is ‘all-levels’.

The copy-selection is still selected (the dashed outline indicates this), so further pastes can 
be made. To paste the same to further Destination(s):

5 Select a Destination (or select multiple destinations) and click on the Paste icon (or 
press ‘CTRL-V’.)

6 Repeat for any further Destinations.

Finally:
7 To clear the copy selection, press ESC. (This can be done at any time.)

‘Copy-Selected’ Destination
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What is Copy-and-Paste Series Routing?
Paste Series fills a range of Destinations with a consecutive series of Sources.

To Perform Copy-and-Paste Series Routing
1 Select a Destination.
2 Click the Copy icon, or press ‘CTRL +C’.

The routing information of the selected destination is copied.
3 Select a range of Destinations.
4 Click the Paste Series icon, or press ‘SHIFT + V’.

Fig. 5-29: Paste Series Icon

The routing of the first, ‘copy-selected’ destination is applied to the first destination in 
the selected range. 
The next sequential source is routed to the next destination in the range 
and so on. 
Routing is done automatically (no Take required).

Paste Series Example
1 Select destination 1 and click Copy.
2 Select destination range 11 up to 19. (Select first and Shift-select last.)
3 Click Paste Series .

The following routing is done:
Source 1 to destination 11, source 2 to 12, 3 to 13, 4 to 14, ... , 9 to 19.

Note: The rules of selection type and order apply. See Multiple Selection 
Type and Routing Order, on page 202.

Paste Series icon
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What is Quick 1-to-1 Routing?
Quick 1-to-1 routing can be used to make 1-to-1 routes quickly. This can be useful at system 
set up. For example, for the first 100 sources routed to the first 100 destinations.

To Perform Quick 1-to-1 Routing
To make a set of quick 1-to-1 routes:

1 Select destination 1, select Source 1, and click Take.

This routes the first destination.
2 Click Copy.

Destination 1’s routing information is copied.
3 Select destination range 1 to 100. (Select first and Shift-select last.)
4 Click Paste Series .

The following routing is done:
Source 1 to 1, source 2 to 2, 3 to 3, ... , 99 to 99, and 100 to 100.

This has quickly copied Sources to all selected Destinations.
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Destination Protect

What is Destination Protect?
When a destination is protected by a user, users of other types of routing control panel 
cannot route to it. 

This means that users of Bulk Routing Panels in GV Orbit Clients would be able to route to a 
destination protected by another such Bulk Routing Panel. But hardware panel users would 
not be able to route to a destination protected by a Bulk Routing Panel. (And vice versa.)

To Protect a Destination
1 Select a Destination.
2 Click the Protect button in the Router Control pane.

The destination is protected.

Fig. 5-30: Protected Destination

To Un-Protect a Destination
1 Select the protected destination.
2 Click the Release button in the Router Control pane.

The destination protection is removed from the selected destination.

Protected 
Destination, 
selected

Protect button

Selected 
Destination’s levels 
are also shown as 
protected

A Protected 
Destination, 
not selected
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Destination Lock

What is Destination Lock?
When a destination is locked, it cannot be routed to by any user.

To Lock a Destination
1 Select a destination.
2 Click Lock in the Router Control pane.

The destination is locked.

Fig. 5-31: Locked Destination 

To Unlock a Destination
1 Select the locked destination.
2 Click the Release button in the Router Control pane.

The destination lock is removed from the selected destination.

Selected 
Destination, Locked

Lock button

Locked 
Destination’s levels 
are also shown as 
locked
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Breakaway and Levels

What is a Breakaway?
A ‘breakaway’ occurs when all levels of a destinations do not come from the same source. 
This is also referred to as the destination being ‘unmarried’. 

Fig. 5-32: Breakaway

Destinations which are ‘unmarried’ are indicated with a breakaway icon (Figure 5-33c) on 
the destination button.

Breakaway example shown:
Two audio channels of Destination B (A1 and A2) are obtained 
from a different source (Source C).
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Perform a Breakaway
To perform a breakaway:

1 Select a Destination.
2 Select the Destination Levels to make a route to (for example, audio channels A1 and 

A2). (See Figure 5-33a.)
3 Select a new Source. 
4 Click Take.

The corresponding levels of the selected source are routed to the selected destination 
levels and a breakaway is formed. Figure 5-33b shows the breakaway result.

Fig. 5-33: Breakaway Example: a) Before TAKE; b) After TAKE; c) Breakaway Icon on Button.

a) Before TAKE: 
• Destination MV10-9 is currently all routed from source 

S10-9
(as shown in the Destination Levels Grid).

• Destinations levels A1 and A2 are selected.
• S10-18 is the currently-selected source.

b) After TAKE: 
• Destination MV10-9 is routed partly from source S10-9 

and partly from S10-18 (levels A1 and A2). 
• This breakaway situation is indicated with a Breakaway 

icon on the destination button.
• The source of each destination level is shown in the 

Destination Levels Grid.

c) Breakaway icon on button

1

2

3
4
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Breakaway - Alternative Method
Also, to perform a breakaway, the source may be selected first:

1 Select a Source.
2 Select a Destination.
3 Select the Destination Levels to route.
4 Click Take.

Quick Breakaway with Dial Source-Level
A quick single-level breakaway method uses the Dial Source-Level Dialog.

To perform a quick video-level breakaway:
1 Select a Destination.
2 Select a Destination Level. (See Figure 5-34.)

Fig. 5-34: Selected A Destination and a Level

3 Type a single alpha-numeric character.

A default Dial Source-Level dialog box appears showing the currently-routed Source 
and Level. 

4 Begin to type a (new) Source name at the keyboard. 
(For example, type “s” or “S” if source names begin with “S” - “S10-10”, “S10-11”, etc.)

Note: A ‘breakaway’ occurs when not all of a destination’s levels are 
selected for routing.
This can also happen if a source with fewer levels than the selected 
destination is routed, this will result in a ‘breakaway’ (without 
selecting destination levels). 

Selected Destination

Selected Video Level
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A Dial Source-Level dialog box appears. See Figure 5-35.

Fig. 5-35: Dial Source-Level Dialog

5 Type the new Source name into the dialog box. But do not press the Enter key yet.
6 When the Source name is typed, press the Tab key.

This toggles focus from ‘Sources’ to ‘Levels’ and to the lower dialog text entry box. 

Fig. 5-36: Source and Level are Dialed-up

7 Type in the Level name, for example “V” and press the Enter key when done. 
Or select a level from the filtered list.

The route is made, connecting the dialed-up Source Level to the selected Destination 
Level and forming a breakaway. See Figure 5-37.

Type Source name

Level text entry box

Source name text entry box

Press Tab key to toggle focus to 
the Level text entry box

Typed in source name
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Fig. 5-37: Resulting Video Level Breakaway

Use this method to set up any breakaways (or shuffles, see Quick One-Level Shuffle with 
Dial Source-Level, on page 217) required.

Video Level sourced from a 
different source. (Breakaway)

(Level sources:

‘Video’ - now from S10-111, 

‘other’ - unchanged, S10-10.)
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Shuffle and Levels

What is a Shuffle?
A destination is said to be ‘shuffled’ when one of its levels is routed from another level of the 
same source. For example, destination audio channel 5 from source audio channel 4. When 
this occurs, the Bulk Routing Panel indicates a ‘shuffled’ destination with a Shuffle icon on 
the destination button.

Fig. 5-38: Shuffles

To Perform a Shuffle
1 Select a Destination.
2 Select the Destination Levels. 

For example, in Figure 5-40a, levels A1, A2, A3 and A4 are selected in that order.
3 Select a Source. 
4 Now select the Source Levels in the order in which they shall apply to the destination 

Levels. 
For example, in Figure 5-40a, levels A4, A3, A2 and A1 are selected in that order.

A source is routed to a destination 
and audio channels are ‘shuffled’ 
around, 
i.e. they are not routed ‘1-to-1’.

Shuffle example shown:
Audio channels of Destination B (A1 and 
A2) are obtained from a source (Source 
A) but not all levels are mapped “1 to 1”.

Note: Selecting just one source level will route this to all selected 
destination levels.
Otherwise select the same number of source levels as destination 
levels. A notification prompt appears at the bottom of the GV 
Orbit Client window, reminding the user to select source levels 
(see Figure 5-39).
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Fig. 5-39: Select Levels Notification

5 Click Take.

The selected source levels are routed to the selected destination levels and a shuffle is 
formed. Figure 5-40 shows a shuffle example reversing the order of the four audio 
channels (A1 to A4).

Notification prompt.
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Fig. 5-40: Shuffle Example: a) Before TAKE; b) After TAKE; c) Shuffle Icon on Dest. Button.

c) Shuffle icon on button

1

5

2

3

4

a) Before TAKE: 
• Destination MV10-9 is currently all routed from source 

S10-9
(as shown in the Destination Levels Grid).

• Destinations levels A1, A2, A3 and A4 are selected.
• Source S10-9 is selected.
• Source Levels A4, A3, A2 and A1 have been selected 

(in that reversed order).

b) After TAKE: 
• Destination MV10-9 is still all routed from source S10-9. 
• This ‘shuffled’ situation is indicated with a Shuffle icon on the 

destination button.
• The source of each destination level is shown in the 

Destination Levels Grid.
In particular, the destination’s A1, A2, A3 and A4 are now routed 
from A4, A3, A2, and A1 respectively.
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Quick One-Level Shuffle with Dial Source-Level
To shuffle (route) one level using the Dial Source-Level Dialog: 

1 Select a Destination.
2 Select a Destination Level.

A Destination and one Level are now selected.
3 Type a single alpha-numeric character.

A default Dial Source-Level dialog appears and showing a filtered list of source names. 
The currently-routed Source and Level are shown.

Do not click; do not press Enter at this time.

Note: The currently-routed Source name is shown in the default dialog.
4 Press the ‘Tab’ key.

Focus then moves (toggles) from Source to Levels in the dialog.

Fig. 5-41: Dial Source-Level Dialog

5 Type in a new Level name and press Enter, or 
select a new Level item in the filtered list, click to select.

A route is performed, connecting the selected Source Level to the selected Destination 
Level. A shuffle is made, see Figure 5-42.

Selected Destination

Selected Destination Level

Dial Source-Level dialog

Source name

Selected Source Level

Current Source routed to 
selected Destination
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Fig. 5-42: Shuffle Routed

Use this method to set up any shuffles (or breakaways, see Quick Breakaway with Dial 
Source-Level, on page 211) required.

Note: Using this method, one Source Level can be routed to one or more 
Destination Levels.

Shuffle now made, audio 
level A11 at destination 
comes from audio level A7.
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Filtering

What is Bulk Routing Panel Filtering?
Most grids/panes of the Bulk Routing Panel have a filter control on their tool bar. The filters 
control what items are shown in the grid/pane. Filters can be applied to the 
Source/Destination grids, the Level Selection grids and the Salvos pane. Custom filters can 
be created and applied. For destinations, filtering can also be by (routed) source. 
By default, level filtering is set up to show the usual video and audio levels.

What are the Filter Controls in a Bulk Routing Panel?
Each grid/pane contains a similar filter text box and icon. These access a filter items list (also 
accessed by typing Ctrl-F when in a grid/pane), and filter options menu respectively.

Fig. 5-43: Filter Controls: 
a) Filter Text Entry Box; b) Filter Drop-Down Options Menu;
c) Drop-Down Menu for Destination Grid; d) Level Grid Filter Items List (Default).

Note: Filtered Lists:
When a filter is applied, a filtered (reduced) set of items is shown in a 
grid/pane. 
Subsequent actions, such as ‘select all items’ or ‘selecting a range’, then 
all operate on the filtered items shown and not on the full list of items. 

Filter search text box

a) Filter Controls - Text Entry Box b) Filter Drop-Down Menu

c) Filter Drop-Down Menu - for the Destination Selection Grid

d) Levels Grid Filter Default

Click the Filter icon to show the Filter options menu.

Filter items listDestination Grid’s Filter options menu

Note: The default ‘Levels’ filter list shows 
one video level and 16 audio channels.
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Filtering Actions

Simple Filtering by Name
To simply filter items in a grid or pane by name: 

1 Select the Filter text entry box.
2 Enter a filter search term into the Filter text box. 

For example, type ‘S11’ to only show source names starting with ‘S11’.

As the filter search term is typed, the number of displayed items in the Grid/Pane is 
reduced (filtered). The reduced number of items gives a preview of the filter’s action.

3 To abort the filter set up, press the ESC key.
4 When the required filtering is reached, press the Return/Enter key to apply the filter.

The filter has been applied to the grid. Then only filtered items are shown in the 
grid/pane, with names which contain the search term. 

Fig. 5-44: Example of Simple Filtering Applied to a Grid/Pane (Search Term = “S11”)

Clear Applied Filtering in a Grid/Pane
To clear filtering that has been applied in a grid or pane: 

1 Either:
• click on the Filter icon ( ) in the grid/pane’s tool bar; or
• in the Filter text entry box, press the Tab key. 

And then select ‘Clear Filter’.

The filtering is removed and all grid/pane items are shown. 
The filter search term is also cleared and the Filter items drop-down list is shown.

2 At this point, a new search term may be entered. 
Or the filter clearing action can be aborted by pressing the ESC key.

If no further filter set up is required:

Filter search term
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3 Press the Enter/Return key to remove the Filtering and the Filter items drop-down list.

Set Level Filtering in a Grid/Pane
To set any applied Level filtering back to its ‘default’: 

1 Either:
• click on the Filter icon ( ) in the Level grid/pane’s tool bar; or
• in the Filter text entry box, press the Tab key, 

And select ‘Video, Audio 1 to 16’.

Fig. 5-45: Set Level Filtering to Default

Any filtering is replaced by the default ‘Video, Audio 1 to 16’ filtering and the filter 
search term reflects this. 

Fig. 5-46: Level Filtering Default

2 Press Enter to apply this change (or press ESC to cancel this filter change).

Fig. 5-47: Level Filtering Default Applied

Select ‘Video, Audio 1 to 16’
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Dynamic Filtering By Name

Fig. 5-48: Dynamic Filtering (Source Names Example): 
a) Enter Search Term and Select. 
b) Selected Item Displayed

To dynamically filter items by their name: 
1 Enter the filter search term into the Filter text box. 

GV Orbit looks for names which contain the filter search term.
A drop-down, scrollable filtered list of names is presented. 
The list dynamically changes with the search term.

2 Find a name in the list by scrolling through the items. 
(Use a mouse wheel, the scroll-bars, or up/down arrow keys to scroll through the list.)

3 Select an item. 
(Click on it, or press the Return/Enter key when item is highlighted.)

The result of the selected filter item is shown in the grid.

b) Selected Item(s) Displayeda) Enter Search Term and Select

Filter search term List of names containing the search term (scrollable).



223

GV Orbit Routing Panel
User Guide

Filtering Destinations by Source
Filtering of items by their names has been described so far. The filtering is extended for 
Destinations to enable Destination names to be filtered by the names of the sources that are 
routed to them. The filter drop-down menu of the Destination Grid contains an extra item, 
for this, ‘Filter by Source’. 

1 In the Destination Grid, click on the Filter icon ( ) and select Filter by Source. 

Fig. 5-49: Filtering of Destinations by Source is Enabled

2 Enter a search term in the Filter text box.

Fig. 5-50: Filter Destinations by Source

3 Press the Enter/Return key to apply the filtering.

With the Filter by Source option selected, the Destination Grid will show only 
destinations which have a filter-matching source routed to them. 

‘Filter by Source’ is selected

Filter search term.
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Fig. 5-51: Example Destination ‘Filter by Source’

Preset Level Filters
The Source Level and Destination Level grids offer some preset filters to filter audio/video 
levels. For example, ‘Video, Audio 1 to 16’ which is for video and 16 audio channels. This 
preset filter is listed in the drop-down Filter items list, along with the names of the items 
(levels).

Custom Filters

What is a Custom Filter in a Bulk Routing Panel?
GV Orbit allows more complex and custom filters to be created. This can be done for any of 
the filterable grids/panes.

A custom filter can be:
• Created, given a name and saved. 
• Edited or deleted. 
• Re-named.

A custom filter is applied by entering the start of the custom filter name into the filter text 
box. The custom filter name will appear in the Filter items drop-down list for selection. 
Select the custom filter name to apply it.

Custom filters are stored in the GV Orbit Routing service for the currently-logged-in GV 
Orbit user. In this way, the filter will be available to the same user on other machines. 

What is a Custom Filter Rule?
Filter expressions can be defined and combined together to form complex filter conditions, 
filter rules. The filter rule of a custom filter is designed in a Filter dialog. 

Destinations shown have 
Source names matching the 
filter search criteria. 

Search term

‘Filter by Source’ is selected

Note: Custom filters will not be seen by other users on other machines.
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Expressions can be combined to make rules by ANDing and ORing them together:
• AND - filter condition is met if both filter expressions are satisfied.
• OR - filter condition is met if either filter expression is satisfied.

Custom Filtering

Creating a Custom Filter
In a grid/pane:

1 Click on the Filter tool bar icon and select ‘Create Filter’.

An empty Filter dialog is shown. See Figure 5-52.

Fig. 5-52: Filter Dialog

2 Enter a Filter name for the filter.

Fig. 5-53: Saving New Custom Filter

3 Click Save.

A new Custom Filter has been created.

Custom filter rule to 
be defined here.

Filter name entered
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Selecting a Custom Filter
A Custom Filter is listed in the drop-down Filter items list:

1 In the Filter text box, start to type the name of a Custom Filter.

The Filter items drop-down list contains the Custom Filter name.

Fig. 5-54: Custom Filter in Filter Items List

Constructing the Rules for a Custom Filter
See Filter Dialog and Custom Filter Rules, on page 228, for adding filter rules with the dialog 
to construct the filter.

To Edit an Existing Custom Filter
1 Click on the Filter tool bar icon and select Edit Filter.

Fig. 5-55: Select Custom Filter to Edit

2 Select the filter to edit from the list shown. (See Figure 5-55b.)

The Filter dialog is shown for the selected custom filter.

Select a Custom Filter name

A Custom Filter name

a) Select Edit Filter name

b) Select which Custom Filter to Edit
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To Delete a Custom Filter
1 Click on the Filter tool bar icon and select Delete Filter.
2 Select the filter to delete from the list shown. 

The filter is deleted when the selection is made.
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Filter Dialog and Custom Filter Rules
The filter rule of a custom filter is designed in the Filter dialog (see Figure 5-56). A rule is 
formed from the logical combination of filter expressions. Expressions can be ANDed or 
ORed together and complex AND/OR configurations can be defined for a custom filter:

• AND - filter condition is met if both filter expressions are satisfied.
• OR - filter condition is met if either filter expression is satisfied.

A worked example is given (Example Custom Filter, on page 229) which shows how to 
construct Filter rules with the Filter dialog.

Fig. 5-56: Filter Dialog - Custom Filter Example

Logical AND / OR Combining

The Custom Filter being designed must be expressible in the form of a logical expression 
so that it can be captured in the Filter dialog.

A rule might be designed to filter:
• destination names that both start with a ‘C’ and contain a ‘6’.
• destination names that either end with a ‘4’ or end with a ‘5’.
• destinations whose source names start with ‘Cam’.
• destinations whose names end with a ‘X’ and whose source names are ‘Cam12’.

Custom Filter name (editable)

Logical AND/OR 
combination item

Click to save the custom filter and close the dialog.

Click to apply custom filter.

Select the target of
the expression,

(Destination) ‘Name’
or ‘Source’

Operator, see Table 5-3

Enter operand

Click to Add Expression item 
under an AND/OR item.

Click to Add AND/OR item 
under an AND/OR item.

Defines the logical 
AND/OR structure 

Delete AND/Or item and 
items beneath it.

Expression item

AND/OR item

Delete Expression item
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Filter Expressions

An expression tests a Destination Name or Source Name with an operator and an operand.

Filter Expression Operators
The operators include:

Example Custom Filter
This section explains What the Filter Should Do and Defining the Custom Filter Example via 
the Filter dialog.

What the Filter Should Do
“Display two destinations only if they have certain sources currently routed to them.“

(Destinations Mon1 and Mon2 and sources Cam1 and Cam2 are used in this example.)

The filter for this example may be written:

“Show a destination if the destination name is Mon1 or Mon2, and its routed source name 
is Cam1 or Cam2.”

This may be written out to show its logical expression structure.
Show a destination if the following is true:

 Table 5-3: Operators - Name/Source and Operand
Operation True when...

Equals Name matches.

Not Equals No match.

StartsWith Starts with the operand.

EndsWith Ends with the operand.

Contains Contains the operand.

NotContains Does not contain the operand.

Greater Than Numerical part of name is greater than the operand.

Less Than Numerical part of name is less than the operand.

GreaterThanEqual Numerical part of name is greater than or equal to the operand.

LessThanEqual Numerical part of name is less than or equal to the operand.

Destination name is Mon1 

OR 

Destination name is Mon2

AND

its routed Source name is Cam1

OR

its routed Source name is Cam2



230

Routing Control - Bulk Routing Panel
Example Custom Filter

Defining the Custom Filter Example
This example Custom Filter filter may be entered into the Filter dialog as follows:

1 Click on the Destination Grid’s Filter tool bar icon and select Create Filter.

An empty Filter dialog is shown. See Figure 5-52 on page 225.
2 Enter a Filter Name for the filter.
3 Select AND as the first (top-level) logical combination item with the drop-down menu 

button. See Figure 5-57.

Fig. 5-57: Select AND

4 Click the Add AND/OR icon. 

An indented AND/OR item appears. 
An expression item also appears below the OR. See 
Figure 5-58.

5 Select OR as the new, indented logical combination item. 

Fig. 5-58: Select OR

6 Click the new Add Expression icon. 

A second expression item appears 
under the OR. See Figure 5-59.

Fig. 5-59: Added a Second Expression Item

7 Click the first Add AND/OR icon again. 

This add a second OR logical combination item 
indented under the AND. See Figure 5-60.

Filter Name entered

Expression item

Second expression item
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Fig. 5-60: Second OR Logical Combination Item Added

8 Add a second expression item under the new OR item. See Figure 5-61.

Fig. 5-61: Second Expression Item Added

The basic ‘AND-OR-OR’ logical combination structure for the example has now been 
entered for the Filter rule.

The next step completes the expression item and saves the filter:
9 Set up the expressions as shown in Figure 5-62. 

Fig. 5-62: Completed Custom Filter

10 Click Save in the Filter dialog to save the custom filter and close the dialog.

Custom filter rules have been entered; the Custom Filter has been created, ready to use. 
See Using a Custom Filter.

Operator

Filter Name

Expressions
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Using a Custom Filter
To use the custom filter ‘My Custom Filter 1’:

1 Start entering the custom filter name into the Filter text box. 
(‘My’ in this example.) A list of possible matching custom filters is presented. 

Fig. 5-63: Select Custom Filter

2 Select the ‘My Custom Filter 1’ item.

The filter is applied. 
In this example, only destinations ‘Mon1’ or ‘Mon2’ are shown if they have sources 
‘Cam1’ or ‘Cam2’ routed to them. See Figure 5-64.

Fig. 5-64: Applied Custom Filter

To clear the filtering: 
3 Click on the Filter tool bar icon and select Clear Filter.

(The Custom Filter displays only destinations
‘Mon1’ and ‘Mon2’ - which happen to be locked.) 



233

GV Orbit Routing Panel
User Guide

Salvos 

What is a Salvo? 
Salvos are created and defined in Grass Valley’s GV Orbit product and are available to the 
Bulk Routing Panel through the GV Orbit Routing service that the Bulk Routing Panel is 
connected to.

Salvos are shown in the Salvos pane of the Bulk Routing Panel. The list of Salvo names can 
be filtered using the tool bar controls. Filters can be set up in a similar way to the other 
grids/panes of the Bulk Routing Panel.

Fig. 5-65: Salvos Pane with Salvo Buttons

Executing Salvos

To Execute a Salvo
Either:

• double-click on the Salvo button; 

or, 
• select the Salvo button (single-click) and click Take. 

To Execute multiple Salvos
1 Select the first Salvo.
2 Select other Salvos with CTRL-click. 
3 Press Take.
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Hide Sources

What is the Hide Sources Mode?
In Hide Sources mode, the Source Selection and Source Level Selection grids may be 
hidden from view. Thus displays more destinations are shown to the user. 

The Hide Sources icon in the Destination Grid’s tool bar enables this mode.

Fig. 5-66: Hide Sources Icon in Destination Grid Tool Bar

Enter Hide Sources Mode
Toggle Hide Sources on/off by:

• Click the Hide Sources icon in the Destination Selection grid tool bar.

The Bulk Routing Panel hides the Sources and more Destinations are shown. See 
Figure 5-67b on page 235.

Routing in Hide Sources Mode
Use the Dial Source or Dial Source-Level facility to route source signals and/or levels to 
destinations. See Dial Source Dialog, on page 195 and Dial Source-Level Dialog, on 
page 196.



235

GV Orbit Routing Panel
User Guide

Fig. 5-67: Bulk Routing Panel: 
a) Sources and Destinations Shown; 
b) Hide Sources.

b) Hide Sources

a) Sources Shown
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List View

What is List View Mode?
List View is a level-centric view of a Bulk Routing Panel, allowing a user to focus on routing 
to Destination Levels. List View hides Sources and Source Levels and presents all of the 
destinations in a ‘list’ format; each list item is a Destination with all of its Levels.

Figure 5-68a shows a normal Bulk Routing Panel view and Figure 5-68b shows a List View.

Fig. 5-68: Bulk Routing Panel: a) Normal View; b) List View

Focus between the Destination and Destination Levels sections can be moved with the 
CTRL-Cursor-arrow-keys, as usual. Focus is shown with a thin blue bounding box.

a) Normal Bulk Routing Panel View

b) List View

Click icon 
to toggle 
between 
views

Scrollable list of 
destinations

Destination Levels Grid

D
es

tin
at
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ns

 C
ol

um
n

Focus is on 
Destinations 
List
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List View Tool Bar
The List View tool bar is an amalgamation of the tool bars of the normal Destination pane 
and Destination Level grid of a Bulk Routing Panel. Icons may be grayed-out according to 
panel focus. See Figure 5-69.

Fig. 5-69: List View Tool Bar

Destination Filtering
There are two filter boxes and these are for: Destination filter and Destination Level filter. 
See Figure 5-69. List View presents all of the destinations in a scrollable list. To aid selection 
of destinations and levels, and navigation of the list, the filter facility can be used to limit 
what is listed:

• Destination filtering may be done by name or by their routed Source. 
• Destination Level filtering may be done by Level name. 

See Filtering, on page 219, for more information about using the filter facility. 

A filter may be invoked by pressing CTRL-F according to where your panel focus is. In List 
View, with panel focus on:

• the Destination column, then CTRL-F invokes Destination filter; or on
• the Level grid, then CTRL-F invokes Destination Level filter.

Selection in List View

Select a Destination
1 Click on a Destination. 

(Or move focus to the level with the cursor keys and press Space-Bar.)

All of the destination’s levels are automatically selected.

Icons, some may be grayed-out depending on panel focus.

Two filter boxes, 
for Destination filtering and Destination Level filtering
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Fig. 5-70: Select a Destination

Select Multiple Destinations
1 Click on a Destination to select it. 

(Or move focus onto the Destination with the cursor arrow keys and press the Space-
Bar key.)

2 CTRL-click to add other Destinations.
(Or focus on another Destination and press CTRL-Space-Bar.)

Alternatively or additionally, SHIFT-select can be used when selecting a range.

Select a Destination Level
1 Click on a Destination Level.

The Level is selected and the Destination is selected automatically. No other Levels are 
selected.
e

Fig. 5-71: Select a Destination Level

Select Multiple Destination Levels

CTRL-Selecting
1 Select a Destination Level.
2 CTRL-Select other Levels to add further Levels to the selection.

Select a Destination, then all Levels are selected

Select a Level, then the Destination is selected.
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Fig. 5-72: Select Multiple Destination Levels

SHIFT-Selecting a Range of Destination Levels

To select a range of Levels:
1 Select the first Level in the range. 

(Move button focus onto a Level and click on it, or press Space-Bar.)
2 SHIFT-Select the last Level in the range.

(To move focus from the first Level to the last, use the mouse or use SHIFT-cursor-
left/right arrow keys. To select, click or press Space-Bar.)

Levels from the first to the last are selected.

Fig. 5-73: Select a Range of Destination Levels

SHIFT-Selecting a Block of Destination Levels

A block of Levels may be selected. This is similar to selecting a range, but it goes across 
more than one destination. To select a block of Levels:

1 Select the first, ‘top-left’ Level in the block.
2 SHIFT-Select the last, ‘bottom-right’ Level in the block.

Levels from the first selection to the last in a block are selected.

Select a Level, then CTRL-Select others.

Select the first Level, then SHIFT-Select the last.
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Fig. 5-74: Select a Block of Destination Levels

Selecting Source and/or Source Level
Source and Source Level selection is done via the Dial Source and Dial Source-Level dial-
up dialog facility. After the required Destination(s) or Destination Level(s) are selected type 
in an alpha-numeric character to open one of the dial-up dialogs. (See Dial Source and Dial 
Source-Level Dialogs, on page 195.)

For normal routing operation in List View mode, only a single Source or a Single Source 
Level can be selected.

Routing in List View
Routing in List View is done by selecting a Destination (and Levels) and then selecting a 
Source and Source Levels via the Dial Source and Dial Source-Level facility. (See Dial 
Source and Dial Source-Level Dialogs, on page 195.) 

Some Routing examples are provided, see:
• Routing Examples - ‘All Levels’, on page 241.
• List View Routing Examples - One-Level, on page 243.
• List View Routing Examples - Destination Copy-Paste, on page 248.
• List View Routing Examples - Copy-Paste Levels, on page 251.

A brief summary of these examples is found at List View Routing Summary, on page 254.

Select the first, ‘top-left’ Level, then SHIFT-Select the last, ‘bottom-right’.
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Routing Examples - ‘All Levels’
Several routing examples are presented:

• Simple Route, One Source to One Destination (‘All-Levels’).
• One Source to Multiple Destinations (‘All-Levels’).

Routing utilizes the Dial Source and Dial Source-Level Dialogs.

Simple Route, One Source to One Destination (‘All-Levels’)
To make a simple ‘all-levels’ route in List View:

1 Select a Destination.

Fig. 5-75: Destination Selected

2 Begin to type a Source name, for example, ‘S10-’.

A Dial Source dialog appears. Source names are listed in the dialog and are filtered on 
the typed text. See Figure 5-76.

Fig. 5-76: Dial Source Dialog

3 Continue to type in (‘dial-up’) a Source Name and press Return; and/or select the 
required Source name from the filtered Source list in the Dial Source dialog. For 
example, ‘S10-22’.

Filtered Source ListTyped in text
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An ‘all-levels’ route is made to the selected Destination.

Fig. 5-77: Routed All-Levels

An ‘all-levels’ route has been made.

One Source to Multiple Destinations (‘All-Levels’)
To make a simple ‘all-levels’ route from one Source to multiple Destinations:

1 Select the first Destination.
2 CTRL-Select and/or SHIFT-Select other Destinations.

When all Destinations have been selected:
3 Begin to type a Source name, for example, ‘S10’.

A Dial Source dialog appears. Source names are listed in the dialog and are filtered on 
the typed text. 

4 Proceed to ‘dial up’ a Source name, as described in Simple Route, One Source to One 
Destination (‘All-Levels’).

5 Select a Source to make the route.

An ‘all-levels’ route is made to multiple Destinations.

New source is routed to the destination, all levels.
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List View Routing Examples - One-Level
Several routing level-based examples are presented:

• Simple One-Level Route (Breakaway).
• One-Level Shuffle.
• One Level to Multiple Levels.

Simple One-Level Route (Breakaway)
To make a ‘one-level’ route in List View:

1 Select a Destination Level.

Fig. 5-78: Destination Level Selected

The corresponding Destination is also selected.
2 Type a single alpha-numeric character. 

A default Dial Source-Level dialog appears. User focus is in the (upper, Source-name) 
text entry box. The dialog shows the currently-routed Source name and Level.

3 Begin to enter a new Source name into the upper text entry box, for example, ‘S11-’.

Source names are listed, filtered on the typed text. See Figure 5-79.

Fig. 5-79: Select a Source Name

4 Either:
• select the required Source name in the filtered list; or
• finish entering the Source name into the dialog and press Enter.

Select a Source, or type in the name fully and press Enter.
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A ‘one-level’ route is made to the selected Destination Level from the selected Source, 
on the same Level. This forms a Breakaway.

Fig. 5-80: One Level Routed from a Different Source, Breakaway

A one-level, breakaway, route has been made.
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One-Level Shuffle
A shuffle is similar to a breakaway and, in List View mode, is routed is a similar way to 
Simple One-Level Route (Breakaway). 

(Refer to What is a Breakaway?, on page 209, and What is a Shuffle?, on page 214, for 
general information.)

To do a one-level route:
1 Select a Destination Level.

The corresponding Destination is also selected.
2 Type a single alpha-numeric character. 

A default Dial Source-Level dialog appears. User focus is in the (upper, Source-name) 
text entry box. The dialog shows the currently-routed Source and Level.

Note: The default dialog already shows the currently-routed Source name and Level 
name, regardless of the single alpha-numeric character typed.

3 Press the Tab key.

In the dialog, user focus changes from the (upper Source name) text entry box to the 
(lower, Source-Level-name) text entry box. 

4 Either:
• begin to type in a (new) Source Level name and then select the required Source 

Level in the list (by clicking on it, or by highlighting the Level and pressing the 
Enter key); or 

• fully type in the Source Level name (for example, ‘A2’) and press the Enter key.

A ‘one-level’ route is made from the selected |Source Level to the selected Destination 
Level, which forms a one-level Shuffle in this case.

A one-level shuffle route has been made.

Note: When a Dial Source-Level dialog first appears, it shows the 
currently-routed Source and Level. For a Shuffle, the Source name 
simply needs to remain the currently-routed Source.



246

Routing Control - Bulk Routing Panel
List View Routing Examples - One-Level

Channel-Swap Shuffle
To do a channel-swap in List View, carry out two One-Level Shuffle routes. See Figure 5-81.

Fig. 5-81: Forming a Channel-Swap Shuffle: 
a) Before any one-Level routing;
b) After first one-Level route;
c) After second one-Level route.

One Level to Multiple Levels
To route one Source Level to multiple Destination Levels:

1 Select a Destination Level.
2 CTRL-Select and/or SHIFT-Select other Destination Levels. 

(Note: These Levels do not have to belong to the same Destination.)

Figure 5-82a gives an example of multiple selected Destination Levels.

This has selected the Destination Levels required. 
Then:

3 Type a single alpha-numeric character. 

a) Before one-Level routing

b) After first one-Level route

c) After second one-Level route

Routed-Source’s channel A3 is routed to Destination’s Channel A2

Routed-Source’s channel A2 is routed to Destination’s Channel A3, and vice versa
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A default Dial Source-Level dialog appears. User focus is in the (upper, Source-name) 
text entry box. The dialog shows the currently-routed Source and Level.

Note: The default dialog already shows the currently-routed Source name and Level 
name, regardless of the single alpha-numeric character typed.

4 Dial-up a Source Level with the Dial Source-Level dialog, see Simple One-Level Route 
(Breakaway) and make a one-Level route to all selected Destination Levels.

Figure 5-82b shows an example with Figure 5-82c showing the resulting route made.

Fig. 5-82: One Level to Multiple Levels: 
a) Multiple Selected Destination Levels; b) Dialing Up the Source Level;
c) Routed Levels.

a) Multiple Selected Destination Levels

b) Dialing Up the Source Level

c) Routed Levels
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List View Routing Examples - Destination Copy-Paste
With Copy-Paste routing, the Source assignments of a Destination (i.e. the current routing 
to all the Levels of a Destination) can be copied to other Destinations. Alternatively, the 
routing to just one or more Destination Levels can be copy-pasted to other Destination 
Levels.

Several routing Copy-Paste examples are presented:
• Destination Copy-Paste.
• Destination Paste-Series.

Destination Copy-Paste
The routing to a Destination can be copied to one or more other Destinations. This operates 
on all levels and allows a routing to be quickly copied to other Destinations:

1 Select a Destination. (See Figure 5-83a.)
2 Copy the Destination by, either:

• CTRL-C; or
• right-click and select ‘Copy’; or 
• click on the ‘Copy’ icon in the List View tool bar.

The selected Destination (with its Levels) is outlined with a ‘crawling’ dashed line. (See 
Figure 5-83b.)

Fig. 5-83: Destination Copy-Paste: a) Selected Destination; b) Destination Copied.

3 Select a Destination to ‘copy to’. (See Figure 5-84.)

a) Selected Destination 

b) Destination Copied
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Fig. 5-84: ‘Copy’To’ Destination Selected

4 If required, 
further ‘copy-to’ Destinations can be added to the selection with CTRL-Select and/or 
SHIFT-Select.

When all ‘copy to’ Destinations are selected, to paste the ‘copied’ Destination’s routing to 
the selection:

5 Paste the ‘copied’ Destination’s routing to the selection by either:
• pressing CTRL-V; or
• right-click and select ‘Paste’; or
• click the ‘Paste’ icon in the List View tool bar.

The routes are made (all levels) and the original copied Destination’s routing is applied 
(pasted) onto all the selected Destination(s). (See Figure 5-85.)

Fig. 5-85: Routing Pasted onto a Destination

Destination Paste-Series
Destination Copy-Paste applies the copied Destination into all of the selected ‘Copy to’ 
Destinations. Alternatively, a series of sources can be applied to several selected ‘Copy to’ 
Destinations. The series starts from the ‘Copied’ Destination’s currently-routed Source and 
the Source increments.

The operation is similar to Destination Copy-Paste. To paste a series onto a selection of 
‘Copy to’ Destinations:

1 Select a Destination and copy it.
2 Select a first ‘Copy to’ Destination and select a range of these by SHIFT-Selecting the 

last ‘Copy to’ Destination.

This has selected the ‘Copy to’ range.
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At this point (with a Destination copied and several ‘Copy to’ destinations selected) a 
normal ‘paste’ would result in the copied routing being applied to all ‘Copy to’ Destinations. 
But, instead, to Paste Series:

3 Press Alt-CTRL-V, or click the Paste Series icon in the List View tool bar.

The currently-routed Source of the copied Destination is applied to the first ‘Copy to’ 
Destination in our ‘Copy to’ range. The next Source is applied to the next ‘Copy to’ 
Destination in the range, etc. See Figure 5-86 for an example.

Fig. 5-86: Result of Destination Paste-Series

Currently-routed 
Source of the 
copied Destination

Currently-routed 
Source applied to 
first ‘Copy to’ 
Destination.

Next Source 
applied to next 
Destination.

And so on.
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List View Routing Examples - Copy-Paste Levels
The routing to one or more selected Destination Levels can be copied and pasted onto 
other Destination Levels. This allows a user to set up levels quickly on one or more 
Destinations.

The copy-paste is a two-step process:
1 Copy - Destination Levels are selected and copied.
2 Paste - A paste ‘starting Level’ is selected and pasting is done from this ‘starting Level’. 

With more than one Destination Level copied, the pasting of routing onto ‘Copy to’ 
Destination Levels can be done in two ways:

• Paste Levels with CTRL-V - pastes with no gaps.
• Paste Levels with Alt-CTRL-R - pastes preserving gaps.

Both paste types are done in the Levels grid from the ‘starting Level’. 
When pasting to more than one ‘starting Level’, a warning is given if there are any pasting 
conflicts. See Levels Copy-Paste Footprint and Levels Paste Warning.

Paste Levels with CTRL-V
1 Select Destination Levels and copy them. For example, A3, A4, A6 and A8, see Figure 5-

87.

This has copied the routing of these selected Destination Levels.
2 Select one ‘Copy to’ Destination Level. This is the ‘starting Level’.

And click the Paste icon, or press CTRL-V, or select right-click ‘Paste’.

Routes are made to consecutive Destination Levels and the copied routing is applied to 
the ‘Copy to’ Destination Level and to subsequent, consecutive Destination Levels. 
See Figure 5-87 for the result of CTRL-V paste from the copied Destination Levels.

Fig. 5-87: Result of CTRL-V Paste

One selected ‘Copy to’ Level,
‘starting Level’

Selected Destination Levels

Routes made to consecutive Levels
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Paste Levels with Alt-CTRL-R
The CTRL-V pasting pastes into consecutive Destination Levels and ignores any gaps there 
might be in the original copied Levels. Whereas, pasting with Alt-CTRL-R retains the 
original copied Levels pattern, preserving any gaps in the original pattern. Pasting is still 
done from a ‘starting Level’.

To paste and preserve gaps:
1 Select Destination Levels and copy them. For example, A3, A4, A6 and A8, see Figure 5-

88.
2 Select one ‘Copy to’ Destination Level. This is the ‘starting Level’.

And press Alt-CTRL-R.

Routes are made and the routing of the copied Levels is applied to the ‘Copy to’ Destination 
Level (‘starting Level’) and to subsequent Levels with any gaps preserved. See Figure 5-88 
for the result of an ALT-CTRL-R paste from the two copied Destination Levels.

Fig. 5-88: Result of Alt-CTRL-V Paste

Levels Copy-Paste Footprint
The copied Levels pattern and the pasting type determine a pasting ‘footprint’ in the List 
View Levels grid. The pasting footprint pattern

• retains or ignores any gaps in the copied Levels pattern, depending on pasting type 
(CTRL-V or Alt-CTRL-R);

• is applied in the List View Levels grid and is based at each ‘starting Level’ in turn, 
starting with the first ‘starting Level’. 
(Note: It is possible to select more than one ‘starting Level’.) 

Figure 5-89 shows 2x1 copied Levels pasted with various ‘Copy to’ starting Levels. In 
Figure 5-89d, the pasting footprints overlap.

• Figure 5-89a - Single starting Level and a resulting 2x1 pasting.
• Figure 5-89b - One column of four starting Levels which result in four 2x1 pasting 

footprints.

One selected ‘Copy to’ Level, 
‘starting Level’

Selected Destination Levels

Routes made to Levels and the original copied pattern is retained, gaps are preserved.
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• Figure 5-89c - Two columns of four starting Levels which result in two columns of four 
2x1 pasting footprints, which do not overlap.

• Figure 5-89d - Two adjacent columns of four starting Levels which results in two 
columns of four 2x1 pasting footprints which do overlap. The overlap is warned with a 
pop-up Levels Paste message, see Levels Paste Warning.

Fig. 5-89: Example Level Pasting

Levels Paste Warning

For a Levels Copy-Paste operation which has more than one ‘starting Level’, if the 
operation will result in overlapping paste footprints (see Figure 5-89d), a Levels Paste 
warning pops up. See Figure 5-90. 

Fig. 5-90: Level Paste Warning

The user can choose to not paste, or to paste anyway, in which case the paste footprints are 
applied sequentially, starting with the first ‘starting Level’ in the selection. If there is 
overlap, then some of the Levels Copy-Paste routing may be overwritten. The later routing 
wins.

Copied Levels, a ‘2x1’ shape.

b) c) a) Single starting Level and 
resulting ‘2x1’ pasting.

d) 
Paste footprint overlaps
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List View Routing Summary

List View Routing Summary - All-Levels 
One Source to One Destinations One Source to Multiple Destinations 

To make: An ‘all-levels’ route to a destination: An ‘all-levels’ route to multiple destinations:

1 Select a single Destination. Select a Destination. 

2 - Select further with CTRL-Select and/or 
SHIFT-Select.)

3 Begin to type a Source name.

A Dial Source dialog appears. 

4 Proceed to ‘dial up’ a Source name.

5 Then either:
• select the typed-in Source by pressing Enter/Return;

and/or:
• select a Source from the Dial Source filtered source list. 

Result: An ‘all-levels’ route is made to the 
destination.

An ‘all-levels’ route is made to the 
destinations.
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List View Routing Summary - One-Level 
Simple One-Level (Breakaway) Simple One-level (Shuffle)

To route: One level from another source: One level from same destination.

1 Select a single Destination Level.

2 Type a single alpha-numeric character. 

A default Dial Source-Level dialog appears showing currently-
routed Source and Level.

3 Begin to enter a new Source name into the 
dialog’s upper text entry box.

Press the Tab key. 

User focus changes to the lower text entry 
box in the dialog, for Source Level entry.

4 Then in the dialog, either:
• select the required Source name; 

or
• finish entering the Source name 

and press Enter/Return.

Then in the dialog, either:
• begin to type in a (new) Source 

Level name and then select the 
required Source Level in the list; 

or 
• fully type in the (new) Source Level 

name (for example, ‘A2’) and press 
the Enter/Return key.

Result: A one-level, breakaway route has been 
made. (For a channel-swap, do 2x Simple 
One-level (Shuffle) ).

A one-level, shuffle route has been made.

One Level to Multiple Levels 
To route: One level to multiple destination levels:

1 Select a Destination Level.

2 And select further with CTRL-Select and/or SHIFT-Select. 

3 Type any single alpha-numeric character. 

A Dial Source-Level dialog appears showing currently-routed Source and Level.

4 Press the Tab key. 

User focus changes to the lower text entry box in the dialog. 

5 Then, either:
• begin to type in a (new) Source Level name and then select the required 

Source Level in the list; or 
• fully type in the (new) Source Level name (for example, ‘A2’) and press the 

Enter/Return key.

Result: A one-level route is made to all selected Destination Levels.
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List View Routing Summary - Destination Copy 
Destination Copy-Paste Destination Paste-Series

To: Copy a Destination’s Source-assignments to 
another Destination:

‘Copy-Paste’ a series of Destinations:

1 Select a single Destination. 

2 Either:
• type CTRL-C; or 
• right-click ‘Copy’; or 
• click on the ‘Copy’ icon in the List View tool bar.

The Destination’s routing (all levels) is 
‘copied’ and is outlined with a ‘crawling’ 
dashed line. 

The Destination is copied. 

3 Select a Destination to ‘copy to’. Select the first Destination in the range to 
‘copy to’.

4 (Optionally, select further ‘copy-to’ 
Destinations with CTRL-Select and/or 
SHIFT-Select.)

SHIFT-Select the last Destination in the 
range to ‘copy to’. 
This has selected the ‘Copy to’ range.

This has selected the ‘Copy to’ range.

5 Either:
• press CTRL-V; or 
• right-click ‘Paste’; or 
• click the ‘Paste’ icon in the List 

View tool bar. 

Then either:
• press Alt-CTRL-V; or
• click the Paste Series icon in the 

List View tool bar.

Result: The ‘copied’ routing (all levels) is pasted to 
the selected Destination(s).

The currently-routed Source of the copied 
Destination is applied to the first 
Destination in our ‘Copy to’ range. The next 
Source is applied to the next Destination in 
the ‘Copy to’ range, etc. 
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List View Routing Summary - Paste Levels
Paste Levels with CTRL-V Paste Levels with Alt-CTRL-R

To: Copy multiple Destination Levels’ routing 
and to consecutive Destination Levels with 
no gaps

Copy multiple Destination Levels’ routing 
and to Destination Levels.with gaps.

1 Select a Destination Level. 

2 Select further with CTRL-Select and/or SHIFT-Select.

3 Then either:
• press CTRL-C; or 
• right-click ‘Copy’; or 
• click on the ‘Copy’ icon in the List View tool bar. 

The routing of the Destination Levels is copied along with the 
pattern of levels. 

4 Select one ‘Copy to’ Destination Level (the ‘starting level’). 

5 And then either:
• click the Paste icon; or
• press CTRL-V; or 
• select right-click ‘Paste’.

And press Alt-CTRL-R

Result: The copied routing is applied to the ‘Copy 
to’ Destination Level (‘starting level’) and 
to subsequent, consecutive Destination 
Levels. Any gaps in the copied pattern are 
not preserved.

The copied routing is applied to the ‘Copy 
to’ Destination Level (‘starting Level’) and 
to subsequent Levels with any pattern gaps 
preserved. 
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GV Orbit Custom User Panels

Can a Bulk Routing Panel be Opened from a Custom User Panel?
The Bulk Routing Panel may be opened from a GV Orbit custom user panel (created as part 
of a GV Orbit control and monitoring, C&M, project). 

When the custom user panel is designed, a ‘Load Panel’ GV Orbit Routing Behaviour is used 
to invoke the Bulk Routing Panel when the custom user panel is run.

Typically, this GV Orbit ‘Behaviour’ would be invoked upon the press of a button on an GV 
Orbit C&M project custom user panel.

See:
• Amend an Existing GV Orbit C&M Project
• Exercise the C&M Custom Screen

Amend an Existing GV Orbit C&M Project
To prepare a GV Orbit C&M project to be able to open a Bulk Routing Panel:

1 Open/create a GV Orbit C&M project.
2 In the main menu, click on Control and Monitoring > Connections > GVOP and set 

the Client Domain to a domain with an GV Orbit Routing Service running.
3 Create a New Screen. 

(I.e. in the Project window: expand the project item, right-click on ‘screens’, and select 
‘New Screen’, enter a name, and click OK.)

A new blank C&M project screen opens as a tabbed screen.
4 In the new C&M project screen, add a Button widget. 

(I.e. drag on a Button widget from the widget icons along the bottom edge of the GV 
Orbit Client application window.)

5 Edit the Button widget’s Caption property. See Figure 5-91.



259

GV Orbit Routing Panel
User Guide

Fig. 5-91: C&M Project Screen with Button Widget

6 Select the Button widget on screen.
7 Click on the Edit Behaviours button. 

The ‘Behaviour and Bindings’ graphical editor is shown. See Figure 5-92.

In the ‘Behaviour and Binding’ graphical editor:
8 Select to show ‘Routing’ Behaviours and click on the ‘Load Panel’ item. 

A Load Panel Behaviour and a configured Click Handler Binding is automatically 
placed into the graphical editor. 
See Figure 5-92.

Project item expanded in Project window Edit Behaviours button

Button widget icon Set Button widget’s Caption property

Button widget on screen
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Fig. 5-92: Behaviour and Bindings Graphical Editor

9 Double-click on the added Load Panel Behaviour.

The Behaviour’s configuration screen is shown in the graphical editor.

In the Network window:
10 Expand and locate the Routing service of the GV Orbit server being used. 
11 Right-click on the Routing service item and select ‘Copy > Address’.

This copies the RollCall address of the Routing service.

In the graphical editor:
12 Paste the copied address into the ‘Address’ property of the Load Panel configuration.

See Figure 5-93.

Select ‘Routing’

Select ‘Open Panel’ item (single-click) to add a Load Panel Behaviour.

‘Behaviour and Binding graphical editor’
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Fig. 5-93: Setting Load Panel Behaviour’s RollCall Address

13 Click Close in the configuration screen.

To save this project change:
14 Click Project > Save File in the main menu
15 Click Project > Save Project.

This has designed (a simple) C&M custom screen which contains a button which will open 
the Bulk Routing Panel.

Right-click on a ‘Routing Service’ item in the Network window.

Select ‘Copy > Address’.

Paste the address into the ‘Address’ property of the Load Panel configuration screen.

Click Close in the Load Panel configuration screen.
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Exercise the C&M Custom Screen
With the designed C&M custom screen open in GV Orbit Client:

1 Click the Design/Run Mode button in the main tool bar of the GV Orbit Client 
application window. See Figure 5-96a.

Fig. 5-94: Design/Run Mode Icon (in Main Tool Bar)

The GV Orbit Client enters Run mode and the custom screen is run. See Figure 5-96b.

Fig. 5-95: Running the Custom Screen

Click to enter Run mode.

Click to enter Design mode.

Design/Run Mode icon indicates GV Orbit is in Design mode.

a) Click to Enter Run Mode

b) Screen is running.

Click on the Button widget to open the Bulk Routing Panel.

Design/Run Mode icon indicates GV Orbit is in Run mode.
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2 Click on the Button widget to open a new tab containing an Bulk Routing Panel. See 
Figure 5-96.

Fig. 5-96: Bulk Routing Panel Opened in a Tab

Tab running C&M Custom Panel Tab running the opened Bulk Routing Panel
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Introduction
GV Orbit Client has user router control functionality and offers the following routing control 
panels:

• Routing Control - Bulk Routing Panel - a simple, non-editable soft panel for fast control 
of all router cross-points. 

• Routing Control - XY Routing Panel (this chapter) - an editable and customizable soft 
panel, typically used for small custom panels for specific routing needs.

This chapter describes the XY Routing Panel.

GV Orbit System
Routing control panels connect to a GV Orbit Routing service running on a GV Orbit server.

Fig. 6-1: GV Orbit Routing Panel, Routing Service and Router Controller

A GV Orbit system has one or more GV Orbit servers which run GV Orbit services. Routing 
panels in a GV Orbit Client connect to a router controller device via the GV Orbit Routing 
service. Router controllers include GV Orbit itself, a Grass Valley Router Controller device, or 
GV Convergent. The Routing service provides source/destination information to the client 
and acts on routing commands from the client. See Figure 6-2.

GV Orbit Client

GVOP protocol

Controller-specific connection protocol: 
• SW-P-08; or
• NP-0017

GV Orbit server

GV Orbit Routing Panel
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Fig. 6-2: GV Orbit System Diagram 

Prerequisites
A GV Orbit server is required, running:

• A GV Orbit Control application.
• A GV Orbit Routing service configured for connection to a Router Controller using 

either NP0017 or SW-P-08 protocol.
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What is an XY Routing Panel?
An XY Routing Panel runs in the GV Orbit Client application. It is editable and customizable 
and is typically used for small, purpose-built routing panels for specific routing needs. It can 
be part of a custom soft user/operator panel in GV Orbit Client. 

It can be created with a wizard and tailored to most needs. It is a flexible soft routing control 
panel which may be:

• Created with a wizard and used.
• Created and then edited for customized use.
• Created from scratch with the GV Orbit Client, in a similar way to a GV Orbit Client C&M 

project user/operator soft control panel.

XY panels can also be embedded in GV Orbit soft custom operator/user panels. 

Fig. 6-3: XY Routing Panel Examples

a) Example XY Routing Panel from the Wizard

b) Example Customized XY Routing Panel c) Example with Customized Layout
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Key Features

This Chapter
This chapter describes:

• How to Create a New XY Panel, on page 271.
• Customizing with the XY Wizard, on page 274.
• XY Panel Layout, on page 280.
• Getting XY Routing Panel Running, on page 288.
• XY Panel Operation, on page 292.
• Assigning Ports to a Port-per-Button XY Panel, on page 301, including:

• Assigning Port-per-Button, on page 301.
• Assign Ports to Individual Buttons, on page 301.
• Quick Port-per-Button Assignment, on page 305.

• Customizing an XY Panel, on page 309, including:
• Further Editing an XY Panel, on page 309.
• Creating a Custom XY Panel from Scratch, on page 310.
• Creating a Custom BPX Panel, on page 318.
• Enhancing the Appearance of a Panel, on page 324.

• How to Embed an XY Panel into a Custom User Panel, on page 330.

• X/Y panel wizard.
• Source and Destination filtering.
• Take, Auto-take, Cancel.
• Shuffles and Breakaways.
• Panel Lock.

• Customizable, editable.
• Source and Destination selection:

• paged access to all ports; or
• definable port-per-button.
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How to Create a New XY Panel
One or more XY Routing Panels can be created in a GV Orbit C&M project.

XY Routing Panels are created in GV Orbit Client Client and stored in a ‘panels’ folder in the 
Project window. (If your project does not contain a ‘panels’ folder, see Creating a ‘panels’ 
Folder for Early GV Orbit Client Projects for instructions on creating one.)

For instructions on creating a new XY Panel, see Create a New XY Routing Panel.

Creating a ‘panels’ Folder for Early GV Orbit Client Projects
Some early GV Orbit C&M projects do not contain a ‘panels’ folder in the Project window. If 
this is the case, then one may be created. See below.

If your project does have a ‘panels’ folder in the Project window, go on to Create a New XY 
Routing Panel.

To create a missing ‘panels’ folder:
1 Open a C&M project in the GV Orbit Client application.
2 Right-click on the project name item in the Project window and select ‘New Folder’.

Fig. 6-4: Creating a New ‘panels’ Folder’

3 Enter ‘panels’ as the folder name, and click OK.

A new folder called ‘panels’ is added into the Project window.

Fig. 6-5: New ‘panels’ Folder’

4 Click Save File. Click Save Project.

This has created a default new ‘panels’ folder in the project. 
Now go on to Create a New XY Routing Panel.

Note: A project folder named ‘panels’:
• allows only files of type ‘panel’;
• displays a ‘New Panel’ right-click menu item.

The folder name is case-sensitive.
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Create a New XY Routing Panel
To create an XY panel in a C&M project in the GV Orbit Client application:

1 Expand the project name in the Project window and look for the ‘panels’ sub-folder. 
2 Right-click on the ‘panels’ folder and select ‘New Panel’. See Figure 6-6. 

The New X/Y Panel dialog is shown.

Fig. 6-6: Create a New XY Routing Panel

3 Enter a name for the new XY Panel in the New X/Y Panel dialog. 
4 And click OK.

A new panel item is then added into the ‘panels’ folder and a new generic XY Panel is 
shown in a tab.
Figure 6-7 shows an example with GV Orbit shown in ‘Design Mode’ (not ‘Run Mode’).

5 Click Save File. Click Save Project.

This has created a default new, generic XY Panel (see example in Figure 6-7) which is 
editable and customizable, see Customizing with the XY Wizard, on page 274. Various 
button types can be shown/hidden on the panel with the wizard.

Right-click and select ‘New Panel’.Project window
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Fig. 6-7: Example New Generic XY Routing Panel

GV Orbit Client Client shown in ‘Design 
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Customizing with the XY Wizard
A default new, generic XY Panel can be created (see How to Create a New XY Panel, on 
page 271) which is editable and customizable. When an XY Panel is open in GV Orbit Client, 
the panel is editable with the client in ‘Design Mode’ (rather than in ‘Run’ mode). 

Customizing may be done with the XY Wizard and editable items include the:
• panel size;
• number of and arrangement of Sources/Destinations; and 
• enabling/disabling of other controls.

Use the XY Wizard on new, generic XY Panels.

To Open the XY Wizard
To open the XY Wizard for an XY Panel:

1 Open the XY Panel and go to ‘Design’ mode in GV Orbit Client Client.
2 Click XY Wizard button. See Figure 6-8. 

Fig. 6-8: XY Wizard Button

The XY Wizard dialog is displayed for editing the XY panel. For a new XY Panel, it is 
generic XY panel settings that are shown selected. See Figure 6-9.

Click XY Wizard to open the XY Wizard dialog.

XY Panel open in GV Orbit Client

‘Design’ mode indicated
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Fig. 6-9: XY Wizard Dialog (a) and Panel (b, New, Generic Panel Settings Shown)

Fig. 6-10: XY Wizard Dialog and Panel (Deselected Settings Shown for a GV Orbit Client System)

a) Settings of a new, generic XY Panel

b) Corresponding XY Panel

Note:
Some settings are not currently applicable to a GV Orbit Client system, these 
include:

Undo, Re-do, Protect  and Dial.

Recommendation: 
Deselect these settings for GV Orbit Client systems. See Figure 6-10.

a) Deselected Settings for GV Orbit Client b) Corresponding XY Panel

= Deselected for GV Orbit Client system 
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3 Deselect the wizard options that are not applicable to GV Orbit Client. See Figure 6-10a.

The panel appearance changes in response to the settings changes as they are made. 
See Figure 6-10b.

For the remaining settings, these may be selected/deselected and configured as required:
4 Change the XY panel setting as required. 

(See XY Wizard Settings and Table 6-1 for descriptions of each XY Wizard setting.)

The panel appearance changes in response to the settings changes as they are made.
5 Close the XY Wizard dialog when finished changing settings. 

(This dialog can always be re-opened if required.)
6 Click Save File. Click Save Project.

The modified XY Panel has been saved. 

XY Wizard Settings

 Table 6-1: XY Wizard Dialog Settings 
Item For GV 

Orbit 
Client

Description

Panel Size: Sets the overall size of the XY Panel (in pixels).

Normally, set this to be the size of the monitor used to display the 
panel.

Width  Text box.
Enter the panel screen width (pixels). Default = 1920.

Height  Text box.
Enter the panel screen height (lines). Default = 1080.

Layout  Select the left-right/top-bottom layout arrangement of the 
Source/Source-level and Destination/Destination-level grids:

Sources

Destinations

Source Levels

Destination Levels

For selection buttons on the XY panel:

 Text box.
Select the number of items to control. (Sources, Destinations, etc.)

Columns  Text box.
Select the number of columns used to display items.

Auto  Check box.
• Select to automatically arrange the items in columns.
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Control: Enable various ‘Routing Control’ controls.

Note: Some items do not apply to GV Orbit Client systems and 
should be deselected.

Enable Take  Check box.
• Select to enable a Take button.

Enable Undo  This does not apply to GV Orbit Client systems.

Check box. 
• Select to enable an Undo button.
• Deselect for GV Orbit Client systems.

Enable Protect  This does not apply to GV Orbit Client systems.

Check box. 
• Select to enable a Protect button.
• Deselect for GV Orbit Client systems.

Enable Redo  This does not apply to GV Orbit Client systems.

Check box. 
• Select to enable a Redo button.
• Deselect for GV Orbit Client systems.

Enable Panel Lock  Check box.
• Select to enable a Panel Lock button.

Enable Cancel  Check box.
• Select to enable a Cancel button.

Display:

Port Numbers  Check box.
• Select to show router port numbers on Source/Destination 

selection buttons.

 Table 6-1: XY Wizard Dialog Settings  (continued)
Item For GV 

Orbit 
Client

Description
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Paging: The Source selection and Destination selection button-grids can 
be independently configured for either:

• paging through all of the respective router sources/destination 
ports; or for 

• accessing a specific router source/destination port per button.

Page Sources  Check box.

Control Source button-grid configuration:
• Select for ‘Paged’:

Paged Source port selection. Button-grid gives paged access to 
all router Sources, indexed. 
See Paged Ports, on page 282.

• Deselect for ‘Port-per-Button’:

A ‘fixed’ specific Source port is assignable per button. Each 
button accesses a specific Source port, non-indexed. 
See Port-per-Button, on page 282.

Page Destinations  Check box.

Control Destination button-grid configuration:
• Select for ‘Paged’:

Paged Destination port selection. Button-grid gives paged 
access to all router Destinations, indexed. 
See Paged Ports, on page 282.

• Deselect for ‘Port-per-Button’:

A ‘fixed, specific Destination port is assignable per button. 
Each button accesses a specific Destination port, non-indexed. 
See Port-per-Button, on page 282.

Filtering:

Filter Sources  Check box.
• Select to show Sources filter control.

Filter Destinations  Check box.
• Select to show Destinations filter control.

Dialing: For dial-up selection of a Source or a Destination via its router port 
number. 
Note: Dialing does not apply to GV Orbit Client systems and these 
controls should be deselected.

 Table 6-1: XY Wizard Dialog Settings  (continued)
Item For GV 

Orbit 
Client

Description
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Dial Sources   This does not apply to GV Orbit Client systems.

Check box.
• Select to show Sources dial-up controls.
• Deselect for GV Orbit Client systems.

Dial Destinations   This does not apply to GV Orbit Client systems.

Check box.
• Select to show Destinations dial-up controls.
• Deselect for GV Orbit Client systems.

Invert Keypads   This does not apply to GV Orbit Client systems.

Check box.
• Select to show Dial-up numeric keypads with 7,8,9 on top 

row.
• Deselect to show 1,2,3 on top row.

 Table 6-1: XY Wizard Dialog Settings  (continued)
Item For GV 

Orbit 
Client

Description



280

Routing Control - XY Routing Panel
XY Panel Layout

XY Panel Layout
The layout and controls of a newly-created XY Panel are shown in Figure 6-11. 

Fig. 6-11: Example New XY Panel Layout

An XY Routing Panel is designed in and run from the Client application. Figure 6-11 shows a 
view of the XY Panel in ‘Design Mode’ and Figure 6-12 shows an annotated view in ‘Run’ 
mode.

The panel is laid out with the following main grids/areas (see Figure 6-12): 
• Source Grid – Sources are presented here, configurable in the XY Wizard to be a:

• Paged list of all available sources.
• Sub-set of defined sources.

• Source Levels Grid – List of available levels for selected source(s).
• Destination Grid – Destinations are presented here, configurable in the XY Wizard to 

be a:
• Paged list of all available destinations.
• Sub-set of defined destinations.

• Destination Levels Grid – List of available levels for selected destination(s).
• Routing Controls – Buttons are configured as shown/hidden in the XY Wizard, and 

include: ‘Undo’, ‘Redo’, ‘Protect’, ‘Take’, ‘Panel Lock’ and ‘Cancel’.
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Fig. 6-12: New XY Panel Layout and Controls (Annotated, ‘Run’ Mode)

Button face legend:

(1) Destination selected.

(2) Currently-routed Source shown.

(3) New Source pre-selected.

(4) Click Take to make route.

Buttons show names and router port numbers.,see Figure 6-15.

Source Grid

Routing 
Controls

Destination Grid

Source Levels Grid Destination Levels Grid

Source grid paging control Destination grid paging controlSources filter box Destinations filter box

Click to toggle 
Source Port Dial Grid 
on/off.

Shown when a Destination is selected

(3) 

(1) 

(4) 

Click to toggle 
Destination Port 
Dial Grid on/off.

Shown when a Source is selected

(2) 

Note: Dial Grids are not applicable to GV Orbit 
Client systems.

Note: The following controls on a newly-created XY Panel are not applicable 
to GV Orbit Client systems:

• Undo, Re-do, and Protect buttons; and
• Source and Destination Dial Grids.
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Source and Destination Selection Button-Grids
The Source and Destination button-grids can be independently configured with the XY 
Wizard Settings for either:

• Paged Ports operation; or for 
• Port-per-Button operation.

When an XY Panel is running, buttons are annotated to reflect the source/destination 
names, see Source/Destination Button Annotations. 

Paged Ports
A Source or Destination button-grid can be configured for paging through all of the 
respective router sources/destination ports. (Configuration is done in the XY Wizard 
Settings.)

Figure 6-13 shows a running example XY Panel with 12-button button-grids configured for 
‘paged ports’ operation. Each paged button grid has paging controls to access all router 
ports (source or destinations accordingly). Page 1 starts at port 1 and shows consecutive 
ports on the button grid buttons. 

Fig. 6-13: Example Paged Ports Button Grid

Port-per-Button
A Source or Destination button-grid can be configured for accessing a ‘fixed’, specific router 
source/destination port per button. (Configuration is done in the XY Wizard Settings, on 
page 276.)

Figure 6-14 shows an example XY Panel with 12-button button-grids configured for ‘port 
per button’ operation. There is no paging here.

The example XY Panel is shown both in ‘Design’ mode and in ‘Run’ mode. This example has 
an initial, default assignment (from the XY Wizard) of ports-to-buttons, where buttons in 
each grid access ports starting from 1 onwards. 

Each button can be further configured to access a specific port, as required. See Assigning 
Port-per-Button, on page 301.

Paging controls
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Fig. 6-14: Example Port-per-Button

a) Wizard settings used in the example here

b) Example XY Panel, Port-per-Button, ‘Design’ mode

c) Example XY Panel, Port-per-Button, ‘Run’ mode

Buttons show router port names etc. when panel is running.

By default, buttons are assigned ports starting from 1 onwards.
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Source/Destination Button Annotations
The source/destination selection and source/destination level selection buttons in ‘Run’ 
mode are annotated to reflect the source/destination name or level name etc. when the 
panel is running. 

Additionally, when making a route, the selected destination button shows the currently-
routed source and the current (pre-)selected source for that destination. 

Buttons can be configured to show router port numbers and port names, see XY Wizard 
Settings, on page 276. 

Figure 6-15 shows button-face annotations.

Fig. 6-15: XY Panel Buttons on a Running XY Panel

Routing Control Buttons

Depending on the settings in the XY Wizard, the Routing Control section of the panel 
contains:

• Take button.

Click to make a route to the selected Destination from a pre-selected Source.
• Cancel button.

Click to deselect all Destinations and Sources.
• Lock button.

Click to lock the XY panel controls. Click again to unlock.

Destination Name name

Pre-selected Source name

Currently-Routed Source name

Destination Button:

Destination Level Button:

Destination Level name

Pre-selected Source Level name

Currently-Routed Source Level name

Source Button:

Source Level Button:

Port number

Source name

Level name

Port number

Note: Undo, Redo, Protect functions are not currently available in an XY 
Panel for GV Orbit systems. (Use the Bulk Routing Panel for these functions.)
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XY Routing Panel- Operational Keys

XY Panel Level Selection
When a source or a destination is selected, the associated levels are shown in the 
corresponding ‘Levels Grid’ panel. If multiple sources or destinations are selected, then only 
their common levels are shown. 

All levels are selected by default. If the user selects one or more levels, then all other levels 
are deselected. 

XY Panel Right-Click Menus
Right-click on background of a XY Routing Panel to show a drop-down context menu. See 
Figure 6-16.

 Table 6-2: XY Panel Operational Keys
Operation Mouse

Select Mouse click on a Source or Destination.

Select a Range Mouse click on first item then
SHIFT click on last item.

Add to/remove from a multiple selection CTRL + Mouse click

Paste Series Click ‘Paste Series’ icon in panel.

Take Double-click on pre-selected Source; 

or click Take button.

Cancel Click ‘Cancel’ button.
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Fig. 6-16: XY Panel Background Right-Click Menu: a) in ‘Run’ Mode; b) in ‘Design’ Mode.

a) In ‘Run’ mode’ b) In ‘Design’ mode

 Table 6-3: XY Panel Right-Click Menu Items 
Item Shown in Description

‘Run’ 
Mode

‘Design’ 
Mode

Dock/Undock 
Window

  Undock or dock the XY Routing Panel window from the GV Orbit 
Client window.

Full Screen   Show the XY Routing Panel window full-screen.

When full-screen, right-click > Exit Full Screen.

Exit Run Mode  Click to exit ‘Run’ mode and enter GV Orbit ‘Design’ mode.

Enter Run Mode  Click to enter GV Orbit ‘Run’ mode.

Scale to Fit   Click to fit the panel to the window.

Select All  Selects all items. 

Deselect All  Deselects all items. 
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Lock/unlock   Click to toggle locking/unlocking the panel. 
When the panel is locked, user operation is disabled.

Note: Clicking the ‘Lock’ icon in the GV Orbit Client main tool 
bar also toggles panel lock.

Resize to Widgets  Click to resize the XY panel background to fit to its constituent 
widgets. 

Reset Panel Styles 
to Default

 Click to set widget styles all to ‘default’.

Variables...   Click to show the Variables dialog.

Note: The Variables dialog is not editable in ‘Run Mode’.

Connection Mode  Note: This item is a generic widget feature, not routing-specific.

Widget feature: 

When designing C&M project screens or XY Panels, the graphical 
widgets used may be shown to be visually connected together 
by a curved line. 
Click Connection Mode to show connection points on the 
widgets.

Edit Behaviours  Click to toggle showing the Behaviours and Bindings graphical 
editor.

 Table 6-3: XY Panel Right-Click Menu Items  (continued)
Item Shown in Description

‘Run’ 
Mode

‘Design’ 
Mode
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Getting XY Routing Panel Running
When an XY Panel runs on the GV Orbit Client Client in a C&M project, it controls signal 
routing via the Routing service running on a GV Orbit Client server.

What is a Routing Service?
As part of setting up a GV Orbit Client system, a Routing service must be configured with a 
RollCall address and a GVOP domain, and started up to run on a GV Orbit Client server. The 
Routing service uses its RollCall address and is visible in the Network window of a GV Orbit 
Client and see Figure 6-17. 

Fig. 6-17: Routing Service in Network Window

Right-click and select ‘Info’ to see details of the Routing service item

Routing service RollCall address’.
To copy this address, right-click in Network window and select ‘Copy > Address’.

Note: The GVOP domain of the GV Orbit C&M project and 
the GVOP domain of the Routing service must be the same.

http://127.0.0.1: 8080/routingnode/
http://127.0.0.1: 8080/routingnode/
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How to Connect an XY Panel to a Routing Service

Automatic Setup
To run in GV Orbit Client Client, an XY Panel must point at a Routing service on a GV Orbit 
Client server. This is usually automatically set up for the user, including:

• GV Orbit Client C&M project GVOP domain the same as the Routing service. This should 
be set automatically.

(To see the project’s GVOP domain number, go to the main menu item 
‘Connections > GV Orbit Server’, and look at the ‘Client domain’ setting. 
Edit the domain number here if required.)

• XY Panel set with a RollCall address of the Routing service. This should be set 
automatically.
To do this, the XY Panel’s ‘Address’ variable must be set to be the RollCall address of the 
target Routing service.

Manual Setup
To manually set up the XY Panel to point at a Routing service:

1 In the Network window, right-click on the Routing service item, and
select ‘Copy > Address’. 

This copies the RollCall address of the service into your copy buffer.
2 Go to the XY Panel and right-click on the XY Panel background and select ‘Variables...’. 

The Variables dialog is shown. See Figure 6-18.

Fig. 6-18: Setting Routing Service RollCall Address for XY Panel

Paste copied address into ‘Address’ value field
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3 In the Variables dialog, 
paste in the copied RollCall address into the value of the ‘Address’ variable. 
See Figure 6-18. (Alternatively, simply enter the address manually.)

4 Click OK.
5 Click Save File. Click Save Project.

This has manually pointed an XY Panel at a Routing service.

To Run an XY Panel
When an XY Panel runs, it connects to the Routing service and collects routing information 
and data (Source names/port numbers, Destination names/port numbers, routed source 
names etc.) and populates the panel buttons with names and router port numbers etc.

To run an XY panel:
1 Open the panel in GV Orbit Client and click on the ‘Run’ mode/’Design’ mode main tool 

bar icon to enter ‘Run’ mode. See Figure 6-20.

Fig. 6-19: Enter Run Mode

The XY Panel run and connects to the Routing service and gets source and Destination 
names etc. See Figure 6-20.

Click to enter ‘Run’ mode (from ‘Design’ mode)’ Buttons show actual source and 
destinations name s etc.

a) XY Panel in ‘Design’ mode b) XY Panel in ‘Run’ mode
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Fig. 6-20: Running XY Panel Example

(1) Destination selected.

(2) Current Source shown.

(3) New Source pre-selected.

(4) Click Take to make route.

(1) 

(2) 

(3) 

Note: Routing Control buttons can be shown/hidden with the XY Wizard tool.
(See Customizing with the XY Wizard, on page 274.)

(4) 
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XY Panel Operation 

Make a Simple Route with an XY Routing Panel

Simple Route
To make a simple route:

1 Select a Destination.

The currently-routed Source is shown.
2 Select a Source.

The pre-selected Source is shown.
3 Click Take. (Click Cancel, to deselect the source/destination.)

The selected source is routed to the selected destination. The route is made.

Alternatively, select the Source first.

Fig. 6-21: Making a Simple Route

1) Select Destination

Currently-routed Source is shown.

2) Select Source

3) Take

1) 1)

2)

3)



293

GV Orbit Routing Panel
User Guide

Route One Source to Multiple Destinations
1 Select a Destination by clicking on the destination selection button.
2 Select a second Destination by CTRL + clicking on a destination button.
3 Select further destinations with CTRL + click.
4 Select one Source.
5 Click Take.

The source is routed to all selected destinations.

Fig. 6-22: One Source Routed to Multiple Destinations

Alternatively, the source may be selected first.

Note: A contiguous range of Destinations (or Sources) can be selected 
by clicking the first Destination (or Source) in the range and then SHIFT-
click on the last Destination (or Source) in the range.

Selected Destinations

Currently-routed Sources shown

Pre-selected Source

Routed result
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Route Multiple Sources to Multiple Destinations
1 Select a Destination by clicking on the destination selection button.
2 Select a second Destination by CTRL + clicking on a destination button.

And select any further destinations with CTRL + click.
3 Select a Source by clicking on the source selection button.
4 Select a second Source by CTRL + clicking on a source button.

And select any further sources with CTRL + click.

5 Click Take.

The source is routed to all selected destinations.

Fig. 6-23: Making Multiple Routes

Alternatively, the Sources may be selected first.

Note: Select the same number of sources as there are selected destinations.

Selected Destinations

Currently-routed Sources are shown

Pre-selected Sources

Routed result
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Note: Source or Destination CTRL-selection Order: 

When routing many sources to many destinations and making 
selections with CTRL-clicks, then the order of selection is 
significant and affects the order in which the routing is done. 
For example, to route sources 1 to 8 to destinations 8 to 1:

• Select Destinations 1 to 8 by ‘CTRL-clicking’ on each button 
in the order 1 to 8.

• Select Sources 8 to 1by ‘CTRL-clicking’ on each button in 
the order 8 to 1.

• Click Take.

Note: With the contiguous SHIFT-selection, the order used is that 
of the buttons on the panel, not the order of selection of buttons. 
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Breakaway

What is a Breakaway?
See What is a Breakaway?, on page 209, for an explanation of a breakaway.

Perform a Breakaway 
To perform a breakaway (see Figure 6-24):

1 Select a Destination.
2 Select one or more Destination Levels to route (for example, audio channels A1 and 

A2).
3 Select a new Source. (Pre-selected source)
4 Click Take.

A routing is made: The selected Destination Levels have corresponding levels from 
the preselected Source routed to them. See Figure 6-24b. 
The Destination button shows a ‘Breakaway’ symbol.

Note: Implied Breakaway:
A ‘breakaway’ occurs when not all of a destination’s levels are selected for 
routing. This can happen if a source with fewer levels than the selected 
destination is routed, this will result in a ‘breakaway’ (without explicitly 
selecting destination levels when routing). 

Note:
Performing a ‘normal’ route to a Destination which already has a ‘Breakaway’ 
will over-ride the breakaway on the Destination, resulting in no ‘Breakaway’.
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Fig. 6-24: Breakaway Example: a) Before TAKE; b) After TAKE.

As an alternative, to perform a breakaway, the source may be selected first.

a) Before TAKE

b) After TAKE 

Selected Destination

Selected Destination Level(s)
Currently-routed Source shown

Audio channels shown routed from another Source

Breakaway symbol shown on button

Take

Pre-selected Source
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Shuffle

What is a Shuffle?
See What is a Shuffle?, on page 214, for an explanation of a shuffle.

Example Shuffle 
This example swaps two audio channels pairs.

Fig. 6-25: Swap Two Audio Channel Pairs

1 Select a Destination.
2 Select one or more Destination Levels. (For example, click on audio channels A5, A6, 

A7 and A8. See Figure 6-26.)
3 Select the currently-routed Source. 
4 Select the Source Levels in the order in which they shall apply to the destination 

Levels.
(For example, audio channels A7, A8, A5 and A6 in that order.)

5 Click Take.

The selected source levels are routed to the selected destination levels and a shuffle is 
formed. Figure 6-26 shows a shuffle example, swapping the order of two audio channel 
pairs, as per Figure 6-25.

Note: A shuffle is applied to a destination and stays with that destination 
when other routes are made to it until the shuffle is explicitly undone.

Note: Selecting just one level will route this to all selected destination 
levels.
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Fig. 6-26: Shuffle Example: a) Before TAKE. b) After TAKE.

a) Before TAKE

b) After TAKE

Selected DestinationSelect the currently-routed Source
Select Source Levels A7, A8, A5 and A6 in that order.

‘Shuffle’ symbol shown on button

Selected Destination Level(s) A5 to A8

Take

Audio channels shown shuffled
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Routing to a Shuffled Destination
When routing to a shuffled Destination, the ‘Shuffle’ persists. 

For example, when a routing Source ‘Cam S10’ to the already-shuffled destination ‘Mon1’, 
created in Example Shuffle, the Source is routed and the audio stereo pair swapping of 
Figure 6-25 still exists (but with the new source).

A ‘Shuffle’ persists on a Destination until it is explicitly undone with a new routing 
operation.

Undo Shuffle
This example describes a new routing operation to undo the shuffle of the Example Shuffle, 
on page 298.

1 Click Cancel to cancel any selections already made.
2 Select the ‘already-shuffled’ Destination.
3 Select the shuffled Destination Levels.
4 Select the currently-routed Source. 
5 Select the Source Levels in the order in which they shall apply to the Destination 

Levels.
So, to undo our Example Shuffle, on page 298, 
select audio channels A5, A6, A7 and A8 in that order.

6 Click Take.

The selected Source Levels are routed to the selected Destination Levels, undoing 
the shuffle. The ‘shuffle’ symbol no longer appears on the Destination button. 
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Assigning Ports to a Port-per-Button XY Panel
When creating an XY Panel, a Source button-grid or Destination button-grid can be defined 
for accessing a ‘fixed’, specific router source/destination port per button. (This ‘fixed’ 
definition is done in the XY Wizard Settings.) 

Following definition with the XY Wizard, each button of a ‘port-per-button’ button-grid 
then can be configured to access a specific port. This port assignment is described here.

Assigning Port-per-Button
Following creation from the XY Wizard, buttons in a ‘Port-per-Button’ button-grid can be 
assigned specific ports on a per button basis, as required. 

There are two ways to perform the port assignments to the buttons:
1 Assign Ports to Individual Buttons, on page 301. This describes individual assignment 

of ports to buttons.
2 Quick Port-per-Button Assignment, on page 305. This describes selecting all ports with 

the Bulk Routing panel and copy-pasting this into the XY Panel.

Assign Ports to Individual Buttons
Assigning individual buttons done in the XY Panel in ‘Design’ mode.

The example of Figure 6-14 shall be used to show how to assign a port to a button:
1 In ‘Design‘ mode, select the Source button-grid and ‘Alt-select’ its first button. 

The first button is selected. See Figure 6-27a.
2 Click on the Edit Behaviours button in the Properties box. See Figure 6-27a.

The graphical Behaviours and Bindings editor is opened. See Figure 6-27b.
The editor shows the Behaviours and Bindings linked to the selected button widget.
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Fig. 6-27: Open Behaviour and Bindings Editor

3 Double-click on the Behaviour linked to the selected widget.

The properties of the Behaviour are shown. See Figure 6-28a.
4 Select the value of the ‘Source’ property (see Figure 6-28a) 

and enter a router port to use:
• enter a port name and/or port number; or
• click on the  icon and select a Source name from the filterable list; or
• enter a GV Orbit Client variable. (For example, {My_Source_Port} )

A new ‘Source’ property value has been entered.

a) First Source button selected, click Edit Behaviours

b) Graphical Behaviours and Bindings Editor

Edit Behaviours buttonSource button selected

Behaviour

Binding

Selected Widget
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Note: The entered router port may be:

• a port number;
• a port name; or
• a ‘Number:Name’, e.g. 12:Cam1; or
• a GV Orbit Client variable.

In the case of a port name, the name is looked up automatically to find 
the port number to assign.

In the case of ‘Number :Name’, then the port number is used to assign 
with.

In the case of a user variable, this should be defined as a port number.

Note: To select a router port from a filterable list:

• Click on the  icon at the far end of the Source/Destination 
property value field (see Figure 6-28 a).

The Source/Destination Picker dialog is shown and displays a 
list of Sources/Destinations. See Figure 6-28b.

• The list is filterable.
• Select a Source/Destination name from the filterable list.
• Click OK when done.
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Fig. 6-28: Setting ‘Source’ or ‘Destination’ Property Value

a) Setting ‘Source’ property of the Behaviour

b) Source Picker Dialog (Destination Picker is similar)

Enter a Port Number, or Name, or Number: Name. 

Alternatively, click on the  icon.
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Fig. 6-29: New ‘Source’ Property Value

5 Click Close.
6 Click Save File. Click Save Project.
7 Enter ‘Run’ mode.
8 The XY Panel runs and the newly-assigned Source is assigned to the Source button, see 

Figure 6-30.

Fig. 6-30: Running XY Panel

Thus, a Source button can have a port assigned to it.

Destinations buttons are assigned similarly.

Assign all buttons as required.

There is a quicker way to make these assignments, which uses the help of the Bulk Routing 
Panel. See Quick Port-per-Button Assignment.

Quick Port-per-Button Assignment
This describes a quicker method of assigning buttons to ‘Port-per-Button’ XY Panel button-
grids. All ports are selected via the Bulk Routing panel and then simply ‘copy-pasted’ into 
the XY Panel.

Prerequisites:
• A new XY Panel with one or more button grids set to be ‘Port-per-Button’ (not ‘Paged 

Ports’, see ‘Paging’ setting in XY Wizard Settings, on page 276).

The following example assumes that the buttons of both the Source button-grid and of the 
Destination button-grid require setting up in for ‘Port-per-Button’ operation. If an XY Panel 
just has one such button-grid, then that grid may be quickly set up in a similar way.

To quickly make port-to-button assignments:
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1 Open a Bulk Routing Panel. 
(Click the ‘Bulk Routing’ icon on the Routing Workflow, see Figure 6-31.)

Fig. 6-31: Open Bulk Routing Panel

2 Select all the Destination and Source ports required.

Fig. 6-32: Copy As Widgets in Bulk Routing Panel

3 When all ports are selected, 
right-click in the background of the Bulk Routing panel and select ‘Copy as Widgets’.

The selected buttons (Source and Destination ones in this example) are copied to your 
GV Orbit Client Client’s copy-buffer.

4 Open the target XY Panel.
5 Enter ‘Design’ mode in GV Orbit Client Client.
6 Right-click in the background of the XY Panel and select ‘Paste’.

Note: When selecting the ports in the Bulk Routing panel, the filtering may 
be used and ranges of ports and individual ports can be selected.

Selected Sources and selected Destinations

Right-click and select ‘Copy as Widgets’.
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The copied buttons are pasted into the XY Panel. See Figure 6-33.

Fig. 6-33: Paste Buttons in from Bulk Routing Panel ‘Copy as Widgets’

7 The buttons now in the XY Panel can be arranged as required and any previously-
existing Source/Destination buttons may be deleted if required.

8 Click Save File. Click Save Project.
9 Go to ‘Run’ mode to exercise the XY Panel.

Fig. 6-34: XY Panel with Quick-Assigned Ports

Port-per-Button Pasting into C&M Custom Soft Panel
The example in Quick Port-per-Button Assignment pastes selected button widgets from a 
Bulk Routing Panel into an XY Panel. This selection of buttons may also be pasted into a GV 
Orbit Client C&M user/operator custom panel.

Pasted buttons

Right-click and select ‘Copy as Widgets’.

‘Design’ mode is shown
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:

In this case, the pasted buttons are still functional and will select Destinations and Sources when 
the soft panel is run. There is no ‘Take’ button and ‘auto-take’ applies. See Figure 6-35

Fig. 6-35: Auto-Take with Pasted-in Routing Buttons (Running)

Note:
In the GV Orbit Client Client Project window:

• XY Panels are listed in the ‘panels’ folder; and
• Custom user/operator soft panels are listed in the ’screens’ folder.

Selected Destination

Routed Source

Pre-selected Source

Route automatically made to destination
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Customizing an XY Panel
An XY Panel may be modified and customized by simply using the XY Wizard. Additionally, 
an XY Panel may be further modified and customized by:

• Using the XY Wizard and then further editing the XY panel, 
see Further Editing an XY Panel, on page 309. 

An XY Panel may also be created from scratch without using the XY Wizard. 
This is done with GV Orbit graphical widgets and GV Orbit Client Behaviours and Bindings 
in a similar way to designing a custom user/operator panel in a C&M project. 
See: 

• Creating a Custom XY Panel from Scratch, on page 310; and see 
• Creating a Custom BPX Panel, on page 318.

To enhance the appearance of a control panel, lines, labels etc may be added. 
See Enhancing the Appearance of a Panel, on page 324.

Further Editing an XY Panel
Editing an XY panel is done in a similar way to editing a GV Orbit Client C&M Project custom 
user/operator screen and an XY Panel can be customized as required. For example:

• buttons may be re-positioned, re-sized; 
• other widgets can be added (Labels, Tally Lamps, etc.); 
• colors can be changed (background colors); and
• widget style themes can be selected. 

Figure 6-36 shows an example XY Panel that has been edited after being started with the 
XY Wizard. See Enhancing the Appearance of a Panel, on page 324, for further examples of 
enhancing the appearance of an XY Panel.

Fig. 6-36: Edited XY Panel Example
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Creating a Custom XY Panel from Scratch
A custom XY Panel can be created from scratch in a GV Orbit Client C&M project.
A custom panel can be made to be smaller and more suited to be embedded into a C&M 
project screen. An example small panel with two destinations and a handful of possible 
sources is given in Figure 6-37 and the steps to generate it are below. 

Fig. 6-37: Custom XY Panel Example

Step1: New Empty Basic XY Panel
Firstly, create a new empty XY Panel:

1 Open an GV Orbit C&M project in the GV Orbit Client application.
2 Right-click on the ‘panels’ folder item in the Project window and select ‘New Panel’.
3 Enter a name into the New XY Panel dialog and click OK. See Figure 6-38.



311

GV Orbit Routing Panel
User Guide

Fig. 6-38: Create New XY Panel

A new XY Panel is created in the ‘panels’ folder and is shown in the Project window and 
is open in a tab.

4 In the new XY Panel tab, delete all widgets. 
(Type CTRL-A in the tab to select all widgets and then press the Delete key.)

An empty XY Panel results.
5 Click Save File.

This has created an empty XY Panel in the C&M project. See Figure 6-39.

Fig. 6-39: Empty XY Panel

When editing the XY Panel, it is useful to adjust the position of the routing control widgets 
tool bar in the GV Orbit Client Client, to make it more accessible. To do this:
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6 Drag the routing control widgets tool bar by its handle to a convenient position. See 
Figure 6-40.

Fig. 6-40: Re-positioning the Routing Control Widgets Tool Bar

Step 2: Add Routing Control Widgets to (empty) XY Panel
With the empty XY Panel open in GV Orbit Client:

1 Add 8 Source Button widgets from the Routing widget tool bar (see Figure 6-41).
(Click on ‘Source Button’ button on the tool bar and drag on button widgets.)

The button annotation names increment automatically for each added button.
2 Similarly add 2 Destination Button widgets.

Drag handle and release to re-position Routing Control widget tool bar
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Fig. 6-41: Adding Source and Destination Buttons

Finally, add a Take button:
3 Select ‘Control Buttons’ in the tool bar.

A small dialog appears.

Fig. 6-42: Adding a Take Button

4 Select ‘Take’ and click OK.

A Take button widget appears at your cursor, drop this onto the XY Panel.
5 Arrange the buttons as required.
6 Click Save File and Save Project.

Source Button widgets
Routing control 
widgets tool bar

Destination Button widgets
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Fig. 6-43: Added Buttons

Step 3: Exercise Panel
This XY Panel, when run, will allow the user to select a source from sources 1 to 8 and route 
it independently to destinations 1 or 2.

Fig. 6-44: Running the New XY Panel

Source selection 
buttons

Destination selection 
buttons
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Step 4: Assigning a Port-per-Button
With the XY Panel in ‘Design’ mode in GV Orbit Client Client, the Source buttons and 
Destination buttons can be configured for other source or destination ports in the same 
way as in a ‘Port-per-Button’ panel (See Assigning Ports to a Port-per-Button XY Panel, on 
page 301, for more information.) 

To assign ports:
1 Right-click in the XY Panel’s background and select ‘Edit Behaviours’.

The ‘Behaviours and Bindings’ graphical editor is shown.

Fig. 6-45: Double-click on ‘Source Button’ Behaviour

2 Select a Source button in the XY Panel and double-click on the ‘Source Button’ 
Behaviour in the editor. See Figure 6-45.

The Behaviour’s properties are shown.
3 Set the ‘Mode’ property to ‘Fixed’.
4 Set the ‘Source’ property to a chosen Source name. 
5 Click Close.

A Source button now has a port assigned.
6 Repeat for the other Source buttons.

And then: 
7 Perform similar steps for each Destination button.

The buttons now all have assigned ports.
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Step 5: Styling
1 Arrange the buttons and resize as required.
2 Add any further labels/shapes/colors to enhance the panel’s appearance, as required.

Finally: 
3 Right-click on the XY Panel background and

select ‘Resize to Widgets’.

Fig. 6-46: Custom XY Panel

4 Click Save File. 
Click Save Project.
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Step 6: Exercise Panel
1 Click the ‘Run Mode’ icon in the main tool bar and exercise the panel.

Fig. 6-47: Exercising the XY Panel

The small custom panel operates like a fixed, reduced-size XY Panel and may be dragged 
onto a C&M project custom user panel screen and embedded into it, if required. See How to 
Embed an XY Panel into a Custom User Panel, on page 330.

• Select Destination.
• Select source to route
• Click Take.
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Creating a Custom BPX Panel

What is a BPX Panel Type?
A BPX (BPX, button per crosspoint) panel enables a button-click to specify and make a 
route between a source and destination. A simple custom panel can be designed as part of 
a C&M project, for example, to route one of several sources to a single destination.

A BPX Behaviour is available in GV Orbit which can be associated with a button widget. This 
enables a button-click to make a route between a specific source and destination. BPX 
Panel Example

An example BPX panel is a simple panel where each button is configured to set a route to 
the same destination, but from a different source. This simple BPX panel is shown in 
Figure 6-48 and the steps to generate it in GV Orbit are given below. 

Fig. 6-48: Custom BPX Example

Each button configured to make a different route 
(usually) to the same destination.
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Basic BPX Panel
To create this panel:

1 Create a new empty XY Panel. 
(This is described in Step1: New Empty Basic XY Panel, on page 310 for the Creating a 
Custom XY Panel from Scratch, on page 310.)

2 Add a graphical Button widget to the panel. (See Figure 6-49.)

Fig. 6-49: Add a Button Widget

3 Right-click in the XY Panel’s background and select ‘Edit Behaviours’.

The ‘Behaviours and Bindings’ graphical editor is shown.
4 Select the Button widget.

The ‘Behaviours and Bindings’ graphical editor for the selected button is shown. 

Drag on a Button widget
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Fig. 6-50: Behaviours and Bindings of Selected Button Widget 
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In the editor:
5 Filter the Behaviours on ‘Routing’. See Figure 6-51a.
6 Select a BPX Behaviour. See Figure 6-51b.

A BPX Behaviour is added to the ‘Behaviour and Bindings’ editor and a Binding too. See 
Figure 6-51b.

Fig. 6-51: Adding a BPX Behaviour

b) Select a BPX Behaviour

a) Filter Behaviours on ‘Routing’

BPX Behaviour is added and a Binding

Filtered list of 
Routing 
Behaviours
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A BPX button’s function is to specify a Source and a Destination and a route between the 
two:

7 Double-click on the BPX Behaviour.

The Behaviour’s properties are shown. See Figure 6-52.
8 Set the ‘Source’ property to a required Source.
9 Set the ‘Destination’ property to the required Destination.

Fig. 6-52: Setting ‘Source’ and ‘Destination’ Property Values

10 Click Close.

This has defined one BPX button. (I.e. a route between the Source and Destination.)

Now we will copy this button (with its Behaviour/Binding settings) twice:
11 In the BPX panel, select the one Button widget, right-click on it and select ‘Copy’.
12 Select the panel’s background, right-click and select ‘Paste’.
13 And again, select the panel’s background, right-click and select ‘Paste’.

This copies the button twice more on the panel.
14 Select the panel’s background, right-click and select ‘Edit Behaviours’.

For each button that was copied:
15 Select the button, and edit the button’s BPX Behaviour.
16 Change the ‘Source’ property to select a different Source each time.

Then:
17 Click Close. 
18 Click Save File. 
19 Click Save Project.
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Fig. 6-53: BPX Panel, Designed

This has created a basic BPX panel with three buttons. Each button is configured to set a 
route to the same destination, but from a different source.

Exercise the BPX Panel 
1 Enter ‘Run’ mode in GV Orbit Client Client.
2 Operate the panel. See Figure 6-54.

Fig. 6-54: BPX Panel Running

Click the second button to 
make a route from its source, S10-2. 
See the result

Click the third button to 
make a route from its source, S10-3. 
See the result

Currently routed Source to the Destination

Destination

Source which the button will route to the Destination, if selected.
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Enhancing the Appearance of a Panel
• Panel Enhancement - Add Labels, on page 324.
• Enhancement - Add Lines, on page 327.

Panel Enhancement - Add Labels
Label widgets can be added for the display of information. In this example, some text is 
added to the BPX panel to display the destination name and the source routed to it.

1 Add four Label widgets to the BPX panel. See Figure 6-55.
2 Set two labels to have fixed ‘Caption’ properties. See Figure 6-55.

Fig. 6-55: Adding Labels

For each of the other two Labels:
3 Open the ‘Behaviour and Bindings’ graphical editor. 

(Right-click and select ‘Edit Behaviours’ in the panel background.)
4 Select one of the Labels. See Figure 6-55.
5 Add a Destination Behaviour. See Figure 6-55.

A Destination Behaviour and a Binding are added to the ‘Behaviour and Bindings’ 
editor.

Note: Carry out edits to the panel design in GV Orbit Client Client in 
‘Design’ mode.

Label widgets with fixed ‘Caption’ property Label widgets using a Destination Behaviour

Selected Label

Add a Destination Behaviour
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6 Double-click on the Destination Behaviour and set its ‘Destination’ property to the 
same destination that each of the Buttons control. See Figure 6-56.

7 Click Close.

Fig. 6-56: Setting Destination for a Label’s Destination Behaviour

This has set up both of the Label captions to show the Source name of the pointed-to 
Destination. To modify one of the Label captions to show the Destination name instead:

8 Select the Label to see its Behaviours and Bindings. See Figure 6-57.

Fig. 6-57: Select a Label

Destination Behaviour pointed at the same destination monitored as the BPX 
buttons.
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9 Double-click on the Binding to see the Binding’s properties.

See Figure 6-58.

Fig. 6-58: Edit Binding Properties

10 Change the following properties of the Binding:
• ‘Behaviour Value’ property from ‘Source Name’ to ‘Dest Name’.
• ‘Name’ property from ‘Routed source onto caption’ to ‘Dest name onto caption’.

11 Click Close.
12 Click Save File. Click Save Project.

This has modified our BPX Panel design. See Figure 6-59a.
13 Exercise the BPX panel with the Labels. 

When a button is clicked, the resulting route is shown by the labels. See Figure 6-59b.

Fig. 6-59: BPX Panel with Labels: a) Designed; b) Running

a) Designed BPX Panel with Labels b) Running BPX Panel with Labels
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Enhancement - Add Lines
Lines (Line widgets) or any shapes may be added to a panel.

Fig. 6-60: Added Lines

Additionally, Line widgets can have their visibility controlled from the state of the routing. 
This is shown by using the example panel from Panel Enhancement - Add Labels, on 
page 324. To do this:

1 Open the panel and show the ‘Behaviour and Bindings’ graphical editor.
2 Add the required lines, in this example, three lines are added.

For each button:
3 Select the button and then view the properties of the associated BPX Behaviour; 

change the ‘Name’ property to a unique name. (E.g. to ‘BPX-1’, ‘BPX-2’, and ‘BPX-3’. )

This gives each BPX Behaviour a unique name.

For each line:
4 Select the line and add a Property Binding. See Figure 6-61.

Fig. 6-61: Add Property Binding
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5 Double-click on the added Property Binding to edit its properties.
6 Change the following Property Binding property values: (See Figure 6-62.)

• ‘Source Behaviour’, select a unique BPX Behaviour (i.e. ‘BPX-1’,or ‘BPX-2’, or ‘BPX-3’).
• ‘Behaviour value’ to ‘Is Routed’.
• ‘Property to Bind’ to ‘Visibility’.

Fig. 6-62: Added Property Binding

7 Click Close.

This has set the visibility of a line to be controlled by the routing status of the BPX 
Behaviour associated to a Button. 
Do this for each line and select a unique BPX Behaviour name each time.

Fig. 6-63: BPX Panel Example
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When the visibilities of all three lines are changed:
8 Click Save File. Click Save Project.
9 Exercise the panel. See Figure 6-64.

The lines simply indicate the route that is made when clicking buttons.

Fig. 6-64: Exercising BPX Panel with Lines

Click button:

Route is made and 
a line indicates the routing 
made.

Click Button:

Route is made and 
a line indicates the routing 
made.

Click Button:

Route is made and 
a line indicates the routing 
made.
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How to Embed an XY Panel into a Custom User Panel
An XY Panel may be embedded into an XY Routing Panel C&M project screen as an GV Orbit 
‘Component’.

To embed:
1 Open the GV Orbit project containing the XY Panel and a C&M project screen.

Firstly, check that the overall XY Panel size is just bigger than the widgets it contains. To do 
this:

2 Open the XY Panel and check the size values in the Properties box.
(Properties box: Screen > Dimensions > Page Size > ‘Width’ and ‘Height’.)

3 If the panel size needs adjusting:
• right-click in the panel background and select ‘Resize to Widgets’, and/or 
• adjust the background’s screen ‘Width’ and ‘Height’ properties directly.

4 Close the XY Panel.

Now embed the XY Panel into a C&M project screen:
5 Open a C&M screen.
6 Drag an XY panel from the Project window onto the C&M project screen. 

and release. See Figure 6-65.

Fig. 6-65: Drag on an XY Panel

The panel object is like a GV Orbit component object on a C&M project screen. 
7 Resize the panel object as required.
8 Click Save File. Click Save Project.
9 Run the C&M screen and exercise the XY Panel on the screen.

One or more instances of an XY panel on a screen can be used.

Drag panel onto screen
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Introduction

A multiviewer cluster (MV Cluster) is a group of multiple MV-8 Series multiviewer devices in 
a GV Orbit system which are all acting together to serve one or more video walls. The 
cluster is treated as one multiviewer resource, rather than as a set of single, individual 
multiviewer devices. 

All of the video walls served by the multiviewer cluster are designed in a single ‘Clustered 
Multiviewer’ project in GV Orbit Client. This is done using the ‘Room Editor’ tool and an MV 
Cluster Manager service is required to be running on a GV Orbit server. The resulting video 
wall(s) are managed at a higher level (at a ‘cluster-level’) and router destinations are referred 
to in operation rather than video wall tiles or multiviewer inputs.

Lite Professional Enterprise

-  
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MV Cluster Information

What is an MV Cluster?
An MV Cluster is a cluster of multiviewer devices configured together and all acting 
together to serve one or more video walls. An MV cluster contains one or more multiviewer 
devices.

MV Cluster Size
The number of devices in an MV Cluster (NCluster) has no fixed limit: The number of multiviewers that GV 
Orbit Client and the MV Cluster Manager service can handle has no real limit.

However, in practice, limiting factors are anticipated. The maximum number of MV-8 Series multiviewers in 
an MV Cluster (NClusterMax) is determined by performance and various system factors, including:

• GV Orbit system size; and 

• network speed. 

Please contact Grass Valley Technical Support for further information on NClusterMax for specific use 
cases.

Defining Video Walls for an MV Cluster
A user can define a set of video walls for a broadcast production studio or OB truck using 
the Grass Valley GV Orbit Client tool with a ‘Clustered MV’ project. The video walls are all 
served by a cluster of MV-8 Series multiviewers.

GV Orbit Client is used along with GV Orbit system services. Video walls are defined and 
managed independently from the individual multiviewer devices used. Video wall tiles are 
referred to by their router destination name.

Additionally, for a ‘Clustered MV’ GV Orbit project, TSL tally settings and audio bars 
configuration can be done for each whole video wall.

 Table 7-1: MV Cluster Numbers for MV-8 Series Multiviewers
Number of 

Multiviewer 
Devices 

Number of head display outputs: Number of video wall tiles: 

per device maximum 
available

per 
device

per 
video wall

1 up to 12 12 48 up to 48

2 up to 12 24 48 up to 48 * 2 (=96)

3 up to 12 36 48 up to 48 * 3 (=144)

... ... ... ... ...

NCluster
a up to 12 12 * NCluster 48 up to 48 * NCluster

a.The number of devices in an MV Cluster has no fixed limit. Please see MV Cluster Size for more 
information. 
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Fig. 7-1: Video Walls Served by Multiviewer Cluster (Example shown has an MV Cluster of 6 Devices)

What is a Clustered Multiviewer Project?
A GV Orbit Clustered MV project (Clustered MV project) enables a user to define a set of 
video walls for a broadcast production studio or OB truck served by an MV Cluster. 

The video walls can each comprise one or more display monitors. One or more video walls 
may be defined, all served by a cluster of multiviewer devices.

All of the video walls are designed in one ‘Clustered MV’ project, which then holds the 
designs of one or more video walls for a studio or an OB truck. 

Overall TSL tally set up and Audio Bars audio channel configuration of audio bars is also 
integrated and handled within such a project. 

The project is stored centrally on the GV Orbit server and the entire video wall design is 
then automatically parsed and administered across the individual multiviewers in the 
cluster.

MV-8XX Multiviewer Cluster Example
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Multiviewer Discovery

Video Wall Design
Video walls are formed from a physical arrangement of one or more display monitors and 
each display monitor is driven from any one of the multiviewer head display outputs 
available from the multiviewer cluster. Video wall tile layouts can be applied and layouts for 
the whole video wall and also for individual monitors can be saved and switched between. 
Assignment of router destinations to video tile layouts completes the video wall design. 
Finally, the assignment of video sources to video tiles (PiPs) is integrated into the GV Orbit 
routing control system and the routing of video to wall tile positions can be interactively 
achieved. 

Deployment
Deployment is a one-step process, requiring the finished project to be simply pushed to the 
GV Orbit server. Behind the scenes, the video wall designs are then automatically translated 
into constituent, individual ‘multiviewer projects’ which are targeted at each individual 
multiviewer of the cluster. The constituent projects are automatically pushed out to the 
individual multiviewer devices.

Is the Multiviewer device on the network?

Yes No

Is Multicast data enabled on network?

Yes No

Multiviewer is 
automatically discovered 
by GV Orbit Client for the 

Clustered MV project.

Require manual entry of 
multiviewer devices into 
the Clustered MV project.

Add the device to the 
network.

IMPORTANT
Multiviewers should be operated either in a clustered mode or as 
individual, non-clustered single-multiviewers. 
Changing readily between these operational modes is not 
supported. 

Recommendation:
All multiviewer set-up and configuration is carried out fully for the 
intended mode of operation.
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Clustered MV project vs. Multiviewer Project
A Clustered MV project is opened, saved, pushed etc. in a similar way to other GV Orbit 
multiviewer projects; the main exceptions/differences are listed in Table 7-2.

Use a Clustered MV project when defining and managing video walls from a cluster of MV-
8xx multiviewers.

 Table 7-2: Clustered MV Project Differences 

Item
GV Orbit Project Type

Clustered Multiviewer Multiviewer, or
Connected Multiviewer

Video wall design tool Room Editor 
in GV Orbit Client

Wall Editor a
in GV Orbit Client

Multiviewer resource(s) One or more multiviewer devices. 
(NCluster devices in an MV Cluster)

A single multiviewer device.

GV Orbit System Required, running a MV Cluster 
Manager Service

Can operate with or without a GV 
Orbit system

Deployment Push project to a 
GV Orbit server repository.

Push project to a 
single multiviewer device.

Max number Video Walls up to 12x NCluster 12

Max number Video Tiles up to 48x NCluster 48

Video Wall Arrangement Flexible Constrained

Video Wall Layouts Yes, Room Layout No.

Monitor-level Layouts Yes, Monitor Layout Yes, Wall Layout

a.For information on the Wall Editor, please refer to Orbit documentation.
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Room Editor vs Wall Editor
Wall Editor - Both the original Orbit Client tool and the current GV Orbit Client tool allow 
configuration of video walls from single multiviewers using the original GV Orbit 
‘Multiviewer’ type projects and the Wall Editor tool (refer to Orbit documentation).

Room Editor - GV Orbit additionally allows configuration of video walls from a multiviewer 
cluster with a ‘Clustered MV’ project. This is done via the new Room Editor tool in GV Orbit 
Client with the MV Cluster Manager service running on a GV Orbit server.

Single Multiviewer as an MV Cluster
A single multiviewer may be considered as an ‘MV Cluster of one’ and a video wall design can 
be generated for a single multiviewer with the Room Editor in a ‘Clustered MV’ project. 

What is an MV Cluster Manager?
The MV Cluster Manager is a service running on the GV Orbit server which automatically 
translates a GV Orbit ‘Clustered MV’ project into its constituent, single-multiviewer projects. 
The service automatically manages each individual multiviewer device of an MV Cluster. A 
GV Orbit system may have zero or one such service.

Once it is configured, the service will:
• check for the availability of multiviewers in the room; and 
• put a watch on the relevant GV Orbit server repositories for any project changes. 

The service processes any detected repository project changes and rebuilds any 
constituent single-multiviewer projects where necessary, automatically pushing the 
projects to the appropriate multiviewer device(s).

Note: Room Editor vs Wall Editor:

MV-8 Series multiviewer(s)

Cluster of 
one or more 

Single, individual

Client tool? Room Editor Wall Editora

a. For information about the Wall Editor, refer to Orbit documentation.

GV Orbit project type? Clustered 
Multiviewer

Multiviewer

Minimum system 
configuration 

GV Orbit system 
with server 

None

Uses MV Cluster 
Manager service?

Yes, 
an MV Cluster 

Manager service is 
required.

No

Note: For an MV Cluster of any size, an MV Cluster Manager service is 
required to be running on a GV Orbit server.
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The service will alert the GV Orbit system to any off-line multiviewers and missing 
repositories.

The service is automatically discovered by a GV Orbit Client in a GV Orbit system and a user 
can then create a ‘Clustered MV’ project.

Configuring an MV Cluster Manager Service
The MV Cluster Manager service configuration is carried out on the GV Orbit server.

The following settings can be configured from the MV Cluster Manager service’s 
configuration page on the GV Orbit server:

• Service Settings:
• GVOP Client Domain ID number for the service to use.
• Network interface(s) on the GV Orbit server for the service to use.
• RollCall address of the service in the GV Orbit system.
• A friendly name for the service, to be used in a GV Orbit Client’s Network window.

• Project Settings:
• GV Orbit server repository name of the Clustered MV project for the service to use. 

Video Wall Configuration Workflow (Clustered Multiviewers)
This user guide describes the configuration and operation of clustered MV-8XX 
multiviewers in a GV Orbit control and monitoring system for multiple video walls, for 
example in an OB truck environment.

This chapter has provided some MV Cluster definitions. It proceeds to provide some MV 
Cluster information:

1 Configuring an MV Cluster Manager Service, on page 338.
2 Creating a New Clustered Multiviewer Project for an MV Cluster, on page 340.
3 Clustered MV Project Screens, on page 352.
4 Managing Multiviewer Cluster Information in a Project, on page 355.

Additionally, the workflow description is continued in further user guide chapters:
5 Chapter 8, MV Cluster - Room Editor:

a Room Editor Introduction, on page 361.
b Room Editor Workflow, on page 373.
c Step 1: Create a Room, on page 376.
d Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 378.

Refer to: Please refer to the GV Orbit Admin Guide for information about GV 
Orbit services, including configuring the MV Cluster Manager 
service.

Note: The ‘Project Settings’ may be set up separately later, when a 
‘Clustered MV’ project has been created along with its repository.
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e Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 390.
f Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 399.
g Step 4a: Assign Destinations to Tile Positions, on page 408
h Step 5a: X/Y Routing Video Sources to Tiles, on page 430.

Also see Chapter 9 MV Cluster - TSL Tally Configuration, on page 445, and Chapter 10 Audio 
Bars Configuration, on page 473.
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Creating a New Clustered Multiviewer Project for an MV Cluster
The video walls served by an MV Cluster are defined with a ‘Clustered Multiviewer’ Project 
in GV Orbit Client. 

Procedure
To create a new ‘Clustered Multiviewer’ project (Clustered MV project) in GV Orbit Client:

Step 1: Create and Connect a Project to a GV Orbit Server
1 Open GV Orbit Client.

The initial screen is shown.

Fig. 7-2: Initial Screen of GV Orbit Client

2 Select New Project on the initial screen.

The New Project dialog is shown.
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Fig. 7-3: New Project Dialog

3 Select the Clustered Multiviewer project type. (See Figure 7-3.)
4 Enter a Name for the new project in the ‘Details’ section.

This is a name for the local storage of project information.
5 Browse to a folder location (local or network) for the project to be stored in while the 

multiviewer video walls are being designed. 

6 Click Choose to select the folder.

Fig. 7-4: Filled Out New Project Dialog

7 Click OK in the dialog.

Note: Folder Location:
The folder location must be accessible from the client computer 
running the GV Orbit Client tool. This location is used while the 
project is being edited. 
When the editing is complete and the project is ready to be deployed, 
it is pushed from the GV Orbit Client to a central repository location 
on the GV Orbit server of the GV Orbit system.

Select Clustered Multiviewer 
project type.

Enter a Name for the new 
project.

Browse to a folder location.
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A Setup dialog for the project is then shown. See Figure 7-7.

Project Setup Dialog:

Fig. 7-5: Setup Dialog 

In the clustered multiviewer project’s Setup dialog:
8 Set Server 1 IP to the IP address of the GV Orbit server and press Enter.

(For a dual-server GV Orbit system, still just enter the IP address of one server. The 
second server will be discovered automatically in the steps below.)

After the IP address is entered, some basic system tests are carried out using the 
current, original settings of the Setup dialog. 
(This basic system testing includes testing system connectivity and gathering some 
basic system information from the GV Orbit server.) 

The results of these basic system tests are then shown in the Setup dialog’s console 
window.

9 After these basic system tests are done, any differences in the settings are adopted by 
the Setup dialog.

Step 2: Repository for Clustered MV Project
When creating a new ‘Clustered Multiviewer’ project, a new repository needs to be created.

(Compare to when opening an existing ‘Clustered Multiviewer ‘project; in this case, an 
existing repository must be specified, see Open an Existing Clustered Multiviewer Project, 
on page 346.)

Note: The current, original dialog settings will most likely differ from those 
of the GV Orbit system being connected to. Discrepancies are shown 
in red-highlighted text in the dialog’s console window. This is normal.

Server 1 IP

Basic system test results
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To Create a New Repository for the Project:

In the Setup dialog, to create a new Repository to be used: 
1 At the Repository setting, click New.

Fig. 7-6: Click New in Setup Dialog 

The Create Repository dialog is shown.

2 Enter a Name for the new repository on the GV 
Orbit server for the ‘Clustered MV’ project to use and press Enter, or click OK.

The new repository name is shown in the Setup dialog.

Note: Characters to use in a Repository Name:
Use only:

• alpha-numeric characters (0 1 2 A B C x y z etc.); and/or
• underscore characters (_); and/or 
• tilde characters (~).

Note: Repository Name:
Use a unique and identifiable repository name for the ‘Clustered MV’ 
project to use. In this way, it is easily identified and found in a list of all 
repositories on a server.

Click New
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Step 3: System Re-Test (optional) During Project Setup
With a new or an existing Repository name shown in the Setup dialog, a system re-test can 
be carried out.

1 Click System Test.

This re-does the basic system tests. The results are shown in the console. Any ‘red’ items 
from before should now be cleared. See Figure 7-7.

Fig. 7-7: System Re-Test

Step 4: Finally, Create Project
1 Click Apply in the Setup dialog.

The settings are applied 
to the project and a 
progress bar appears in 
the dialog.

IMPORTANT
If a new Repository has been created during the ‘Clustered MV’ 
project creation, then the MV Cluster Manager service repository 
needs to be configured with the new Repository.
(See the ‘Project Settings‘part of Configuring an MV Cluster Manager 
Service, on page 338.)

Note: At this point, a system re-test is optional and will now remove any 
red items in the console pane. Optionally, in the Setup dialog:
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2 While settings are applied, a pop-up dialog 
may appear, asking if the local project 
should be updated from the chosen 
repository:

For a new project where no changes have 
been made locally, answer Yes.

• Click Yes to update the local project 
from the repository on the server (this will lose any local changes made); or

• Click No to keep any local project changes made (and not pull the project from the 
repository on the server).

3 While the applying of the settings continues, progress is shown in the progress bar. 
4 When the settings changes are all applied, an All Done message pops up. 

:

Fig. 7-9: Applying of Project Settings is All Done

5 Click OK.
6 Close the Setup dialog.

The new Clustered Multiviewer project is created and its Home screen is then shown. 
See Clustered MV Project Home Screen.

7 Click OK.

The Clustered Multiviewer project information is contained in the local folder, ready for 
editing. For a newly-created project it is an empty project.

Note: The Setup dialog can also be viewed when a GV Orbit project is open 
by clicking Connections > GV Server in the main menu.

Fig. 7-8: Update Local Project?
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Open an Existing Clustered Multiviewer Project
To open an existing ‘Clustered Multiviewer’ project from a repository on the GV Orbit server, 
the procedure is similar to the procedure for creating a new ‘Clustered Multiviewer’ project 
(refer to Creating a New Clustered Multiviewer Project for an MV Cluster, on page 340).

The steps below open an existing project from an existing repository.

Procedure

Step 1: Create and Connect
1 Carry out the steps in Step 1: Create and Connect a Project to a GV Orbit Server, on 

page 340.

This creates an empty, locally-stored project.

Step 2: Repository for Clustered MV Project
When opening a Clustered MV project from a repository, an existing repository must be 
specified:

To specify an existing Repository for the project, in the Setup dialog: 
1 At the Repository drop-down box, select a Repository from the drop-down list. (See 

Figure 7-10.) 
The repository must be a ‘Clustered Multiviewer’ repository.

Fig. 7-10: Select Existing Repository

The selected Repository name is shown in the Setup dialog.

Step 3: System Re-Test (optional)
With a Repository name shown in the Setup dialog, a system re-test can be carried out.

1 Carry out the steps in Step 3: System Re-Test (optional) During Project Setup, on 
page 344.

Select an existing RepositoryClick on drop-down arrow
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Step 4: Finally, Open the Project from the Repository
1 Click Apply in the Setup dialog.

The settings are applied 
to the project and a 
progress bar appears in 
the dialog.

2 While settings are applied, a pop-up dialog 
may appear, asking if the local project 
should be updated from the chosen 
repository:

For a new project where no changes have 
been made locally, answer Yes.

• Click Yes to update the local project 
from the repository on the server (this will lose any local changes made); or

• Click No to keep any local project changes made (and not pull the project from the 
repository on the server).

3 While the applying of the settings continues, progress is shown in the progress bar. 
4 When the settings changes are all applied, an All Done message pops up. 

Fig. 7-12: Applying of Project Settings is All Done

5 Click OK.
6 Close the Setup dialog.

The exiting Clustered Multiviewer project is opened and its Home screen is then 
shown. See Clustered MV Project Home Screen.

7 Click OK.

The Clustered Multiviewer project information is contained in the local folder, ready for 
editing. For a newly-created project it is an empty project.

Note: To edit an existing repository project information on a new PC, then 
click Yes to pull the existing project information from the repository 
into the newly created ‘Clustered MV’ project.
If the user clicks No here, then subsequent pushing back to the 
repository will overwrite the existing project information in the 
repository.

Note: The Setup dialog can also be viewed when a GV Orbit project is open 
by clicking Connections > GV Server in the main menu.

Fig. 7-11: Update Local Project?
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Note: The Home Page is not automatically refreshed, and new Room files 
will not be shown. 
Close and re-open the project to refresh and then see files pulled 
from the repository.
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Deploying a Clustered Multiviewer Project (Push/Pull)
For deployment, a Clustered MV project is pushed to a central store on the GV Orbit server, 
i.e. to the Repository. There is one project per Repository. 
(Compare this to a single-multiviewer project – i.e. for a non-clustered multiviewer device – 
in which case the project is pushed to the multiviewer itself.)

Push Project to Repository
To send a locally-saved and edited project to the Repository for automatic deployment on 
the multiviewer cluster by the MV Cluster Manager Service on the GV Orbit server:

1 Click Push in the main tool bar.

Fig. 7-13: Push in Tool Bar

A Choose Projects dialog is shown.

Fig. 7-14: Choose Push

2 Ensure that the project Repository to be pushed is selected (highlighted in blue) in the 
dialog. See Figure 7-14.

3 Click OK.

The project information is pushed to the Repository.
4 When the Push is done, a Push dialog is shown.

Fig. 7-15: Push Done

5 Click OK to close the Push dialog.
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Pull Project from Repository
To get a project from a Repository into an opened project for editing and/or locally saving: 

1 Click Pull in the main tool bar.

Fig. 7-16: Pull in Tool Bar

A Choose Projects dialog is shown.

Fig. 7-17: Choose Pull

2 Ensure that the project Repository to be pulled is selected (highlighted in blue) in the 
dialog. See Figure 7-17.

3 Click OK.

The project information is pulled from the Repository.
4 When the Pull is done, a Pull dialog is shown.

Fig. 7-18: Pull Done

5 Click OK to close the Pull dialog.
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Note: For best practice, Pull a project before starting to edit it. 
This ensure that the most up to date project information is used.

If there are any conflicts between locally-stored project information 
and the repository, then the user is prompted. The user may then 
either discard their changes, or keep their changes and discard any 
server-side changes.
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Clustered MV Project Screens

Clustered MV Project Home Screen
The Home screen of a Clustered Multiviewer project is shown in Figure 7-19.

Fig. 7-19: Clustered Multiviewer Project Home Screen

The Home screen of the Clustered MV project is similar to that for a GV Orbit Multiviewer 
project; differences include:

• Multiviewer Cluster dialog which lists the multiviewers of the cluster. 
(Main menu item ‘Multiviewer -> Multiviewer Cluster’.)

• Rooms icon on the Home screen which allows the user to create .room files and edit 
them in the Room Editor. (See Chapter 8, MV Cluster - Room Editor, on page 359.)

• Project window has a ‘rooms’ sub-folder for .room files.

The large icons are similar to (non-clustered) multiviewer projects:
• Manage Users - Set up project users and their roles. (See Chapter 4, Manage Users, on 

page 141.)

Main menu bar
Project name

Click Edit to edit Project name
Main tool bar

Local path to project folder

Click ‘Multiviewer > Multiviewer Cluster’ in 
the main menu for information on the 
multiviewers in the MV Cluster.

Click Rooms icon to create a .room file in the project 
and open it in the Room Editor.
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• Themes - Edit or create new on-screen appearance styles for graphical widgets for use 
on the video wall.

• Rooms - Edit or create .room file(s) with the Room Editor tool for the ‘Clustered 
Multiviewer’ project. (See Chapter 8, MV Cluster - Room Editor, on page 359.)

• Tiles - Edit or create new Custom Tiles for use on the video wall.

Main Menu Items
Please see Main Menu Items, on page 127.

Main Tool Bar Items
Please see Main Tool Bar Items, on page 133.

Further Tool Bar items are shown when a multiviewer video wall is open. See Main Tool Bar 
with Room Editor Open.

Clustered MV Room Editor Screen
The Home screen of the Room Editor is shown in Figure 7-20.

Fig. 7-20: Clustered Multiviewer Room Editor Screen

Main menu bar
Properties BoxMain tool bar

.room file open in Room Editor tab window

Room Editor tool bar

Network window

Project window
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For further description of the Room Editor, please see Chapter 8, MV Cluster - Room Editor, 
on page 359.

Main Tool Bar with Room Editor Open
Additional tool bat icons are shown here. See Main Tool Bar Items for the other icons.

Fig. 7-21: Clustered Multiviewer Main Tools Bar with Room Editor Screen Open

Run/Design Mode
shown in Design mode)

Properties window

Dock/Undock the active window

Set the active window to full-screen mode

Display drawing grid

Options 
(Tools > Options in main menu)

Zoom stage screen in/out

Graphic object alignment controls,
see Graphic Object Alignment Controls, on page 135

Graphic object layer
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Managing Multiviewer Cluster Information in a Project
The multiviewers in a multiviewer cluster are automatically discovered by GV Orbit where a 
network allows multicast discovery data packets.

In addition, a user can manually add one or more networked multiviewers to the cluster. 

View/Edit Multiviewer Information about Multiviewers in the Cluster

Procedure
To view information about each multiviewer in the multiviewer cluster:

1 Click ‘Multiviewer > Multiviewer Cluster’ in the GV Orbit Client main menu.

The Multiviewer Cluster dialog is shown. See Figure 7-22. 
The dialog shows the auto-discovered multiviewers of the cluster.

Fig. 7-22: Multiviewer Cluster Dialog

In the Multiviewer Cluster dialog, the following should be manually set up:
2 Select the number of ‘Heads’ that are licensed for each multiviewer in the list.
3 Select the output ‘Resolution’ for the multiviewers.
4 Click OK.

If required, multiviewers can be explicitly added, see Adding Multiviewers Explicitly.

Note: Manual entry of multiviewer devices is required where a network 
does not have multicast data enabled.

Note: The head display outputs of an MV-8 Series multiviewer all share the 
same resolution. Select either 1920x1080 or 720x1280.
UHD (4K) is achieved with four outputs and 1080p quad-link.

RollCall address
IP address

Number of supported, licensed 
multiviewer head display outputs

Multiviewer output resolution
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Adding Multiviewers Explicitly
It is possible to add multiviewers to the list in the Multiviewer Cluster dialog. This may be 
required if, for example, multicast discovery data packets are not allowed on a network. 

Procedure
To add multiviewers manually:

1 Click New to add the information about each multiviewer of the cluster. See Figure 7-
23. 

2 Click OK to close the dialog.
3 Click Project -> Save Project in the main menu to save the project locally.

Fig. 7-23: Multiviewer Cluster Dialog- Adding New Multiviewer Device

MV-8 Series multiviewer head display outputs all 
share the same resolution. 
Select either 1920x1080 or 720x1280.
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Video Walls Etc. Design Workflow for an MV Cluster
For instructions on designing video walls in a ‘Clustered MV’ project see the workflow 
described in:

• Chapter 8, MV Cluster - Room Editor, on page 359.

Also see these additional design steps:
• Chapter 9 MV Cluster - TSL Tally Configuration, on page 445.
• Chapter 10 Audio Bars Configuration, on page 473.
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Room Editor Introduction

Room Editor is a facility offered in a ‘Clustered MV’ project in GV Orbit Client. It enables a 
user to design one or more video walls that are served by a cluster of multiviewers. This 
allows a user to design and manage all the video walls in a production-facility (e.g. studio, 
or OB truck). The multiviewer devices are automatically discovered by GV Orbit Client.

Fig. 8-1: Example Facility Schematic - Cluster of Multiviewer Devices Serving a Production Facility

In the This section defines and describes some terms etc. used when using the Room Editor 
in GV Orbit Client., a user can define and position all of the physical monitor displays for all 
their video walls. Assignment of multiviewer devices and outputs to video wall monitors is 
performed once. Video walls can be fed by any multiviewer output available in the 
multiviewer cluster and are assigned to router destinations. Assignment of video signals to 
the video wall for monitoring is integrated into the GV Orbit routing system and carried out 
with a graphical interface in GV Orbit Client.

Subsequent design and management of all the various video walls is then independent of 
the individual multiviewers in the cluster and video tile positions on the video wall are 
referred to with router destination names.

The Room Editor also enables a user to set up TSL tally settings and audio bars 
configuration for a video wall.

This section defines and describes some terms etc. used when using the Room Editor in GV 
Orbit Client.

Lite Professional Enterprise

-  

Cluster of multiviewers

Video walls, Rooms
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What is a Room?
A Room (also known as a Room file, or, simply, a Room) is part of a Clustered MV project. A 
file holds information for a video wall (Room Design). There can be more than one Room 
in a Clustered MV project. 

The files are stored in the ‘Clustered MV’ project’s folder structure, in the ‘rooms’ sub-folder, 
and are accessible from the Project window in GV Orbit Client or from the opening project 
Home Page.

Fig. 8-2: Room Files in a Clustered Multiviewer Project Describe Video Walls

What is a Room Design?
A video wall is formed in a ‘Clustered MV’ project from ‘physical’ video monitor displays. 
Each video wall design is a Room Design. A user can form a large video wall from multiple 
‘physical’ displays arranged and configured. They can be driven from one or more 
multiviewer devices from an MV cluster. Video wall tile layouts can be applied and video 
tiles can be assigned router destinations. 

Cluster of 
multiviewers
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A Room Design is stored in a Room file. 

See Step 1: Create a Room, on page 376, for the workflow steps.

What is Monitor Arrangement and Multiviewer Output Assignment?
As part of a Room Design, a user can configure a large video wall from multiple ‘physical’ 
displays and driven from one or more multiviewer devices from an MV cluster. 

Fig. 8-3: Room Designs: a) Arranging Monitors; b) Assigning and Configuring Multiviewer Outputs.

Monitor Arrangement includes:
1 Creating a representation of a large video monitor wall by positioning ‘physical’ 

displays on a ‘stage’. 
2 Defining each display, including:

• Display size, geometry.
• Type: single HD, or quad-split for UHD. 

b) Assign a Multiviewer Output to Each Monitor

Cluster of multiviewers

Monitors

a Room Design

a) Arrange Monitors for each video wall
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• Orientation: Vertical or Horizontal. 

Assign Outputs includes:
3 Assigning a multiviewer output to each physical monitor display. 

A monitor arrangement and assigned outputs in a Room file can be saved locally and, 
when complete, the Room Design can be saved centrally on a GV Orbit server in a 
‘Clustered Multiviewer’ project.

See Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 378, for the 
workflow steps.

What is Room Design Layout?
This defines the arrangement of tiles used in a project for each video wall monitor. 

The arrangement of tiles plus their connection to multiviewer inputs on a monitor is termed 
its Layout. 

Fig. 8-4: Video Wall Design Layout

Layout Workflow
For a created Room Design, for each monitor:

Note: A UHD monitor is fed from four MV-8 Series multiviewer “HD” 
multiviewer outputs. These must be multiviewer outputs from the 
same multiviewer device.

Note: Monitor aspect ratio is assumed to be 16:9.

Tile layouts added to video wall monitors

Tiles
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• A tile-grid is applied from a selection of templates (for example, 2x2, 3x3 etc.) to 
position tiles and fine-positioning can be done. 

• Each tile type is then defined (for example, video tile, audio tile, or custom tile).

This has prepared a basic Design Layout in a Room Design.

(See What is a Monitor Layout?, and What is a Room Layout?)

See Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 390, for the 
workflow steps.

What is a Tile-Grid?
A tile-grid determines the position and size of tiles on a monitor, irrespective of tile type. 
For example, a tile-grid may comprise:

• 3x3 tiles; or of
• one larger, central tile surrounded by twelve smaller tiles .

A tile-grid includes the assignment of multiviewer inputs and router destinations to each 
tile position in the grid.

Tile-Grid Excludes Tile Types
A tile-grid excludes the tile types that populate the tile-grid. 

What is a Monitor Layout?
In a project, monitors on the video wall are each configured to show a tile-grid layout, 
either from pre-configured grids (2x2 or 3x3 etc.), or from user-defined grids. These 
‘monitor layouts‘ then make up the layout of the entire video wall.

Further, an individual monitor may be set up with a set of two or more alternative tile-grid 
layouts which can be available to the monitor at run time. (For example, there may be a 2x2, 
3x3, a 4x4 tile grid and a user-defined tile grid layout in the set of alternative layouts to 
select from at run time on the monitor.) 

These alternative layouts are saved for an individual monitor for selecting at run time on the 
video wall. These are called Monitor Layouts and they apply to individual monitors on the 
video wall.

These ‘monitor-level’ layouts form part of the overall Layout Configuration. 

Note: Tile-grid + Tile types = Monitor Layout. 
(See What is a Monitor Layout?.)

Note: Live-Selecting of Monitor Layouts:
Monitor Layouts are live-selectable.

(Monitor Layout in the Room Editor tool is equivalent to 
Wall Layout in the Wall Editor tool in GV Orbit Client.)
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Monitor Layouts can be created (see Create a New Monitor Layout, on page 399).

Monitor Layouts can be selected live for a video wall in X/Y Routing mode (see Step 5b: 
Change Layouts in X/Y Routing Mode, on page 439).

What is a Room Layout?
A Room Layout is a snapshot of Monitor Layouts across the monitors on a video wall. A 
Room Design can have one or more Room Layouts to select from. This ‘room-level’ layout 
applies across a whole video wall in a Room.

(See Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 399, for the 
workflow steps.)

Room Layouts enable a video wall to have various optional, alternative, similar layouts to 
use for different scenarios. Table 8-1 shows some possible example combinations.

Room Layouts can be created (see Create a Room Layout for a Video Wall, on page 404).

Room Layouts can be selected live for a video wall in X/Y Routing mode (see Step 5b: 
Change Layouts in X/Y Routing Mode, on page 439) and, in this mode, they may also be 
created live and saved.

 Table 8-1: Example Room Layouts with different Monitor Layouts Combinations
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What is Destination Assignment for a Room?
Assignment of router destinations to tile positions on the video wall tile-grid allows the 
user to manage video walls, and their specifically tile positions, in terms of router 
destinations.

Assignment of destinations is done for all video walls in a Clustered MV project (i.e. for 
all Rooms in the project). There are two destination assignment mechanisms that can be 
used:

• Static Destination Assignment - see What is Static Destination Assignment?, on 
page 367.

• Dynamic Destination Assignment - see What is Dynamic Destination Assignment?, 
on page 368.

Fig. 8-5: Video Wall - Assigned Destinations

TSL Configuration and Audio Bars Configuration
Additionally, this Room Editor mode allows:

• TSL settings to be configured globally for the Room. 
(See Chapter 9, MV Cluster - TSL Tally Configuration, on page 445.)

• Audio bar configuration for Audio Bars in on-screen graphical widgets to be configured 
globally for the Room. 
(See Chapter 10, Audio Bars Configuration, on page 473.)

What is Static Destination Assignment?
Static Destination Assignment is where one, or more, or all video tiles on video walls are 
manually assigned specific router destinations. It may be implemented partly or fully in a 
system. Full static assignment is suitable in routing systems where each video tile on each 

Router destinations assigned to each tile position.
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video wall from each multiviewer is assigned a fixed, specific router destination, which 
needs to remain static throughout routing operation. (For example, this may be suitable for 
systems with third-party router controllers.)

For a created Room Design, for each monitor in a video wall, the workflow for static 
destination assignment is:

1 Router destinations are manually mapped to multiviewer inputs for all devices in the 
MV cluster.

2 Destinations are then manually assigned to tile positions on the video walls.

This has prepared the Destination Assignments for monitors in a Room. The multiviewers 
are ready have signals routed to them.

What is Dynamic Destination Assignment?
Dynamic Destination Assignment implements routing based on video wall tiles rather 
than on router destinations. This is made possible with the integrated nature of 
multiviewing and routing in a GV Orbit system.

The assignment of router destinations to video tiles is done at run time by a GV Orbit 
service. This keeps track of the current video wall active layouts for each multiviewer. The 
service then knows which multiviewer inputs are actively feeding video tiles and which are 
free. This information is shared with the GV Orbit system.

Upon a video wall layout change, the service re-assigns destinations on the fly to meet the 
needs of the newly switched-to layout. 

In this way:
• A user does not have to keep track of multiviewer input usage across different video 

wall layouts.
• Multiviewer inputs (up to 48 per multiviewer) can flexibly accommodate the needs of 

different video wall layouts.
• It is easier for a user to design video walls, because dynamic destination assignment is 

the default on video tiles from the outset. 
(Note: A video tile can still be set to a static destination, preventing the destination to 
be assigned dynamically if required.)

Note: The GV Orbit Multiviewer Cluster Manager Service (MVCMS) is 
required for the dynamic destinations assignment to function.

Note: TSL assignments made will automatically follow any destination re-
assignments done in dynamic destination assignment mode.
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What is X/Y Routing Source Assignment for a Room?
The final step in designing the video wall (Room) involves routing sources to all of the tile 
positions in each monitor tile-grid. This is done with an integrated, easy-to-use, graphical 
routing panel enabling the user to route by selecting sources and destination tiles.

Fig. 8-6: Video Wall - Routed Sources

The ‘X/Y Routing’ tool mixes a graphical representation of the monitor wall with a (router) 
source selection panel. The monitor wall representation is the (router) destination selection 
panel. 

A source can easily be assigned (routed) to a tile position on a monitor of a video wall. 

See Step 5a: X/Y Routing Video Sources to Tiles, on page 430, for the workflow steps.

Routing Sources Workflow
The workflow for each video tile position on a monitor is:

1 select the tile position in the monitor’s tile-grid (this is the destination to route to); and
2 select the source.

When a route is made, all levels are routed. and tile positions on the tile-grid show their 
logical names.

Router sources assigned to each tile position.
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Room Editor Home Screen

Room Editor Home Screen

Fig. 8-7: Room Editor Screen Example

The Room Editor stores video wall design information for one or more video walls in a 
single ‘Clustered MV’ GV Orbit project (see What is a Clustered Multiviewer Project?). Each 
video wall design is stored in a Room file (see What is a Room?) in the project.

Room Editor Workflow Overview
Room Editor allows a user to easily create video walls. This is an overview of the workflow:

1 Create monitor wall arrangements from one or more monitors and assign multiviewer 
outputs. 

2 Create the layout - Assign tile-grids to each monitor in the video wall and populate with 
tile types, and create all room layouts and monitor layouts.

3 Assign router video destinations to video wall tile positions in the grid. 
4 Assign video sources to video wall tile positions in the tile-grid.

The Room Editor workflow steps are outlined in Room Editor Workflow, on page 373. The 
steps are then fully described in the subsequent sections of this chapter, i.e. in sections: 
Step 1: Create a Room through to Step 5a: X/Y Routing Video Sources to Tiles.

Video wall design open in Room Editor tab window

Room Editor Tool Bar 



371

GV Orbit Client
User Guide

Room Editor Tool Bar
The first few icons in the Room Editor tool bar (see Figure 8-8) follow the MV Cluster video 
wall design’s Room Editor workflow and take the user through the various modes of 
operation of the Room Editor.

Fig. 8-8: Room Editor Tool Bar - Main Icons

Arrange Monitors and Assign MV Outputs Mode
Icons in the Room Editor tool bar in this mode:

Fig. 8-9: Room Editor Tool Bar - Arrange Monitors and Assign MV Outputs Mode

Design Layout Mode
Icons in the Room Editor tool bar in this mode:

Fig. 8-10: Room Editor Tool Bar - Design Layout Mode

Room Editor workflow:
• Select for Arrange Monitors and Assign MV Outputs Mode.
• Select for Design Layout Mode.
• Select for Assign Router Destinations Mode.
• Select for X/Y Routing Mode

Tool bar icons shown depends on workflow step that is active

Click to delete the selected monitor

• Room Layout actions.
• Monitor Layout actions.
• Fine, free-hand positioning of tiles on tile-grid.
• Delete currently-selected item.
• Select all tiles on selected monitor.
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Assign Router Destinations Mode
Icons in the Room Editor tool bar in this mode:

Fig. 8-11: Room Editor Tool Bar - Assign Router Destinations Mode

X/Y Routing Mode
Icons in the Room Editor tool bar in this mode:

Fig. 8-12: Room Editor Tool Bar - X/Y Routing Mode

• Room Layout actions.
• Monitor Layout actions.
• Map multiviewer inputs to router destinations.
• Select all tiles on selected monitor.

• Room Layout actions.
• Monitor Layout actions.
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Room Editor Workflow
The workflow for creating Room designs in the Room Editor is listed here and described in 
the following sections of this chapter. A prerequisite is a GV Orbit ‘Clustered MV’ project 
open in GV Orbit Client. (See Creating a New Clustered Multiviewer Project for an MV 
Cluster, on page 340.)

Workflow steps overview:
• Create a Room (Room File)
• Arrange Monitors and Assign Multiviewer Outputs
• Design Room Layout - Assign Tile Grid Layouts
• Create Optional Alternative Layouts for a Video Wall
• Assign Router Destinations to Tile Positions
• Tally Configuration
• Routing Video Sources to Tile Positions

These steps are outlined in subsequent sections of this chapter, listed as Workflow 
Procedure Steps, on page 375.

Create a Room (Room File)
Firstly, for each video wall, create a Room for each video wall.
See Step 1: Create a Room, on page 376.

Then, for each Room, create a Room Design to form the video wall design, as described in 
subsequent sections:

Arrange Monitors and Assign Multiviewer Outputs
See Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 378.

Position monitors on a ‘stage’; define monitor types (includes size, orientation, single HD or 
quad-split for UHD); and assign one or more MV outputs to each monitor.

Design Room Layout - Assign Tile Grid Layouts
See Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 390.

Note: The Assign Multiviewer Outputs mode of the Room Editor does 
not use ‘Run mode’ ; the ‘Design/Run Mode’ tool bar icon is hidden
(See Design Mode / Run Mode, on page 134.)
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Assign tile-grid templates to the monitors of the video wall; populate with tiles; and 
customize if required to form the video wall layout. Additionally, manage destinations 
assigned to the video wall tiles.

Create Optional Alternative Layouts for a Video Wall
See Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 399.
 This mode enables creates different layouts for the video monitor wall.

Assign Router Destinations to Tile Positions
See Step 4a: Assign Destinations to Tile Positions, on page 408.

This mode: maps destinations to multiviewer inputs; assigns destinations to video wall tile 
positions on each tile-grid; and can also be used to assign TSL settings for the Room.

The mapping made between router destinations and multiviewer inputs needs to be made 
whether operating in the Dynamic Destination Assignment mode or in the Static 
Destination Assignment mode, or in a mixture of both. All the destinations that are 
mapped to tiles configured for dynamic assignment will be assigned dynamically.

Tally Configuration
See Step 4b: Configure TSL Tally Settings for a Room, on page 429.
Optional at this stage and may be done separately later.

Routing Video Sources to Tile Positions
See Step 5a: X/Y Routing Video Sources to Tiles, on page 430.

Note: Design Room Layout mode of the Room Editor may operate in GV 
Orbit Client’s Design or Run Mode.
(See Design Mode / Run Mode, on page 134.)

Note: The Assign Router Destinations mode of the Room Editor does not 
use ‘Run mode’ ; the ‘Design/Run Mode’ tool bar icon is hidden. 
(See Design Mode / Run Mode, on page 134.)
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This mode routes required sources to video tiles for the required video monitoring. 
Different video monitor wall layouts can be selected from this Room Editor mode and seen 
live on the video monitor wall. Additionally, new layouts can be tried and saved.

Workflow Procedure Steps
Workflow steps described in subsequent sections of this chapter:

• Step 1: Create a Room, on page 376
• Step 2: Arrange Monitors and Assign Multiviewer Outputs, on page 378
• Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 390
• Step 3b: Create Optional Alternative Layouts for a Video Wall, on page 399
• Step 4a: Assign Destinations to Tile Positions, on page 408
• Step 4b: Configure TSL Tally Settings for a Room, on page 429
• Step 5a: X/Y Routing Video Sources to Tiles, on page 430
• Step 5b: Change Layouts in X/Y Routing Mode, on page 439

Note: Routing Video Sources mode of the Room Editor operates in ‘Run 
Mode’, allowing live changes on a video wall to be made.
(See Design Mode / Run Mode, on page 134.)
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Step 1: Create a Room
Create a Room (Room file) with the Rooms icon from the Home Page or from the Project 
window. All video wall design information for one video wall will be stored in the Room 
file. A project may contain one or more Room files, which are shown in the Project window.

Create a Room for each video wall.

Procedure
To create a Room in the project from the Home Page:

1 Click the Rooms icon on the Home Screen and click New Room.

The New Room File dialog is shown. (See Figure 8-13)

Fig. 8-13: New Room File Dialog

2 Enter a name for the Room and click OK.

A new, empty Room is created and is shown in the Project window in the ‘rooms’ sub-
folder.

Click OK.

Enter a name for the Room file.

Click New Room.
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Fig. 8-14: Create New Room File

Alternative Procedure, from Project Window
Alternatively, to create a Room from the Project window (see Figure 8-15):

1 Right-click on the ‘rooms’ folder in the Project window and select New Room.

Fig. 8-15: Create New Room File

The New Room File dialog is shown.
2 Enter a name for the Room and click OK.

A new, empty Room file is created and is shown in the Project window in the ‘rooms’ 
sub-folder.

Room file is created and shown 
in the Project window.

Project window ‘rooms’ sub-folder.

Rt-click on ‘rooms’ folder in 
Project window. 
Select New Room.
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Step 2: Arrange Monitors and Assign Multiviewer Outputs

Prerequisites:
• There is a new Room in GV Orbit Client as part of a Clustered MV project.
• Multiviewers in the multiviewer cluster are discoverable or have been manually 

entered into the GV Orbit Client via the ‘Multiviewer > Multiviewer Cluster’ dialog of 
the Clustered MV project.

a) Arrange Monitors

b) Assign Multiviewer and Multiviewer Outputs

Cluster of multiviewers

Monitors

Video Wall Room Design
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Procedure
Overview of procedure:

• Drag Monitors onto Video Wall Stage Area, on page 379.
• Configure Monitor on Video Wall Stage Area, on page 382.
• Arrange Monitors on Video Wall Stage, on page 386.

Drag Monitors onto Video Wall Stage Area
To position monitors for one video wall, in the Project window:

1 Open the Room by double-clicking on the Room file name, or by right-clicking on it 
and selecting Open.

The Room opens in the Room Editor in GV Orbit Client. When first opened, the Room 
is shown in its ‘Assign Multiviewer Outputs’ mode. And All multiviewer outputs are 
listed in a banner at the top of the central stage area.

Fig. 8-16: New Room in Room Editor (‘Assign Multiviewer Outputs’ Mode shown)

Room name 
shown in tab.

Stage area

Room Editor tool bar Multiviewer outputs listed 
in banner,

’Assign Multiviewer Outputs’ mode button is selected.
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Note: If there are no multiviewer devices in the cluster, then the banner area 
is empty and a message appears at the bottom of the stage area, 
instructing the user how to add multiviewer devices to the cluster. 

“No multiviewers have been automatically discovered. 
To manually add a multiviewer, 
click ‘Multiviewer > Multiviewer Cluster’ from the tool bar menu.”

Fig. 8-17: Message at the Bottom of the Stage Area

(See Managing Multiviewer Cluster Information in a Project, on 
page 355 for a description of adding multiviewers to cluster.)

Note: Banner Controls:
The multiviewer outputs banner area has controls to help locate 
multiviewer outputs (especially useful with several multiviewers and 
outputs). Controls are (see Figure 8-18):

• Scroll control - A vertical scroll to see multiviewer outputs.
• Resize control - A splitter bar to re-size the banner and see 

more multiviewer outputs at one time.
• Filter control - A filter control to locate multiviewer outputs in 

the banner.

– Enter text in the filter text box. 
For example, Enter ‘Output 1’ to see:
multiviewer outputs ‘Output 1 MV1’, ‘Output 10 MV1’ ... and 
‘Output 1 MV2’, ‘Output 10 MV2’ etc. 
Note that this is case sensitive. For example, seraching for 
output returns nothing, where Output does find results.

– Click on the filter symbol and select a multiviewer name in 
the drop-down list to see all outputs from that multiviewer.

To clear the filter, clear the filter text box.
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2 Drag a multiviewer output from the banner onto the stage area and release.

Fig. 8-18: Drag on a Multiviewer Output

A representation of the monitor appears on the stage. See Figure 8-19. 

Fig. 8-19: Dragged-on Monitor

All multiviewer outputs

Drag a multiviewer 
output onto the stage

Use scroll control to see 
multiviewer outputs.

Drag splitter bar to see more/fewer 
multiviewer outputs.

Use the filter control to find 
multiviewer outputs.

Drag on

Monitor label: 
Output and multiviewer device is 
indicated in label for display 
purposes in the Room Editor.
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Configure Monitor on Video Wall Stage Area
1 Configure the monitor on the stage area by double-clicking on it.

The Configure Monitor dialog is shown (see Figure 8-20), where monitor properties 
can be changed.

2 Also, when a monitor is selected, 
its properties may be viewed and edited in the Properties window. 
To view the Properties window:

• Select the ‘Properties Window’ button in the main tool bar. See Figure 8-20.)
• Right-click on the monitoring and select Configure Output.

Note: For display purposes in the Room Editor, 
each monitor on the stage area has a label indicating which 
multiviewer output and device is being used for the monitor.

Note: Monitor Aspect Ratio:
Monitors aspect ratio should be 16:9.
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Fig. 8-20: Configure Monitor Dialog

To edit monitor properties, set up the monitor parameters in the Configure Monitor 
dialog, including:

3 TV Size - Enter the nominal monitor screen diagonal size (inches). 

When a value is entered:

• indicates a supported size; and

• indicates an unsupported size.

4 Rotation - Select the monitor screen orientation used: 

• Landscape ( ), 

Double-click on monitor to show its Configure Monitor dialog

Select Properties Window button to show Properties Window.
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• Portrait ( ); or 

• Inverted Portrait ( ).
5 Resolution - Define whether monitor is an HD monitor, or a UHD monitor (requiring 

quad-link multiviewer outputs) by selecting the corresponding icon:

• HD monitor ( ).

• UHD monitor, requires 4x multiviewer (HD) outputs ( ).

The following multiviewer assignment settings of the monitor are automatically set up 
when the monitor is dragged onto the screen. However, these may be changed in the 
Configure Monitor dialog, if required:

6 Multiviewer - Select a different multiviewer device to be assigned to the monitor, if 
required.

7 Multiviewer Output - Select different multiviewer output(s) (head output) to be 
assigned to drive the monitor. (Already-used outputs are grayed-out.)

For:
• HD monitors, select one output (see Figure 8-21a). 
• UHD monitors, select four outputs for driving the four monitor picture quadrants 

(see Figure 8-21b).
8 Re-ordering UHD monitor quadrants, if required, enables the user to quickly and easily 

compensate for any quadrant wiring mis-matches. For UHD monitors:
• Re-order four the quadrant inputs by dragging monitor quadrants in the dialog, 

see Figure 8-21c.



385

GV Orbit Client
User Guide

Fig. 8-21: Select Multiviewer Outputs for Monitor:
a) HD Monitor - one output selected.
b) UHD Monitor - four outputs selected.
c) UHD Monitor - selected outputs rearranged.

9 Monitor Name - Enter an optional operational name for the monitor, which will appear 
on the monitor label. For example “Cameras”, see Figure 8-22.

b) UHD Monitor - four outputs selected. c) UHD Monitor - outputs rearranged

a) HD Monitor - one output selected.
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Fig. 8-22: Monitor Name

Additionally, the following TSL item may be set up:
10 TSL 5.0 screen index to use by default for video tiles shown by the multiviewer output.

Finally, 
when all settings changes are complete in the dialog:
11 Click OK in the Configure Monitor dialog.

This has configured the monitor.

Arrange Monitors on Video Wall Stage
1 Position the monitor on the video wall stage area.

Enter an operational name for the monitor, 
which appears on the monitor label.

Note: If using the TSL 5.0 tally protocol, then set the TSL 5.0 screen index 
for each monitor screen.

Note: Undo / Redo:
Edits in the Room Editor are all un-doable and re-doable with the 
usual GV Orbit Client key strokes:

• CTRL-Z (undo action); and 
• CTRL-Y (redo action).



387

GV Orbit Client
User Guide

Then:
2 Drag on further monitors, configure and position these to form your video wall monitor 

arrangement by abutting monitors on the stage.

Note: Fine Positioning:
Monitors can be finely-positioned using the arrow keys. 

Note: When dragging monitors on the stage, overlap of monitors is not 
permitted in a video wall. Any overlapping areas are shown in red.

Note: Monitor Alignment:
Monitors can be aligned and arranged on the stage using the GV 
Orbit Client’s alignment tools in the tool bar.

Note: Snap-to-Monitor and Snap-to-Grid:
Monitors will snap to other monitors on the stage when brought 
close. 
If ‘snap to grid’ is turned on for the Room Editor, then snap-to-grid 
takes precedence over snap-to-monitor when positioning monitors. 
(‘Tools > Option > App’ in main menu for Room Editor grid controls.)
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3 Click Project > Save File in the main menu to save changes to the Room file.

This has created a Room Design in a Room file in the Clustered MV project. 

A video wall is defined with its constituent monitors and connected to multiviewer outputs 
from the MV cluster.

Finally:
4 Repeat this for each video wall required for each Room.

Notes Etc. for Monitor Arrangement

Note: Copy-Paste Monitors with CTRL-C and CTRL-V:
Monitors can be copy-pasted for quick editing on the stage. The 
configuration of a copied monitor must be set up accordingly in the 
Configure Monitor dialog.
To copy-paste a monitor:

• Select a monitor on the stage and press CTRL-C. 
• Click elsewhere on the stage and press CTRL-V to paste a 

copy of the monitor. 
(Further CTRL-V will paste more monitors.)

CAUTION 
Multiviewer Outputs for UHD monitors:
When assigning four multiviewer outputs for a UHD 
monitor use any four licensed outputs from the same 
multiviewer device.
Note: All four outputs must be from the same multiviewer 
device. (This enables the required quad-split to be formed 
from four (HD) multiviewer outputs.)

Note: Landscape and Portrait:
Room Editor:
When using the Room Editor, a monitor arrangement can mix 
‘Landscape’ and ‘Portrait’ monitors.
Wall Editor:
However, when using the older Wall Editor, there is a restriction that 
‘Landscape’ and ‘Portrait’ must not be mixed on a video wall. 
(This restriction does not apply when using the Room Editor and a 
cluster of multiviewers.)
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Example Monitor Arrangement
Figure 8-24 shows an example video wall monitor arrangement with assigned multiviewer 
outputs.

Fig. 8-24: Example Video Wall Monitor Arrangement

Next step: Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall

Note: Monitor Properties:
When the Properties window is open, selecting a monitor in the 
video wall stage area will show the monitor’s properties in the 
Properties window.

Fig. 8-23: Monitor Properties in Properties Window



390

MV Cluster - Room Editor
Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall

Step 3a: Design Layout - Assign Tile Grid Layouts to a Video Wall

Prerequisites:
• There is a Room file open in the Room Editor which has a Room Design.

Note: Tile Grid relates to a grid arrangement of tiles on a video wall 
monitor. This ‘grid’ is different to the ‘drawing grid’ that can be 
enabled in graphical drawing tools, such as in the Room Editor in 
GV Orbit Client. 
(‘Drawing grid’ controls are accessed via ‘Tools > Options > App’ in 
the main menu.)

Tile layouts

Video Wall Tile Layout Configuration
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Procedure to Assign Tile Grids
To assign tile-grids to a video wall, in the Project window:

1 Open the Room file in the Room Editor. 
2 To select the grid design mode, select the Design Layout icon.

Fig. 8-25: Room Editor Tool Bar - Design Layout Icon

The Room Design is now shown in Design Layout mode which shows the available 
Tile Grid templates. See Figure 8-54.

Fig. 8-26: Design Layout Mode in Room Editor

Design Layout icon selected

Available Tile Grid templates

Monitor header, showing: Multiviewer Output and Device
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To apply a grid layout to a monitor:
3 Select a monitor by clicking on its monitor header.
4 Then select a tile-grid from the available Tile Grid templates.

The grid is applied to the monitor.

Two things have actually happened to the monitor:

i) a grid layout has been applied; and 

ii) the grid has been automatically populated with video tiles.

Fig. 8-27: Apply Tile Grid Template to Monitor

5 Apply grid layouts to all monitors.

When all monitors have been assigned grid layouts:
6 Click Project > Save File in the main menu to save the grid layout changes to 

the Room.

Note: Tile-grids are automatically populated with video tiles by default 
when added to a monitor. The tiles populated on a tile-grid can be 
configured as required or replaced with customs Tiles. See Monitor 
Layouts and Tiles, on page 401.

Select Tile Grid template

Select monitor

Unassigned monitorsAssigned monitors
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This has quickly defined the layout of the video wall using tile grids from the available 
templates. Figure 8-28 shows an example.

Fig. 8-28: Example Quick Grid Layout on Video Wall

A Room Layout has been generated. 

Modifying a Tile-Grid on a Video Wall
Quick edits to a tile-grid of a video wall can be done in Design Layout mode. The following 
example modifies the video wall shown in Figure 8-28 on page 393:

1 Select a monitor to modify. 

’Dynamic’ indicates tile has 
Dynamic Destination Assignment enabled.

Note: Each video tile in each tile-grid by default has ‘Dynamic 
Destination Assignment’ enabled, by default.
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Fig. 8-29: Selected Monitor to Modify

2 Select a new Tile Grid template.

The new Tile Grid is assigned and shown on the monitor.

Fig. 8-30: Modified Grid Layout

3 Click Project > Save File to save the grid layout in the Room file.

Selected Monitor to 
modify

New grid layout on 
monitor

Select new Tile Grid 
template to use.
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Customizing a Tile-Grid on a Video Wall
Further, a custom change can be made to a grid layout in Design Layout mode.

In Design Layout mode:
1 Select a monitor to modify. 

Fig. 8-31: Select a Monitor

2 Select a tile position in the monitor’s tile-grid.

Fig. 8-32: Select a Tile Position in a Tile-Grid

3 Drag a corner of the tile position and release it to resize it.

Fig. 8-33: Resize a Tile Position in a Tile-Grid

A video wall’s tile-grid layout on one monitor has been customized.

This customized tile-grid may be saved, see Saving a Customized Tile-Grid.

Select a tile position.

a) Drag a Corner of a Tile Position

Drag tile position corner

b) Release a Corner of Tile Position
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Saving a Customized Tile-Grid
For a customized tile-grid that is on a video wall, to add it to the available templates in 
Design Layout mode:

1 Select the monitor containing the with the customized tile-grid.

Fig. 8-34: Select a Monitor Grid Layout

2 Click Add Grid.

The Tile Grid of the selected monitor is added to the available templates and is then 
available for use in the project.

Fig. 8-35: Custom Grid Layout Added to Available Grid Templates

3 Click Project > Save File to save the video wall’s grid layout in the Room file.

Select customized monitor
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A customized grid layout has been saved in the Room and can be re-used. The information 
is stored in the Room file in the project.

Example Customized Tile-Grids 

Fig. 8-36: Example Grid Layout with Two Customized Monitor Grid Layouts

Customized Tile-Grids saved as Tile-Grid Templates
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Fine Positioning of Tile Positions on a Tile-Grid
So far in this chapter, the tile grids have been populated with tiles placed at tile-positions of 
the (template) tile-grid. A tile-position may be repositioned ‘off-grid’ when in Design 
Layout mode:

1 Click on the Freehand Positioning icon (see Figure 8-37). 

Fig. 8-37: Freehand Positioning Icon

The stage now enables the freehand positioning of tile-positions.

Fig. 8-38: Freehand Positioning Icon

2 Select a tile at a tile position on a tile-grid.
3 Move it, or drag one of its corners, to finely reposition it.
4 Click Save File in the main tool bar to save the change.

Lastly:
5 Click on the Freehand Positioning icon to toggle freehand mode off. 

Drag corner
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Step 3b: Create Optional Alternative Layouts for a Video Wall
Design Layout mode can be used to create different layouts for a video wall.

In a Room, each video wall monitor can have more than one possible tile-grid layout. (This 
is called a Monitor Layout. See What is a Monitor Layout?, on page 365 for further 
information.)

A Room Layout is a snapshot of Monitor Layouts on a video wall and a Room can have 
more than one Room Layout for its video wall. 
(See What is a Room Layout?, on page 366 for more information.)

Use the Room Editor’s Design Layout mode to optionally create alternative layouts for a 
video wall, either for its monitors:

• Create a New Monitor Layout.
• Monitor Layouts and Tiles.

Or for the whole video wall:
• Create a Room Layout for a Video Wall.

Create a New Monitor Layout
To create a new Monitor Layout for a monitor on a video wall, in Design Layout mode:

1 Select a monitor. 

Fig. 8-39: Select a Monitor

2 Click on the Monitor Layout icon ( ) in the Room Editor tool bar and 
select ‘New Monitor Layout’.

Fig. 8-40: Select ‘New Monitor Layout’
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3 Enter a name for the new Monitor Layout and click OK.

Fig. 8-41: Enter a Name for the New Monitor Layout’

4 Select a new Tile Grid template from those available.

The selected template appears on the selected monitor.

Fig. 8-42: Select New Tile Grid Template

5 Click Save File in the main tool bar.

This has created a new tile-grid layout for use by the selected monitor. Further Monitor 
Layouts for the monitor may be created.

New selected Tile Grid appears on monitor.
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List Monitor Layouts
To see what Monitor Layouts there are for a monitor:

1 Select the monitor.
2 Click the Monitor Layout icon.

The pop-up menu lists the available Monitor Layouts for the selected monitor. See 
Figure 8-43. A radio button allows a Monitor Layout to be selected.

Fig. 8-43: List Monitor Layouts for a Selected Monitor

Monitor Layouts and Tiles
A tile grid is populated with tiles. Monitor Layouts also record the type of tile at each 
populated tile position. In this way, two Monitor Layouts may have the same tile-grid but 
contain different tiles. Tile change-overs on a video wall can then be recalled with a 
Monitor Layout. 

Tile types to populate a tile-grid with include:
• an Auto-tile configured as a video tile. (See Configured Video Tile, on page 402.)
• an Auto-tile configured as a clock tile. (See Clock Tile, on page 402.)
• a Custom Tile.

A new Monitor Layout can be created for each change of tile type and saved. Then a 
Monitor Layout can be recalled and saved as a Room Layout (see Create a Room Layout 
for a Video Wall, on page 404).
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Configured Video Tile

Fig. 8-44: Configured Video Tile Example

Clock Tile

Fig. 8-45: Dragged-On Clock Tile Example

Video tile properties changed in Properties box

Properties of selected tile

Drag tile on
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Custom Tile

Fig. 8-46: Drag on Custom Tile

a) Edit a video tile in the Tile Editor to create a Custom Tile

b) Drag Custom Tile onto Tile Grid in Room Editor

Image widget added Digital Clock widget added

UMD widget added

Audio Bars widget configured 
for more bars etc.

Drag tile onto the stage
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Create a Room Layout for a Video Wall
Prerequisite:

• One or more Monitor Layouts have been generated for each monitor in the video wall 
of the Room.

With various Monitor Layouts created for monitors, different Monitor Layouts can be 
selected and saved as new Room Layouts for a video wall. 

To create a new Room Layout based on the current Room Layout:
1 View a video wall in Design Layout mode.

Fig. 8-47: Video Wall in Grid Layout Mode.

2 On each monitor in the video wall, select the required Monitor Layouts on each 
monitor.

3 Click on the Room Layout icon ( ) and select ‘New Layout’. 

Fig. 8-48: Select New (Room) Layout
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4 Enter a name for the new Room Layout and click OK.

Fig. 8-49: Enter a Name for the New Room Layout

This creates a new Room Layout from the current one. 

To make a change to this new Room Layout:
5 Select a monitor that has more than one Monitor Layout and 

then right-click on it.

A drop-down menu appears.
6 Select ‘Switch Monitor Layout’ and 

select a Monitor Layout from the list. (See Figure 8-50.)

Fig. 8-50: Select a Monitor Layout

The selected monitor shows the new Monitor Layout.

Select a tile
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Fig. 8-51: New, Selected Monitor Layout

7 Click Save File in the main tool bar.

The new Room Layout now uses the selected Monitor Layout for the selected 
monitor.

Edit an Existing Room Layout
To edit an existing Room Layout:

1 View the Design Layout mode and select the Room Layout to be edited.
2 Select a monitor and, for that monitor, select a new Monitor Layout.
3 Click Save File in the main tool bar to save the modified Room Layout.
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Example Room Layouts

Fig. 8-52: Example Room Layouts 1 to 5

Next step: Step 4a: Assign Destinations to Tile Positions

Example Room Layout1

Example Room Layout2

Example Room Layout3

Example Room Layout4

Uses Monitor Layout = “Layout_5x5”

Uses Monitor Layout = “Layout_4x4”

Uses Monitor Layout = “Layout_2x2”

Uses Monitor Layout = “Layout1”

Uses Monitor Layout = “Layout_3x3”

Example Room Layout5
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Step 4a: Assign Destinations to Tile Positions

This step (Step 4a: Assign Destinations to Tile Positions)associates router destinations to 
video wall tiles. 

For video tiles which are configured for Static Destination Assignment, the assignments 
made are used unchanged.

For video tiles configured for Dynamic Destination Assignment, then the assignments 
made define which destinations may be dynamically routed.
(Note: This needs the Multiviewer Cluster Manager Service running on the GV Orbit server), 

Prerequisites:
• There is a Room open in the Room Editor which has a Room Design which defines a 

video wall which has a Design Layout. 
• Router destinations have been set up in the router controller (GV Orbit Control).
• The Routing service is connected to GV Orbit Control.

Router destinations assigned to each tile position.

Assign Router Destinations to Video Wall Tile Positions
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Procedure Overview
The Assign Router Destinations workflow is presented below in the following steps:

• Step 4a-1: Open Room Editor in Assign Destinations Mode
• Step 4a-3: To Edit a Tile to be Static
• Step 4a-2: Map Router Destinations to Multiviewer Inputs
• Step 4a-4: Assign Mapped Destinations to Tile Positions

And then some TSL configuration settings may be optionally set up (or set up later, as 
required):

• Step 4b: Configure TSL Tally Settings for a Room 

Step 4a-1: Open Room Editor in Assign Destinations Mode
By default, destinations are set to dynamic mode. To assign multiviewer router destinations 
to a video wall, in the Project window:

1 Open the Room in the Room Editor. 
2 To select the destination assignment mode, select the Assign Destinations icon.

Fig. 8-53: Room Editor Tool Bar - Assign Destinations Icon

The Room Design is now shown in Assign Destinations mode. See Figure 8-54.

Fig. 8-54: Assign Destinations Mode in Room Editor - First Screen

Assign Destinations icon selected

Icon indicates that 
a video wall tile 
uses Dynamic 
Destination 
Assignment
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Note: Video tiles that are using the Dynamic Destination Assignment

mode are indicated with a  icon.



411

GV Orbit Client
User Guide

Step 4a-2: Map Router Destinations to Multiviewer Inputs
Router destinations should have already been reserved for all multiviewer inputs of the MV 
cluster in the routing system. These each need mapping to the multiviewer inputs for our 
Clustered MV project for either the Static Destination Assignment case or Dynamic 
Destination Assignment case.

First, map the destinations before the assignments can be done.

In the Room Editor tool bar in Assign Destinations mode, to map destinations to 
multiviewer inputs:

1 Click on the Configure Mapping icon.

Fig. 8-55: Room Editor Tool Bar - Assign Destinations Mode, Configure Mapping Icon

A Destination Configuration tab is opened which lists all multiviewer devices in the 
cluster. For each multiviewer, all multiviewer inputs are listed. Initially this list is 
empty.See Figure 8-56.

Fig. 8-56: Destination Configuration Tab

To map router destinations to multiviewer inputs:
2 Select the multiviewer.
3 Click on the ‘Destinations’ column heading to select all multiviewer inputs.

Click on Configure Mapping icon
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Fig. 8-57: Select Multiviewer, Select All Inputs

All inputs of the selected multiviewer are selected. 
4 Alternatively, select a range of inputs by:

• clicking on the first empty destination box in the range;
• scrolling down the list; and 
• SHIFT-clicking on the last item. 

See Figure 8-58.

All inputs in the range are selected. 

Fig. 8-58: Select Multiviewer and Select Multiviewer Input Range

Click on column heading to 
select all multiviewer inputs.

Select

SHIFT-Select to select a range
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With inputs selected:
5 Click on the Destination Picker icon in the Destination Configuration tab tool bar.

Fig. 8-59: Multiviewer Selected and Inputs Selected

The Add Destinations dialog is shown, which shows a filterable and scrollable list all of 
the destinations of the GV Orbit routing system. See Figure 8-60. 

Click on the Destination Picker icon
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Fig. 8-60: Add Destinations Dialog

6 Typically, destination names have consistent and logical naming. 
(For example, ‘MV-1 Dest**’, or ‘MV-2 Input**’ . )

Note: List items can be selected in a similar way to using the Bulk Routing 
Panel: Select and item, then SHIFT-select to select a range of items 
and CTRL-select to add individual items to the selection. 

Scrollable

Tool bar icons:
• Select all - Select all destinations displayed in the dialog.
• De-select All - De-select all destinations.
• Wide Buttons - Click to toggle Destination button width.
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If required, use the filtering to locate the destinations for your selected multiviewer 
inputs.

7 Select the range of destinations for the selected multiviewer inputs. (Select, then SHIFT-
Select.)

Fig. 8-61: Selected Range of Destinations

8 Click OK in the Add Destinations dialog.

The selected destinations are mapped and listed against the multiviewer inputs.

Note: Useful Filter feature:
When assigning router destinations to multiviewer inputs, typically, 
the destinations intended for multiviewer inputs are consistently and 
logically named. The filter feature of the Add Destinations dialog can 
then be used to easily list the destinations required.

Select

SHIFT-Select

Select

Filtering on MV*
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Fig. 8-62: Selected Destinations Mapped to Multiviewer Inputs

Some multiviewer inputs have been mapped to destinations. 

Now:
9 Repeat these steps to map all of the multiviewers and their inputs to router 

destinations.
10 Click Save File.

When all multiviewer inputs have been mapped to destinations and saved:
11 Close the Destination Configuration tab.

Fig. 8-63: Close Destination Configuration Tab

All multiviewer inputs have been mapped to router destinations.

Note: Changes made in the Destination Configuration tab need to be 
saved before the changes can be seen in the Room Editor.

Destinations mapped 
to multiviewer inputs
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Step 4a-3: To Edit a Tile to be Static
Dynamic Destination Assignment is the default tile configuration. It may be applied to 
one, or more, or all video tiles. It is possible to mix dynamic- and static-assigned tiles.

To configure a tile for Static Destination Assignment:
1 Select a tile.

Fig. 8-64: Preparing to Set a Static Destination

2 Deselect the Automatic Destination Assignment button.

Router destinations are listed in the lower pane. See Figure 8-77.

Select a tile.

Deselect the 
Automatic 
Destination 
Assignment 
button.
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Fig. 8-65: Set a Static Destination

If no destinations are listed on the lower pane, then see Step 4a-2: Map Router 
Destinations to Multiviewer Inputs, on page 411, for instructions for manually mapping 
router destinations.

Once destinations are listed:
3 Select a multiviewer input in the lower pane.

The selected tile now indicates its static router destination setting.
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Fig. 8-66: Static Destination for a Tile

4 Click Save File in the main menu.

Selected tile has a 
static router 
destination 
setting.
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Step 4a-4: Assign Mapped Destinations to Tile Positions
The video wall tab shows our video wall and we have mapped destinations to multiviewer 
inputs.

Fig. 8-67: Video Wall Tab Ready for Assigning Mapped Destinations to Tile Positions

The workflow is presented with these sub-sections:
• Assign Single, Static Destination to Single Tile Position.
• To Assign Static Destination(s) to All Tile Positions on a Monitor’s Tile-Grid.
• Assign (Static) Series of Destinations to Multiple Tile Positions.

And:
• Delete a Destination Assignment.
• Edit a Static Destination Assignment.
• Edit a Tile - Static to Dynamic Destination Assignment.

Assign Single, Static Destination to Single Tile Position
To assign static destinations to tile position:

1 Select a tile position on a monitor.

For the selected position, the destinations mapped to the corresponding multiviewer 
are listed below. These are all possible destinations for the selected position. See 
Figure 8-68.

Note: This step is only required to be done for tiles which are configured for 
Static Destination Assignment.

Monitor header areas annotated 
with multiviewer output 
information.

Video wall tiles populated 
in the tile positions
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Fig. 8-68: Possible Mapped Destinations for Selected Tile Position

2 Select a destination.

The destination is assigned as a static destination to the tile position, which is 
annotated with the destination name.

Fig. 8-69: Static Destination Assigned to Tile Position

This has assigned a static destination to a tile position on the tile-grid. Other tile positions 
can be assigned static destinations similarly.

To Assign Static Destination(s) to All Tile Positions on a Monitor’s Tile-Grid
To quickly assign static destinations, all tile positions on a monitor can be selected and 
assigned:

1 Double-click on a monitor header area.

All tile positions on the monitor are selected.

Destinations mapped 
to multiviewer

Click to toggle wide 
buttons

Selected tile 
position

Tile position annotated with assigned (static) destination name.

Tile position is unassigned.
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Fig. 8-70: Select All Tile Positions on Monitor

2 Select a destination.

An Assign Destination to Multiple Tiles dialog pops up. See Figure 8-71.

Fig. 8-71: Assign Destination to Multiple Tiles Dialog

Double-click on monitor header area to select all tile positions on the monitor.

Select a destination.

Select several tiles.
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3 In the Assign Destination to Multiple Tiles dialog:
• Click Fill Series to fill the selected tile positions with a series of destination, starting 

from the selected one.
• Click Duplicate Destination to fill all the selected tile positions with the selected 

destination.

Figure 8-72 shows the result of doing Fill Series.

Fig. 8-72: Result of Fill Series

Assign (Static) Series of Destinations to Multiple Tile Positions
Assignment by Fill Series can be done to a selection of tile positions: 

1 Select tile positions from the same multiviewer with ‘select’ and ‘SHIFT-select’. 
2 Use ‘Fill Series’ to assign static destinations.

Series-filled tiles
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Delete a Destination Assignment
1 Select one or more tile positions.
2 Click the Unassign icon or press the Delete key to delete the destination assignment.

Fig. 8-73: Deleted Destination Assignment

Edit a Static Destination Assignment
1 Select a tile position.

Fig. 8-74: Selected Tile Position

2 Select a new static destination.

Fig. 8-75: Select New Destination

The new static destination assignment is made.

Destination assignment deleted.

Unassign icon

Tile position selected

Selected destination
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Fig. 8-76: New Static Destination Assignment

New static destination assignment
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Edit a Tile - Static to Dynamic Destination Assignment
To set dynamic assignment for a static assignment tile:

1 Select a tile.
2 Select the Automatic Destination Assignment button in the lower pane.

The selected tile now indicates its dynamic router destination setting. See Figure 8-77.

Fig. 8-77: Make a Static Destination Assigned Tile Dynamic

3 Click Save File in the main menu.

Select a static tile.

Click on the 
Automatic 
Destination 
Assignment 
button.

Automatic Destination Assignment 
button is shown selected.

Selected tile now has 
Dynamic Destination Assignment.

a) Select a static tile b) Tile now has dynamic destination assignment
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Destination Assignment Notes

Example Static Destination-Assigned Video Wall
The video wall is now managed in terms of destinations.

Fig. 8-78: Example Video Wall Tab

The destination assignment needs only to be done once in a project.

Note: When assigning static destinations:
• assigning the same destination to more than one tile position is 

permitted. 
Note: For MV-8XX multiviewers, the architecture of the MV-8 Series 
core multiviewer has one image scaling function per multiviewer 
input. If one destination is assigned to more than one tile position, 
then the video image is viewed at the smallest resizing scale.

• not all destinations need to be assigned.

Note: Prerequisites of assigning router destinations is that:

1 The router controller (‘GV Orbit Control’ in the GV Orbit system) 
is configured with destinations reserved for use by multiviewer 
inputs in its topology. 
Please see the GV Orbit Control User Guide.

2 The GV Orbit Routing service must have a valid connection to 
‘GV Orbit Control’. 
Please see the GV Orbit Admin Guide.
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Next
When all destination assignment is done (dynamic, static, or a mixture) to multiviewer 
inputs and tile positions, then TSL Tally configurations (including for TSL address mappings 
to multiviewer inputs and video wall tile) can optionally be done. See Step 4b: Configure 
TSL Tally Settings for a Room.

After this, the next step in video wall design is: Step 5a: X/Y Routing Video Sources to Tiles

Note: The TSL Tally configuration can also be done separately later. It is 
optional at this stage in video wall design.
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Step 4b: Configure TSL Tally Settings for a Room
Following the assignment of destinations to multiviewer inputs and mapping to video wall 
tile positions in the Room Editor ‘Assign Destinations’ mode, TSL Tally configuration for the 
Room can also be done. 

Configuring the TSL settings is described in Chapter 9, MV Cluster - TSL Tally Configuration, 
on page 445.

After this optional TSL Tally configuration step during video wall design, the next step in 
video wall design is: Step 5a: X/Y Routing Video Sources to Tiles

Note: The Destination Assignments should be all completed in the Room 
Editor before for the Tally settings can fully function and map to 
video wall tiles etc.

Note: TSL configuration is optional at this stage of the video wall design 
(Room design) and it can be set up later, if required.
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Step 5a: X/Y Routing Video Sources to Tiles

Prerequisites:
• There is a Room file open in the Room Editor which has a Room Design defining a 

video wall which has a assigned router destinations. 
• Clustered Multiviewer project has been pushed to the repository on the GV Orbit 

server.
• The Multiviewer Cluster Manager Service (MVCMS) is running on the GV Orbit server 

and is set to use the pushed project from the repository.

Router sources assigned to each tile position.

X/Y Routing of Video Sources to Video Wall Tile Positions
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Introduction
X/Y Routing mode has a live connection to the multiviewer cluster via the MVCMS service.

When using dynamic destinations, a live connection (through the MVCMS service) to an MV 
unit is required, otherwise the tiles will show up without any destinations assigned to them. 

The X/Y Routing workflow is presented in the following sub-sections:
• Open ‘X/Y Routing’ in the Room Editor
• Procedure for ‘X/Y Routing’ to a Video Wall Tile Position
• Route a Source to Multiple Tile Positions
• Route Multiple Sources to Multiple Tile Positions

Additionally, in this X/Y Routing mode of the Room Editor, the selection or creation of a 
different Room or Monitor Layout is shown live on the multiviewer video wall, see Step 5b: 
Change Layouts in X/Y Routing Mode, on page 439.

Open ‘X/Y Routing’ in the Room Editor
The routing of sources to video tiles (actually to the tile positions) is done in the Room 
Editor, in its ‘X/Y Routing’ tool. To open this Room Editor facility:

1 Open the Room file in the Room Editor.
2 Click on the X/Y Routing icon to select the mode.

Fig. 8-79: Room Editor Tool Bar - XY Routing Icon

The Room Design is now shown in X/Y Routing mode. See Figure 8-80. 

X/Y Routing icon selected
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X/Y Routing Mode in Room Editor

Fig. 8-80: X/Y Routing Mode in Room Editor

Router sources are listed in a grid below the representation of the video wall showing the 
tiles, which are the routing destinations. Routing ‘Take’ controls appear in the banner area. 
The X/Y Routing mode effectively offers the user an XY routing panel. 

Routings that are made will be reflected on the Room video wall itself.

Router sources grid

Routing ‘Take’ controls

Filter box Sources Filter box

Room Video Wall Tile Destinations

Note: For full information on routing with an XY routing panel, refer to 
Chapter 6, XY Panel Operation, on page 292.
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X/Y Routing Mode Controls

Fig. 8-81: Routing Controls

Fig. 8-82: Router Sources Grid Banner Tool Bar Controls

• Click to Take destination-source selection.
• Click to Cancel destination-source selection.

• Select ‘Take’ action. Make route:
• When Take button is clicked, or when double-clicking on source.
• Immediately when source is selected.

• Click to Release selected destination 
from Lock/Protect.

• Click to Protect selected destination.
• Click to Lock selected destination

• Select All
• Deselect all.
• Sort A to Z
• Sort Z to A
• Toggle wide button size

Sources Filter box, to limit which 
sources are shown.

Note: When routing sources to the video wall, typically, such sources are 
consistently and logically named. (For example, ‘CAM 1’, ‘CAM 2’ etc.) 
The filter feature of the X/Y Routing mode can then be used to easily 
list the source(s) required.
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Procedure for ‘X/Y Routing’ to a Video Wall Tile Position
The procedure broadly operates like an XY routing panel:

• select the destination (where the route is to be made to); and 
• then select the source of the route to be made; and 
• then there is an optional ‘Take’ step.

To route a source:
1 Select a tile position. (This is the destination of the route to be made.)

Note: Any other tile position that is fed by the same source as the selected tile position 
is also selected.

2 Select a router (video) source in the sources grid. (This is the source of the route to be 
made.)

With a destination selected and a source selected, a route is ready to be made. See 
Figure 8-83.

Fig. 8-83: Ready to Make a Router

Selected tile-grid destination

Selected router source
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3 Click the Take button. 

The route is made from the selected source to:

a) the selected tile position (see Figure 8-84); and also to 

b) any other tile Position on the video wall that is fed with the same source.

Fig. 8-84: Routed Result

Routed Source shown on tile

Currently-routed source
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Route a Source to Multiple Tile Positions
To route router sources to a video wall, in the Project window:

1 Select a tile position. 
2 Select further positions with:

• SHIFT-select a range of tile positions; and/or 
• CTRL-select to add positions to the selection.

3 Select a router (video) source in the sources grid. 
4 Click Take.

The routes are made.

Route Multiple Sources to Multiple Tile Positions
To route router sources to a video wall, in the Project window:

1 Select a tile position. 
2 Select further tile positions with:

• SHIFT-select a range of positions; and/or 
• CTRL-select to add positions to the selection.

3 Select a router (video) source in the sources grid. 
4 Select further sources with:

• SHIFT-select a range of sources; and/or 
• CTRL-select to add sources to the selection.

5 Click Take.

The routes are made.

Routing with Dynamic Destination Assignment
If dynamic destination assignment is operating, routing is performed in the same way as 
before. See Procedure for ‘X/Y Routing’ to a Video Wall Tile Position, on page 434, etc.

When using dynamic destinations, a live connection (through the MVCMS service) to an MV 
unit is required, otherwise the tiles will show up without any destinations assigned to them. 

Quick Dial Source Routing on the X/Y Routing Screen
Dial Source routing speeds up the selection of a source for routing to a tile.

In X/Y Routing mode:
1 Select a tile on a monitor using the mouse. 

Note: Navigation:
• To navigate between tiles on the selected monitor, 

use the left- and right-arrow cursor keys.
• To select a different monitor, use the mouse.
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2 With a tile selected, 
start typing a source name.

A filtered list of sources pops up. 

Fig. 8-85: Pop-Up Filtered Sources List

Continue to type in the source name. While characters are entered, source names 
matching the entered characters are displayed in the pop-up list. 

3 To pre-select a source to be routed and make the route (see Figure 8-86), either:
• Use the down- and up-arrow keys to highlight the required source in the filtered 

list (thus pre-selecting the source).
And then press the Enter key to route the pre-selected source to the selected tile.

or:
• Click on the required source in the filtered list to select it and make the route.
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Fig. 8-86: Select Source

The route is made. See Figure 8-87.

Fig. 8-87: Pre-Selected Source is Routed to the Selected Tile

Currently-routed source to tile

Pre-selected source
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Step 5b: Change Layouts in X/Y Routing Mode
X/Y Routing mode has a live connection to the multiviewer cluster (via the MVCMS service) 
and the stage area shows the video wall layout of the multiviewer devices. 
The mode offers the facility to change Room Layouts (see What is a Monitor Layout?, on 
page 365) and Monitor Layouts (see What is a Monitor Layout?, on page 365).

In this section:
• Select a Room Layout in X/Y Routing Mode
• Select a Monitor Layout in X/Y Routing Mode
• New Layouts:

• Select a New Current Video Wall Layout
• X/Y Routing Mode Video Wall Layout vs Room Layout
• Saving a New Video Wall Layout as a Room Layout

Select a Room Layout in X/Y Routing Mode
If there is more than one Room Layout, then a different Room Layout may be selected in 
the X/Y Routing mode of the Room Editor. This will also change the layout on the physical 
video wall. Sources may then be routed to this layout, as required.

In X/Y Routing mode in the Room Editor, to select a Room Layout:
1 With no monitor selected, 

click on the Room Layout icon and select a different layout to show.

The Room Editor screen shows the selected layout and commands are sent to the live 
video monitor wall to change layouts. The selected Room Layout is then shown on the 
monitor wall.

Fig. 8-88: Select an Alternate Room Layout in X/Y Routing mode in Room Editor

Note: The live selection of Room or Monitor Layouts is only possible in the 
X/Y Routing screen of the Room Editor. This is not available in other 
Room Editor modes.

Room Layout icon
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Fig. 8-89: Newly-Selected Room Layout

Select a Monitor Layout in X/Y Routing Mode
If there is more than one Monitor Layout for a monitor, then a different Monitor Layout 
may be selected in the X/Y Routing mode of the Room Editor. This will change the layout 
on the physical video wall also.

In X/Y Routing mode in the Room Editor, to select a new Monitor Layout:
1 Select a monitor in the X/Y Routing screen stage area. (See Figure 8-90.)

Fig. 8-90: Select Alternate Monitor Layout

2 Click on the Monitor Layout icon in the Room Editor tool bar
and select the required Monitor Layout to show. (See Figure 8-90.)

Note: Tile positions in this newly-selected monitor’s layout 
require more routed sources

Select a monitor in the stage area.

Select a Monitor Layout.

Monitor Layout icon
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The Room Editor screen shows the selected layout and commands are sent to the live 
video monitor wall to change layouts. The selected Monitor Layout is then shown on 
the monitor wall. (See Figure 8-91.)

Fig. 8-91: Selected Alternate Monitor Layout Shown

Layout Change in Dynamic Destination Assignment Mode
Layout changes are made in the same way when Dynamic Destination Assignment is 
active. 

If a layout change results in not enough multiviewer destinations being available to meet 
the layout’s needs, then this is indicated in the X/Y Routing mode screen in GV Orbit Client 
and on the video wall with one or more 50%-transparent blue tiles in GV Orbit Client. See 
Figure 8-92. The actual video wall will show a black tile area.
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Fig. 8-92: New Layout and Not Enough Free Multiviewer Destinations

a) Selecting another Monitor Layout

b) New Monitor Layout Shows there are not enough free multiviewer destinations

• Blue coloration to tile indicates that the 
current overall on-screen layout requires more 
multiviewer destination than are currently 
available from the multiviewer.

• A pop-up message reinforces this, explaining 
that the number of destinations has been 
exceeded.

A Monitor layout change
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New Layouts
Room Layouts and Monitor Layouts can be selected when in X/Y Routing mode and the 
video wall changes accordingly. (See Select a Room Layout in X/Y Routing Mode, on 
page 439, and Select a Monitor Layout in X/Y Routing Mode, on page 440.)

A video wall layout can be adjusted ‘on the fly’ in the X/Y Routing mode of the Room 
Editor.

Select a New Current Video Wall Layout
With a Room Layout selected and displayed:

1 Select an alternate Monitor Layout for a monitor, in order to change the on-screen 
video wall layout.

The resulting new overall video wall layout is shown. 

X/Y Routing Mode Video Wall Layout vs Room Layout
The displayed video wall layout is a combination of Monitor Layouts which may, or may 
not, correspond to an already-saved Room Layout in the ‘Clustered Multiviewer’ project.
If the Monitor Layout combination:

• Does Correspond to a Room Layout:

GV Orbit recognizes this and automatically selects the corresponding Room Layout.
• Does NOT correspond to a Room Layout: 

GV Orbit detects this and automatically creates a new, ‘Untitled*’ item in the Room 
Layout drop-down menu (see Figure 8-93), which may be saved and renamed as 
required, see Saving a New Video Wall Layout as a Room Layout.

Fig. 8-93: ‘Untitled*’ Room Layout

Saving a New Video Wall Layout as a Room Layout
To save a ‘Untitled*’ video wall layout as a Room Layout, with the layout displayed in the 
stage area:

1 Click the Design Layout icon in the Room Editor to leave the X/Y Routing mode.

A Room Layout Changes dialog asks the user if they wish to save the layout as a new 

Room Layout icon Monitor Layout icon

New item in Room Layout drop-down menu, ‘Untitled*’



444

MV Cluster - Room Editor
New Layouts

Room Layout.

Fig. 8-94: Room Layout Changes Dialog

2 Click Yes.

The user is asked and which Room Layout name to use.

Fig. 8-95: New Room Layout Name Dialog

3 Enter a new name and click OK.

Note: If the X/Y routing mode screen is returned to in GV Orbit Client, then 
the X/Y Routing stage will reflect the current video wall layout of the 
multiviewer devices. 
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Introduction

TSL tally configuration is integrated and centralized for a ‘Clustered MV’ project. 
Configuration is done on a per Room basis and the whole video wall inherits the Tally 
configuration. This provides the basic Tally settings for the video wall’s graphical, on-screen 
widgets to use to display Tally status. (For example, a Tally Lamp, Label, or Shape.)

TSL tally protocols supported:
• TSL 3.1 - Basic industry tally standard protocol over UDP.
• TSL 5.0 - Advance industry tally protocol over UDP or TCP. 

In GV Orbit Client, TSL tally configuration is carried out from the Room Editor’s 
Destination Assignment mode. Tally configuration includes:

• Selecting TSL protocol to use.
• Optionally customizing Tally names, Tally address level names, and on-screen Tally 

colors.
• Mapping of TSL addresses and video wall video tiles (multiviewer device logical inputs 

and their assigned router destinations). 

When TSL tally configuration is done, ‘tally-indicating’ graphical widgets in video wall tiles 
can be configured. This then determines which TSL data packets are indicated by which 
widgets.

Tally Protocols
Up to four Tally addresses supported per multiviewer input (i.e. up to four address levels). 

The TSL protocols are compared in the table below:

Lite Professional Enterprise

-  

Note: When designing a video wall and using widgets to display Tally 
status, the Tally configuration provides the basic settings. It is still 
possible to change local settings on a video wall tile to modify widget 
behavior and/or appearance on a tile-by-tile basis in GV Orbit Client.

 Table 9-1: Comparing TSL Protocols 
TSL Protocol

TSL 3.1 TSL 5.0

Tallies ‘Tally 1’ to ‘Tally 4’ ‘Left’, ‘Right’, and ‘Text’

Tally States Two states: On, Off Four states
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Tally Configuration in Room Editor
TSL Tally settings for a Room are configured in a Destination Configuration tab which is 
found in the Destination Assignment mode of the Room Editor.

Open Destination Configuration Tab
1 Open the Room file in the Room Editor and select the Assign Destinations icon in the 

Room Editor tool bar. 
(Refer to Chapter 8, Step 4a: Assign Destinations to Tile Positions, on page 408 for full 
instructions.)

The Room Design is shown in its Assign Destinations mode. See Figure 9-1.

Number of Tallies 
per MV-8 Multiviewer 

Video Wall Tile
16 12

Address Range 0 to 126 0 to 65534

IP data packet protocol 
used UDP UDP or TCP

 Table 9-1: Comparing TSL Protocols  (continued)
TSL Protocol

TSL 3.1 TSL 5.0

Note: The Destination Assignments should be all completed in the Room 
Editor before for the Tally settings can fully function and map to 
video wall tiles etc. 
(For Destination Assignment steps, please see Chapter 8 Step 4a: 
Assign Destinations to Tile Positions, on page 408.)
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Fig. 9-1: Assign Destinations Mode in Room Editor

2 Click on the Configure Mapping icon in the Room Editor tool bar.

A Destination Configuration tab is opened. See Figure 9-2.

Destination Configuration Tab

Fig. 9-2: Destination Configuration Tab - TSL Tally Levels Config Columns

Click on Configure Mapping icon

Selected Assign Destinations icon

Room Editor tool bar

TSL Tally Levels Config columnsTSL button
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Following a Destination Assignment step in video wall design, the ‘Destinations’ column 
is filled out and multiviewer inputs are mapped to video wall tiles. See Chapter 8, Step 4a: 
Assign Destinations to Tile Positions, on page 408.

‘Tally’ features of the Destination Configuration tab are:
• TSL Tally Levels Config columns ‘L1’ to ‘L4’:

• Initially the columns are empty. 
• Assign TSL Tally Addresses to Multiviewer Inputs.
• Customize TSL Tally Address Level Names by renaming columns, if required.

• TSL button in the tool bar. Use the TSL button to:
• Select TSL 3.1 or 5.0 Tally Protocol; and
• Customize Tally Names and On-Screen Colors.
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Assign TSL Tally Addresses to Multiviewer Inputs

Assign Addresses
TSL Tally addresses can be assigned for each multiviewer input. Up to four addresses may 
be assigned (i.e. up to four address ‘levels’ for a video wall tile).

The TSL Tally Level address mapping defaults to being ‘empty’. Assign TSL addresses to 
each multiviewer input. Up to four are allowed per input.

Ranges of TSL addresses can be automatically assigned and manually edited/entered as 
required.

Auto-Assignment
To automatically assign a range of addresses to TSL Tally Levels in the Destination 
Configuration tab screen:

1 Select a multiviewer. (See Figure 9-3.)

To select a contiguous range of TSL addresses to fill out:
2 Click in the first TSL Level table cell of the range.

And SHIFT-click in the last cell of the range.

(Further cells may be added to the selection with CTRL-click/SHIFT-click.)

This selects the TSL addresses to be filled out. See Figure 9-3.

Fig. 9-3: Destination Configuration Tab - TSL Tally Level Config Columns

Select a multiviewer

Select

CTRL-Select

Auto-Assign TSL Addresses button

Selected range
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3 Click on the Auto-Assign TSL Addresses button
and enter a start TSL address in the pop-up dialog. (See Figure 9-4.)

4 Click OK.

Fig. 9-4: TSL Address Range Filled Out

The selected TSL addresses cells are filled out from the entered start address.

This has quickly assigned some TSL addresses.
5 Repeat this to assign up to four addresses (columns ‘L1’ to ‘L4’) per multiviewer input, 

using the four columns.

Then:
6 Repeat for each multiviewer.

And finally:
7 Click Save File.

This has quickly assigned TSL addresses for each multiviewer input.

It is possible to manually enter addresses or to edit addresses, see Manual Assignment.

Select

CTRL-Select

Selected range

a) Enter start address to fill from. b) Filled out TSL addresses.

Note: Checking and Auto-Assigned TSL Tally Addresses:
The addresses added during auto-assignment are checked and an 
error message pops up to alert the user that the address is already in 
use.
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Manual Assignment
To assign addresses to TSL Tally Levels:

1 Select a multiviewer.
2 Click in a TSL Level column row item and enter a TSL address.
3 Press the Down-arrow key to go on to the next row in the column. 

Enter another address. Etc.
4 Repeat for all multiviewer inputs.

Fig. 9-5: Destination Configuration Tab - TSL Tally Level Config Columns

5 Press Return when done to exit the address level column.

6

When four addresses (columns ‘L1’ to ‘L4’) have been assigned for each multiviewer, finally:
7 Click Save File.

This has assigned TSL addresses for each multiviewer input.

Select multiviewer

CAUTION Unlike auto-addressing, there is no check on entered 
addresses when manually editing the addresses. 

Note: TSL addresses can be duplicated, if required, by using manual entry of 
TSL addresses.
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Customize TSL Tally Address Level Names

Fig. 9-6: Customized Tally Address Level Names

TSL Tally address level names can be customized, which is useful when assigning Tallies to 
on-screen Tally indicators such as Tally Lamps or UMDs.

Procedure
To rename a Tally address Level across the whole Room:

1 Click on the ‘Tally Level’ column heading in the Destination Configuration tab.

A Header dialog is shown.

Fig. 9-7: Customize Tally Address Level Name 

2 Enter a new name for the address level and click OK.

The new address level name is used for the Room Design and appears in the column 
header and persists for all multiviewers used by the Room. See Figure 9-8.

Click on ‘Tally Level’ column heading
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Fig. 9-8: New Address Level Name Persists for Other Multiviewers in the Room

3 Click Save File.
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TSL Tally Configuration for a Room
The TSL tally settings assigned here will be assigned to the video wall tiles for the Room 
and will be available to on-screen, graphical, tally-indicating widgets (i.e. Lamps, Labels, 
Shapes, UMDs).

Configuration is done the Destination Configuration tab in the Room Editor.

Configuration items:
• Select TSL 3.1 or 5.0 Tally Protocol
• Customize Tally Names and On-Screen Colors

• TSL 3.1 Customizing
• TSL 5.0 Customizing

Select TSL 3.1 or 5.0 Tally Protocol
To select the TSL Tally protocol to be used in the Room Design:

1 Click on TSL icon in the Room Editor tool bar.

Fig. 9-9: TSL Icon

A TSL Configuration dialog is shown.

Fig. 9-10: TSL Configuration Dialogs: a) TSL 3.1 Selected; b) TSL 5.0 Selected.

2 Select TSL 3.1 or TSL 5.0.
3 Click Apply.

This has selected the TSL Tally protocol to be used in the Room.

a) TSL 3.1 Dialog b) TSL 5.0 Dialog
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TSL Protocols
• TSL 3.1

There are four Tallies (Tally 1 to Tally 4) and each has an associated Tally color. 
There are colors for graphical on-screen Tally Lamp widgets and for Shape widgets.

• TSL 5.0

There are four Tally states (State 1 to State 4) and each has an associated ‘Left-Tally’, 
‘Right-Tally’, and ‘Tally Text’. And, in turn, each has associated on-screen colors.

The protocols are compared in Table 9-1, on page 446.

Note: Dynamic selection of Tally protocol on MV-8 multiviewer devices:
The Tally protocol is usually selected once in a project and then does 
not change.
The dynamic selection of the Tally protocol in a project will be 
supported in MV-8 multiviewer software version v4 onwards. 

CAUTION Typically the TSL Tally protocol is set once. 
If, however, the setting is changed between protocols, it is 
recommended that all the Tally assignments that have 
been made are re-checked.



457

GV Orbit Client
User Guide

Customize Tally Names and On-Screen Colors
The names of each tally and the on-screen colors used can be customized in the TSL 
Configuration dialog. A customized Tally name can help to identify it when assigning 
tallies to on-screen graphical widgets (Tally Lamps etc.) in the video wall design steps.

Customizations:
• TSL 3.1 Tally Name
• TSL 3.1 Tally Lamp Color
• TSL 3.1 Shape Fill Color
• TSL 5.0 Tally Name
• TSL 5.0 Tally Lamp State Color
• TSL 5.0 Shape Fill State Color
• TSL 5.0 Text Tally Font Color

Show TSL Configuration Dialog
To show the TSL Configuration dialog:

• Click on the TSL icon in the Room Editor tool bar.

The TSL Configuration dialog is shown. (See Figure 9-10 on page 455.)
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TSL 3.1 Customizing

TSL 3.1 Tally Name
In the TSL 3.1 TSL Configuration dialog:

Fig. 9-11: Customize TSL 3.1 Tally Name

1 Click on a Tally name.
2 Enter a new name and Click OK.

The new tally name is shown.
3 Click Apply.
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TSL 3.1 Tally Lamp Color
Three standard colors are available ( ). 

In the TSL 3.1 TSL Configuration dialog:

Fig. 9-12: Customize TSL 3.1 Tally Lamp Color

1 Click on a Lamp color.
2 Select a new color.

The new color is shown.
3 Click Apply.
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TSL 3.1 Shape Fill Color
For an on-screen shape, four standard colors are available ( ) to be used as the 
shape fill color. Alternatively, a custom color may be picked to allow custom colors to be 
used.

In the TSL 3.1 TSL Configuration dialog:

Fig. 9-13: Customize TSL 3.1 Tally Shape Fill Color

1 Click on a Shape color.

A small color selector menu pops up.
2 Select a new color: 

Select a preset color, or 
select the Color Picker icon to show 
the Select Color dialog, then select 
a color and click OK.

The new color is shown.
3 Click Apply.

Preset colors

Select Color dialog
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TSL 5.0 Customizing

TSL 5.0 Tally Name
(The procedure for TSL 5.0 is similar to TSL 3.1 Tally Name, on page 458.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Tally name (‘Left Tally’, or ‘Text Tally’, or ‘Right Tally’).
2 Enter a new name and Click OK.

The new name is shown.
3 Click Apply.

Fig. 9-14: Customized TSL 5.0 Tally Names

TSL 5.0 Tally Lamp State Color
(The procedure for TSL 5.0 is similar to TSL 3.1 Tally Lamp Color, on page 459.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Lamp state color.
2 Select a new color.

The new color is shown.
3 Click Apply.

Fig. 9-15: Customizes TSL 5.0 Tally Lamp State Colors
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TSL 5.0 Shape Fill State Color
(The procedure for TSL 5.0 is similar to TSL 3.1 Shape Fill Color, on page 460.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Shape state color.
2 Select a new color to be used for the shape’s fill color.

Or, if the color picker icon is selected, the Select Color dialog is shown. 
Select a color and click OK.

The new color is shown.
3 Click Apply.

Fig. 9-16: Customized TSL 5.0 Tally Shape State Colors

TSL 5.0 Text Tally Font Color
(The procedure for TSL 5.0 is similar to TSL 3.1 Shape Fill Color, on page 460.)

In the TSL 5.0 TSL Configuration dialog:
1 Click on a Text Tally state color.
2 Select a new color.

Or, if the color picker icon is selected, the Select Color dialog is shown. 
Select a color and click OK.

The new color is shown.
3 Click Apply.

Fig. 9-17: Customized TSL 5.0 Text Tally Font Colors
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Configuring On-Screen Widgets
With each multiviewer input configured for TSL Tallies, graphical widgets on video tiles can 
be configured. The widget editing is done when editing a Custom Tile in the Tile Editor.

Open a Custom Tile in the Tile Editor

Open an Existing Custom Tile:
To open a Custom Tile in the Tile Editor:

Either:
• Expand the project in the Project window and in the ‘Tiles’ folder, double-click on the 

Custom Tile name. The tile is opened in the editor.

Or:
• Open the video wall double-click on the Custom Tile. The tile is opened in the editor.

Create a New Custom Tile

New Empty Custom Tile

A Custom Tile may be created from scratch, if required: 
• Expand the project in the Project window and right-click on the ‘Tiles’ folder and select 

‘New’. Then select the tile type. A new tile is opened in the editor.

Quick Custom Tile

Alternatively, a new Custom Tile can be created quickly from an existing video auto-tile by 
double-clicking on a video tile to copy it and open it in the Tile Editor.

To quickly create a new Custom Tile:
1 Double-click on a video tile in the video wall.

The Create Custom Tile dialog is shown.

Note: Typically for a video wall, a few particular ‘template’ video tile designs 
are used throughout. In GV Orbit Client the user can design custom 
video tiles for use on video walls (Custom Tiles).
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Fig. 9-18: Create Custom Tile

2 Enter a name for the Custom Tile and click OK.

The selected tile is copied and opened in the Tile Editor. See Figure 9-19.

Fig. 9-19: Custom Tile in Tile Editor

Widget palette

Custom Tile tab
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TSL Tally Configuring Widgets
Certain graphical widgets can be used on video wall tiles to display Tally information. The 
TSL Tally configuration of a widget comprises specifying what Tally data is to drive the 
widget. Widgets include:

• Tally Lamp Widget
• Label Widget (Font Color)
• Shape Widget (Fill Color)

Tally Lamp Widget
Open a Custom Tile in the Tile Editor.

If a Tally Lamp widget needs to be added, then: 
1 Click on the Tally Lamp icon in the Widget Palette and drop on a Tally Lamp widget. 

repeat for a second one if required. See Figure 9-20.

Fig. 9-20: Added Tally Lamp Widget(s)

Configure the widget tallies:
2 Right-click on a Tally Lamp widget and select ‘Tally Configuration’.

A Tally Configuration dialog is shown, either for TSL 3.1 (see Figure 9-21a) or for TSL 
5.0 (see Figure 9-21b).

Click on Tally Lamp widget 
icon in the Widget palette, 
then drop a widget onto the 
Tile stage area.

Drop widget onto tile stage area.
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Fig. 9-21: Tally Lamp Widget Tally Configuration Dialogs: a) TSL 3.1; b) TSL 5.0

3 In the dialog, 
select the Tally Status and Address level, or Tally Position and Address level for the 
widget 
for TSL 3.1 or 5.0 respectively. 

4 Click Apply.

This configures the TSL settings for the widget. 
• Configure each Tally Lamp widget on the tile.

With the tallies up for the widget in the Room, the following will determine which TSL data 
packet controls the Tally Lamp’s color:

• the widget’s Tally Configuration setting (above); 
• the video tile position on the video wall; and 
• the TSL address mapping set up in the Destination Configuration tab.

Label Widget (Font Color)
A Label widget can have its font color controlled by TSL messages. The widget tally 
configuration is done in a similar way to the Tally Lamp Widget.

a) TSL 3.1 Widget Tally Configuration

b) TSL 3.1 Widget Tally Configuration
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Fig. 9-22: Label Widget

Shape Widget (Fill Color)
A Shape widget (for example, a Rectangle) can have its fill color controlled by TSL 
messages. The widget tally configuration is also done in a similar way to the Tally Lamp 
Widget.

Fig. 9-23: Shape Widget

Tally Lamp widget

Label widget

Rectangle shape 
widget.
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Tally Border Video Tile Example
This example forms a video tile with a customizable colored border which is bound to a TSL 
tally message. 

Assumptions
• A Room has been created.
• Monitors have been arranged to form a video wall.
• Monitors have been assigned to multiviewer outputs.
• A layout has been designed for the video wall.
• Destinations have been assigned to multiviewer inputs and to video wall tiles

TSL address mapping has been done in the Destination Configuration tab in the 
Destination Assignment mode of the Room Editor.

Create a Starter Custom Tile
A custom video tile can be created quickly to start with in GV Orbit Client:

1 Double-click on a video tile in the video wall.

The Create Custom Tile dialog is shown.
2 Enter a name for the Custom Tile and click OK.

The selected video tile is copied and opened in the Tile Editor. 

Fig. 9-24: Starter Custom Tile

Tile Size:
3 Click off the Tile but in the Tile Editor stage area. See Figure 9-25.

The Tile’s Width and Height are shown in the Properties box. 
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Fig. 9-25: Tile Size in Properties

In the example in Figure 9-25, the Custom Tile’s dimensions are:
• width = 910 pixels 
• height = 503 pixels.

Add a Border Tally
A border Tally may be added to the Custom Tile by:

• slightly resizing the Video widget and centering it on the Tile;
• adding a Rectangle shape widget;
• setting the shape to be the same size as the Tile itself; 
• placing the shape behind the Video widget; and 
• configuring the TSL settings for the Rectangle shape 

(i.e. which TSL data packets will drive the shape fill color).

Procedure Example
For this example, to add a 15 pixel wide TSL Tally border:

Resize and re-position Video widget:
1 Select the Video widget.
2 Change the Properties:

• ‘Dimensions > Position > X’ = 15.
• ‘Dimensions > Position > Y’ = 15.
• ‘Dimensions > Size > Width’ = 880. (880 = 910 - 2x15)
• ‘Dimensions > Size > Height’ = 473. (473= 503 - 2x15)

This reduces the widget size and centers the widget on the Tile, adding a 15 pixel 

Click off the Tile, but on the Tile Editor stage area.
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margin around the sides.

Fig. 9-26: Video Widget Size/Position Properties

Add border shape:
3 Click on the Rectangle shape icon in the Widget Palette.

Fig. 9-27: Rectangle Shape Widget Icon in Widget Palette

4 Add a Rectangle shape widget to the tile.
5 Select the shape and change its position/size properties:

• ‘Dimensions > Position > X’ = 0.
• ‘Dimensions > Position > Y’ = 0.
• ‘Dimensions > Size > Width’ = 910. (910 is the Tile width.)
• ‘Dimensions > Size > Height’ = 503. (503 is the Tile height.)
• ‘Extended Style > Border > Border Thickness’ = 0.

6 Right-click on the Rectangle shape widget and select ‘Tally Configuration’.
7 Set up the widget’s Tally settings (i.e. to control the shape’s Fill color).
8 With the shape still selected, click the Move to Back icon in the main tool bar.

Video widget resized and centered.

Click Rectangle shape widget icon
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Fig. 9-28: Move Selected Object to Back

The Rectangle shape moves to be behind the Video widget.

Fig. 9-29: Video Widget Size/Position Properties

9 Click Save File.

Add more Tally widgets:

If required, further tally-indicating widgets may be added:
10 Add two Tally Lamps.
11 Right-click on each widget and set up the widget Tally settings.
12 Add a Label widget.
13 Right-click on the widget and set up the widget settings (to control the Label text’s font 

color).
14 Click Save File.

The Custom Tile has been prepared.

Deploy Tile
The tile may already be present on the video wall in the Room Design. In this case, the new 
Custom Tile will be seen in the Room Editor. Otherwise, the tile may be added to the 
Room’s video wall in the Room Editor in its Design Layout mode. (See Chapter 8, Step 3a: 
Design Layout - Assign Tile Grid Layouts to a Video Wall, on page 390.)

Click Move to Back icon

Rectangle shape widget is behind the Video widget
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Fig. 9-30: Deployed Custom Tile Example
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Introduction
Audio meters are implemented on video wall tiles with graphical Audio Bars widgets, 
which require configuring for the audio channels they will monitor.

Widgets are configured from the Tile Editor by selecting them and editing their properties 
in the Properties box. For an Audio Bars widget on a Custom Tile, its audio channel 
configuration may be set up quickly via a pop-up menu. 

Note: Typically for a video wall, a few particular ‘template’ video tile designs 
are used throughout. In GV Orbit Client the user can design custom 
video tiles for use on video walls (Custom Tiles).
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Audio Bars Widget Configuration
The Audio Bars widget may be set up by selecting the widget in the Tile Editor and 
modifying properties in the Properties box. See Figure 10-2.

Fig. 10-1: Audio Bars Widget Properties

The setting up of which audio channels are being monitored by the widget is done in a 
pop-up menu, see Audio Bars Widget Audio Channels.

Properties boxSelected Audio Bars widget
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Audio Bars Widget Audio Channels
An Audio Bars widget shows one or more bars of audio data from specified audio 
channels. This ‘bars’ configuration is set up in a dialog which is accessible from a right-click 
in the Tile Editor.

Open Audio Configuration Dialog

For an Audio Bars widget on a Custom Tile its audio bars configuration can be quickly set 
up:

1 Select the Audio Bars widget in the Tile Editor.
2 Right-click on the widget and select ‘Audio Configuration’ in the pop-up menu. (See 

Figure 10-2.)

Note: Audio Configuration and MV-8 Multiviewer Software Version:
The Audio Configuration dialog feature will be supported in MV-8 
multiviewer software version v4 onwards.
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Fig. 10-2: Right-Click on Audio Bars Widget

The Audio Configuration dialog is shown. 
The dialog is described in Audio Configuration Dialog - PCM Audio Bars Configuration, 
on page 479. 

3 To set up the audio bars configuration, see instructions in:
• Audio Configuration Dialog - PCM Audio Bars Configuration, on page 479; or in 
• Audio Configuration Dialog - DolbyE Audio Bars Configuration, on page 481.

4 When the audio bar configuration is done, click Apply.

The Audio Bars widget on the Custom Tile now shows the number of audio bars set up.

Properties boxRight-click on selected Audio Bars 
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Fig. 10-3: Example 6-Bar Audio Bars Widget
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Fig. 10-4: Example Audio Monitoring with Audio Bars Widget

CAUTION Ballistics and MV-8 Series Multiviewer Devices:
For MV-8 Series multiviewers, each multiviewer device has a 
global audio data ballistics setting. 
All audio metering data generated by the device uses this one 
global ballistics setting.
A device’s global ballistics setting is found:

• For a non-clustered multiviewer -

See the GV Orbit Client main menu
‘Multiviewer > Input Audio > Meter’  item
‘Meter Type’ setting.

• For a clustered multiviewer -

See the device’s control screen (RollCall template).
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Audio Configuration Dialog - PCM Audio Bars Configuration
The dialog has a ‘PCM’ or a ‘DolbyE’ mode (see Figure 10-5 and Figure 10-6 respectively) 
and permits the configuration of up to 8 audio bars in the Audio Bars widget. 

Fig. 10-5: Audio Bars Configuration Dialog PCM Selected)

Bar Configuration
To configure audio bars for monitoring PCM audio channels:

1 Select PCM in the Audio Configuration dialog.

PCM / DolbyE selection

(Mono) Audio channel selection 
for display on the audio bar

Audio Bar enable
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2 Enable the number of audio bars required. 
Note: These must be contiguous in the dialog, starting with ‘Bar 1’.

Tip: For example, to enable six bars:
• Simply enable ‘Bar 6’. 

Bars 1 to 5 are enabled automatically.

For each enabled bar:
3 Select a mono audio channel (if the automatically selected channel is not what is 

required). There are 32 mono audio channels to choose from.
4 Repeat the above for each enabled bar.
5 Click Apply.

The Audio Bars widget shows the new number of audio bars in the Tile Editor.

Note: As bars are enabled, the (mono) audio channel selection increments 
automatically.
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Audio Configuration Dialog - DolbyE Audio Bars Configuration
The dialog has a ‘PCM’ or a ‘DolbyE’ mode (see Figure 10-5 and Figure 10-6 respectively) 
and permits the configuration of up to 8 audio bars in the Audio Bars widget.

Fig. 10-6: Audio Bars Configuration Dialog (DolbyE Selected)

Bar Configuration
To configure audio bars for monitoring DolbyE audio channels:

1 Select DolbyE in the Audio Configuration dialog.

PCM / DolbyE selection

Channel-pair selection
(Mono) Audio channel selection

for display on the audio bar

Audio Bar enable



482

Audio Bars Configuration
Audio Configuration Dialog - DolbyE Audio Bars Configuration

2 Enable the number of audio bars required. 
Note: These must be contiguous in the dialog, starting with ‘Bar 1’.

Tip: For example, to enable six bars:
• Simply enable ‘Bar 6’. 

Bars 1 to 5 are enabled automatically.

For each enabled bar:
3 Select a channel-pair to use (if the automatically selected channel-pair is not what is 

required). There are 16 channel-pairs to choose from.
4 Select a mono audio channel (if the automatically selected channel is not what is 

required). There are 8 audio channels to choose from (decoded from the DolbyE data in 
the selected channel-pair).

5 Repeat the above for each enabled bar.
6 Click Apply.

The Audio Bars widget shows the new number of audio bars in the Tile Editor.

Note: As bars are enabled, the (mono) audio channel selection increments 
automatically.
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Introduction
GV Orbit is a dynamic system orchestrator tool. One of its many features is that it can 
configure, control and monitor signal routing in a GV Orbit IP routing system: It is the GV 
Orbit Control application that handles the routing. GV Orbit Client is used to enter and 
manage the configuration settings of IP endpoints of devices for the IP routing system. This 
‘IP configuration’ uses the IP Configuration tool within GV Orbit Client. 

The IP Configuration tool automatically discovers all GVOP-supporting devices in a GV 
Orbit system which are on a GVOP domain, connected to the network and up-and-running. 
The resulting list of discovered devices is presented to the user. The tool allows the user to 
configure IP settings for the devices ready for IP routing. Settings include:

• device name, device short name, and network host name;
• multicast group IP address settings; 
• spigot names and port numbers ; and 
• IP flow enabling from spigots on a device etc. 

GV Orbit Client provides the IP Configuration information to the GV Orbit system, and in 
particular it is automatically passed to the router controller application, GV Orbit Control. 
The information is automatically used as the basis for IP device and spigot naming etc. for 
the routing topology that GV Orbit Control controls.

More than one IP routing system can be ‘IP-configured’ with GV Orbit Client in the same GV 
Orbit project. 

Spreadsheet Import
IP routing configuration information can be added manually into the IP Configuration tool 
or, more practically, it can be imported from a spreadsheet. The spreadsheet import/export 
facility provides a quick and convenient way of defining and saving IP endpoint settings, 
automating data entry and saving system settings.

Some validation of the data in the spreadsheet is performed automatically, checking for 
duplicate entries. 

IP routing devices in the system are either sources of or destinations for IP streams, or both. 
Data validation is carried out at import and status reporting on the devices and their IP 
streams is provided in the IP Configuration tool.

Manual Edits
IP routing configuration information can be edited manually in the IP Configuration tool. 
Some validation of each new manual entry is performed automatically, checking for 
duplicate entries. 

Note: The IP Configuration tool currently supports all endpoint devices 
that support GVOP, the GV Orchestration Protocol.
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IP Configuration Tool
The IP Configuration tool in GV Orbit Client enables fast, easy and reliable configuration of 
IP routing device parameters for use in a GV Orbit system. In this way, configurations are 
entered by the user and then used by GV Orbit applications – for example by GV Orbit 
Control for the system routing. 

Such parameters are editable in GV Orbit Client only.

What the IP Configuration Tool Does Do...
IP Configuration tool is used to:

• Assign device and spigot names.
• Configure all IP flows sourced by the devices.
• Assign (traditional) router port numbers to the spigots used by the flows. (Source 

spigots and destination spigots.)
• Set (traditional) router port numbers and names.

Once a source flow within a Grass Valley device has been configured with multicast 
parameters, it starts to send IP flow data to the IP network switch.

GV Orbit Client IP Configuration tool does do the following:
• Discovers devices of an IP network system which use the same GVOP domain.
• Enables the setting up of IP routing device parameters, including for A and B redundant 

network fabrics.
• Sets up ‘traditional’ router port assignments.
• Provides the IP configuration information to the GV Orbit system, and in particular to its 

router controller application, GV Orbit Control.

What the IP Configuration Tool Does Not Do...
GV Orbit Client IP Configuration tool does NOT do the following:

• Does not configure network settings etc. on the devices themselves (such as: device IP 
addresses or VLAN information). This must be done when setting up each device.

• Does not know about any IP network topology nor about physical networks.

IP Configuration Tool and IP Router Operation
Once the IP Configuration is made, the information is passed to the GV Orbit system and 
then routing can be done in the usual way. 

While the IP router is operating and continues to operate:
• GV Orbit Client may be run with the IP Configuration screen open.
• The GV Orbit project may be closed.
• GV Orbit Client may be closed.

Note:  GV Orbit Client talks to devices while carrying out its configuring 
and monitoring.
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• If the PC hosting the GV Orbit Client is running no other Grass Valley applications, then 
it too may be shut down (and disconnected from the network). 

If GV Orbit Client is re-started and the GV Orbit project is re-opened, then GV Orbit Client 
will auto-discover the devices and gather all the information it needs. GV Orbit Client will 
present all of the IP Routing project screens as usual, listing discovered devices and with IP 
configuration details filled out.

GV Orbit Control
The GV Orbit Control part of a GV Orbit system uses information from GV Orbit Client: It 
automatically and dynamically generates Logical sources and destinations from the IP 
Configuration information. 

For more information on GV Orbit Control, please refer to the GV Orbit Control User Guide, 
see Related Documentation, on page iii.

Devices that Support GVOP
Devices that support GVOP include:

• IQ-UCP - Universal Compute Processor,
• IQ-MIX - 3G/HD/SD-SDI Multi-channel IP Transceiver,
• IQ-AMD - Multi-channel MADI to IP Interface
• AudioLive - Audio Router for Multi-stream IP Audio Processing.
• IPVU - IP-to-HDMI Monitoring Gateway,
• MV-821 - Multiviewer.

More than One IP Configuration
It is possible to have more than one IP Configuration in a GV Orbit project. 

More than one IP routing system can be ‘IP-configured’ in the same GV Orbit project by 
specifying a different GVOP domain and creating a GV Orbit IP Configuration (.net file) for 
each IP routing system. 

Each IP Configuration must connect to different devices. An IP Configuration deals with 
devices that it can discover. Devices can be segregated by either:

• Devices being on separate IP networks.

(Requires two separate IP networks and GV Orbit Client’s host PC to have separate 

Note: Parameter values from the IP Configuration tool are use in GV 
Orbit Control but are not editable in GV Orbit Control; they are 
shown ‘grayed-out’ in GV Orbit Control screens.

Recommend: Ensure GV Orbit Control is running in the GV Orbit system 
while the IP Configuration tool is being used and while 
any whole configuration IP end point records are deleted.
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network connection to each IP network.)
• Devices being on separate GVOP Domains.

(This may use one IP network. It requires devices to be set up to be in one of two GVOP 
domains.)

Then create a new IP Configuration .net file for use with each other IP routing system. (See 
Create a New IP Configuration.)

IP Routing Networks and the IP Configuration Tool
This section presents some aspects of IP routing systems which are encountered in the IP 
Configuration tool screens.

IP Routing Redundancy - Fabric A and Fabric B
GV Orbit supports network redundancy. Two independent IP networks may be used for 
routing redundancy. These two media networks are referred to as ‘fabric A’ and ‘fabric B’. 

Within a device, a source flow is split into identical source flows, A and B. These are sent 
from the same source spigot and onto different networks (fabrics A and B). The flows travel 
independently through their respective networks. Both flow A and flow B arrive at the 
destination spigot of the destination device. The original IP signal is then re-formed from 
the data packets from fabric A or fabric B. 

Devices must connect to both fabrics and GV Orbit Client must also connect to both fabrics.

Device Control Networks

Devices typically have one or more media network connections (for example, A and B 
redundant) and possibly a control network connection.

Devices may be controlled either in-band or out-of-band: 

• In-band - This means control is done over the media network(s). 
• Out-of-band - This means there is a separate control network. 

) 

Switching at Destination
A traditional router switches source signals going to a destination. A Grass Valley IP routing 
system can do the same. In a Grass Valley IP routing system, switching is done at the 
destination spigot. This means that switching can be asynchronous to the underlying 
network fabric and the network system does not have to be media-aware.

Switching is done from a current IP flow to a new IP flow in a ‘Break before Make’ or in a 
‘Make before Break’ way:

• Break before Make (BbM): The current IP flow is dropped and then a connection is 
made to a new IP flow. 

Note: It is possible for a device to be controllable but to have no 
connection to media network(s).
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• Make before Break (MbB): While connection to a new IP flow is being made, extra 
connection bandwidth is momentarily required. The current IP flow is then dropped 
once the new connection is made.

Grass Valley IP devices derive timing information from the IP network for switching 
between signals. For example, switching is done on video frame boundaries and a Grass 
Valley device’s destination spigot will switch and can provide a continuous video signal 
input to the device: 

• BbM: continuous signal achieved with “repeat current video frame”. 
• MbB: video simply cuts seamlessly from the current to a new video signal.

In This Chapter ...
In the remaining part of this chapter, the steps required to get started with an IP 
Configuration are outlined. 

• Open the IP Configuration Tool, on page 493.
• IP Configuration Tool Screen, on page 498.

Importing data from a spreadsheet is described in:
• Import Preview Dialog and Spreadsheet Duplicate Scan Dialog, on page 504; and 
• Getting Started with Spreadsheet Import, on page 519.

The ability to over-ride some import checking and keep duplicate port names (GV Orbit 
Control mnemonics) is described in Allowing Duplicate Port Names on Import, on 
page 517.

Additionally, if a further IP Configuration is required, then Create a New IP Configuration, 
on page 490, describes creating a new configuration in a C&M project.

Note: For each device, ‘Break before Make’ or ‘Make before Break’ is set 
up on a ‘per destination spigot’ basis as part of the set up of each 
device (i.e. this is not set up in GV Orbit Client):
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Create a New IP Configuration
A Control and Monitoring GV Orbit project (C&M project) has an existing default IP 
Configuration (default.net) that may be used.

If more than one IP Configuration is required in a project, then one or more further, new IP 
Configuration(s) can be created, as required, from the Project window in GV Orbit Client. 
They are created as separate .net file(s) in the project. 

A second IP configuration would need to be set up to look at a different set of devices, 
typically on a different GVOP domain.

To create a new IP Configuration file:
1 In the Project window, expand the item for the currently-open project.

Fig. 11-1: New Network

2 Right-click on the ‘networks’ sub-folder item and select ‘New Network’.

The New Network File dialog is shown.
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Fig. 11-2: New Network File Dialog

3 Enter a name for the new IP Configuration and click OK.

A new IP Configuration .net file is created in the Project window in the ‘networks’ sub-
folder and is opened in the main screen area.

Fig. 11-3: New IP Configuration

New IP Configuration in the Project window and also open in GV Orbit Client
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Fig. 11-4: New IP Configuration Open in GV Orbit Client

4 Configure the IP Configuration by clicking on the Comms Setup button in the 
Properties box. See instructions in IP Configuration Tool Comms Setup, on page 495. 
Setup the IP Configuration up to look for devices on a different GVOP domain and/or 
on a different network.
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Open the IP Configuration Tool

Prerequisites
Before performing IP Configuration, the following are required:

• A GV Orbit system.
• Each device must be configured with basic settings (i.e. valid IP addresses and sub-nets, 

and on the same GVOP domain). 

• Each device must be powered on and connected to all the network(s) (i.e. to one or 
more media networks, and/or to a control network).

• GV Orbit Client running on a client PC with a Control and Monitoring GV Orbit project 
opened.

• A list of required configuration settings - multicast IP addresses, device names, spigot 
names etc. in a spreadsheet format for importing.

Procedure
In a configuration and monitoring project (C&M project) that is already set up on a GV Orbit 
system, to open the IP Configuration tool:

1 View the Routing Workflow screen.
2 Click on the ‘IP Configuration and Spreadsheet Import’ icon. See Figure 11-5.

An IP Configuration tab is opened. For a new project, the default tab name is 
‘default.net’. See Figure 11-6.

The IP Configuration tool requires setting up, see IP Configuration Tool Comms Setup, 
on page 495.

Note: Each device must be set up independently of GV Orbit Client via 
its usual control screen; it is set up as part of the configuration step 
for each device and also includes IP addresses for each of the 
device’s IP network ports. (Refer to the specific documentation for 
each device for this setting up.)

Note: The default GVOP domain ID number is 101. 
For a newly-created network, if there are any devices present on 
the default domain, then they will be shown in the ‘Devices’ tab.
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Fig. 11-5: IP Configuration and Spreadsheet Import Icon in the Routing Workflow Screen

Fig. 11-6: IP Configuration Editor Screen 

Click on the ‘IP Configuration and Spreadsheet Import’ icon

Devices tab Comms Setup button

Properties box

Project name in the Project window

IP Configuration name in 
Project window and on main tab

IP Configuration tool editor screen main area
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IP Configuration Tool Comms Setup
To initially set up the IP Configuration tool:

1 Click the Comms Setup button.

The Comms Setup dialog is shown.

Fig. 11-7: Comms Setup Dialog

2 In the Comms Setup dialog:
a) IP Routing Domain - The default IP Routing GVOP Domain for a GV Orbit system is 

‘101’ and should not need to be changed here if there is only one IP 
Configuration.

b) Routing System - The selected routing controller type should be ‘GV Orbit 
Control’ (‘GVOC’). 

This selects to work with the router controller of the GV Orbit system.
c) GVOC Domain - The default GVOC Domain for a GV Orbit system is ‘105’ and 

should not need to be changed here.
d) IP interfaces - Select the client PC network IP interfaces for the IP Configuration 

tool to use. 
This will depend on the network connections that the PC has. 

For example, in order for the IP Configuration tool to discover all devices on a 
GVOP Domain, the client PC may need connections to:
– both media network interfaces (A and B, for in-band control); and 
– the system’s control network (for out-of-band control). 

These PC interfaces need to be selected.
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3 Click OK. 

GV Orbit Client will discover IP End-points on devices and list them in the main screen 
area. See Figure 11-8.

Fig. 11-8: Listed Discovered Devices

IMPORTANT Do not enable more than four network interfaces.
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In the main screen area:
4 Click on the Devices tab, if it is not already shown, to see the listed devices.
5 Verify that all devices are shown listed in the Devices tab. 

The IP Configuration tool is ready.



498

IP Configuration
IP Configuration Tool Screen

IP Configuration Tool Screen
The IP Configuration tool comprises several tabbed screens and a Properties box. 

For a description of each tab in the IP Configuration tool screen and the Properties box, 
please refer to the Orbit for IP Routing user manual.

Fig. 11-9: IP Configuration Tool Screen

IP Configuration Tabs

The IP Configuration tool tabs are presented from left to right in the order in which they 
are used when configuring an IP routing network system: configuration of and information 
about devices, spigots, flows, and router ports; and status and log information.

The tabs are:
• Devices
• Spigots
• Source Flows
• Destination Flows
• Router Source Ports
• Router Destination Ports
• LLDP, LLDP A, LLDP B
• Routing Status
• Bandwidth Status
• Log

Tabs Properties box

Main Area
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For a description of each tab in the IP Configuration tool screen and the Properties box, 
please refer to the Orbit for IP Routing user manual.

Columns

Sort Columns
In tables in the tabs, click on column headings to toggle sorting of row entries 
alphabetically in ascending or descending order (i.e. A-to-Z or Z-to-A).

Expand/Collapse Rows

Individual Row Items

Some table rows may be individually expanded and collapsed by clicking on the small 
triangular icon at the left hand side of each row. See Figure 11-10.

 Table 11-1: IP Configuration Tool Tabs

IP Configuration 
Tool Tab Description

Devices Shows discovered devices.

Spigots Connects spigots to router ports.

Src Flows Assigns multicast groups to source flows.

Dst Flows Assigns destination flows to multicast IP streams.

Router Src Ports Summarizes the router source ports.

Router Dst Ports Summarizes the router destination ports.

LLDP, LLDP A, 
LLDP B

Presents local link device information.

Routing Status Graphical presentation of routing.

Bandwidth Status Graphical presentation of device bandwidth usage.

Log Shows log messages.
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Fig. 11-10: Expand/Collapse Individual Row Items

Click the small triangle to collapse the row item.

Click the small triangle to expand the row item.

b) Expanded Row Item

a) Collapsed Row Item
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All Row Items

To expand or collapse all rows, use the Expand All and Collapse All icons. Figure 11-11.

Fig. 11-11: Expanding/Collapsing All Row Items

a) Expand/Collapse Controls

b) Collapsed

c) Expanded to One Level

d) Expanded to All Levels

• Click to collapse rows.
• Click to expand to one level.
• Click to expand to all levels.
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Editable Cells

Many of the tabs in the IP Configuration tool have similar features. Several tabs permit 
manual editing of some table cells. Table cells which may be edited are shown with a 
‘pencil’ edit icon when the cursor is hovering inside them. See Figure 11-12.

Fig. 11-12: Editable Cell and Pencil Edit Icon

To edit an editable table cell:
1 Click in the cell. 
2 Enter new text.
3 When new text has been entered:

• Press the Enter key to enter the new text. 

Or:
• To abort changes, click outside the cell to keep the original text.

Automatic Entry Checking
When a cell value is changed, a check is automatically carried out, checking for duplicate 
values and the user is alerted. See Figure 11-13.

Fig. 11-13: Cell Text Entry Error

Checking is done for uniqueness of:
• Device Name
• (Device) Short Name
• (Device) Host Name
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• (Spigot) Port Name
• (Spigot) Short Name
• (Spigot) Port Number

Note: The duplicates checking that is carried out is insensitive to case.
For example, 

the duplicate checking will warn the user that 
‘MVinput’ is the same as ‘MVINPUT’.
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Import Preview Dialog and Spreadsheet Duplicate Scan Dialog
This section describes the spreadsheet import options that there are for the IP 
Configuration tool in GV Orbit Client and which are shown in the Import Preview dialog 
and the accompanying Spreadsheet Duplicate Scan dialog:

In this section:
• Viewing the Dialogs, on page 504
• Spreadsheet Duplication Scan Dialog, on page 506

• Import Data Validation - Duplicate Scan, on page 506
• Resolving Duplicate Issues, on page 507
• Before Allowing Duplicate Port Names in an Import, on page 508

• Import Preview Dialog, on page 509
• Import Preview Dialog - Spreadsheet Section, on page 509
• Import Preview Dialog - Options Section, on page 515
• Import Preview Dialog - Preview of Device Changes, on page 516

Viewing the Dialogs
To see the Import Preview dialog and the Spreadsheet Duplicate Scan dialog:

1 In the Devices tab, click Import .
2 Select the required spreadsheet and click Open.

The spreadsheet is opened and the resulting Import Preview dialog is shown. (See 
Figure 11-14.) And, automatically:

• the spreadsheet contents are automatically analyzed; 
• some basic checks are carried out; and
• the result of these checks is shown in a summary Spreadsheet Duplicate Scan 

dialog, which pops up. See Figure 11-15.
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Fig. 11-14: Import Preview Dialog

Fig. 11-15: Spreadsheet Duplication Dialog
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If the Spreadsheet Duplication Scan Dialog shows that there are some issues when 
importing, then these must be resolved in the spreadsheet before importing can be done.

3 Correct any problem(s) in the spreadsheet and re-import the spreadsheet.

See Import Data Validation - Duplicate Scan, on page 506 and Resolving Duplicate 
Issues, on page 507.)

If the Spreadsheet Duplication Scan dialog shows no issues, 
4 Close the Spreadsheet Duplicate Scan dialog. 

For a description of each of these dialogs, see:
• Spreadsheet Duplication Scan Dialog, on page 506; and 
• Import Preview Dialog, on page 509.

Spreadsheet Duplication Scan Dialog
A Spreadsheet Duplication Scan dialog is shown after the start of a spreadsheet import 
after an automatic Duplicate Scan check is carried out.

Fig. 11-16: Spreadsheet Duplication Dialog 

Import Data Validation - Duplicate Scan
A Duplicate Scan checks the imported IP Configuration data to ensure that the GV Orbit 
Control application does not receive incorrect or corrupted IP configuration data. The 
following are checked: 

• Duplicate IP addresses.
• Duplicate device names, short names and host names.
• Duplicate router source port numbers, port names and short names.

Click View to see a list of the duplicate issues found.
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• Duplicate router destination ports numbers, port names and short names.

In a large network system, this check can help find typographical errors in the system set 
up.

The results of the checks are shown in the Spreadsheet Duplicate Scan dialog.

Resolving Duplicate Issues
If the Spreadsheet Duplication Scan dialog shows that there are some issues when 
importing: 

Inspect and correct each issue:
1 Click View beside the problem issue(s) in the dialog.

This lists the issues.
2 Select an issue item in the list.

More details about the issue are shown. See Figure 11-17.

Fig. 11-17: Inspecting Duplication Scan Issues

3 Correct the problem(s) in the spreadsheet.

Do this for each issue.

Finally, once all issues are addressed:
4 Close the Spreadsheet Duplicate Scan dialog and 

Cancel the Import Preview dialog.

This aborts the import.
5 Re-import the spreadsheet.

Select an issue item 
to see details.

Click View to see a list of the duplicate issues found.
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Before Allowing Duplicate Port Names in an Import
For Port Names, it is possible to override the checking and perform an import with 
duplicate Port Names, if required.

Before allowing duplicate Port Names when importing data:
1 Clear other issues that there might be from the duplicate scan.

This should leave only a duplicate ‘Port Name(s) alert’ in the Spreadsheet Duplicate 
Scan dialog that results from known Port Name duplicates that the user wishes to 
allow.

2 Close the Spreadsheet Duplicate Scan dialog.

Then:
3 See Allowing Duplicate Port Names on Import, on page 517.

Note: The default behavior on importing new values from a spreadsheet is 
to not allow duplicate values. For user cases where duplicate Port 
Names, for some reason, are required, there is a mechanism for 
getting round this.

IMPORTANT With Allow Duplicate Port Names selected in the 
Import Preview dialog, duplicate Port Name values are allowed when 
importing. However, the user should take care that such duplicate 
value entries will not impact their system.
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Import Preview Dialog

Fig. 11-18: Import Preview Dialog Anatomy

Import Preview Dialog - Spreadsheet Section
The Spreadsheet section of the Import Preview dialog contains:

• the facility to open the spreadsheet for editing; and 
• a spreadsheet summary, which summarizes information present in the worksheets of 

the selected spreadsheet.

Any issues with or differences in the selected spreadsheet compared to the current settings 
in the IP Configuration tool are indicated in the dialog. This provides a useful means of 
checking:

1 if the selected spreadsheet is the correct one before importing; 
2 if there are any issues with the spreadsheet; and 
3 any difference the spreadsheet contains compared to the currently-open IP 

Configuration of the open C&M project.

Click to Import

Spreadsheet section,
see Import Preview Dialog - Spreadsheet Section, on page 509.

Import Options section, 
see Import Preview Dialog - Options Section, on page 515.

Import Preview of Device Changes section, 
see Import Preview Dialog - Preview of Device Changes, on page 516.
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The Spreadsheet section of the dialog is shown in Figure 11-19 and it is described in 
Table 11-2.

Fig. 11-19: Import Preview Dialog - Spreadsheet Information

Selected spreadsheet file path and file name.

Click Open Spreadsheet to open the file in a spreadsheet editor (for 
example in WindowsTM Excel).

Spreadsheet Summary of selected file, see Table 11-2.

Explanation of ‘Spreadsheet Summary’ column headings. See Table 11-2.

 Table 11-2: Spreadsheet Summary - Column Headings 

 Column Heading Description

Sheet Name of a worksheet in the spreadsheet file.

Total Records Number of row items in the worksheet.

Changed Number of row items that are different to current values.

Unchanged Number of row items that are the same as current values.

Offline Number of row items that match to a device that is off-line.
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Example Spreadsheet Summary Issues:

The ‘Spreadsheet Summary’ in the Import Preview dialog can indicate several issues with 
the form and the content of a spreadsheet-to-be-imported compared to the currently-
open IP Configuration. Some example spreadsheet issues are presented here.

Figure 11-20 shows an example ‘Spreadsheet Summary’. Each red item is caused by an issue 
in the selected spreadsheet, shown in Figure 11-21 to Figure 11-26.

Inapplicable Number of row items that are inconsistent with the currently 
open GV Orbit project IP Configuration:

• For a spigot row item: 
Spigot is set to the wrong mode, or it is a phantom.

Note: A phantom spigot has an entry in the routing system’s 
working port table but does not exist on the device.

• For a flow row item: 
Parent spigot is the wrong mode or its parent device is 

not on-line.

For example, 
a Grass Valley IQMIX IP modular card may have been re-
configured to have a different number of inputs and outputs 
(i.e. destinations and sources).

Unmatched Number of row items not matched to any device. This means 
that either: 

• an item does not have a counterpart in the currently-open 
C&M project IP Configuration; or 

• an item is not found in the open project.

For example:
• a device may be temporarily off-line; or
• on a live routing system, the current routes to/from 

destination/source spigots will differ from any “snapshot” 
captured in a spreadsheet.

Invalid Number of row items that are malformed. 
I.e. an item with missing values in one or more required fields.

Additional Information Provides additional information about work sheets.

 Table 11-2: Spreadsheet Summary - Column Headings  (continued)

 Column Heading Description
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Fig. 11-20: Example Spreadsheet Summary

Fig. 11-21: Example Spreadsheet Issues - a) An Unmatched New Device.

Six ‘invalid’ issues for Destination Ports, see Figure 11-23f.

261 unmatched issues for Destination Ports 
- because the currently open IP Configuration is for a 
live IP routing system and routes have been changed.

One unmatched issue on the Device Names worksheet, see Figure 11-23a.

Two unmatched issues for Source Ports, see Figure 11-23b.

Three unmatched issues for Destination Ports, see Figure 11-23c.

Four unmatched issues for Source Flows, see Figure 11-23d.

Five ‘inappropriate’ issues for Destination Ports, see Figure 11-23e.

New device row item
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Fig. 11-22: Example Spreadsheet Issues - b) Two Unmatched New Source Ports.

Fig. 11-23: Example Spreadsheet Issues - c) Three Unmatched New Destination Ports.

Fig. 11-24: Example Spreadsheet Issues - d) Four Unmatched New Source Flows.

New source port rows

New destination port rows

New source flow rows
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Fig. 11-25: Example Spreadsheet Issues - e) Five Inappropriate Destination Flow Row Items.

Fig. 11-26: Example Spreadsheet Issues - f) Six Invalid Destination Flow Row Items.

Source 
spigot 

indexes

The spigot index used here for a Destination spigot index 
is actually the index for a Source spigot on the device.

Row items are invalid - each does not have a GUID nor an IP Address entry.
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Import Preview Dialog - Options Section

Fig. 11-27: Import Preview Dialog - Options Section

Import Options

Import unchanged records:
• Select - Import and apply all spreadsheet records when importing the spreadsheet. 

(This forces an IP Configuration into a known state.)
• Deselect - Import and apply only changed records.

Allow Duplicate Port Names:
• Select - Allow duplicate port names to be imported.
• Deselect - Imports with duplicate port names are now allowed.

See Allowing Duplicate Port Names on Import, on page 517.

Import Functions

Click on an item to perform a checking action: 

Multicast Scan

Click to generate a full listing of the multicast groups comprising the IP flows in the IP 
Configuration. The check results are shown in a dialog. 
For more information, refer to the Orbit for IP Routing user manual.

Select the worksheets of the 
spreadsheet to import

Import Options Import Functions

IMPORTANT With Allow Duplicate Port Names selected in the 
Import Preview dialog, duplicate Port Name values are allowed when 
importing. However, the user should take care that such duplicate 
value entries will not impact their system.
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Subnet Scan

Click to check that device IP addresses are on specified network subnets. The check results 
are shown in a dialog.
For more information, refer to the Orbit for IP Routing user manual.

Duplicate Scan

Click to check for duplicate IP addresses, device names, port numbers/names etc. This 
check is automatically done before importing. The check results are shown in a dialog. See 
Import Data Validation - Duplicate Scan, on page 506.

Import Preview Dialog - Preview of Device Changes
The Import Preview dialog indicates the nature of changes that would occur in the IP 
Configuration if the spreadsheet were to be imported.

Fig. 11-28: Import Preview Dialog - Preview of Device Changes

Full previewed list of changed settings items, see Table 11-3.

Click Select All to select all preview items.

Click Deselect All to deselect all preview items.

 Table 11-3: Preview of Device Changes - Column Headings

Import Preview 
Column Headings Description

(First column)  Check box.
• Select - to select an item for importing.
• Deselect - to deselect an item for importing.

Device Device GUID.

Name Device name.
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Allowing Duplicate Port Names on Import
For Port Names, it is possible to override the checking and perform an import with 
duplicate Port Names, if required.

To allow duplicate Port Names when importing spreadsheet data:
1 First, clear other issues that there might be from the duplicate scan.

This should leave only a duplicate ‘Port Name(s) alert’ in the Spreadsheet Duplicate 
Scan dialog that results from known Port Name duplicates that the user wishes to 
allow.

2 Close the Spreadsheet Duplicate Scan dialog.

Then, in the Import Preview dialog:
3 Select the Allow Duplicate Port Names option.

The Import button should become ungrayed-out. See Figure 11-29.
4 Click Import to begin the import.

Name change ‘Yes’ - Device name has changed.

Source Port changes ‘NN’ - number of source ports that have settings changes,
where NN is an integer number.

Dest Port changes ‘NN’ - number of destination ports that have settings changes,
where NN is an integer number.

Source Flow changes ‘NN’ - number of source flows that have settings changes,
where NN is an integer number.

Dest Flow changes ‘NN’ - number of destination flows that have settings changes,
where NN is an integer number.

 Table 11-3: Preview of Device Changes - Column Headings (continued)

Import Preview 
Column Headings Description

IMPORTANT With Allow Duplicate Port Names selected in the 
Import Preview dialog, duplicate Port Name values are allowed when 
importing. However, the user should take care that such duplicate 
value entries will not impact their system.
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Fig. 11-29: Allowing Duplicate Port Names when Importing from a Spreadsheet
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Getting Started with Spreadsheet Import
The IP Configuration spreadsheet can be created off-line from scratch. However, when 
getting started, it is often easier to first export a spreadsheet from the IP Configuration 
tool in GV Orbit Client. This ‘starting’ IP Configuration should have discovered all of the 
devices in the GV Orbit system. The resulting exported spreadsheet will then contain all of 
the discovered devices in the GV Orbit system.

The spreadsheet should be edited to add router port numbers, device and source port 
names, multicast address details etc. Finally, the spreadsheet is imported into the IP 
Configuration tool of GV Orbit Client, and its information is validated and then is passed to 
the rest of the GV Orbit system.

This section describes:
• Step 1: Exporting a Spreadsheet, on page 519.
• Step 2: Editing a Spreadsheet, on page 522.
• Step 3: Importing a Spreadsheet, on page 526.

See Appendix B, IP Configuration Spreadsheet Appendix, on page 535, for more 
information on the spreadsheet.

Step 1: Exporting a Spreadsheet
To export a spreadsheet which contains all discovered devices, in the Devices tab:

1 Ensure that the filter text field is empty (see Figure 11-30).

Fig. 11-30: Devices Tab - Export Button

2 Check that all devices are listed in the tab.

Note: The ‘Export’ and ‘Import’ facility can be used to take a snapshot of 
settings and restore settings.

Filter text field, empty

Export button

Listed devices
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3 Click the Export button.

A small dialog window appears.

Fig. 11-31: Export Dialog

4 Select ‘Include device GUIDs’.
5 Click Export.
6 Select a filename and location to save the spreadsheet in,

and click Save’

An exported spreadsheet is created
and a confirmation dialog is shown which lists how many records have been saved:

Fig. 11-32: Export Dialog (Export Completed)

7 Click Close.

The blank settings of the new project have been exported to a spreadsheet file (extension 
.xlsx).
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Spreadsheet Format
See Appendix B, IP Configuration Spreadsheet Appendix, on page 535 for more 
information on the spreadsheet.

Fig. 11-33: IP Configuration Spreadsheet
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Step 2: Editing a Spreadsheet
The worksheets in the spreadsheet file comprise:

• Device Names
• Source Ports
• Destination Ports
• Source Flows
• Destination Flows

Instructions on editing the spreadsheet to set up initial device information follow. 
Worksheets must be edited to:

• set up friendly device names, short names and host names
(see Device Names Worksheet);

• set up an optional device descriptions (see Device Names Worksheet);
• set up user-defined traditional router port numbers and names 

(see Source Ports Worksheet and Destination Ports Worksheet);
• set up all possible potential sources (source flows) 

(see Source Flows Worksheet); and 
• clear any existing routes, if required

(see Destination Flows Worksheet (Clear Routes).
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Device Names Worksheet
On the ‘Device Names’ worksheet, for each device:

1 Enter a friendly name in the Device Name column. 
2 Enter a short, friendly device name in the Short Name column.
3 Enter a host name in the Host Name column. 
4 Enter a description in the Description column. 

Fig. 11-34: Enter Device Name

Source Ports Worksheet
On the ‘Source Ports’ worksheet, for each source port (device source spigot):

1 Enter the (traditional) router source port number in the Port Number column.
2 Enter the (traditional) router source port name in the Port Name column.
3 Enter a short source port name in the Short Name column.

Fig. 11-35: Enter Source Ports (Source Spigots) Details

Note: Recommend a maximum of 8 characters for the Short Name.
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Destination Ports Worksheet
On the ‘Destination Ports’ worksheet, for each source port (device source spigot):

1 Enter the (traditional) router destination port number in the Port Number column.
2 Enter the (traditional) router destination port name in the Port Name column.
3 Enter a short destination port name in the Short Name column.

Fig. 11-36: Enter Destination Port (Spigot) Details

Source Flows Worksheet
On the ‘Source Flows’ worksheet, configure each source flow, edit the following columns:

1 Flow Enabled - Enter ‘Y’ to enable the source flow.
2 Multicast Address - Enter a multicast group IP address.
3 Dst RTP Port - Enter an IP port number. 

(To define which IP port a source flow should use at a destination spigot.) 
4 Src RTP Port - Enter an IP port number. 

(To define which IP port a source flow should use at its source spigot.) 

Fig. 11-37: Enter Source Flow Details

Note: Recommend a maximum of 8 characters for the Short Name.
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Destination Flows Worksheet (Clear Routes)
For the initial setting up of the spreadsheet, all routes can be cleared with the spreadsheet. 
On the ‘Destination Flows’ worksheet, configure each destination flow:

1 In the Flow Type column, enter ‘None’.
2 Delete all entries in the following columns:

• Flow Enabled, 
• Multicast Address, 
• Source Address, 
• Dst RTP Port; and 
• Src RTP Port columns.

See Figure 11-38.

This will stop flows to all destinations, i.e. clearing all routes.

Fig. 11-38: Destination Flows Worksheet AFTER editing.

Save
Spreadsheet editing is now finished. 

1 Save the spreadsheet file.
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Step 3: Importing a Spreadsheet
The spreadsheet contains IP Configuration data. It is automatically validated when being 
imported into the GV Orbit Client. The data is used by the IP Configuration tool and 
automatically passed on to the GV Orbit Control application for use in its routing. 

The importing is presented below in the following steps:
• Step 3a: Import Preview, on page 526.
• Step 3b: Clearing Any Import Issues, on page 528.
• Step 3c: Import the Spreadsheet, on page 528.

Step 3a: Import Preview
To import the spreadsheet into the IP Configuration tool:

1 Select the Devices tab and click the Import button.

Fig. 11-39: Devices Tab Import Button

2 Select the required spreadsheet file to import and click Open.

The spreadsheet is opened and its contents are initially read and compared to the 
current data values in the IP Configuration tool automatically. Some preliminary data 
checks are done, checking for the uniqueness of spreadsheet values. 
Note: The importing operation is NOT done yet.

An Import Preview dialog (see Figure 11-40) is then shown and if there are any issues 
found from the data checks, then a Spreadsheet Duplicate Scan dialog is also shown 
(see Figure 11-41), which reports any issues found from the data checking. 

CAUTION Importing a spreadsheet into the IP Configuration is a 
potentially disruptive operation.

This is because it may affect all existing devices and routes. 

To try and prevent unintentional importing and 
disruption, GV Orbit Client alerts the user to the risk of the 
operation and presents an overt, prompting authorization 
step to go through.
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If there are issues, then the Import button in the Import Preview dialog is grayed out, 
preventing imports. This will be un-grayed out when issues are cleared.

(See Import Preview Dialog and Spreadsheet Duplicate Scan Dialog, on page 504, for 
more information about the dialog.)

Fig. 11-40: Import Preview Dialog

Note: The preliminary data value checking that is carried out upon 
spreadsheet import is insensitive to case.
For example, 

the duplicate checking will warn the user that 
‘MVinput’ is the same as ‘MVINPUT’.

Note: For information on the import data validation, see Import Preview 
Dialog and Spreadsheet Duplicate Scan Dialog, on page 504 and 
Import Data Validation - Duplicate Scan, on page 506.

‘Sheets to Import’ section, 
select all options for ‘Getting Going’ 
for the first time.

Note: The Import button will be grayed out if 
there are any import issues (presented in the 
pop-up Spreadsheet Duplicate Scan dialog).
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Step 3b: Clearing Any Import Issues

Fig. 11-41: Spreadsheet Duplicate Scan Dialog.

If there are any issues shown in the Spreadsheet Duplicate Scan dialog, then:
1 Inspect each issue in the dialog.
2 Re-visit the spreadsheet and correct any issues.

(See Spreadsheet Duplication Scan Dialog, on page 506, and Resolving Duplicate 
Issues, on page 507.)

Finally:
3 Close the Spreadsheet Duplicate Scan dialog and Cancel the Import Preview dialog.

This aborts the import.
4 Re-import the spreadsheet.

Step 3c: Import the Spreadsheet
The Import button on the Import Preview dialog is:

• Grayed out when there are reported or unaccounted for import duplicate issues.
• Not grayed out when there are no issues or all issues are accounted for.

Note: The default behavior on importing new values from a spreadsheet is 
to not allow duplicate values. For user cases where duplicate Port 
Names are required for some reason, there is a mechanism for getting 
round this. See Before Allowing Duplicate Port Names in an Import, 
on page 508.

Note: This dialog is shown before any importing of spreadsheet 
information, and it warns of any potential import issues that there are.
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To import:
1 In the ‘Sheets to Import’ section of the Import Preview dialog, 

select the import options required. 
When ‘Getting Going’ for the first time, select all options.

2 Click Import.

The importing of the spreadsheet information begins. 
3 A High Risk Alert dialog is shown when importing a spreadsheet.

See Figure 11-42a, b and c.

.

Fig. 11-42: HIGH RISK Alert and Authorization:
a) HIGH RISK Alert; b) Enter User Password; c) Authorization Successful.

IMPORTANT Importing is a potentially disruptive operation to any 
current IP routing being done by GV Orbit. 
When ‘getting started’ for the first time, no routing should 
be currently happening, it is alright to continue.

a) High risk operation alert message

b) Enter user project password

c) Authorization successful, press ‘Next’
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4 Follow the on-screen instructions on the HIGH RISK dialogs to authorize the importing.

To abort the importing process, click Cancel on the HIGH RISK dialog.
To continue, press Next on the dialog.

Entry of the user password is required.
after which, to begin importing, press Next in the dialog. (Pressing Cancel aborts.)

The importing proceeds.
5 When the importing is complete, 

an Import summary dialog shows a summary of what configuration settings have 
been restored.

Fig. 11-43: Import Summary

6 Click OK.

The configuration in the spreadsheet has been imported into the IP Configuration tool in 
GV Orbit Client. The information is made available to GV Orbit Control for routing.

After import, in the IP Configuration tool:
• Devices will adopt the newly-set device names.
• Device ports will be mapped to the newly-defined router port numbers, with new port 

names.
• Device source spigots will be able to send out flows.
• Device destination spigots will be ready to receive flows.
• No flows will be routed.

CAUTION Importing a spreadsheet into the IP Configuration is a 
potentially disruptive operation.

This is because it may affect all existing devices and routes. 

To try and prevent unintentional importing and 
disruption, GV Orbit Client alerts the user to the risk of the 
operation and presents an overt, prompting authorization 
step to go through.

Note: Only settings for on-line devices are initially compared and then 
imported.
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GV Orbit C&M projects contain C&M project screens and XY Panel screens (see Chapter 6, 
Routing Control - XY Routing Panel, on page 265) which use on-screen widgets and 
‘behind-the-scenes’ GV Orbit Client Behaviours and Bindings. 

Routing type Behaviours and Bindings may be used with on-screen Button widgets etc. on 
XY Panel screens or soft control panels to synthesize a custom router control panel. 

These Routing Behaviours and Bindings are listed in Table A-1 and Table A-2 respectively. 

Routing Behaviours

Note: It is recommended that an XY panel screen created via the XY Wizard 
is used as the basis of a custom routing panel. This may be edited in GV Orbit 
and customized as required.

 Table A-1: Routing Behaviours 

Behaviour Parameters

Name,
(RollCall) Address,
+...

Description

When triggered on an GV Orbit C&M project XY panel screen...

BPX Source,
Destination

Routes a defined Source to a defined Destination.

(BPX, button per crosspoint)

Cancel Mode Cancels any selected Destination(s) and pre-selected 
Source(s).

Destination Destination,
Level

Provides access to information about a Destination, including 
its name, port number and the currently-routed Source.

Destination Button Index,
Destination,
Mode

Enables a button to act like a Destination selection button.

Destination Level 
Button

Index Enables a button to act like a Destination Level selection 
button.

Dialpad Index,
Sources,
Clear,
Delete

Enables a button widget to act like a Dial Pad button.

Dialup Tally Sources Allows the currently active Dialup value to be displayed (on a 
panel screen).
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Filter Sources Applies a filter to the router Sources or Destinations.

Load Panel Target Opens the GV Orbit Client Routing Panel in the client window 
or on a monitor display.

Page Page Sources,
Page Offset

Switches between router panel pages

Page Index Page Sources,
Index

Switches to a specific page index,

Page Tally Page Sources Allows the current page value to be displayed (on a panel 
screen).

Panel Lock Mode Toggles panel lock/unlock.

Protect - Protects a selected Destination.

Redo Button - Re-makes a route, used to implement a Redo button. 
(When placed on a panel schematic, enables Redo mode.)

Salvo Salvo Executes a salvo.

Source Button Index,
Source,
Mode

Selects a Source.

Source Level 
Button

Index Enables a button to act like a Source Level selection button.

Take Mode Router Take: Makes a route, used to implement a Take button. 
(When placed on a panel schematic, enables Take mode.)

Undo Button Undo Requires Take,
Undo Timeout

Undoes a route, used to implement an Undo button. 
(When placed on a panel schematic, enables Undo mode.)

 Table A-1: Routing Behaviours  (continued)

Behaviour Parameters

Name,
(RollCall) Address,
+...

Description

When triggered on an GV Orbit C&M project XY panel screen...
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Routing Bindings

 Table A-2: Routing Bindings 

Binding Parameters

Name,
+...

Description

Binding binds a...

Panel Lock Source Behaviour,
Locked Caption,
Unlocked Caption

...Widget to Panel Lock function.

Router Button Source Behaviour,
Normal Style,
Preset Style,
Routed Style

...Routing Behaviour to a Button.
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Introduction
This appendix outlines the format of the IP Configuration spreadsheet used by GV Orbit 
Client

All IP endpoint settings (device name, spigot and flow settings etc.) of an GV Orbit Client IP 
routing network configuration (IP Configuration) may be exported (saved) to a file or 
imported from a file. The file is a spreadsheet file and it may be created off-line from scratch; 
or an exported spreadsheet may be used and edited off-line (which is easier).

The exported file is in a spreadsheet format and can:
• be edited;
• provide a ‘template’ spreadsheet;
• be used during system set up; 
• be the primary source of information;
• be the Orbit project backup mechanism.

Import and Export Buttons
Exporting or importing is done in the Devices tab of the IP Configuration tool in GV Orbit 
Client. 

• Clicking on the Export or on the Import buttons in the tab’s tool bar. 

Note: It is recommended that an exported spreadsheet from your system is 
used as the basis for entering settings for your system.
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Fig. B-1: Devices Tab - Import and Export Buttons
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Exported Spreadsheet File

Fig. B-2: IP Configuration Spreadsheet

The exported file is in an MS Office spreadsheet format (file extension .xlsx).
There are five tabbed work sheets in the file:

• Device Names Work Sheet
• Source Ports and Destination Ports Worksheets
• Source Flows and Destination Flows Worksheets

Each worksheet contains two sorts of data columns:
• Key Field columns - these list parameters which define a Device, a Spigot or a Flow. 

These fields simply report existing settings and should not be changed.
• Value Field columns - these hold user-defined values that may be changed in the 

spreadsheet.

Thus, each worksheet row has Key Fields and Value Fields.
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Device Names Work Sheet
Each row represents a Device. A Device is defined either by the device GUID or by the 
device IP address; the IP address can be either the primary (fabric A) or secondary (fabric B) 
address. If both the GUID and the IP address are present then the GUID is used to identify 
the device. 

Fig. B-3: Device Names Worksheet Example

In the Spreadsheet:
In the spreadsheet, the following fields are key value fields:

• Device Name (max 63 characters).
• Short Name (max 15 characters).
• Host Name (max 63 characters).
• Description (max 255 characters).

In the IP Configuration Tool:
In the IP Configuration tool, the following columns are editable by the user in the tool:

• Device Name.
• Short Name.
• Host Name.
• Description.

Key field columns Value Field columns

Each row represents a Device
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Source Ports and Destination Ports Worksheets
These two worksheets are similar. Each row represents a spigot on a device defined by the 
device GUID, or by the device IP address, or by the device name. On the device, a spigot is 
defined by a spigot number, Spigot Index.
If the GUID is present, it is used in preference to either the IP address or device name. 
If the IP address is present, it is used in preference to the device name.

Fig. B-4: Source Ports Worksheet Example

Fig. B-5: Destination Ports Worksheet Example

In the Spreadsheet:
In the spreadsheet, the following fields are key value fields:

• Port Number (integer).
• Port Name (max 63 characters).
• Short Name (max 9 characters, but 8 characters for an IPRA routing-controlled system).

In the IP Configuration Tool:
In the IP Configuration tool, the following columns are editable by the user in the tool:

• Port Name.
• Short Name.
• Port Number.

Each row represents a Source Spigot

Key field columns  Value field columns

Each row represents a Destination Spigot

Key field columns  Value field columns
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Source Flows and Destination Flows Worksheets
These two worksheets are similar.

Each row represents an IP flow on a device defined by the device GUID, or by the device IP 
address, or by the device name. On the device, a spigot is defined by a spigot number, 
Spigot Index.
If the GUID is present, it is used in preference to either the IP address or device name. 
If the IP address is present, it is used in preference to the device name.

Fig. B-6: Source Flows Worksheet Example

Note: Flow Index is for information only - created at Export and ignored 
during Import.

Value field columns

For information only

Key field columns

Each row represents a Source Flow
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Fig. B-7: Destination Flows Worksheet Example

In the Spreadsheet:
In the spreadsheet, the following fields are key value fields.

• Flow Enabled.
• Multicast Address.
• Source Address.
• Dst RTP Port.
• Src RTP Port.

In the IP Configuration Tool:
In the IP Configuration tool, the following columns are editable by the user in each tab of 
the tool:

• Flow Enabled.
• Multicast Group Address.
• Source IP Address.
• Dest RTP Port.
• Source RTP Port.

Value field columns

For information only

Key field columns

Each row represents a Destination Flow
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Example Spreadsheet

Fig. B-8: Device Names Worksheet
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Fig. B-9: Source Ports Worksheet

Fig. B-10: Destination Ports Worksheet
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Fig. B-11: Source Flows Worksheet

Fig. B-12: Destination Flows Worksheet
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Glossary of Terms
3G Proxy An ST-2110 video IP stream representing another video signal in a 

production system. The proxy has the same video and audio content as the 
signal it represents. The proxy’s video standard is ‘3G’. 

Alarm An indication that a component or device or module or unit within a facility 
is not operating at normal established parameters.

Alarm Acknowledgment An on-line, live action to notify other users that new alarms were raised in a 
facility. This is usually manually done by a user and is usually followed by 
actions to resolve cause of the alarms in question. Alarms in the system will 
flash when raised, or be in some alert state, until they are acknowledged.

Client Computer software that accesses services made available by a server. The 
server itself resides on a different piece of computer hardware. The client 
can be downloaded from the server on a local computer.

Client Domain A GVOP Domain used by the GV Orbit Client to interact with devices and 
services in a GV Orbit system.

Cluster Multiple devices grouped or merged together to increase the capacity of 
inputs, outputs, or processing power.

Clustered Multiviewer 
Project,

Clustered MV Project

A GV Orbit project type which defines one or more video walls served by a 
cluster of multiviewer devices.

Domain A group of devices on a network that are administered as a unit with 
common rules and procedures.

Dynamic Destination 
Assignment

A mode of operation of a Clustered Multiviewer project where video wall 
tiles are automatically assigned a router destination when a Room Layout 
changes, based on the needs of the currently-shown Room Layout. 
Dynamic assignment can apply to all tiles, or a sub-set of tiles on the video 
wall.

Fabric A combination of hardware and software that forms a network.

Fabric A & Fabric B Two identical network systems that form an IP media network with a 
redundant network topology.

GV Orbit Client Graphical client user application in a GV Orbit configuration, control and 
monitoring system. A user can run various projects in a client and can 
configure devices, control routing, and monitor systems. Graphical soft 
control and monitoring user panels can be designed and run. Graphical 
video walls can be designed for multiviewers.
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GV Orchestration Protocol, 
GVOP

The main messaging protocol used in GV Orbit configuration, control and 
monitoring systems. 

GVOP Domain A GV Orbit system employs GVOP Domains to segregate internal 
communications. The various GV Orbit services, system devices, and GV 
Orbit Client applications all communicate with one another; 
communications may be segregated by using GVOP Domains.

GVOP Domain ID A GV Orbit system employs GVOP Domains specified with a Domain ID 
number (1 to 252).

Head,
Head Display Output,
Multiviewer Output

A multiviewer output to be shown on a monitor display. The MV-821-IP 
multiviewer has up to 12 Head Display Outputs and offers these as signals 
on rear physical connectors and as full ST-2110 video IP streams.

Home Page First page (also known as ‘current home’ or ‘default home’) that is displayed 
by default when a site is opened, or by clicking a dedicated home button, 
in a site or panel. This page is usually set by the user at configuration time.

Log Server Domain A GV Orbit Domain used by the Log Server Service to collect RollCall-
protocol device logging data.

Log Server Service A GV Orbit service which collects and collates logging information from 
RollCall-protocol devices for the GV Orbit system. The service typically 
provides logging data to the GV Orbit Monitoring Service.

MapView A control and monitoring GV Orbit project (C&M project) that contains 
custom screens to enable the user to control and monitor a system. 

Media IP Network A high-capacity network dedicated to carrying high bit rate media.

Monitor Layout The grid of tiles on a monitor of a video wall and the tiles populated on the 
grid. This refers to video walls designed with the Room Editor tool in GV 
Orbit Client. 
‘Monitor Layout’ is analogous to ‘Wall Layout’ for video walls designed with 
the Wall Editor tool.

Monitor Wall, 
Video Wall

One or more monitor display screens arranged and configured to form one 
larger screen area.

Multiviewer A device that consolidates multiple video sources onto one or more head 
display outputs for ultimate display on monitor screens.

Multiviewer Input A video source routed into a multiviewer.

Multiviewer Output A multiviewer head display output. See ‘Head’.

Multiviewer Cluster,
MV Cluster

A cluster of multiviewer devices configured together and all acting 
together to serve one or more video walls. A cluster contains one or more 
MV-8 Series multiviewer devices.

MV Cluster Manager Service A GV Orbit service which enables a user to configure a cluster of MV-8 series 
multiviewers as a single multiviewing system, rather than as separate, 
individual multiviewer devices.

MV-8 Series Multiviewer A Grass Valley multiviewer series which includes router-integrated devices 
(for example, MV-831) and stand-alone devices (for example, MV-821-IP IP 
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multiviewer). All MV-8 Series multiviewers share the same core multiviewer 
functionality.

Network Map A tree view representation of system devices and services.

Network View A window that displays a network map. Various device operations can be 
carried out from this view, such as opening device configuration screens 
and device alarm history views.

NP0017 An established Grass Valley dedicated router control protocol. 

PiP ‘Picture-in-Picture’ and another word for a multiviewer video wall Tile.

Overall Alarm A type of virtual alarm that indicates the overall condition of a device or 
service. It is based on the combined state of constituent alarms and is often 
generated automatically by a monitoring system.

Relay Service A GV Orbit service which passes selected GVOP data between two GVOP 
Domains. For example, to an MV-821 multiviewer Domain.

Room A video wall comprising one or more monitors - for example, in a 
production room of a broadcast facility or OB truck. A Room is served by a 
cluster of multiviewers. A ‘Room’ is designed in the ‘Room Editor’ tool.

Room file,
.room file

A data file used by a GV Orbit Clustered MV project and which contains the 
definition of a Room video wall. This is not editable by the user outside of 
GV Orbit Client. The Room file is usually referred to as the Room.

Room Design A design for a Room, a video wall, including monitor arrangement, tile 
layouts, source and destination assignments. A ‘Room Design’ is stored in 
a ‘Room File’ in a ‘Clustered MV’ project.

Room Editor An editing facility in GV Orbit Client enabling a video wall to be designed 
and edited in a GV Orbit Clustered MV project. 

Room Layout The grid of tiles on an entire video wall and the tiles populated on the grid. 
This refers to video walls designed with the Room Editor tool in GV orbit 
Client. 

Routing Domain A GVOP Domain used by the ‘Routing Service’ for routing control messages 
in a GV Orbit system.

Routing Service A GV Orbit service which provides a translation between dedicated routing 
protocols and the GV Orbit router controller for GV Orbit clients and other 
services. The service enables the state of all routes and routing levels to be 
saved as a snapshot. The service allows routes to be made from the GV Orbit 
Client and source and destination names to be known by GV Orbit Client.

Scaler An image re-sizing ‘engine’. Several are found within a multiviewer. For 
example, the MV-8 Series of multiviewers contains 48 ‘Scalers’, one per 
multiviewer input.

Spigot A logical connector on an IP media network. A spigot which sources 
(originates, transmits) an IP stream is a source spigot. One which receives an 
IP stream is a destination spigot.

Stream A flow of data, video, audio or metadata which arrives at or leaves a device 
through one of its ports.
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Tally A ‘Tally’ refers to a state of a production system. For example: “On Air”, “Iso”, 
or “Preview”.

Tally Routing The identity or label of the actual source that is routed to a destination 
(routed source).

Tile, 
PiP

(Multiviewer video wall context:) 
A rectangular area on a video wall screen, usually displaying video inputs 
and other supporting information. 
For example, a tile (or PiP) may display a video picture with audio bars and 
other related label and status information, including Tally information. 
Other information may be displayed in tiles. For example: time; images; or 
text.

Tile Grid The arrangement of tiles on a monitor of a video wall. A tile grid specifies 
the position of tiles. A tile grid is then populated with tiles of the required 
type/ configuration. The default is a video tile.

Topology The logical or physical arrangement of the various devices within a 
broadcast facility.

Video Wall, 
Monitor Wall

One or more monitor display screens arranged and configured to form one 
larger screen area.

Wall, A ‘Wall’ is the name given to a monitor wall that has been designed in the 
Wall Editor tool of GV Orbit Client (or Orbit Client). ‘

Wall Editor An editing facility in GV Orbit Client (and in Orbit Client) enabling a video 
wall to be designed and edited in a GV Orbit multiviewer project. The video 
wall is served by a single multiviewer.

Wall Layout The grid of tiles on a monitor of a video wall and the tiles populated on the 
grid. Typically, this refers to video walls designed with the Wall Editor tool.

Widget A graphical element that displays information or let a user interact with 
various tasks of a control system.
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